This Computer program (including software design, programming structure, graphics, manual, and on-line help) was created and published by STRUCTUREPOINT, formerly the Engineering Software Group of the Portland Cement Association (PCA) for the engineering analysis and design of reinforced concrete beams and slab floor systems.

While STRUCTUREPOINT has taken every precaution to utilize the existing state-of-the-art and to assure the correctness of the analytical solution techniques used in this program, the responsibilities for modeling the structure, inputting data, applying engineering judgment to evaluate the output, and implementing engineering drawings remain with the structural engineer of record. Accordingly, STRUCTUREPOINT does and must disclaim any and all responsibility for defects or failures of structures in connection with which this program is used.

Neither this manual nor any part of it may be reproduced, edited, or altered by any means electronic or mechanical or by any information storage and retrieval system, without the written permission of STRUCTUREPOINT LLC.

All products, corporate names, trademarks, service marks, and trade names referenced in this material are the property of their respective owners and are used only for identification and explanation without intent to infringe. spSlab® and spBeam® are registered trademarks of STRUCTUREPOINT LLC.

Copyright © 2002 – 2011, STRUCTUREPOINT LLC All Rights Reserved.
## Table of Contents

Chapter 1 – Introduction .............................................................................................................. 1-1
Program Features ...................................................................................................................... 1-1
Program Capacity ..................................................................................................................... 1-2
System Requirements .............................................................................................................. 1-2
Terms ...................................................................................................................................... 1-2
Conventions ............................................................................................................................. 1-3
Installing, Purchasing and Licensing spSlab/spBeam .............................................................. 1-3

Chapter 2 – Method of Solution .......................................................................................... 2-1
Geometric Checks .................................................................................................................... 2-1
Code Checks .......................................................................................................................... 2-1
Special Considerations for One and Two-Way Joist Systems .............................................. 2-5
Material Properties................................................................................................................ 2-7
Equivalent Frame Method ...................................................................................................... 2-9
Loading ................................................................................................................................... 2-14
Column and Middle Strip Widths ........................................................................................... 2-17
Strip Design Moments .......................................................................................................... 2-20
Moment Redistribution ......................................................................................................... 2-23
Shear Analysis of Slabs ......................................................................................................... 2-24
One-Way Shear Analysis of Longitudinal Beams And Slabs .............................................. 2-30
Torsion and Shear .................................................................................................................. 2-34
Area of Reinforcement .......................................................................................................... 2-39
Reinforcement Selection ........................................................................................................ 2-42
Concentration and Additional Reinforcement at Support .................................................. 2-45
Structural Integrity Reinforcement ....................................................................................... 2-46
Corner Reinforcement ......................................................................................................... 2-47
Deflections ............................................................................................................................. 2-47
Material Quantities ............................................................................................................... 2-51
References .............................................................................................................................. 2-52

Chapter 3 – spSlab/spBeam Interface .................................................................................. 3-1
Main Window .......................................................................................................................... 3-1
File Menu ............................................................................................................................... 3-2
Input Menu ............................................................................................................................. 3-5
Solve Menu ............................................................................................................................. 3-9
View Menu ............................................................................................................................. 3-10
Options Menu ......................................................................................................................... 3-12
Window Menu ........................................................................................................................ 3-13
Help Menu ............................................................................................................................. 3-14
Control Menu ........................................................................................................................ 3-14
Program Toolbar ..................................................................................................................... 3-15

Chapter 4 – Operating spSlab/spBeam .................................................................................. 4-1
Working with Data Files (menu File) ...................................................................................... 4-1
Specifying Model Data (menu Input) ...................................................................................... 4-2
Executing Calculations (menu Solve) ..................................................................................... 4-38
View Program Output (menu View) ....................................................................................... 4-41
Customizing Program (menu Options) .................................................................................. 4-53
Working with View Windows (menu Window) ..................................................................... 4-54
Obtaining Help Information (menu Help) .............................................................................. 4-57

Chapter 5 – Output Description ............................................................................................ 5-1
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Elements</td>
<td>5-1</td>
</tr>
<tr>
<td>Program Version</td>
<td>5-1</td>
</tr>
<tr>
<td>Input Echo</td>
<td>5-1</td>
</tr>
<tr>
<td>Design Results</td>
<td>5-2</td>
</tr>
<tr>
<td>Column Axial Forces and Moments</td>
<td>5-6</td>
</tr>
<tr>
<td>Internal Forces - Load Cases</td>
<td>5-6</td>
</tr>
<tr>
<td>Internal Forces - Load Combinations</td>
<td>5-6</td>
</tr>
<tr>
<td>Internal Forces - Envelopes</td>
<td>5-6</td>
</tr>
<tr>
<td>Deflections</td>
<td>5-6</td>
</tr>
<tr>
<td>Required Reinforcement</td>
<td>5-6</td>
</tr>
<tr>
<td>Graphical Output</td>
<td>5-7</td>
</tr>
<tr>
<td>Chapter 6 – Examples</td>
<td>6-1</td>
</tr>
<tr>
<td>Example 1 Spandrel beam with moment redistribution</td>
<td>6-1</td>
</tr>
<tr>
<td>Example 2 Spandrel beam with torsion</td>
<td>6-19</td>
</tr>
<tr>
<td>Example 3 Design of a Continuous Beam</td>
<td>6-37</td>
</tr>
<tr>
<td>Example 4 Flat Plate Floor System</td>
<td>6-57</td>
</tr>
<tr>
<td>Example 5 Two-way slab system</td>
<td>6-76</td>
</tr>
<tr>
<td>Appendix</td>
<td>A-1</td>
</tr>
<tr>
<td>Conversion Factors - English to SI</td>
<td>A-1</td>
</tr>
<tr>
<td>Conversion Factors - SI to English</td>
<td>A-1</td>
</tr>
<tr>
<td>Contact Information</td>
<td>A-1</td>
</tr>
</tbody>
</table>
STRUCTUREPOINT EVALUATION SOFTWARE LICENSE AGREEMENT

BY CLICKING THE "I AGREE" ICON BELOW, OR BY INSTALLING, COPYING, OR OTHERWISE USING THE SOFTWARE OR USER DOCUMENTATION, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE WARRANTY DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL OR USE THE SOFTWARE OR USER DOCUMENTATION, EXIT THIS APPLICATION NOW AND RETURN THE SOFTWARE AND USER DOCUMENTATION TO STRUCTUREPOINT.

STRUCTUREPOINT, 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077, GRANTS THE CUSTOMER A PERSONAL, NONEXCLUSIVE, LIMITED, NONTRANSFERABLE LICENSE TO USE THIS SOFTWARE AND USER DOCUMENTATION SOLELY FOR TRIAL AND EVALUATION PURPOSES ONLY IN ACCORDANCE WITH THE TERMS AND CONDITIONS OF THIS AGREEMENT. SOFTWARE AND USER DOCUMENTATION IS SUPPLIED TO CUSTOMER EITHER BY STRUCTUREPOINT DIRECTLY OR THROUGH AN AUTHORIZED DEALER OF STRUCTUREPOINT (HEREAFTER DEALER).

WHILE STRUCTUREPOINT HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS OF THE ANALYTICAL SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, IT CANNOT AND DOES NOT GUARANTEE ITS PERFORMANCE, NOR CAN IT OR DOES IT BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH WHICH THIS SOFTWARE MAY BE USED. DEALER (IF ANY) HAS NOT PARTICIPATED IN THE DESIGN OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER GUARANTEES THE PERFORMANCE OF THE SOFTWARE NOR BEARS ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH WHICH THIS SOFTWARE IS USED.

STRUCTUREPOINT AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY THAT: (A) THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE REQUIREMENTS OF CUSTOMER OR OPERATE IN COMBINATIONS THAT MAY BE SELECTED FOR USE BY CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE FREE OF ALL "BUGS" OR PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO ANY PERFORMANCE SPECIFICATIONS. CUSTOMER ACKNOWLEDGES THAT STRUCTUREPOINT IS UNDER NO OBLIGATION TO PROVIDE ANY SUPPORT, UPDATES, BUG FIXES OR ERROR CORRECTIONS TO OR FOR THE SOFTWARE OR USER DOCUMENTATION.

THE LIMITED WARRANTIES IN SECTION 6 HEREOF ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED.

EXCEPT AS SET FORTH IN SECTION 6, THE SOFTWARE AND USER DOCUMENTATION ARE PROVIDED ON AN "AS-IS" BASIS.

IN NO EVENT SHALL STRUCTUREPOINT OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS OF PROFITS, DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF STRUCTUREPOINT OR DEALER (IF ANY) HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM AGAINST CUSTOMER BY ANY THIRD PARTY; OR (C) ANY DAMAGES CAUSED BY (1) DELAY IN DELIVERY OF THE SOFTWARE OR USER DOCUMENTATION UNDER THIS AGREEMENT; (2) THE PERFORMANCE OR NON PERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM USE OF THE SOFTWARE OR USER DOCUMENTATION, INCLUDING, WITHOUT LIMITATION, MISTAKES, ERRORS, INACCURACIES, FAILURES OR CUSTOMER'S INABILITY TO PROVIDE SERVICES TO THIRD PARTIES THROUGH USE OF THE SOFTWARE OR USER DOCUMENTATION; (4) CUSTOMER'S FAILURE TO PERFORM CUSTOMER'S RESPONSIBILITIES; (5) STRUCTUREPOINT NOT PROVIDING UPDATES, BUG FIXES OR CORRECTIONS TO OR FOR ANY OF THE SOFTWARE OR USER DOCUMENTATION; (6) DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, CONSEQUENTIAL OR OTHER DAMAGES, ARISING FROM THE USE OR ABSENCE OF THE SOFTWARE OR USER DOCUMENTATION CAUSED BY (a) ACCIDENT, (b) NEGLIGENCE OR ABUSE BY CUSTOMER, (c) ACTS OF THIRD PERSONS INCLUDING, BUT NOT LIMITED TO, INSTALLATION, REPAIR, MAINTENANCE OR OTHER CORRECTIVE WORK RELATED TO ANY EQUIPMENT BEING USED, (d) CAUSES EXTERNAL TO THE SOFTWARE SUCH AS POWER FLUCTUATION AND FAILURES, OR (e) FLOODS, WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN NO EVENT SHALL STRUCTUREPOINT BE LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS OR ANY OTHER UNDERSTANDINGS BETWEEN CUSTOMER AND DEALER (IF ANY) RELATING TO THE SOFTWARE OR USER DOCUMENTATION.

THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN CUSTOMER AND STRUCTUREPOINT AND DEALER (IF ANY) WITH RESPECT TO THE SOFTWARE AND USER DOCUMENTATION TO BE FURNISHED HEREUNDER. IT IS A FINAL EXPRESSION OF THAT AGREEMENT AND UNDERSTANDING. IT SUPERSEDES ALL PRIOR COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION LICENSE AND ALL ORAL AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY STRUCTUREPOINT'S OR DEALER'S (IF ANY) REPRESENTATIVES ABOUT THE SOFTWARE OR USER DOCUMENTATION DO NOT CONSTITUTE REPRESENTATIONS OR WARRANTIES, SHALL NOT BE RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS AGREEMENT.

1. LICENSE RESTRICTIONS

a. Except as expressly provided in this Agreement or as otherwise authorized in writing by STRUCTUREPOINT, Customer has no right to: (1) use, print, copy, display, reverse assemble, reverse engineer, translate or decompile the Software or User Documentation in whole or in part; (2) disclose, publish, release, sublicense or transfer to another person any Software or
User Documentation; (3) reproduce the Software or User Documentation for the use or benefit of anyone other than Customer; or (4) modify any Software or User Documentation. All rights to the Software and User Documentation not expressly granted to Customer hereunder are retained by STRUCTUREPOINT. All copyrights and other proprietary rights except as expressed elsewhere in the Software or User Documentation and legal title thereto shall remain in STRUCTUREPOINT. Customer may use the Software only as licensed by STRUCTUREPOINT on designated workstation at Customer's site at any given time. Customer may not transmit the Software licenses electronically to any other workstation, computer, node or terminal device whether via a local area network, a wide area network, telecommunications transmission, the Internet or other means now known or hereafter created without prior written permission by STRUCTUREPOINT.

b. Customer acknowledges that this is a limited license for trial and evaluation purposes only. This limited license shall automatically terminate upon the earlier of: (1) ten executions of the Software on the computer on which it is installed; or (2) fifteen days after the installation of the Software. Thereafter, Customer may only use the Software and Documentation if it acquires a production license for the same.

2. TERM AND TERMINATION

a. This Agreement shall be in effect from the date Customer clicks the “I AGREE” icon below or installs, copies or otherwise uses the Software or User Documentation until: (1) it is terminated by Customer, by Dealer (if any) on behalf of Customer or STRUCTUREPOINT or by STRUCTUREPOINT as set forth herein; or (2) the limited trial and evaluation license terminates.

b. This Agreement may be terminated by STRUCTUREPOINT without cause upon 30 days' written notice or immediately upon notice to Customer if Customer breaches this Agreement or fails to comply with any of its terms or conditions. This Agreement may be terminated by Customer without cause at any time upon written notice to STRUCTUREPOINT.

3. BACKUP AND REPLACEMENT COPIES

Customer may make one copy of the Software for back-up and archival purposes only, provided STRUCTUREPOINT's copyright and other proprietary rights notices are included on such copy.

4. PROTECTION AND SECURITY

a. Customer shall not provide or otherwise make available any of the Software or User Documentation in any form to any person other than employees of Customer with the need to know, without STRUCTUREPOINT’s written permission.

b. All Software and User Documentation in Customer's possession including, without limitation, translations, compilations, back-up, and partial copies is the property of STRUCTUREPOINT. Upon termination of this Agreement for any reason, Customer shall immediately destroy all Software and User Documentation, including all media, and destroy any Software that has been copied onto other magnetic storage devices. Upon STRUCTUREPOINT’s request, Customer shall certify its compliance in writing with the foregoing to STRUCTUREPOINT.

c. Customer shall take appropriate action, by instruction, agreement or otherwise, with any persons permitted access to the Software or User Documentation, to enable Customer to satisfy its obligations under this Agreement with respect to use, copying, protection, and security of the same.

d. If STRUCTUREPOINT prevails in an action against Customer for breach of the provisions of this Section 4, Customer shall pay the reasonable attorneys' fees, costs, and expenses incurred by STRUCTUREPOINT in connection with such action in addition to any award of damages.

5. CUSTOMER'S RESPONSIBILITIES

The essential purpose of this Agreement is to provide Customer with limited use rights to the Software and User Documentation. Customer accepts full responsibility for: (a) selection of the Software and User Documentation to satisfy Customer's business needs and achieve Customer's intended results; (b) the use, set-up and installation of the Software and User Documentation; (c) all results obtained from use of the Software and User Documentation; and (d) the selection, use of, and results obtained from any other software, programming equipment or services used with the Software or User Documentation.

6. LIMITED WARRANTIES

STRUCTUREPOINT and Dealer (if any) warrants to Customer that: (a) STRUCTUREPOINT and Dealer (if any) has title to the Software and User Documentation and/or the right to grant Customer the rights granted hereunder; (b) the Software and User Documentation provided hereunder is STRUCTUREPOINT's most current production version thereof; and (c) the copy of the Software provided hereunder is an accurate reproduction of the original from which it was made.

7. LIMITATION OF REMEDY

a. STRUCTUREPOINT AND DEALER (IF ANY) HAS NO LIABILITY UNDER THIS AGREEMENT. CUSTOMER'S EXCLUSIVE REMEDY FOR DAMAGES DUE TO PERFORMANCE OR NONPERFORMANCE OF ANY SOFTWARE OR USER DOCUMENTATION, STRUCTUREPOINT, DEALER (IF ANY), OR ANY OTHER CAUSE WHATSOEVER, AND REGARDLESS OF THE FORM OF ACTION, WHETHER IN CONTRACT OR IN TORT, INCLUDING NEGLIGENCE, SHALL BE LIMITED TO CUSTOMER STOPPING ALL USE OF THE SOFTWARE AND USER DOCUMENTATION AND RETURNING THE SAME TO STRUCTUREPOINT.

b. NEITHER STRUCTUREPOINT NOR DEALER (IF ANY) IS AN INSURER WITH REGARD TO THE PERFORMANCE OF THE SOFTWARE OR USER DOCUMENTATION. THE TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE LIMITED WARRANTIES, AND THE LIMITATION OF LIABILITY
AND REMEDY, ARE A REFLECTION OF THE RISKS ASSUMED BY THE PARTIES. IN ORDER TO OBTAIN THE SOFTWARE AND USER DOCUMENTATION FROM STRUCTUREPOINT OR DEALER (IF ANY), CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES DISCLAIMED BY STRUCTUREPOINT AND DEALER (IF ANY) ON THE FACE HEREOF; AND (2) ALL ACTUAL OR ALLEGED DAMAGES IN CONNECTION WITH THE USE OF THE SOFTWARE AND USER DOCUMENTATION. THE ESSENTIAL PURPOSE OF THE LIMITED REMEDY PROVIDED CUSTOMER HEREUNDER IS TO ALLOCATE THE RISKS AS PROVIDED ABOVE.

8. U.S. GOVERNMENT RESTRICTED RIGHTS

This commercial computer software and commercial computer software documentation were developed exclusively at private expense by STRUCTUREPOINT, 5420 Old Orchard Road, Skokie, Illinois, 60077. U.S. Government rights to use, modify, release, reproduce, perform, display or disclose this computer software and computer software documentation are subject to the restrictions of DFARS 227.7202-1(a) (September 2007) and DFARS 227.7202-3(a) (September 2007), or the Restricted Rights provisions of FAR 52.227-14 (December 2007) and FAR 52.227-19 (December 2007), as applicable.

9. GENERAL

a. No action arising out of any claimed breach of this Agreement or transactions under this Agreement may be brought by Customer more than two years after the cause of such action has arisen.

b. Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license granted herein or the Software or User Documentation by operation of law or otherwise without the prior written consent of STRUCTUREPOINT. Any attempt to do any of the foregoing without STRUCTUREPOINT’s consent is void.

c. Customer acknowledges that the Software, User Documentation and other proprietary information and materials of STRUCTUREPOINT are unique and that, if Customer breaches this Agreement, STRUCTUREPOINT may not have an adequate remedy at law and STRUCTUREPOINT may enforce its rights hereunder by an action for damages and/or injunctive or other equitable relief without the necessity of proving actual damage or posting a bond therefor.

d. THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE GOVERNED BY THE UNITED NATIONS CONVENTION ON CONTRACTS FOR THE INTERNATIONAL SALE OF GOODS, THE APPLICATION OF WHICH IS EXPRESSLY EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL INSTEAD BE GOVERNED BY THE LAWS OF THE STATE OF ILLINOIS, APPLICABLE TO CONTRACTS ENTERED INTO AND PERFORMED ENTIRELY WITHIN THE STATE OF ILLINOIS AND APPLICABLE FEDERAL (U.S.) LAWS. UCITA SHALL NOT APPLY TO THIS AGREEMENT.

e. THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN THE COUNTY OF COOK, STATE OF ILLINOIS, AND WAS TO HAVE BEEN PERFORMED IN THE COUNTY OF COOK, STATE OF ILLINOIS. ANY ACTION RELATING TO THIS AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN A COURT LOCATED IN COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY CONSENTS TO EXTRATERRITORIAL SERVICE OF PROCESS.

f. Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and inure to the benefit of the personal and legal representatives, permitted successors, and permitted assigns of the parties hereto.

g. All notices, demands, consents or requests that may be or are required to be given by any party to another party shall be in writing. All notices, demands, consents or requests given by the parties hereto shall be sent either by U.S. certified mail, postage prepaid or by an overnight international delivery service, addressed to the respective parties. Notices, demands, consents or requests served as set forth herein shall be deemed sufficiently served or given at the time of receipt thereof.

h. The various rights, options, elections, powers, and remedies of a party or parties to this Agreement shall be construed as cumulative and no one of them exclusive of any others or of any other legal or equitable remedy that said party or parties might otherwise have in the event of breach or default in the terms hereof. The exercise of one right or remedy by a party or parties shall not in any way impair its rights to any other right or remedy until all obligations imposed on a party or parties have been fully performed.

i. No waiver by Customer, STRUCTUREPOINT or Dealer (if any) of any breach, provision, or default by the other shall be deemed a waiver of any other breach, provision or default.

j. The parties hereto, and each of them, agree that the terms of this Agreement shall be given a neutral interpretation and any ambiguity or uncertainty herein should not be construed against any party hereto.

k. If any provision of this Agreement or portion thereof is held to be unenforceable or invalid by any court or competent jurisdiction, such decision shall not have the effect of invalidating or voiding the remainder of this Agreement, it being the intent and agreement of the parties that this Agreement shall be deemed amended by modifying such provision to the extent necessary to render it enforceable and valid while preserving its intent or, if such modification is not possible, by substituting therefor another provision that is enforceable and valid so as to materially effectuate the parties’ intent.

Except as set forth herein, this Agreement may be modified or amended only by a written instrument signed by a duly authorized representative of STRUCTUREPOINT and Customer.
STRUCTUREPOINT SOFTWARE LICENSE AGREEMENT

BY CLICKING THE "I AGREE" BELOW, OR BY INSTALLING, COPYING, OR OTHERWISE USING THE SOFTWARE OR USER DOCUMENTATION, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE WARRANTY DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL OR USE THE SOFTWARE OR USER DOCUMENTATION, EXIT THIS APPLICATION NOW AND RETURN THE SOFTWARE AND USER DOCUMENTATION TO STRUCTUREPOINT FOR A FULL REFUND WITHIN THIRTY DAYS AFTER YOUR RECEIPT OF THE SOFTWARE AND USER DOCUMENTATION.

STRUCTUREPOINT, 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077, GRANTS THE CUSTOMER A PERSONAL, NONEXCLUSIVE, LIMITED, NONTRANSFERABLE LICENSE TO USE THIS SOFTWARE AND USER DOCUMENTATION IN ACCORDANCE WITH THE TERMS AND CONDITIONS OF THIS AGREEMENT. SOFTWARE AND USER DOCUMENTATION IS SUPPLIED TO CUSTOMER EITHER BY STRUCTUREPOINT DIRECTLY OR THROUGH AN AUTHORIZED DEALER OF STRUCTUREPOINT (HEREAFTER DEALER).

WHILE STRUCTUREPOINT HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS OF THE ANALYTICAL SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, IT CANNOT AND DOES NOT GUARANTEE ITS PERFORMANCE, NOR CAN IT OR DOES IT BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH WHICH THIS SOFTWARE IS USED. DEALER (IF ANY) HAS NOT PARTICIPATED IN THE DESIGN OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER GUARANTEES THE PERFORMANCE OF THE SOFTWARE NOR BEARS ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH WHICH THIS SOFTWARE IS USED.

STRUCTUREPOINT AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY THAT: (A) THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE REQUIREMENTS OF CUSTOMER OR OPERATE IN COMBINATIONS THAT MAY BE SELECTED FOR USE BY CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE FREE OF ALL "BUGS" OR PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO ANY PERFORMANCE SPECIFICATIONS. CUSTOMER ACKNOWLEDGES THAT STRUCTUREPOINT IS UNDER NO OBLIGATION TO PROVIDE ANY SUPPORT, UPDATES, BUG FIXES OR ERROR CORRECTIONS TO OR FOR THE SOFTWARE OR USER DOCUMENTATION.

THE LIMITED WARRANTIES IN SECTION 7 HEREOF ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED. EXCEPT AS SET FORTH IN SECTION 7, THE SOFTWARE AND USER DOCUMENTATION ARE PROVIDED ON AN "AS-IS" BASIS.

IN NO EVENT SHALL STRUCTUREPOINT OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS OF PROFITS, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF STRUCTUREPOINT OR DEALER (IF ANY) HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM AGAINST CUSTOMER BY ANY THIRD PARTY EXCEPT AS PROVIDED IN SECTION 8 ENTITLED "INFRINGEMENT"; OR (C) ANY DAMAGES CAUSED BY (1) DELAY IN DELIVERY OF THE SOFTWARE OR USER DOCUMENTATION UNDER THIS AGREEMENT; (2) THE PERFORMANCE OR NONPERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM USE OF THE SOFTWARE OR USER DOCUMENTATION, INCLUDING, WITHOUT LIMITATION, MISTAKES, ERRORS, INACCURACIES, FAILURES OR CUSTOMER'S INABILITY TO PROVIDE SERVICES TO THIRD PARTIES THROUGH USE OF THE SOFTWARE OR USER DOCUMENTATION; (4) CUSTOMER'S FAILURE TO PERFORM CUSTOMER'S RESPONSIBILITIES; (5) STRUCTUREPOINT NOT PROVIDING UPDATES, BUG FIXES OR CORRECTIONS TO OR FOR ANY OF THE SOFTWARE OR USER DOCUMENTATION; (6) LABOR, EXPENSE OR MATERIALS NECESSARY TO REPAIR DAMAGE TO THE SOFTWARE OR USER DOCUMENTATION CAUSED BY (a) ACCIDENT, (b) NEGLIGENCE OR ABUSE BY CUSTOMER, (c) ACTS OF THIRD PERSONS INCLUDING, BUT NOT LIMITED TO, INSTALLATION, REPAIR, MAINTENANCE OR OTHER CORRECTIVE WORK RELATED TO ANY EQUIPMENT BEING USED, (d) CAUSES EXTERNAL TO THE SOFTWARE SUCH AS POWER FLUCTUATION AND FAILURES, OR (e) FLOODS, WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN NO EVENT SHALL STRUCTUREPOINT BE LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS OR ANY OTHER UNDERSTANDINGS BETWEEN CUSTOMER AND DEALER (IF ANY) RELATING TO THE SOFTWARE OR USER DOCUMENTATION.

THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN CUSTOMER AND STRUCTUREPOINT AND DEALER (IF ANY) WITH RESPECT TO THE SOFTWARE AND USER DOCUMENTATION TO BE FURNISHED HEREUNDER. IT IS A FINAL EXPRESSION OF THAT AGREEMENT AND UNDERSTANDING. IT SUPERSEDES ALL PRIOR COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION LICENSE AND ALL ORAL AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY STRUCTUREPOINT'S OR DEALER'S (IF ANY) REPRESENTATIVES ABOUT THE SOFTWARE OR USER DOCUMENTATION DO NOT CONSTITUTE REPRESENTATIONS OR WARRANTIES, SHALL NOT BE RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS AGREEMENT.

1. LICENSE RESTRICTIONS

a. Except as expressly provided in this Agreement or as otherwise authorized in writing by STRUCTUREPOINT, Customer has no right to: (1) use, print, copy, display, reverse assemble, reverse engineer, translate or decompile the Software or User Documentation in whole or in part; (2) disclose, publish, release, sublicense or transfer to another person any Software or User Documentation; (3) reproduce the Software or User Documentation for the use or benefit of anyone other than Customer; or (4) modify any Software or User Documentation. All rights to the Software and User Documentation not expressly granted to Customer hereunder are retained by STRUCTUREPOINT. All copyrights and other proprietary rights except as expressed elsewhere in the Software or User Documentation and legal title thereto shall remain in
This Agreement shall be in effect from the date Customer clicks the “I AGREE” below or installs, copies or otherwise uses the Software or User Documentation until it is terminated by Customer, by Dealer (if any) on behalf of Customer or STRUCTUREPOINT or by STRUCTUREPOINT as set forth herein.

b. This Agreement may be terminated by STRUCTUREPOINT without cause upon 30 days' written notice or immediately upon notice to Customer if Customer breaches this Agreement or fails to comply with any of its terms or conditions. This Agreement may be terminated by Customer without cause at any time upon written notice to STRUCTUREPOINT.

4. BACKUP AND REPLACEMENT COPIES
Customer may make one copy of the Software for back-up and archival purposes only, provided STRUCTUREPOINT's copyright and other proprietary rights notices are included on such copy.

5. PROTECTION AND SECURITY
a. c. Customer shall not provide or otherwise make available any of the Software or User Documentation in any form to any person other than employees of Customer with the need to know, without STRUCTUREPOINT’s written permission.

b. All Software and User Documentation in Customer's possession including, without limitation, translations, compilations, back-up, and partial copies is the property of STRUCTUREPOINT. Upon termination of this Agreement for any reason, Customer shall immediately destroy all Software and User Documentation, including all media, and destroy any Software that has been copied onto other magnetic storage devices. Upon STRUCTUREPOINT’s request, Customer shall certify its compliance in writing with the foregoing to STRUCTUREPOINT.

c. Customer shall take appropriate action, by instruction, agreement or otherwise, with any persons permitted access to the Software or User Documentation, to enable Customer to satisfy its obligations under this Agreement with respect to use, copying, protection, and security of the same.

d. If STRUCTUREPOINT prevails in an action against Customer for breach of the provisions of this Section 5, Customer shall pay the reasonable attorneys' fees, costs, and expenses incurred by STRUCTUREPOINT in connection with such action in addition to any award of damages.

6. CUSTOMER'S RESPONSIBILITIES
The essential purpose of this Agreement is to provide Customer with limited use rights to the Software and User Documentation. Customer accepts full responsibility for: (a) selection of the Software and User Documentation to satisfy Customer's business needs and achieve Customer's intended results; (b) the use, set-up and installation of the Software and User Documentation; (c) all results obtained from use of the Software and User Documentation; and (d) the selection, use of, and results obtained from any other software, programming equipment or services used with the Software or User Documentation.

7. LIMITED WARRANTIES
STRUCTUREPOINT and Dealer (if any) warrants to Customer that: (a) STRUCTUREPOINT and Dealer (if any) has title to the Software and User Documentation and/or the right to grant Customer the rights granted hereunder; (b) the Software and User Documentation provided hereunder is STRUCTUREPOINT's most current production version thereof; and (c) the copy of the Software provided hereunder is an accurate reproduction of the original from which it was made.

8. INFRINGEMENT
a. STRUCTUREPOINT shall defend Customer against a claim that the Software or User Documentation furnished and used within the scope of the license granted hereunder infringes a U.S. patent or U.S. registered copyright of any third party that was issued or registered, as applicable, as of the date Customer clicked the “I AGREE” below or installed, copied or otherwise began using the Software or User Documentation, and STRUCTUREPOINT shall pay resulting costs, damages, and attorneys’ fees finally awarded, subject to the limitation of liability set forth in Section 9 entitled “Limitation of Remedy,” provided that:
1. Customer promptly notifies STRUCTUREPOINT in writing of the claim.
2. STRUCTUREPOINT has sole control of the defense and all related settlement negotiations.
3. If such claim has occurred or in STRUCTUREPOINT's opinion is likely to occur, Customer shall permit STRUCTUREPOINT at its sole option and expense either to procure for Customer the right to continue using the Software or User Documentation or to replace or modify the same so that it becomes noninfringing. If neither of the foregoing alternatives
is reasonably available in STRUCTUREPOINT’s sole judgment, Customer shall, on one month's written notice from STRUCTUREPOINT, return to STRUCTUREPOINT the Software and User Documentation and all copies thereof.

b. STRUCTUREPOINT shall have no obligation to defend Customer or to pay costs, damages or attorneys' fees for any claim based upon (1) use of other than a current unaltered release of the Software or User Documentation, or (2) the combination, operation or use of any Software or User Documentation furnished hereunder with any other software, documentation or data if such infringement would have been avoided but for the combination, operation or use of the Software or User Documentation with other software, documentation or data.

c. The foregoing states the entire obligation of STRUCTUREPOINT and Customer’s sole remedy with respect to infringement matters relating to the Software and User Documentation.

9. LIMITATION OF REMEDY

a. STRUCTUREPOINT’s AND DEALER’S (IF ANY) ENTIRE LIABILITY AND CUSTOMER’S EXCLUSIVE REMEDY FOR DAMAGES DUE TO PERFORMANCE OR NONPERFORMANCE OF ANY SOFTWARE OR USER DOCUMENTATION, STRUCTUREPOINT, DEALER (IF ANY), OR ANY OTHER CAUSE WHATSOEVER, AND REGARDLESS OF THE FORM OF ACTION, WHETHER IN CONTRACT OR IN TORT, INCLUDING NEGLIGENCE, SHALL BE LIMITED TO THE AMOUNT PAID TO STRUCTUREPOINT OR DEALER (IF ANY) FOR THE SOFTWARE AND USER DOCUMENTATION.

b. NEITHER STRUCTUREPOINT NOR DEALER (IF ANY) IS AN INSURER WITH REGARD TO THE PERFORMANCE OF THE SOFTWARE OR USER DOCUMENTATION. THE TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE LIMITED WARRANTIES, AND THE LIMITATION OF LIABILITY AND REMEDY, ARE A REFLECTION OF THE RISKS ASSUMED BY THE PARTIES. IN ORDER TO OBTAIN THE SOFTWARE AND USER DOCUMENTATION FROM STRUCTUREPOINT OR DEALER (IF ANY), CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES DISCLAIMED BY STRUCTUREPOINT AND DEALER (IF ANY) ON THE FACE HEREOF; AND (2) ALL ACTUAL OR ALLEGED DAMAGES IN EXCESS OF THE AMOUNT OF THE LIMITED REMEDY PROVIDED HEREUNDER. THE ESSENTIAL PURPOSE OF THE LIMITED REMEDY PROVIDED CUSTOMER HEREUNDER IS TO ALLOCATE THE RISKS AS PROVIDED ABOVE.

10. U.S. GOVERNMENT RESTRICTED RIGHTS

This commercial computer software and commercial computer software documentation were developed exclusively at private expense by STRUCTUREPOINT, 5420 Old Orchard Road, Skokie, Illinois 60077. U.S. Government rights to use, modify, release, reproduce, perform, display or disclose this computer software and computer software documentation are subject to the restrictions of DFARS 227.7202-1(a) (September 2007) and DFARS 227.7202-3(a) (September 2007), or the Restricted Rights provisions of FAR 52.227-14 (December 2007) and FAR 52.227-19 (December 2007), as applicable.

11. GENERAL

a. No action arising out of any claimed breach of this Agreement or transactions under this Agreement may be brought by Customer more than two years after the cause of such action has arisen.

b. Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license granted herein or the Software or User Documentation by operation of law or otherwise without the prior written consent of STRUCTUREPOINT. Any attempt to do any of the foregoing without STRUCTUREPOINT’s consent is void.

c. Customer acknowledges that the Software, User Documentation and other proprietary information and materials of STRUCTUREPOINT are unique and that, if Customer breaches this Agreement, STRUCTUREPOINT may not have an adequate remedy at law and STRUCTUREPOINT may enforce its rights hereunder by an action for damages and/or injunctive or other equitable relief without the necessity of proving actual damage or posting a bond therefor.

d. THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE GOVERNED BY THE UNITED NATIONS CONVENTION ON CONTRACTS FOR THE INTERNATIONAL SALE OF GOODS, THE APPLICATION OF WHICH IS EXPRESSLY EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL INSTEAD BE GOVERNED BY THE LAWS OF THE STATE OF ILLINOIS, APPLICABLE TO CONTRACTS ENTERED INTO AND PERFORMED ENTIRELY WITHIN THE STATE OF ILLINOIS AND APPLICABLE FEDERAL (U.S.) LAWS. UCITA SHALL NOT APPLY TO THIS AGREEMENT.

e. THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN THE COUNTY OF COOK, STATE OF ILLINOIS, AND WAS TO HAVE BEEN PERFORMED IN THE COUNTY OF COOK, STATE OF ILLINOIS. ANY ACTION RELATING TO THIS AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN A COURT LOCATED IN COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY CONSENTS TO EXTRATERRITORIAL SERVICE OF PROCESS.

f. Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and inure to the benefit of the personal and legal representatives, permitted successors, and permitted assigns of the parties hereto.

g. All notices, demands, consents or requests that may be or are required to be given by any party to another party shall be in writing. All notices, demands, consents or requests given by the parties hereto shall be sent either by U.S. certified mail, postage prepaid or by an overnight international delivery service, addressed to the respective parties. Notices, demands, consents or requests served as set forth herein shall be deemed sufficiently served or given at the time of receipt thereof.
h. The various rights, options, elections, powers, and remedies of a party or parties to this Agreement shall be construed as cumulative and no one of them exclusive of any others or of any other legal or equitable remedy that said party or parties might otherwise have in the event of breach or default in the terms hereof. The exercise of one right or remedy by a party or parties shall not in any way impair its rights to any other right or remedy until all obligations imposed on a party or parties have been fully performed.

i. No waiver by Customer, STRUCTUREPOINT or Dealer (if any) of any breach, provision, or default by the other shall be deemed a waiver of any other breach, provision or default.

j. The parties hereto, and each of them, agree that the terms of this Agreement shall be given a neutral interpretation and any ambiguity or uncertainty herein should not be construed against any party hereto.

k. If any provision of this Agreement or portion thereof is held to be unenforceable or invalid by any court or competent jurisdiction, such decision shall not have the effect of invalidating or voiding the remainder of this Agreement, it being the intent and agreement of the parties that this Agreement shall be deemed amended by modifying such provision to the extent necessary to render it enforceable and valid while preserving its intent or, if such modification is not possible, by substituting therefor another provision that is enforceable and valid so as to materially effectuate the parties’ intent.

Except as set forth herein, this Agreement may be modified or amended only by a written instrument signed by a duly authorized representative of STRUCTUREPOINT and Customer.

April 2009
Chapter 1

Introduction

Formerly pcaSlab and ADOSS, spSlab is a computer program for the analysis and design of reinforced concrete beams and slab floor systems. Two-way slab systems are analyzed using the Equivalent Frame Method. Beams and frames of up to 22 spans can be analyzed and designed. In addition to the design option spSlab has the capability of investigating existing beams and slab systems. spSlab includes provisions for slab band systems as well as punching shear check and deflection calculations using cracked or gross sections. For beams, moment redistribution as well as combined shear and torsion design are available. Material quantity take-offs are computed. In addition to the required area of reinforcing steel at the critical sections, spSlab provides a complete bar schedule that includes number of bars and bar sizes and lengths. spSlab checks the applicable provisions of the relevant code.

Formerly pcaBeam, spBeam is a limited version of spSlab. It includes all elements that apply to beams and one-way slab systems. Topics describing these elements are denoted with an icon because they are included in both spSlab and spBeam. Two-way slab systems are available in spSlab only and topics related to two-way slab systems are denoted with an icon.

Program Features

- ACI 318-11, ACI 318-08, ACI 318-05, ACI 318-02, ACI 318-99, CSA A23.3-04, and CSA A23.3-94
- English and SI units
- Design and investigation of beams, one and two-way slabs including one-way joist systems (standard and wide module) and two-way joist systems (waffle slabs)
- Slab band system design and investigation for CSA A23.3-04 standard
- Flexure and shear design and investigation
- Torsion design and investigation for beams/one-way slab systems
- Longitudinal reinforcement for combined flexure, shear, and torsion per CSA A23.3-04 standard
- Automatic or manual moment distribution factors and strip widths
- Moment redistribution for beams/one-way slab systems
- Calculation of instantaneous and long-term deflections
- Mixed span types within one-way or two-way systems
- Auto-input wizard with instantaneous data checking
- Graphical display of geometry and loads as they are input
- Print preview of graphical screen
- User-controlled screen color settings
- Customizable results report
- Import input data from ADOSS v6.0x/7.0x and PCA-Beam v1.0x
- Detailed manual and online help
**Program Capacity**

- 21 supports (22 spans including left and right cantilevers)
- 6 load cases
- 50 load combinations
- 999 partial dead loads per case
- 999 partial live loads per case
- 2 top bar layers (Design mode)
- 2 bottom bar layers (Design mode)
- 15 bar sets per span

**System Requirements**

Any computer running Microsoft Windows XP, Windows Vista, or Windows 7 operating system is sufficient to run the spSlab and spBeam programs. For instructions on how to troubleshoot system specific installation and licensing issues, please refer to support pages on StructurePoint website at [www.StructurePoint.org](http://www.StructurePoint.org).

**Terms**

The following terms are used throughout this manual. A brief explanation is given to help familiarize you with them.

- **Windows** refers to the Microsoft Windows environment as listed in System Requirements.

- **[ ]** indicates equivalent value expressed in metric unit or CSA code requirement corresponding ACI code requirement

- **Click on** means to position the cursor on top of a designated item or location and press and release the left-mouse button (unless instructed to use the right-mouse button).

- **Double-click on** means to position the cursor on top of a designated item or location and press and release the left-mouse button twice in quick succession.

- **Marquee select** means to depress the mouse button and continue to hold it down while moving the mouse. As you drag the mouse, a rectangle (known as a marquee) follows the cursor. Release the mouse button and the area inside the marquee is selected.
Conventions

Various styles of text and layout have been used in this manual to help differentiate between different kinds of information. The styles and layout are explained below…

placed in a topic header means that the topic applies to both spSlab and spBeam

placed in a topic header means that the topic applies to spSlab only

*Italic* indicates a glossary item, or emphasizes a given word or phrase.

**Bold** All bold typeface makes reference to either a menu or a menu item command such as *File* or *Save*, or a tab such as *General Information* or *Columns*

**Mono-space** indicates something you should enter with the keyboard. For example type “c:\*.*.txt”.

**KEY + KEY** indicates a key combination. The plus sign indicates that you should press and hold the first key while pressing the second key, then release both keys. For example, “ALT + F” indicates that you should press the “ALT” key and hold it while you press the “F” key. Then release both keys.

**SMALL CAPS** Indicates the name of an object such as a dialog box or a dialog box component. For example, the OPEN dialog box or the CANCEL or MODIFY buttons.

Installing, Purchasing and Licensing spSlab/spBeam

For instructions on how to install, purchase, and license StructurePoint software please refer to support pages on StructurePoint website at [www.StructurePoint.org](http://www.StructurePoint.org).
Chapter 2

Method of Solution

The user should be aware of the assumptions made by the program during the design stage. These include details regarding loading, strip widths, reinforcement selection, deflection computations, material quantities, etc.

Geometric Checks

spSlab and spBeam provide various geometric checks to avoid an analysis with an inconsistent system. Dimensions of slabs, beams, drops, bands and column capitals are checked and modified to produce a code compliant system.

If a slab cantilever length is less than one-half the column dimension in the direction of analysis, $c_1$, or less than the lateral extension of the transverse beam into the cantilever, the cantilever length will be increased to the larger of these two lengths. If the slab width is less than one-half the column dimension transverse to the direction of analysis, $c_2$, or less than one-half the longitudinal beam width, the slab width will be increased to the larger of these two widths.

If a drop panel extends beyond the end of a slab cantilever, the drop panel dimensions will be reduced so that it extends only to the cantilever tip.

When a column capital is defined, the program checks if capital side slope (depth/extension ratio) is more than 1, i.e. the angle between capital side and column axis is no greater than 45 degrees. The upper limit for the side slope is 50. If a column with capital frames into a drop panel (or a beam), extension of the capital will be automatically adjusted – if necessary – so that projected sides of the capital do not fall outside of the drop panel (or the beam) edges before reaching slab soffit (see Figure 2-1). The modified column capital extension will be used when computing column stiffness and in punching shear calculations.

![Figure 2-1 Maximum capital width](image)

Code Checks

**Minimum Thickness – One-Way Construction**

The program checks beam or one-way slab thickness based on minimum requirement for ACI-318 code as specified in Table 9.5(a) or for CSA code according to Table 9.2. For lightweight concrete with density $90 \text{ lb/ft}^3 \leq w_c \leq 115 \text{ lb/ft}^3$ [1440 kg/m$^3$ \leq w$_c$ \leq 1840 kg/m$^3$] for ACI 318-11 and ACI 318-08.

90 lb/ft$^3 \leq w_c \leq 120 \text{ lb/ft}^3$ [1440 kg/m$^3$ \leq w$_c$ \leq 1920 kg/m$^3$] for ACI 318-05.

1 ACI 318-11 (Ref. [1]), 13.1.2; ACI 318-08 (Ref. [2]), 13.1.2; ACI 318-05 (Ref. [3]), 13.1.2; ACI 318-02 (Ref. [4]), 13.1.2; ACI 318-99 (Ref. [5]), 13.1.2; CSA A23.3-04, 2.2; CSA A23.3-94, 13.1

2 ACI 318-11, 9.5.2.1; ACI 318-08, 9.5.2.1; ACI 318-05, 9.5.2.1; ACI 318-02, 9.5.2.1; ACI 318-99, 9.5.2.1;

3 CSA A23.3-04, 9.8.2.1 (Ref. [8]);
90 lb/ft³ ≤ 90 lb/ft³ [1500 kg/m³ ≤ 90 lb/ft³ (1500 kg/m³ ≤ 2000 kg/m³)] for ACI 318-02, and ACI 318-99, the minimum slab thickness is additionally increased by adjustment factor (1.65 – 0.005w_c), but not less than 1.09. For CSA standards, the adjustment is calculated as (1.65 – 0.0003w_c), but not less than 1.0, for structural low density (w_c ≤ 1850 kg/m³) and structural semi-low density (1850 kg/m³ ≤ w_c ≤ 2150 kg/m³) concrete.

**Minimum Slab Thickness – Two-Way Construction**

The program checks slab thickness against minimum slab thickness defined by design standards for two-way systems with long to short span ratio not greater than 2.0. Slabs with thickness below the minimum value will be flagged by the program, however, they are allowed provided that calculated deflections do not exceed maximum permissible computed deflections.

Minimum thickness of slabs with beams spanning between supports on all sides is calculated for ACI 318 codes in US customary units from:

\[
h = \begin{cases} 
\frac{\ell_n \left( 0.8 + \frac{f_y}{200,000} \right)}{36 + 5\beta (\alpha_m - 0.2)} \geq 5\text{i}n., & \text{if } 0.2 < \alpha_m \leq 2.0 \\
\frac{\ell_n \left( 0.8 + \frac{f_y}{200,000} \right)}{36 + 9\beta} \geq 3.5\text{i}n., & \text{if } \alpha_m > 2.0 
\end{cases}
\]

\[\text{Eq. 2-1}\]

in metric unit system for ACI 318-11, ACI 318-08, and ACI 318-05 from:

\[
h = \begin{cases} 
\frac{\ell_n \left( 0.8 + \frac{f_y}{1400} \right)}{36 + 5\beta (\alpha_m - 0.2)} \geq 125\text{mm}, & \text{if } 0.2 < \alpha_m \leq 2.0 \\
\frac{\ell_n \left( 0.8 + \frac{f_y}{1400} \right)}{36 + 9\beta} \geq 90\text{mm}, & \text{if } \alpha_m > 2.0 
\end{cases}
\]

\[\text{Eq. 2-2}\]

and in metric unit system for ACI 318-02 and ACI 318-99 from:

\[
h = \begin{cases} 
\frac{\ell_n \left( 0.8 + \frac{f_y}{1500} \right)}{36 + 5\beta (\alpha_m - 0.2)} \geq 120\text{mm}, & \text{if } 0.2 < \alpha_m \leq 2.0 \\
\frac{\ell_n \left( 0.8 + \frac{f_y}{1500} \right)}{36 + 9\beta} \geq 90\text{mm}, & \text{if } \alpha_m > 2.0 
\end{cases}
\]

\[\text{Eq. 2-3}\]

where:

\(\ell_n\) = clear span in the direction of analysis,

\(\beta\) = ratio of the clear spans in long to short direction,

\(f_y\) = yield stress of reinforcing steel,

---

4 CSA A23.3-04, 2.2; CSA A23.3-94 (Ref. [10]), 2.1

5 ACI 318-11, 9.5.3.1, 13.6.1.2; ACI 318-08, 9.5.3.1, 13.6.1.2; ACI 318-05, 9.5.3.1, 13.6.1.2; ACI 318-02, 9.5.3.1, 13.6.1.2; ACI 318-99, 9.5.3.1, 13.6.1.2; CSA A23.3-04, 13.2.2, 2.2; CSA A23.3-94, 13.3.2, 1.1

6 ACI 318-11, 9.5.3.4; ACI 318-08, 9.5.3.4; ACI 318-02, 9.5.3.4; ACI 318-99, 9.5.3.4; CSA A23.3-04, 13.2.7; CSA A23.3-94, 13.3.6

7 ACI 318-11, 9.5.3.3; ACI 318-08, 9.5.3.3; ACI 318-05, 9.5.3.3; ACI 318-02, 9.5.3.3; ACI 318-99, 9.5.3.3

8 ACI 318M-11, 9.5.3.3; ACI 318M-08, 9.5.3.3; ACI 318M-05, 9.5.3.3

9 ACI 318M-02, 9.5.3.3; ACI 318M-99, 9.5.3.3
\( \alpha_m \) = average value of \( \alpha \), the ratio of flexural stiffness of a beam section to the flexural stiffness of a width of slab bounded laterally by centerlines of adjacent panels on either side of the beam, for all beams supporting the edges of a slab panel.

The program assumes that beams are present on all sides of a panel if the span under consideration includes a longitudinal beam and there are transverse beams defined at both ends of the span. If this assumption is satisfied but in reality beams are not present on all sides (e.g. design strip next to the one under consideration has no longitudinal beam) then the user is advised to check displacements even if slab thickness is larger than the minimum slab thickness reported by the program.

For the design of ACI slabs without beams \((\alpha_m \leq 0.2)\) spanning between interior supports the minimum thickness shall conform to ACI 318 Table 9.5(c) and will not be less than 5.0 in. [125 mm for ACI 318M-11/08/05 or 120 mm for ACI 318M-02/99] for flat plates (slabs without drop panel) and not less than 4.0 in. [100 mm] for two-way flat slab systems (slab with drop panels)\(^{10}\). For flat slabs that contain valid drop panels (see Figure 2-2), Table 9.5(c) reduces the minimum thickness by approximately 10%. For values of \( f_y \) between the ones given in the table, minimum thickness is determined by linear interpolation.

For design strips that have neither beams between all supports nor beams between interior supports (e.g. exterior strips with beams on the outside edges only), the program reports maximum value of minimum slab thickness resulting from both Table 9-5(c) and Equations . However, since this case is not explicitly covered by the ACI code, the user is advised to check displacements even if slab thickness is larger than the minimum slab thickness reported by the program.

For CSA A23.3 standard\(^{11}\), the minimum thickness of slab with beams spanning between all supports is:

\[
h_s \geq \frac{0.6 + \frac{f_y}{1000}}{30 + 4\beta \alpha_m}, \quad \alpha_m \text{ taken } \leq 2.0, \quad \text{Eq. 2-4}
\]

with the value of \( \alpha_m \) evaluated for CSA A23.3-04 using the following beam moment of inertia:

\[
l_b = \frac{b_w h^3}{12} 2.5 \left(1 - \frac{h_s}{h}\right) \quad \text{Eq. 2-5}
\]

For flat plates and slabs with column capitals\(^{12}\), the minimum slab thickness is:

\[
h_s \geq \frac{0.6 + \frac{f_y}{1000}}{30}, \quad \text{Eq. 2-6}
\]

For slabs with drop panels\(^{13}\), the minimum slab thickness satisfies the conditions:

\[
h_s \geq \frac{0.6 + \frac{f_y}{1000}}{30 \left[1 + \frac{2x_d}{\ell_n} \left(\frac{h_d - h_s}{h_s}\right)\right]}, \quad \text{(CSA A23.3-94)}, \quad \text{Eq. 2-7}
\]

\[
h_s \geq \frac{0.6 + \frac{f_y}{1000}}{30 - \frac{2x_d}{\ell_n} \Delta_h}, \quad \text{(CSA A23.3-04)}, \quad \text{Eq. 2-8}
\]

\(^{10}\) ACI 318-11, 9.5.3.2; ACI 318-08, 9.5.3.2; ACI 318-05, 9.5.3.2; ACI 318-99, 9.5.3.2; ACI 318M-08, 9.5.3.2; ACI 318M-02, 9.5.3.2; ACI 318M-99, 9.5.3.2

\(^{11}\) CSA A23.3-04, 13.2.5; CSA A23.3-94, 13.3.5

\(^{12}\) CSA A23.3-04, 13.2.3; CSA A23.3-94, 13.3.3

\(^{13}\) CSA A23.3-04, 13.2.4; CSA A23.3-94, 13.3.4
where \((h_d - h_s)\) shall not be greater than \(h_s\) and

\[
\begin{align*}
    x_d &= \text{dimension from face of column to edge of drop panel, but not more than } \frac{\ell_n}{4} \\
    2x_d / \ell_n &= \text{the smaller of the values determined in the two directions} \\
    \Delta_h &= \text{additional thickness of the drop panel below the soffit of the slab and shall not be taken more than } h_s.
\end{align*}
\]

The minimum thickness in a span that contains a discontinuous edge will be increased by 10%, if the edge beam provided has a stiffness ratio, \(\alpha\), of less than 0.80. The first and last spans are considered to contain a discontinuous edge as well as a span that contains an exterior edge.

The minimum thickness of slab bands follows the requirements for the beams.\(^{15}\)

**Drop Panel Dimensions**

Per ACI\(^{16}\), a valid drop must extend in each direction at least one-sixth the center-to-center span length in that direction (Figure 2-2). The depth of an invalid drop will not be used in the calculation of the depth used to reduce the amount of negative reinforcement required over a column\(^{17}\). If the valid drop depth is greater than one-quarter the distance from the edge of the drop panel to the face of the column \((x)\) the excess depth exceeding \(\frac{1}{4}x\) will not be considered in the calculation of the effective depth used to reduce the amount of negative reinforcement required at a column (Figure 2-3)\(^{18}\). Slabs that contain valid drops are allowed a 10% decrease in minimum slab depth\(^{19}\).

![Figure 2-2 Valid drop dimensions](image)

The input drop dimensions will be used for self-weight computations, when computing slab stiffness to determine deflections, moments, shears, and when computing punching shear around a column\(^{20}\).

---

\(^{14}\) ACI 318-11, 9.5.3.3 (d); ACI 318-08, 9.5.3.3 (d); ACI 318-05, 9.5.3.3 (d); ACI 318-02, 9.5.3.3 (d); ACI 318-99, 9.5.3.3 (d), CSA A23.3-04, 13.2.3, 13.2.4; CSA A23.3-94, 13.3.3

\(^{15}\) CSA A23.3-04, 13.2.6

\(^{16}\) ACI 318-11, 13.2.5; ACI 318-08, 13.2.5; ACI 318-05, 13.2.5; ACI 318-02, 13.3.7.1, 13.3.7.2; ACI 318-99, 13.3.7.1, 13.3.7.2

\(^{17}\) ACI 318-11, 13.2.5; ACI 318-08, 13.2.5; ACI 318-05, 13.2.5; ACI 318-02, 13.3.7; ACI 318-99, 13.3.7

\(^{18}\) ACI 318-11, 13.3.7; ACI 318-08, 13.3.7; ACI 318-05, 13.3.7; ACI 318-02, 13.3.7; ACI 318-99, 13.3.7; CSA A23.3-04, 13.10.7; CSA A23.3-94, 13.11.6

\(^{19}\) ACI 318-11, 9.5.3.2; ACI 318-08, 9.5.3.2; ACI 318-05, 9.5.3.2; ACI 318-02, 9.5.3.2, ACI 318-99, 9.5.3.2

\(^{20}\) ACI 318-11, R13.2.5; ACI 318-08, R13.2.5; ACI 318-05, R13.2.5
**Beam Dimensions**

The program follows linear distribution of strain (plain section) assumption\(^{21}\) for flexure design which is applicable to shallow flexural members. In case of deep beams\(^{22}\), design standards recommend using non-linear distribution of strain or strut-and-tie method. The program checks beam dimensions and if a beam with the following clear span, \(l\), to overall depth, \(h\), ratio is found:

\[
\frac{l}{h} \leq 4h, \quad \text{ACI 318-11, ACI 318-08, ACI 318-05 and ACI 318-02} \\
\frac{l}{h} \leq 2.5h, \quad \text{ACI 318-99, continuous spans} \\
\frac{l}{h} \leq 1.25h, \quad \text{ACI 318-99, simple spans} \\
\frac{l}{h} \leq 2h, \quad \text{CSA A23.3-04 and CSA A23.3-94}
\]

Eq. 2-9

a warning is issued alerting the user that additional deep beam design and detailing is required. For cantilevers, the warning is issued only if their clear span is larger than overall depth.

**Special Considerations for One and Two-Way Joist Systems**

**Rib Dimensions**

Rib dimensions will be considered valid if the rib width is at least 4 in. [100 mm], the depth is no more than 3-1/2 times the rib width, and the clear spacing between ribs does not exceed 30 in. [800 mm]\(^{23}\). If rib dimensions do not meet these requirements (e.g. wide module joist systems) the code requires such ribs to be designed as beams\(^{24}\). The program treats the design of wide-spaced joists the same way as for valid slabs, regardless of code limitation. If the code limits are exceeded, the condition is flagged and the 10% increase of rib shear capacity is not used. The user is then responsible to validate the resulting design and reconcile the code requirements.

**Minimum Thickness for Joist Systems**

The minimum slab thickness allowed for joist slabs is one-twelfth the clear rib spacing, or 1.5 in [40 mm] for ACI code\(^{25}\) and 50mm for CSA code\(^{26}\).

**Joist System Analysis and Design**

For the purposes of analysis and design, the program replaces the ribbed slab with solid slabs of equivalent moment of inertia, weight, punching shear capacity, and one-way shear capacity.

---

\(^{21}\) ACI 318-11, 10.2.2; ACI 318-08, 10.2.2; ACI 318-05, 10.2.2; ACI 318-02, 10.2.2; ACI 318-99, 10.2.2; CSA A23.3-04, 10.1.2; CSA A23.3-94, 10.1.2
\(^{22}\) ACI 318-11, 10.7.1; ACI 318-08, 10.7.1; ACI 318-05, 10.7.1; ACI 318-02, 10.7.1; ACI 318-99, 10.7.1; CSA A23.3-04; 10.7.1; CSA A23.3-94, 10.1.1
\(^{23}\) ACI 318-11, 8.13.2, 8.13.3; ACI 318-08, 8.13.2, 8.13.3; ACI 318-05, 8.11.2, 8.11.3; ACI 318-02, 8.11.2, 8.11.3; ACI 318-99, 8.11.2, 8.11.3; CSA A23.3-04, 10.4.1; CSA A23.3-94, 10.4.1
\(^{24}\) ACI 318-11, 8.13.4; ACI 318-08, 8.13.4; ACI 318-05, 8.11.4; ACI 318-02, 8.11.4; ACI 318-99, 8.11.4; CSA A23.3-04, 10.4.2; CSA A23.3-94, 10.4.2
\(^{25}\) ACI 318-11, 8.13.5.2; ACI 318-08, 8.13.5.2; ACI 318-05, 8.11.5.2; ACI 318-02, 8.11.5.2; ACI 318-99, 8.11.5.2
\(^{26}\) CSA A23.3-04, 10.4.1; CSA A23.3-94, 10.4.1
The equivalent thickness based on system weight is used to compute the system self-weight. This thickness, \( h_w \), is given by:

\[
h_w = \frac{V_{\text{mod}}}{A_{\text{mod}}}, \quad \text{Eq. 2-10}
\]

where:
- \( V_{\text{mod}} \): the volume of one joist module,
- \( A_{\text{mod}} \): the plan area of one joist module.

![Figure 2-4 Valid rib dimensions](image)

The equivalent thickness based on moment of inertia is used to compute slab stiffness. The ribs spanning in the transverse direction are not considered in the stiffness computations. This thickness, \( h_{\text{MI}} \), is given by:

\[
h_{\text{MI}} = \frac{1}{3} \left( \frac{12I_{\text{rib}}}{b_{\text{rib}}} \right)^{\frac{1}{3}}, \quad \text{Eq. 2-11}
\]

where:
- \( I_{\text{rib}} \): moment of inertia of one joist section between centerlines of ribs.
- \( b_{\text{rib}} \): the center-to-center distance of two ribs (clear rib spacing plus rib width).

The drop panel depth for two-way joist (waffle) slab systems is set equal to the rib depth. The equivalent drop depth based on moment of inertia, \( d_{\text{MI}} \), is given by:

\[
d_{\text{MI}} = h_{\text{MI}} + h_{\text{rib}}, \quad \text{Eq. 2-12}
\]

where:
- \( h_{\text{rib}} \): rib depth below slab,
- \( h_{\text{MI}} \): equivalent slab thickness based on moment of inertia.

A drop depth entered for a waffle slab system other than 0 will be added to \( d_{\text{MI}} \), thus extending below the ribs.

One-way shear capacity, \( V_c \) (increased by 10% for ACI code\(^{27}\)), is calculated assuming the shear cross-section area consisting of ribs and the portion of slab above, decreased by concrete cover. For such section the equivalent shear width of single rib is calculated from the formula:

\[
b_v = b + d/12, \quad \text{Eq. 2-13}
\]

where:
- \( b \): rib width,
- \( d \): distance from extreme compression fiber to tension reinforcement centroid.

\(^{27}\) ACI 318-11, 8.13.8; ACI 318-08, 8.13.8; ACI 318-05, 8.11.8; ACI 318-02, 8.11.8; ACI 318-99, 8.11.8
The equivalent thickness based on shear area is used to compute the area of concrete section resisting punching shear transfer, $A_e$, around drop panels in two-way joist (waffle) systems. The equivalent slab thickness, $h_v$, used to compute $A_e$, is given by:

$$h_v = \frac{A_{rib} + d_{reinf}}{b_{rib}}$$  \hspace{1cm} \text{Eq. 2-14}

where:

$A_{rib} = \text{the entire rib area below the slab plus the slab thickness minus the distance to the reinforcement centroid, $d_{reinf}$, within the rib width, i.e., the slab depth between the ribs is not considered as contributing to shear capacity},$

$b_{rib} = \text{the center-to-center distance of two ribs (clear rib spacing plus rib width)},$

$d_{reinf} = \text{the distance to reinforcement centroid from the slab top at the support}.$

**Material Properties**

By entering the concrete density and compressive strength of the members, default values for the other concrete properties are determined. The slab, column, and beam members may have different concrete properties.

The density of concrete is used to determine the type of concrete, modulus of elasticity, and self-weight.

The concrete type is determined in accordance with Table 2-1.

<table>
<thead>
<tr>
<th>Type</th>
<th>ACI 318-11, 318-08</th>
<th>ACI 318-05, 318-02, 318-99</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$w_c$ (pcf)</td>
<td>$w_c$ (kg/m$^3$)</td>
</tr>
<tr>
<td>Normal</td>
<td>135 $\leq w_c$</td>
<td>2155 $\leq w_c$</td>
</tr>
<tr>
<td></td>
<td></td>
<td>130 $\leq w_c$</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2000 $\leq w_c$</td>
</tr>
<tr>
<td>Sand-Lightweight</td>
<td>115 $&lt; w_c &lt; 135$</td>
<td>1840 $&lt; w_c &lt; 2155$</td>
</tr>
<tr>
<td></td>
<td>105 $&lt; w_c &lt; 130$</td>
<td>1700 $&lt; w_c &lt; 2000$</td>
</tr>
<tr>
<td>All-Lightweight</td>
<td>$w_c \leq 115$</td>
<td>$w_c \leq 1840$</td>
</tr>
<tr>
<td></td>
<td>$w_c \leq 105$</td>
<td>$w_c \leq 1700$</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type</th>
<th>CSA A23.3-04, 94</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$\gamma_c$ (pcf)</td>
</tr>
<tr>
<td>Normal</td>
<td>2150 $\leq \gamma_c$</td>
</tr>
<tr>
<td></td>
<td>2000 $\leq \gamma_c$</td>
</tr>
<tr>
<td>Low Density</td>
<td>1850 $&lt; \gamma_c &lt; 2150$</td>
</tr>
<tr>
<td></td>
<td>1700 $&lt; \gamma_c &lt; 2000$</td>
</tr>
<tr>
<td>Semi-Low Density</td>
<td>$\gamma_c \leq 1850$</td>
</tr>
<tr>
<td></td>
<td>$\gamma_c \leq 1700$</td>
</tr>
</tbody>
</table>

**Table 2-1 Concrete Weight Classification**

Once the compressive strength of concrete $f'_c$ is input, various parameters are set to their default values.
The modulus of elasticity is computed as:
\[ E_c = 33 w_c^{1.5} \sqrt{f'_c}, \]  
Eq. 2-15
where:
\[ w_c = \text{the unit weight of concrete}. \]

For CSA A23.3 standard
\[ E_c = \left(3300 \sqrt{f'_c} + 6900\right) \left(\frac{\gamma_c}{2300}\right)^{1.5}, \]  
Eq. 2-16
where:
\[ \gamma_c = \text{the density of concrete}. \]

The square root of \( f'_c \) is limited to 100 psi for the computation of shear strength provided by concrete, \( V_c \), and development lengths. \(^{30}\)

For CSA A23.3-04 standard the value of square root of \( f'_c \) used to calculate factored shear resistance \( v_r \) shall not exceed 8MPa. \(^{31}\)

The modulus of rupture is used to determine the cracking moment when computing the effective moment of inertia in deflection calculations. For ACI 318 code, the default value of modulus of rupture, \( f_r \), is set equal to:
\[ f_r = 7.5 \lambda \sqrt{f'_c}, \]  
Eq. 2-17
and for the CSA A23.3 standard, the default value of modulus of rupture \( f_r \) is:
\[ f_r = 0.6 \lambda \sqrt{f'_c}. \]  
Eq. 2-18

For two-way slabs analyzed in accordance with CSA A23.3-94 as well as for beams, one-way, and two-way slabs analyzed in accordance with CSA A23.3-04, the default value is reduced to its half value \(^{34}\), i.e.
\[ f_r = \frac{0.6 \lambda \sqrt{f'_c}}{2}. \]  
Eq. 2-19

Factor \( \lambda \) reflecting the reduced mechanical properties of lightweight concrete is equal to \(^{35}\): 1.00 for normal density concrete, 0.85 for sand-lightweight (structural semi-low-density) concrete, and 0.75 for all-lightweight (structural low-density) concrete. Refer to Table 2-1 for determination of concrete type.

There is no limit imposed on \( f_r \). Entering a large value of \( f_r \) will produce deflections based on gross properties (i.e. uncracked sections).

The default values for the longitudinal reinforcement yield strength, \( f_y \), and shear reinforcement yield strength, \( f_{ys} \), if applicable, are set equal to 60 ksi [413 MPa] for ACI and 400 MPa for CSA.

---

\(^{28}\) ACI 318-11, 8.5.1; ACI 318-08, 8.5.1; ACI 318-05, 8.5.1; ACI 318-02, 8.5.1; ACI 318-99, 8.5.1; CSA A23.3-04, 8.6.2.2; CSA A23.3-
94, 8.6.2.2

\(^{29}\) CSA A23.3-04, 8.6.2.2; CSA A23.3-94, 8.6.2.2

\(^{30}\) ACI 318-11, 11.1.2; ACI 318-08, 11.1.2; ACI 318-05, 11.1.2; ACI 318-05, 11.1.2; ACI 318-99, 11.1.2

\(^{31}\) CSA A23.3-04, 13.3.4.2

\(^{32}\) ACI 318-11, 9.5.2.3; ACI 318-08, 9.5.2.3; ACI 318-05, 9.5.2.3; ACI 318-02, 9.5.2.3; ACI 318-99, 9.5.2.3

\(^{33}\) CSA A23.3-04, 8.6.4; CSA A23.3-94, 8.6.4

\(^{34}\) CSA A23.3-04, 9.8.2.3; CSA A23.3-94, 13.3.6

\(^{35}\) ACI 318-11, 11.1.2.1; ACI 318-08, 11.1.2.1; ACI 318-05, 11.1.2.1; ACI 318-02, 11.1.2.1; ACI 318-99, 11.1.2.1; CSA A23.3-04, 8.6.5; CSA A23.3-94, 8.6.5
The equivalent frame method, as described in the code\textsuperscript{36}, is used by spSlab for both analysis and design. The code specifies procedures for the analysis and design of slab systems reinforced for flexure in more than one direction, with or without beams between the supports. A two-way slab\textsuperscript{37} system, including the slab and its supporting beams, columns, and walls may be designed by either of the following procedures:

- The Direct Design Method
- The Equivalent Frame Method

spSlab uses the Equivalent Frame Method of analysis which is based on extensive analytical and experimental studies conducted at the University of Illinois. Note also that there are no restrictions on the number of slab spans or on dead-to-live load ratios in this method of analysis.

The first step in the frame analysis is to divide the three-dimensional building into a series of two-dimensional frames extending to the full height of the building. Horizontal members for each frame are formed by slab strips as shown in Fig. 2-5. For vertical loads, each story (floor and/or roof) may be analyzed separately with the supporting columns being considered fixed at their remote ends (Figure 2-6).

**Stiffness Characteristics**

The stiffness factors for the horizontal members (the slab beams) and the vertical members (the equivalent columns) are determined using segmental approach.

**Slab Beams**

The moment of inertia of the slab beam elements between the faces of the columns (or column capitals) is based on the uncracked section of the concrete including beams or drop panels. The moment of inertia from the face of the column (or capital) to the centerline of the column (or capital) is considered finite and is dependent on the transverse dimensions of the panel and support. This reduced stiffness (as compared to the infinite stiffness assumed in previous codes) is intended to soften the slab at the joint to account for the

\textsuperscript{36} ACI 318-11, 13.7; ACI 318-08, 13.7; ACI 318-05, 13.7; ACI 318-02, 13.7; ACI 318-99, 13.7; CSA A23.3-04, 13.8; CSA A23.3-94, 13.9

\textsuperscript{37} Implies a slab supported by isolated supports which permits the slab to bend in two orthogonal directions.
flexibility of the slab away from the support. This is consistent with provisions of the code. Figure 2-7 shows the changes in stiffness between a slab, and a drop panel, and a column (or capital).

Columns

The computation of the column stiffness is more complicated as it utilizes the concept of an equivalent column. Theoretical slab studies have shown that the positive moment in a slab may increase under pattern loads, even if rigid columns are used, because of the flexibility of the slab away from the column. However, if a two-dimensional frame analysis is applied to a structure with rigid columns, pattern loads will have little effect.

To account for this difference in behavior between slab structures and frames, the equivalent column torsional member, as shown in Figure 2-8, runs transverse to the direction in which the moments are being determined. The transverse slab beam can rotate even though the column may be infinitely stiff, thus permitting moment distribution between adjacent panels. It is seen that the stiffness of the equivalent column is affected by both the flexural stiffness of the columns and the torsional stiffness of the slabs or beams framing into the

---

38 ACI 318-11, 13.7.3; ACI 318-08, 13.7.3; ACI 318-05, 13.7.3; ACI 318-02, 13.7.3; ACI 318-99, 13.7.3; CSA A23.3-04, 13.8.2.3; CSA A23.3-94, 13.9.2.3
columns. Note that the method of computation of column stiffness is in accordance with the requirements of the code\(^{39}\). Figure 2-10 shows a schematic representation of the stiffness of typical columns.

Figure 2-7 continued

The column stiffness is based on the column height, \(l_c\), measured from mid-depth of the slab above, to the mid-depth of the slab below. spSlab calculates the stiffness of the column below the design slab, taking into account the design slab system at its top end. spSlab calculates the stiffness of the column above the design slab taking only the slab depth into account at its bottom end; column capitals, beams, or drops are ignored.

The computation of the torsional stiffness of the member requires several simplifying assumptions. The first step is to assume dimensions of the transverse torsional slab-beam members. Assumptions for dimensions of typical torsional members are shown in Figure 2-9.

The stiffness, \(K_t\), of the torsional member is given by the following expression\(^{40}\):

\[
K_t = \sum \frac{9 \cdot E_{CS} \cdot C}{l_i \left(1 - \frac{c_2}{l_i}\right)}, \quad \text{Eq. 2-20}
\]

where:
- \(\Sigma\) denotes summation over left and right side torsional member,
- \(E_{CS}\) = modulus of elasticity for slab concrete,
- \(C\) = cross-sectional constant defined in Eq. 2-21
- \(c_2\) = size of rectangular column or capital measured transverse to the direction in which moments are being determined,
- \(l_i\) = \(l_{2L}\) and \(l_{2R}\), lengths of span transverse to \(l_i\), measured on each side of the column for ACI 318; for CSA A23.3 value of \(l_i\) is taken as the smaller of \(l_{ia}\) and \(l_{2a}\) where \(l_{ia}\) is the average \(l_i\) and \(l_{2a}\) is the average \(l_2\) on each side of an interior column. In case of an exterior

\(^{39}\) ACI 318-11, 13.7.4; ACI 318-08, 13.7.4; ACI 318-05, 13.7.4; ACI 318-02, 13.7.4; ACI 318-99, 13.7.4; CSA A23.3-04, 13.8; CSA A23.3-94, 13.9

\(^{40}\) ACI 318-11, 13.7.5; ACI 318-08, 13.7.5; ACI 318-05, 13.7.5; ACI 318-02, 13.7.5; ACI 318-99, 13.7.5; CSA A23.3-04, 13.8.2.8; CSA A23.3-94, 13.9.2.8
columns, \( \ell_{1a} \) and \( \ell_{2a} \) are taken respectively as \( \ell_1 \) (if the column is exterior with respect to the direction of analysis) and \( \ell_2 \) (if column is exterior in the transverse direction) of the adjacent span, i.e. cantilevers, if any, are neglected.

![Figure 2-8 Equivalent column](image)

The constant \( C \) is evaluated for the cross section by dividing it into separate rectangular parts and by carrying out the following summation\(^{41}\):

\[
C = \sum \left( 1 - 0.63 \frac{x}{y} \right) \frac{x^3 y}{3}
\]

Eq. 2-21

where:
\( x \) = short overall dimension of the rectangular part of a cross section,
\( y \) = long overall dimension of the rectangular part of a cross section.

The program divides the section into rectangles in such a way that the value of constant \( C \) is maximum (see Figure 2-9).

Walls perpendicular to the direction analysis can be modeled as wide columns. If a column/wall runs full length of the total design strip\(^{42}\), the program modifies moment distribution factors to achieve uniform distribution of moments along the column and middle strips. If the width of the wall is less than 75% of the total design strip then no modification of distribution factors is applied. For column/wall widths between 75% and 100% of total strip widths, moment distribution factors are linearly interpolated between regular values and uniformly distributed values.

When beams frame into the column in the direction of analysis, the value of \( K_t \) as computed in Eq. 2-20 is multiplied by the ratio of the moment of inertia of the slab with the beam (\( I_{s\text{b}} \)) to the moment of inertia of the slab without the beam (\( I_s \)), as shown:

\[
K_{ta} = K_t \frac{I_{s\text{b}}}{I_s}
\]

Eq. 2-22

\(^{41}\) ACI 318-11, 13.6.4.2; ACI 318-08, 13.6.4.2; ACI 318-05, 13.6.4.2; ACI 318-02, 13.0; ACI 318-99, 13.0; CSA A23.3-04, 13.8.2.9; CSA A23.3-94, 13.9.2.9

\(^{42}\) For walls running full width of the slab (\( c_2 = \ell_2 \)), the program slightly adjusts the width of the wall to avoid singularity in the denominator of Eq. 2-20.
With reference to Figure 2-8, \( I \) is computed from part A (slab without beam), whereas \( I_{sb} \) is computed from both parts A and B (slab with beam).

![Figure 2-8](image)

\[
C = \frac{1}{2} \left( 1 - 0.63 \frac{y_1^2}{y_1} \right) \frac{x_1}{3} + \frac{1}{2} \left( 1 - 0.63 \frac{y_2^2}{y_2} \right) \frac{x_2}{3}
\]

**Figure 2-9 Section of the attached torsional members**

![Figure 2-9](image)

**Figure 2-10 Sections for calculating the stiffness \((K_c)\) of the column below the design floor (\(\ell_c\)-input, \(\ell_c^*\)-computed)**

Having the column stiffness, \( K_c \), and the stiffness of the attached torsional member, \( K_t \), the stiffness of the equivalent column, \( K_{ec} \), is computed from the equation:

**Method of Solution**
\[ K_{cc} = \frac{K_{ct} + K_{cb}}{1 + \frac{K_{ct} + K_{cb}}{K_{ta} + K_{ta}'}} \]

Eq. 2-23

where:

\[ K_{ct} = \text{top column stiffness}, \]
\[ K_{cb} = \text{bottom column stiffness}, \]
\[ K_{ta} = \text{torsional stiffness of the left } (K_{ta}^l) \text{ and the right } (K_{ta}^r) \text{ member}. \]

**Loading**

All applied loads are input as unfactored loads. There are no limitations imposed on the ratio of dead to live loads in the Equivalent Frame Method. Results of gravity load and lateral load analyses may be combined, however, the effects of cracking and reinforcement on stiffness must be accounted for in the lateral load analysis.

**Self-Weight**

The self weight of the system is automatically calculated and assigned to the reserved load selfweight load case, SELF, which is by default defined in all new data files. The weights of the slabs, drops, and longitudinal and transverse beams are considered in the selfweight computations. Only the concrete weight is considered, the reinforcement weight is ignored. The weight of longitudinal beams is ignored starting at the column centerline, for a length equal to one-half \( c_1 \), the column dimension in the direction of analysis. This will produce slightly less self-weight than actually present for beams wider than \( c_2 \), the column’s transverse dimension.

If load case SELF is removed then the program will ignore self weight in all ultimate load combinations as well as in internally defined service load combination used to calculate displacements.

**Superimposed Loading**

All superimposed vertical loading is considered to act over the entire transverse width of the slab. For slab systems with beams, loads supported directly by the beam (such as the weight of the beam stem or a wall supported directly by the beams) are also assumed to be distributed over the entire transverse width of the strip. An additional analysis may be required, with the beam section designed to carry these loads in addition to the portion of the slab moments assigned to the beam.

**Lateral Loading**

For lateral loads, each frame should be analyzed as a unit for the entire height of the building (Figure 2-11). Computer programs, such as spFrame, are available for performing such analyses. It should be realized that, for lateral load analysis, slab-beam elements may have a reduced stiffness due to cracking as well as other assumptions made for the effective slab width used for the lateral analysis. The moments obtained from such an analysis may then be input into the equivalent frame model using the program to determine the appropriate design moments under combined vertical and lateral loads.

![Figure 2-11 Analytical model for lateral loads](image-url)
The program distributes the effect of the superimposed lateral load moments to the column strip and middle strip according to the moment distribution factors computed for gravity loads (see Table 2-2 through Table 2-4 later in this chapter).

**Loading Patterns**

The analysis of floor systems requires the consideration of several loading configurations. For example, the two adjacent spans loaded may produce the maximum shear stress around a column, while the alternate spans loaded may produce the maximum flexural moments. To cover different loading scenarios the program generates live load case based on the following load patterns (Figure 2-12):

- Pattern No. 1 (All): All spans loaded with live load,
- Pattern No. 2 (Odd): Starting at span 1, alternate spans loaded with live load,
- Pattern No. 3 (Even): Starting at span 2, alternate spans loaded with live load,
- Pattern No. 3+N (SN): Two spans adjacent to support No. N loaded with live load.

![Live load patterns](image)

*Figure 2-12 Live load patterns*

The program reduces the magnitude of live load patterns No. 2 through No. (3+n) by a predefined ratio. For two-way systems, the default live load pattern ratio selected by the program equals 75% as permitted by the code\(^{43}\). The user has the ability to select different value for the pattern ratio within the range 0-100%. If 0% is

\(^{43}\) ACI 318-11, 13.7.6.3; ACI 318-08, 13.7.6.3; ACI 318-05, 13.7.6.3; ACI 318-02, 13.7.6.3; ACI 318-99, 13.7.6.3; CSA A23.3-04, 13.8.4; CSA A23.3-94, 13.9.4
selected then load patterning effects will be neglected. However, the pattern No. 1 with all spans loaded (as specified by the user) is always considered with full unreduced magnitude.

Load Combinations

The program allows defining up to 20 load combinations. The user has full control over the combinations. The program contains predefined (built into the program) default primary load combinations for the supported codes. These default combinations are created when starting a new project.

For the ACI 318-11, ACI 318-08, ACI 318-05, and ACI 318-02 codes, the default combinations of the Dead (D), Live (L), Snow (S), Wind (W) and Earthquake (E) loads considered by the program are\textsuperscript{44}:

\begin{align*}
U_1 &= 1.4D \\
U_2 &= 1.2D + 1.6L + 0.5S \\
U_3 &= 1.2D + 1.0L + 1.6S \\
U_4 &= 1.2D + 1.6S + 0.8W \\
U_5 &= 1.2D + 1.6S – 0.8W \\
U_6 &= 1.2D + 1.0L + 0.5S + 1.6W \\
U_7 &= 1.2D + 1.0L + 0.5S – 1.6W \\
U_8 &= 0.9D + 1.6W \\
U_9 &= 0.9D – 1.6W \\
U_{10} &= 1.2D + 1.0L + 0.2S + 1E \\
U_{11} &= 1.2D + 1.0L + 0.2S – 1E \\
U_{12} &= 0.9D + 1.0E \\
U_{13} &= 0.9D – 1.0E \\
\end{align*}

For the ACI 318-99 code, the default combinations of the Dead (D), Live (L), Wind (W) and Earthquake (E) loads considered by the program are\textsuperscript{45}:

\begin{align*}
U_1 &= 1.4D + 1.7L \\
U_2 &= 0.75(1.4D + 1.7L + 1.7W) \\
U_3 &= 0.75(1.4D + 1.7L – 1.7W) \\
U_4 &= 0.75(1.4D + 1.7W) \\
U_5 &= 0.75(1.4D – 1.7W) \\
U_6 &= 0.9D + 1.3W \\
U_7 &= 0.9D – 1.3W \\
U_8 &= 0.75(1.4D + 1.7L + 1.7*1.1E) \\
U_9 &= 0.75(1.4D + 1.7L – 1.7*1.1E) \\
U_{10} &= 0.75(1.4D + 1.7*1.1E) \\
U_{11} &= 0.75(1.4D – 1.7*1.1E) \\
U_{12} &= 0.9D + 1.43E \\
U_{13} &= 0.9D – 1.43E \\
\end{align*}

For the CSA A23.3-04 code load combinations are compliant with 2005 NBCC. The default combinations of the Dead (D), Live (L), Snow (S), Wind (W) and Earthquake (E) loads considered by the program are\textsuperscript{46}:

\begin{align*}
U_1 &= 1.4D \\
U_2 &= 1.25D + 1.5L \\
U_3 &= 1.25D + 1.5L + 0.5S \\
U_4 &= 1.25D + 1.5L + 0.4W \\
U_5 &= 1.25D + 1.5L – 0.4W \\
U_6 &= 0.9D + 1.5L \\
U_7 &= 0.9D + 1.5L + 0.5S \\
U_8 &= 0.9D + 1.5L + 0.4W \\
U_9 &= 0.9D + 1.5L – 0.4W \\
\end{align*}

\textsuperscript{44} ACI 318-11, 9.2; ACI 318-08, 9.2; ACI 318-05, 9.2; ACI 318-02, 9.2; (assuming W based on service-level wind load and E based on ultimate-level forces)

\textsuperscript{45} ACI 318-99, 9.2

\textsuperscript{46} CSA A23.3-04, 8.3.2; CSA A23.3-04, Annex C, Table C1; NBCC 2005 (Ref. [7]), Table 4.1.3.2
U_{10} = 1.25D + 1.5S \\
U_{11} = 1.25D + 0.5L + 1.5S \\
U_{12} = 1.25D + 0.4W + 1.5S \\
U_{13} = 1.25D – 0.4W + 1.5S \\
U_{14} = 0.9D + 1.5S \\
U_{15} = 0.9D + 0.5L + 1.5S \\
U_{16} = 0.9D + 0.4W + 1.5S \\
U_{17} = 0.9D – 0.4W + 1.5S \\
U_{18} = 1.25D + 1.4W \\
U_{19} = 1.25D + 0.5L + 1.4W \\
U_{20} = 1.25D + 0.5L + 1.4W \\
U_{21} = 1.25D – 1.4W \\
U_{22} = 1.25D + 0.5L – 1.4W + 0.5S \\
U_{23} = 1.25D – 1.4W + 0.5S \\
U_{24} = 0.9D + 0.5L + 1.5W \\
U_{25} = 0.9D + 0.5L + 1.4W \\
U_{26} = 0.9D + 1.4W + 0.5S \\
U_{27} = 0.9D – 1.4W \\
U_{28} = 0.9D + 0.5L – 1.4W \\
U_{29} = 0.9D – 1.4W + 0.5S \\
U_{30} = 1.0D + 1.0E \\
U_{31} = 1.0D + 0.5L + 1.0E + 0.25S \\
U_{32} = 1.0D – 1.0E \\
U_{33} = 1.0D + 0.5L – 1.0E + 0.25S \\

For the CSA A23.3-94 code, the default combinations of the Dead (D), Live (L), Wind (W), Earthquake (E), and Snow (S) loads considered by the program are:

U_1 = 1.25D + 1.5L \\
U_2 = 1.25D + 1.5L + 1.5S \\
U_3 = 1.25D + 0.7(1.5L + 1.5W) \\
U_4 = 1.25D + 0.7(1.5L – 1.5W) \\
U_5 = 1.25D + 0.7(1.5L + 1.5W+ 1.5S) \\
U_6 = 1.25D + 0.7(1.5L – 1.5W+ 1.5S) \\
U_7 = 1.25D + 1.5W \\
U_8 = 1.25D – 1.5W \\
U_9 = 0.85D + 1.5W \\
U_{10} = 0.85D – 1.5W \\
U_{11} = 1.0D + 0.5L + 1.0E \\
U_{12} = 1.0D + 0.5L – 1.0E \\
U_{13} = 1.0D + 0.5L + 1.0E + 0.5S \\
U_{14} = 1.0D + 0.5L – 1.0E + 0.5S \\
U_{15} = 1.0D + 1.0E \\
U_{16} = 1.0D – 1.0E \\
U_{17} = 0.9D + 1.5S \\
U_{18} = 0.9D + 0.5L + 1.5S \\
U_{19} = 0.9D + 0.4W + 1.5S \\
U_{20} = 0.9D – 0.4W + 1.5S \\
U_{21} = 1.25D + 1.4W \\
U_{22} = 1.25D + 1.4W + 1.5S \\
U_{23} = 1.25D + 0.7(1.5L + 1.5W+ 1.5S) \\
U_{24} = 1.25D + 0.7(1.5L – 1.5W+ 1.5S) \\
U_{25} = 1.25D + 1.4W + 0.5S \\
U_{26} = 0.9D + 1.4W + 0.5S \\
U_{27} = 1.25D – 1.4W + 0.5S \\
U_{28} = 0.9D – 1.4W + 0.5S \\
U_{29} = 1.25D – 1.4W \\
U_{30} = 0.9D – 1.4W \\
U_{31} = 1.0D + 1.0E \\
U_{32} = 1.0D + 0.5L + 0.5S \\
U_{33} = 1.0D + 0.5L – 0.5S \\
U_{34} = 1.0D + 1.0E \\
U_{35} = 1.0D – 1.0E \\
U_{36} = 1.0D + 0.5L + 1.0E + 0.25S \\
U_{37} = 1.0D + 0.5L – 1.0E + 0.25S \\
U_{38} = 1.0D + 1.5W \\
U_{39} = 1.0D – 1.5W \\
U_{40} = 0.85D + 1.5W \\
U_{41} = 0.85D – 1.5W \\
U_{42} = 1.0D + 0.5L + 1.0E \\
U_{43} = 1.0D + 0.5L – 1.0E \\
U_{44} = 1.0D + 0.5L + 1.0E + 0.5S \\
U_{45} = 1.0D + 0.5L – 1.0E + 0.5S \\
U_{46} = 1.0D + 1.0E \\
U_{47} = 1.0D – 1.0E \\
U_{48} = 1.25D + 0.5L + 1.25D + 1.5S \\
U_{49} = 1.25D + 0.5L – 1.25D + 1.5S \\
U_{50} = 1.25D – 0.5L + 1.25D – 1.5S \\
U_{51} = 1.25D – 0.5L – 1.25D – 1.5S \\

Column and Middle Strip Widths

The code defines the width of the column strip on each side of the column centerline as being one-fourth of the smaller of either the transverse or the longitudinal span. These widths are printed as part of the design results.

The strip widths at a support are computed by (see Figure 2-13)

- column strip

---

47 CSA A23.3-94, 8.3.2 (assuming occupancies other than storage and assembly)
48 ACI 318-11, 13.2.1; ACI 318-08, 13.2.1; ACI 318-05, 13.2.1; ACI 318-02, 13.2.1; ACI 318-99, 13.2.1; CSA A23.3-04, 2.2; CSA A23.3-94, 13.1
2-18  Method of Solution

\[ w_{cs} = \min \left\{ \min \left( \frac{\ell_{2,1}}{4}, \frac{\ell_{i}}{4} \right)_i, \min \left( \frac{\ell_{2,r}}{4}, \frac{\ell_{i}}{4} \right)_i \right\}, \quad \text{Eq. 2-24} \]

- middle strip

\[ w_{ms} = \min \left\{ \ell_{2,i}, \ell_{2,i+1} \right\} - w_{cs}. \quad \text{Eq. 2-25} \]

Figure 2-13 Strips widths at support

The strip widths in the span are defined as (see Figure 2-14):

- column strip

\[ w_{cs} = \min \left\{ \min \left( \frac{\ell_{2,1}}{4}, \frac{\ell_{i}}{4} \right)_i + \min \left( \frac{\ell_{2,r}}{4}, \frac{\ell_{i}}{4} \right)_i \right\}, \quad \text{Eq. 2-26} \]

- middle strip

\[ w_{ms} = \ell_i - w_{cs}, \quad \text{Eq. 2-27} \]

where:

- \( \ell_i \) = span length in the direction of analysis,
- \( \ell_{2,j} \) = the input transverse strip widths on the left of column centerline,
- \( \ell_{2,r} \) = the input transverse strip widths on the right of column centerline,
If a longitudinal slab band is defined (CSA A23.3-04 standard only) then the column strip width is automatically adjusted to be equal to the band width:

\[ w_{cs} = w_{band} \]  \hspace{1cm} \text{Eq. 2-28} \\

If a longitudinal beam exists then the adjusted column strip width, \( w_{cs} \), is calculated by subtracting the beam width, \( w_{beam} \), from the width of the column strip:

\[ w_{cs} = w_{cs} - w_{beam} \] \hspace{1cm} \text{Eq. 2-29} \\

If the user selects the BEAM T-SECTION DESIGN option in Solve Options, the beam width, \( w_{beam} \), used by the program will include portion of the slab on each side of the beam equal to projection of the beam below the slab, but not greater than slab thickness\(^{49}\). Otherwise, only web width is used. If the beam width, \( w_{beam} \), is greater than the column strip width, \( w_{cs} \), then the adjusted column strip width is set to zero and moment distribution factors are adjusted to apply all column strip moment to the beam. This may occur when modeling a slab band with a wide longitudinal beam for codes other than CSA A23.3-04. In case of CSA A23.3-04 standard, the dedicated LONGITUDINAL SLAB BAND option in General Information dialog window is available to model slab band systems explicitly.

By selecting USER SLAB STRIP WIDTH and USER DISTRIBUTION FACTORS options in Solve Options dialog window, the user has the ability to manually override strip widths and moment distribution factors calculated automatically by the program.

Note: For exterior frames, the edge width should be specified to the edge of the slab from the column centerline.

---

\(^{49}\) ACI 318-11, 13.2.4; ACI 318-08, 13.2.4; ACI 318-05, 13.2.4; ACI 318-02, 13.2.4; ACI 318-99, 13.2.4; CSA A23.3-04 Figure N13.1.2(a) in Ref. [9], CSA A23.3-94, 13.1
For design purposes, spSlab considers negative moments as those producing tension at the top of the slab and positive moments as those producing tension at the bottom of the slab. The negative design moment is taken at the face of the column below the slab, or at the face of the column capital, but in no case is it considered at a location greater than 0.175 of the longitudinal span length, \( l_1 \), away from the center of the column. This imposes a limit on long narrow supports, in order to prevent undue reduction in the design moment. For slab systems with transverse beams, the face of a beam is not considered as the face of support. For end columns with capitals, the negative moments are taken at the midpoint of the capital extension. If a positive moment occurs at a support then its value at the face of the column above the slab is considered (or at the support centerline if there is no column above the slab).

spSlab computes the amount of reinforcement for the moments on the left and the right side of the support. The negative design moment is the moment which requires the most area of reinforcement to be resisted. The location, left or right of the support, of the maximum moment may vary when systems differ on each side of the support (for example, a system with beams on one side only).

spSlab automatically calculates the values of strip moment distribution factors for column strips and longitudinal beams (if present). Portion of the total factor moment not assigned to a column strip or a beam is then proportionally assigned to the remaining middle strip.

Note: By checking User Distribution Factors option in Solve Options dialog window, the user has the ability to manually adjust strip moment distribution factors calculated automatically by the program.

**ACI 318 and CSA A23.3-94**

The column strips are proportioned to resist the portions in percent of interior negative factored moments according to Table 2-2.

<table>
<thead>
<tr>
<th>( \ell_2/\ell_1 )</th>
<th>0.5</th>
<th>1.0</th>
<th>2.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \alpha_{f1} \ell_2/\ell_1 = 0 )</td>
<td>75</td>
<td>75</td>
<td>75</td>
</tr>
<tr>
<td>( \alpha_{f1} \ell_2/\ell_1 \geq 1.0 )</td>
<td>90</td>
<td>75</td>
<td>45</td>
</tr>
</tbody>
</table>

**Table 2-2 Column Strip Percent of Interior Negative Factored Moments at Supports**

The column strips are proportioned to resist the portions in percent of exterior negative factored moments according to Table 2-3.

<table>
<thead>
<tr>
<th>( \ell_2/\ell_1 )</th>
<th>( \beta_i = 0 )</th>
<th>( \beta_i \geq 2.5 )</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \alpha_{f1} \ell_2/\ell_1 = 0 )</td>
<td>100</td>
<td>75</td>
</tr>
<tr>
<td>( \alpha_{f1} \ell_2/\ell_1 \geq 1.0 )</td>
<td>100</td>
<td>90</td>
</tr>
</tbody>
</table>

**Table 2-3 Column Strip Percent of Exterior Negative Factored Moments at Supports**

The values \( \alpha_i \) in Table 2-2 and Table 2-3 and \( \beta_i \) in Table 2-3 are defined as:

---

50 ACI and CSA provisions for the location of critical section for flexure referred to in this paragraph apply to two-way systems. Due to lack of similar provisions for one-way systems and beams in ACI and CSA standards, the program consistently applies the same rules (with the exception of 0.175\( l_1 \) limitation) to one-way systems and beams.

51 ACI 318-11, 13.7.7.1; ACI 318-08, 13.7.7.1; ACI 318-05, 13.7.7.1; ACI 318-02, 13.7.7.1; ACI 318-99, 13.7.7.1; CSA A23.3-04, 13.8.5.1; CSA A23.3-94, 13.9.5.1

52 ACI 318-11, 13.7.7.2; ACI 318-08, 13.7.7.2; ACI 318-05, 13.7.7.2; ACI 318-02, 13.7.7.2; ACI 318-99, 13.7.7.2; CSA A23.3-04, 13.8.5.2; CSA A23.3-94, 13.9.5.2

53 For CSA A23.3-94 standard, the program assumes by default values given by ACI code which fall within the ranges specified in CSA A23.3-94, 13.12.2

54 ACI 318-11, 13.6.4.1; ACI 318-08, 13.6.4.1; ACI 318-05, 13.6.4.1; ACI 318-02, 13.6.4.1; ACI 318-99, 13.6.4.1; CSA A23.3-94, 13.9.5.1; CSA A23.3-94, 13.8.5.1

55 ACI 318-11, 13.6.4.2; ACI 318-08, 13.6.4.2; ACI 318-05, 13.6.4.2; ACI 318-02, 13.6.4.2; ACI 318-99, 13.6.4.2;
\[ \alpha_\text{f1} = \text{ratio of flexural stiffness of the beam section to flexural stiffness of a width of slab bounded by centerlines of adjacent panels (if any) on each side of the beam in the direction of analysis. For flat plates, flat slabs, and waffle} \ \alpha_\text{f1} \ell_2/\ell_1 = 0 \]

\[ \beta_\text{t} = \text{ratio of torsional stiffness of an edge beam section to flexural stiffness of a width of slab equal to the span length of the beam, center-to-center of supports.} \]

When no transverse beams are present, \( \beta_\text{t} = 0 \), otherwise

\[ \beta_\text{t} = \frac{E_{\text{cb}} C}{2E_{\text{cs}} I_s}, \quad \text{Eq. 2-30} \]

where:

- \( E_{\text{cb}} \) = modulus of elasticity of beam concrete,
- \( E_{\text{cs}} \) = modulus of elasticity of slab concrete,
- \( C \) = cross-sectional constant, see Eq. 2-21,
- \( I_s \) = moment of inertia of the gross section of the slab about its centroidal axis.

For intermediate values of \( (\ell_2/\ell_1) \), \( (\alpha_\text{f1} \ell_2/\ell_1) \) and \( \beta_\text{t} \) the values in Table 2-2 and Table 2-3 are interpolated using equations Eq. 2-31 and Eq. 2-32.

**Percentage of negative factored moment at interior support to be resisted by column strip:**

\[ 75 + 30 \left( \frac{\alpha_\text{f1} \ell_2}{\ell_1} \right) \left( 1 - \frac{\ell_2}{\ell_1} \right). \quad \text{Eq. 2-31} \]

**Percentage of negative factored moment at exterior support to be resisted by column strip:**

\[ 100 - 10 \beta_\text{t} + 12 \beta_\text{t} \left( \frac{\alpha_\text{f1} \ell_2}{\ell_1} \right) \left( 1 - \frac{\ell_2}{\ell_1} \right). \quad \text{Eq. 2-32} \]

When a column width, \( c_2 \), is equal to or greater than 75 percent of the tributary strip width \( l_2 \), the distribution factor for negative column strip moment is linearly interpolated between the factor for regular support, and the factor equal 0.50 (moment uniformly distributed across \( l_2 \)). This extends the requirement of the design code\(^{57}\), by providing continuous linear transition between standard and uniform moment distributions, depending on the relative dimension of the support with respect to strip width. User may override software assumptions by selecting user defined distribution factors.

When designing by the CSA A23.3-94 code, a portion of the total positive or interior negative moment equivalent to\(^{58}\): \[ \frac{\alpha_\text{f1}}{1 + \left( \frac{\ell_2}{\ell_1} \right)^2}, \quad \text{Eq. 2-33} \]

is resisted by the beam. For exterior supports, the beam is proportioned to resist 100% of the negative moment.

That portion of the moment not resisted by the beam is resisted by the slab. The reinforcement required to resist this moment is distributed evenly across the slab.

For ACI designs the longitudinal beams are proportioned to resist 85 percent of the column strip moments if \( \alpha_\text{f1} \ell_2/\ell_1 \) is equal to or greater than 1.0. For values of \( \alpha_\text{f1} \ell_2/\ell_1 \) between 0 and 1.0, the beam is designed to resist a proportionate percentage of the column strip moment between 0 and 85\(^{59}\).

The middle strips are proportioned to resist the portion of the total factored moments that is not resisted by the column strips.

\(^{56}\) ACI 318-11, 13.6.4.2; ACI 318-08, 13.6.4.2; ACI 318-05, 13.6.4.2; ACI 318-02, 13.0; ACI 318-99, 13.0; CSA A23.3-94, 13.0

\(^{57}\) ACI 318-11, 13.6.4.3; ACI 318-08, 13.6.4.3; ACI 318-05, 13.6.4.3; ACI 318-02, 13.6.4.3; ACI 318-99, 13.6.4.3

\(^{58}\) CSA A23.3-94, 13.13.2.1

\(^{59}\) ACI 318-11, 13.6.5; ACI 318-08, 13.6.5; ACI 318-05, 13.6.5; ACI 318-02, 13.6.5; ACI 318-99, 13.6.5
The column strips are proportioned to resist the portions in percent of positive factored moments according to Table 2-4.60

<table>
<thead>
<tr>
<th>( \ell_2/\ell_1 )</th>
<th>0.5</th>
<th>1.0</th>
<th>2.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>((\alpha_{f1}\ell_2/\ell_1) = 0)</td>
<td>60</td>
<td>60</td>
<td>60</td>
</tr>
<tr>
<td>((\alpha_{f1}\ell_2/\ell_1) \geq 1.0)</td>
<td>90</td>
<td>75</td>
<td>45</td>
</tr>
</tbody>
</table>

*Table 2-4 Column Strip Percent of Positive Factored Moments*

For intermediate values of \((\ell_2/\ell_1)\) and \((\alpha_{f1}\ell_2/\ell_1)\) the values in Table 2-4 are interpolated using Eq. 2-34 as follows:

\[
60 + 30 \left( \frac{\alpha_{f1}\ell_2}{\ell_1} \right) \left( 1.5 - \frac{\ell_2}{\ell_1} \right)
\]

*Eq. 2-34*

Note: For flat plates, flat slabs, and waffle slabs, \(\alpha_{f1}\ell_2/\ell_1 = 0\).

**CSA A23.3-04**

For slabs without drop panels (with or without transverse beams) the following moment factors are used61:

- Negative moment at interior column, factor = 0.80
- Negative moment at exterior column, factor = 1.00
- Positive moment at all spans, factor = 0.60

For slabs with drop panels (with or without transverse beams) the following moment factors are used62:

- Negative moment at interior column, factor = 0.825
- Negative moment at exterior column, factor = 1.00
- Positive moment at all spans, factor = 0.60

For slabs with longitudinal slab bands63:

- Negative moment at interior column, factor = 0.90
- Negative moment at exterior column, factor = 1.00
- Positive moment at all spans, factor = 0.90

For slabs with transverse slab bands64:

- Negative moment at interior column in width \(b_b\), factor from 0.05 to 0.15 range is selected so that the remaining moment is distributed evenly over the entire frame width (including \(b_b\) width) and at least one-third of the total factored moment65 is applied to the band width \(b_b\).
- Negative moment at exterior column, factor = 1.00
- Positive moment at all spans where \((\ell_1/\ell_2) \geq 1.0\), factor = 0.55
- Positive moment at all spans where \((\ell_1/\ell_2) < 1.0\), factor = 0.55 \((\ell_1/\ell_2)\)

For slabs with beams between all the supports66, the positive and interior negative factored moments are distributed as follows:

---

60 ACI 318-11, 13.6.4.4; ACI 318-08, 13.6.4.4; ACI 318-05, 13.6.4.4; ACI 318-02, 13.6.4.4; ACI 318-99, 13.6.4.4
61 CSA A23.3-04, 13.11.2.2
62 CSA A23.3-04, 13.11.2.3
63 CSA A23.3-04, 13.11.2.4
64 CSA A23.3-04, 13.11.2.5
65 CSA A23.3-04, 13.11.2.7
66 CSA A23.3-04, 13.12.2
Factored negative moments at exterior supports are assigned in 100% proportion to beams.

CSA A23.3-04 does not stipulate requirement for distributing moments in slab systems with beams between some (but not all) supports. For estimation of the moment resisted by the beams in this case, the program applies the ACI approach described in the previous section where longitudinal beams are proportioned to resist 85 percent of the column strip moments if \( \alpha_f l_2/l_1 \) is equal to or greater than 1.0. For values of \( \alpha_f l_2/l_1 \) between 0 and 1.0, the beam is designed to resist a proportionate percentage of the column strip moment between 0 and 85%.

**Moment Redistribution**

Redistribution of negative moments applies to one-way and beam systems only. It can be engaged using the **Input Redistribution** option on the **Solve Options** tab in the **General Information** dialog box.

The program allows for redistribution of negative moments at supports. Only reduction in negative moments is considered. Increase of negative moments at the support is not taken into account even though it is allowed by the code\(^{67}\). Static equilibrium is maintained meaning that bending moments and shear forces along the span are adjusted in accordance with the reduction of moments applied at the supports. The following procedure is followed to obtain moment redistribution factors at the supports.

From elastic static analysis, the largest moments from all load combinations and load patterns are determined at support faces on both ends of each span except cantilevers. These moments are used to calculate the maximum percentage adjustment of moments, \( \delta \), allowed by the codes.

For ACI 318-11, ACI 318-08, ACI 318-05, and ACI 318-02\(^{68}\):

\[
\delta = \begin{cases} 
0, & \text{if } \varepsilon_t < 0.0075, \\
1000 \cdot \varepsilon_t, & \text{if } \varepsilon_t \geq 0.0075, 
\end{cases} 
\]

Eq. 2-36

where \( \varepsilon_t \) is net tensile strain in extreme tension steel at nominal strength.

For ACI 318-99\(^{69}\):

\[
\delta = \begin{cases} 
0, & \text{if } (\rho - \rho') > 0.5\rho_b, \\
20 \left(1 - \frac{\rho - \rho'}{\rho_b}\right), & \text{if } (\rho - \rho') \leq 0.5\rho_b, 
\end{cases} 
\]

Eq. 2-37

where:

\( \rho \) = tension reinforcement ratio,

\( \rho' \) = compression reinforcement ratio,

\( \rho_b \) = balanced reinforcement ratio.

For CSA A23.3\(^{70}\):

\[
\delta = 30 - 50 \frac{c}{d},
\]

Eq. 2-38

where:

\( c \) = distance from extreme compression fiber to neutral axis.

---

\(^{67}\) ACI 318-11, 8.4.1; ACI 318-08, 8.4.1; ACI 318-05, 8.4.1; ACI 318-02, 8.4.1; ACI 318-99, 8.4.1; CSA A23.3-04, 9.2.4; CSA A23.3-94, 9.2.4

\(^{68}\) ACI 318-11, 8.4.1 and 8.4.3; ACI 318-08, 8.4.1 and 8.4.3; ACI 318-05, 8.4.1 and 8.4.3; ACI 318-02, 8.4.1 and 8.4.3

\(^{69}\) ACI 318-99, 8.4.1 and 8.4.3

\(^{70}\) CSA A23.3-04, 9.2.4; CSA A23.3-94, 9.2.4
\[ d = \text{distance from extreme compression fiber to centroid of tension reinforcement.} \]

In the investigation mode, the program uses the area of provided reinforcement to obtain redistribution factors. In the design mode, the required reinforcement area is used. Additionally, \( \delta \) is limited to 20\% and not to exceed the maximum values specified by the user. Negative moments at span ends are reduced by the amount of redistribution factors and new moment values are iteratively used to obtain new redistribution factors. This iterative procedure is repeated until the change in distribution factor is negligible (does not exceed 0.01\%), but no more than 10 times.

**Shear Analysis of Slabs**

Shear analysis in spSlab takes into account one way shear and two-way shear. For two-way shear, the program considers contributions of factored shear force \( V_u \), and fraction of unbalanced moment transferred by shear \( \gamma \cdot M_{\text{unbal}} \). spSlab does not consider torsional stresses in the slab. If in the engineer’s judgment this may control, it must be computed manually.

spSlab checks one-way shear at a critical section located at a distance not less than the effective depth away from the face of the support. If a concentrated load is applied closer than the effective depth away from the face of the support then critical section is located at the face of the support. Factored shear force at the critical section is obtained from the analysis of the equivalent frame.

![Figure 2-15 Critical section for two-way shear](image)

Figure 2-15 shows the general two-way shear area used by spSlab. Note that the shaded area represents the general case and is modified for special considerations as explained below.

Beams are considered in the two-way shear as indicated in Figure 2-15 by areas \( B_1, B_2, B_3, B_4, B_5, \) and \( B_6 \). Ordinarily, transverse beams transfer unbalanced moment to the column through torsion along the beam and not through shear between the slab and column. However, the code leaves the transfer method to the engineer’s judgment concerning the point at which punching shear is no longer applicable and beam shear becomes the dominant element in shear transfer to the column. spSlab makes no such distinction and computes unbalanced moment transfer stress without regard to any beams framing into the column. When a beam is present, the depth of the beam increases the depth of the critical section where it intersects with the beam. The distances from the face of the support to the critical section will also be increased, i.e. effective

---

71 ACI 318-11, 11.11.7.2; ACI 318-08, 11.11.7.2; ACI 318-05, 11.12.6.2; ACI 318-02, 11.12.6.2; ACI 318-99, 11.12.6.2; CSA A23.3-04, 13.3.5.2; CSA A23.3-04, 13.4.5.2  
72 ACI 318-11, 11.11.7.1; ACI 318-08, 11.11.7.1; ACI 318-05, 11.12.6.1; ACI 318-02, 11.12.6.1; ACI 318-99, 11.12.6.1; CSA A23.3-04, 13.4.5.3; CSA A23.3-04, 13.4.5.3  
73 ACI 318-11, 13.5.4, 11.1.3; ACI 318-08, 13.5.4, 11.1.3; ACI 318-05, 13.5.4, 11.1.3; ACI 318-02, 13.5.4, 11.1.3; ACI 318-99, 13.5.4, 11.1.3; CSA A23.3-94, 13.4.6.1, 13.4.6.1; 11.3.2  
74 ACI 318-11, 13.7.1; ACI 318-08, 13.7.1; ACI 318-05, 13.7.1; ACI 318-02, 13.7.1; ACI 318-99, 13.7.1; CSA A23.3-04, 13.8.1.1; CSA A23.3-94, 13.9.1.1  
75 ACI 318-11, 11.11.1.2; ACI 318-08, 11.11.1.2; ACI 318-05, 11.12.1.2; ACI 318-02, 11.12.1.2; ACI 318-99, 11.12.1.2; CSA A23.3-04, 13.3.3; CSA A23.3-94, 13.4.3
depth of the beam will be used to calculate the distance instead of effective depth of the slab, if it results in a critical section that is still within the beam. Otherwise, distances to the critical section are not increased.

For circular supports (column or column capital), the program calculates properties of the critical section for punching shear based on the square support with the same centroid and equal perimeter length\(^76\). The equivalent square support has side length equal to \(\pi D/4 \approx 0.785 D\) where \(D\) is the diameter of the circular support as shown in Figure 2-15.

\[
\text{Figure 2-16 Critical section for circular column}
\]

The critical section is considered closed if the concrete slab around a column extends to a distance greater than or equal to the specified threshold value. In spSlab, the user may define the distance extended beyond the column face in order to consider the section closed. If the critical section does not meet the distance requirement, it is considered open.

ACI 318-08 code introduced the definition of the shear cap\(^77\) which, alternatively to column capital, can be used to increase the critical section around the column. spSlab users can use the capital geometry to model a shear cap and calculate the punching shear through the thickness of the slab itself (shear cap acting as capital). Other failure modes, such as punching within the perimeter of the shear cap, need to be verified by the user manually. The dimensions of the substitute capital have to be selected such that the resulting critical section is equivalent to critical section for a column with a shear cap. ACI code\(^78\) requires shear caps to extend beyond the face of the column by at least the distance equal to cap depth, and so depth/extension ratio should not exceed 1.0. For column capitals depth/extension ratio should not be less than 1.0. Therefore to model shear cap acting as capital, the substituted capital should have depth/extension ratio equal to 1.0.

**Critical Section for Interior Supports of Interior Frames**

The critical section (Figure 2-17) consists of four vertical surfaces through the slab, located at distances of \(d/2\) beyond the support faces.

The critical section for interior supports of interior frames is always closed. A closed section will have all its faces defined in Figure 2-15 resisting shear as indicated by Eq. 2-39:

\[
A_C = \sum_{i=1}^{8} A_i . \tag{Eq. 2-39}
\]

If beams frame\(^79\) into the column, then the critical section includes the dimensions of the beams (\(B_1\) through \(B_6\) in Figure 2-15).

---

\(^{76}\) See Fig.13-38(b) and Fig. 13-57 in Ref. [13], and Fig. 10.5(f) in Ref. [22]

\(^{77}\) ACI 318-11, 2.2; ACI 318-08, 2.2

\(^{78}\) ACI 318-11, 13.2.6; ACI 318-08, 13.2.6

\(^{79}\) A beam is considered as framing into the column if the beam is within a face of the column.
Critical Section for Exterior Supports of Interior Frames

The critical section for exterior supports of interior frames (Figure 2-18) will be either closed (full A7 and A6 for the first column or A1 and A2 for the last column in Figure 2-15) or open, depending upon the length of the cantilever in relation to slab thickness. The critical section will be considered closed when the clear cantilever span, \(l_c\), is greater than or equal to the distance defined by the user beyond the column face. The default value of the distance is 4 \(h\) when an ACI code is selected\(^{80}\) and 5 \(d\) for the CSA standard\(^{81}\). The user can modify the default value to accommodate scenarios when larger distances are required, e.g. 10 \(h\) for slabs with openings\(^{82}\). If beams frame into the column then the critical section includes the contributions from the beam dimensions (B1 through B6 in Figure 2-16).

Critical Section for Interior Supports of Exterior Frames

Figure 2-19 shows the critical section for shear for an interior support of an exterior frame. Note that the section is considered as U-shaped \((A_x = 0, A_y = 0, B_3 = 0, B_4 = 0\) in Figure 2-15) and it extends up to the edge of the exterior face of the support. If beams frame into the column, then the critical section includes the contribution from the beam dimensions \((B_1, \ldots, B_6\) in Figure 2-15). If the exterior cantilever span, \(l_c\), is greater than or equal to the distance defined by the user beyond the column face (the default value is 4 \(h\) when an ACI code is selected\(^{80}\) and 5 \(d\) for the CSA standard\(^{81}\)), the section is treated as closed, that is, the support is treated as an interior support of an interior frame.

---

\(^{80}\) Critical Sections near Holes and at Edges in Ref. [12], pp.672, Fig 13-59 (b) and (c)
\(^{81}\) CSA A23.3-04 Figure N13.3.3.4 (b) in Ref. [9]; CSA A23.3-94 Figure N13.4.3.4 (b) in Ref. [11]
\(^{82}\) ACI 318-11, 11.11.6; ACI 318-08, 11.11.6; ACI 318-05, 11.12.5; ACI 318-99, 11.12.5; CSA A23.3-04, 13.3.3.4; CSA A23.3-94, 13.4.3.4
Critical Section for Exterior Supports of Exterior Frames

The critical section for an exterior support of an exterior frame will typically be L-shaped ($A_5 = 0$, $A_6 = 0$, $A_7 = 0$, $A_8 = 0$, $B_1 = 0$, $B_3 = 0$, and $B_4 = 0$ in Figure 2-15).

If the cantilever span, $\ell_c$, (in the direction of analysis) is greater than or equal to the distance defined by the user beyond the column face (the default value is $4\,h$ when an ACI code is selected\(^{80}\) and $5\,d$ for the CSA standard\(^{81}\)), then the section is treated as a U-shaped interior support. If, in addition, the cantilever span in transverse direction is greater than or equal to the distance defined by the user beyond the column face, the section is treated as closed. If beams frame into the column, then the critical section includes the contributions from the beam dimensions.

![Figure 2-19 Interior supports of exterior frames](image)

Computation of Allowable Shear Stress at Critical Section

One-way shear strength of slabs is limited\(^{83}\) to $2\beta_c\sqrt{f_c'}$. Two-way shear strength of slabs is affected by concrete strength, relationship between size of loaded area and slab thickness, loaded area aspect ratio, and shear-to-moment ratio at slab-column connections.

These variables are taken into account in the allowable shear stress, $v_c$, computed at distances of $d/2$ around the columns and drops (if applicable). For the ACI 318 code, $v_c$ is taken as the smallest of the 3 quantities:\(^{84}\)

$$v_c = \left(2 + \frac{4}{\beta_c}\right)\lambda\sqrt{f_c'}, \quad \text{Eq. 2-40}$$

$$v_c = \left(2 + \frac{\alpha_s d}{b_0}\right)\lambda\sqrt{f_c'}, \quad \text{Eq. 2-41}$$

$$v_c = 4\lambda\sqrt{f_c'}, \quad \text{Eq. 2-42}$$

where:

- $\beta_c$ = the ratio of the long to the short side of the column.
- $\alpha_s$ = a constant dependent on the column location, (40 for an interior 4-sided effective critical area, 30 for an exterior 3-sided critical area, 20 for a corner 2-sided effective critical area.)
- $d$ = distance from the slab bottom to centroid of the slab tension reinforcement at support (average value is used if $d$ changes along critical section perimeter)
- $b_0$ = the perimeter of the critical section
- $\lambda$ = factor\(^{85}\) reflecting the reduced mechanical properties of lightweight concrete equal to 0.75 for all-lightweight concrete, 0.85 for sand-lightweight concrete and 1.0 for normal weight concrete. Refer to Table 2-1 for determination of concrete type.

---

\(^{83}\) ACI 318-11, 11.2.1.1; ACI 318-08, 11.2.1.1; ACI 318-05, 11.3.1.1; ACI 318-02, 11.3.1.1; ACI 318-99, 11.3.1.1

\(^{84}\) ACI 318-11, 11.12.1.1; ACI 318-08, 11.12.1.1; ACI 318-05, 11.12.1.1; ACI 318-02, 11.12.1.1; ACI 318-99, 11.12.1.1

\(^{85}\) ACI 318-11, 11.12.2.1; ACI 318-08, 11.12.2.1; ACI 318-05, 11.12.2.1; ACI 318-02, 11.12.2.1; ACI 318-99, 11.12.2.1
For the CSA A23.3\textsuperscript{86}, the allowable shear stresses are calculated as the minimum of the following metric equations:

\[ v_c = \left(1 + \frac{2}{\beta_c}\right)\eta\lambda\phi_c\sqrt{f'_c}, \quad \text{Eq. 2-43} \]

\[ v_c = \left(\frac{a_d}{b_o} + \eta\right)\lambda\phi_c\sqrt{f'_c}, \quad \text{Eq. 2-44} \]

\[ v_c = 2\eta\lambda\phi_c\sqrt{f'_c}, \quad \text{Eq. 2-45} \]

where

- \( \eta = 0.19 \) for CSA A23.3-04 and 0.20 for CSA A23.3-94
- \( a_s \) is a constant dependent on the column location, (4 for an interior 4-sided effective critical area, 3 for an edge column, 2 for a corner column)
- \( d \) is distance from the slab bottom to centroid of the slab tension reinforcement at support (average value is used if \( d \) changes along critical section perimeter)
- \( \phi_c \) is resistance factor for concrete\textsuperscript{87} equal to 0.60 for CSA A23.3-94 and for CSA A23.3-04 it is equal to 0.65 for regular and 0.70 for precast concrete
- \( \lambda \) is factor\textsuperscript{88} reflecting the reduced mechanical properties of lightweight concrete equal to 0.75 for structural low-density concrete, 0.85 structural semi-low-density concrete and 1.0 for normal density concrete. Refer to Table 2-1 for determination of concrete type.

\[ \sqrt{f'_{cc}} \leq 8 \text{ MPa}. \]

When the value of \( d \) is greater than 300mm, allowable stress \( v_c \) obtained from the above three equations shall be multiplied by \( 1300/(1000+d) \) as required by CSA A23.3-04 code\textsuperscript{89}.

The allowable shear stress around drops when waffle slabs are used is computed as:

\[ v_c = \begin{cases} 
2\lambda\sqrt{f'_{cc}} & \text{for ACI,} \\
0.20\phi_c\sqrt{f'_{cc}} & \text{for CSA A23.3-94,} \\
0.19\phi_c\sqrt{f'_{cc}} & \text{for CSA A23.3-04.} 
\end{cases} \quad \text{Eq. 2-46} \]

For waffle slab systems with valid ribs defined earlier in this chapter, the allowable shear stress is increased by 10% for ACI designs\textsuperscript{90}.

**Computation of Factored Shear Force at Critical Section**

The factored shear force \( V_u \) in the critical section, is computed as the reaction at the centroid of the critical section (e.g., column centerline for interior columns) minus the self-weight and any superimposed surface dead and live load acting within the critical section. If the section is considered open, two 45 degree lines are drawn from the column corners to the nearest slab edge (lines AF and DE in Figure 2-19) and the self-weight and superimposed surface dead and live loads acting on the area ADEF are omitted from \( V_u \).

**Computation of Unbalanced Moment at Critical Section**

The factored unbalanced moment used for shear transfer, \( M_{unbal} \), is computed as the sum of the joint moments to the left and right. Moment of the vertical reaction with respect to the centroid of the critical section is also taken into account by

\textsuperscript{86} CSA A23.3-04, 13.3.4; CSA A23.3-94, 13.4.4
\textsuperscript{87} CSA A23.3-04 8.4.2, 16.1.3; CSA A23.3-94 8.4.2
\textsuperscript{88} CSA A23.3-04, 8.6.5; CSA A23.3-94, 8.6.5
\textsuperscript{89} CSA A23.3-04, 13.3.4.3
\textsuperscript{90} ACI 318-11, 8.13.8; ACI 318-08, 8.13.8; ACI 318-05, 8.11.8; ACI 318-02, 8.11.8; ACI 318-99, 8.11.8
\[ M_{\text{unbal}} = (M_{u,\text{left}} - M_{u,\text{right}}) - V_u c_g, \quad \text{Eq. 2-47} \]

where:
- \( M_{u,\text{left}} \) = factored bending moment at the joint on the left hand side of the joint,
- \( M_{u,\text{right}} \) = factored bending moment at the joint on the right hand side of the joint,
- \( V_u \) = factored shear force in the critical section described above,
- \( c_g \) = location of the centroid of the critical section with respect to the column centerline (positive if the centroid is to the right in longitudinal direction with respect to the column centerline).

**Computation of Shear Stresses at Critical Section**

The punching shear stress computed by the program is based on the following:\(^{91}\)

\[ V_u = \frac{V_u}{A_c}, \quad \text{Eq. 2-48} \]

where:
- \( V_u \) = factored shear force in the critical section described above,
- \( A_c \) = area of concrete, including beam if any, resisting shear transfer.

Under conditions of combined shear, \( V_u \), and unbalanced moment, \( M_{\text{unbal}} \), \( \gamma_v M_{\text{unbal}} \) is assumed to be transferred by eccentricity of shear about the centroidal axis of the critical section. The shear stresses computed by the program for this condition correspond to:\(^{92}\)

\[ V_{AB} = \frac{V_u}{A_c} + \gamma_v M_{\text{unbal}} e_{AB} \frac{c}{J_c}, \quad \text{Eq. 2-49} \]

\[ V_{CD} = \frac{V_u}{A_c} - \gamma_v M_{\text{unbal}} e_{CD} \frac{c}{J_c}, \quad \text{Eq. 2-50} \]

where:
- \( M_{\text{unbal}} \) = factored unbalanced moment transferred directly from slab to column, as described above,
- \( \gamma_v \) = \( (1 - \gamma_f) \), \quad \text{Eq. 2-51} \)
- \( e_{AB} \), \( e_{CD} \) = is a fraction of unbalanced moment considered transferred by the eccentricity of shear about the centroid of the assumed critical section,\(^{93}\)
- \( c \) = distance from centroid of critical section to the face of section where stress is being computed,
- \( J_c \) = property of the assumed critical section analogous to polar moment of inertia.

Factor \( \gamma_f \) in Eq. 2-51 is calculated as:\(^{94}\)

\[ \gamma_f = \frac{1}{1 + (2/3)\sqrt{b_1/b_2}}, \quad \text{Eq. 2-52} \]

where:
- \( b_1 \) = width of critical section in the direction of analysis,
- \( b_2 \) = width of the critical section in the transverse direction.

\(^{91}\) ACI 318-11, 11.12.6.2; ACI 318-05, 11.12.6.2; ACI 318-02, 11.12.6.2; ACI 318-99, 11.12.6.2; CSA A23.3-04, 13.3.5; CSA A23.3-94, 13.4.5

\(^{92}\) ACI 318-11, R11.11.7.2; ACI 318-08, R11.11.7.2; ACI 318-05, R11.12.6.2; ACI 318-02, R11.12.6.2; ACI 318-99, R11.12.6.2; CSA A23.3-04, 13.3.5.5; CSA A23.3-94, 13.4.5.5; Ref. [21]

\(^{93}\) ACI 318-11, 11.11.7.1; ACI 318-08, 11.11.7.1; ACI 318-05, 11.12.6.1; ACI 318-02, 11.12.6.1; ACI 318-99, 11.12.6.1; CSA A23.3-04, Eq. 13-8; CSA A23.3-94, Eq. 13-8

\(^{94}\) ACI 318-11, 13.5.3.2; ACI 318-08, 13.5.3.2; ACI 318-05, 13.5.3.2; ACI 318-02, 13.5.3.2; ACI 318-99, 13.5.3.2; CSA A23.3-04, Eq. 13-8; CSA A23.3-94, Eq. 13-7
If an ACI 318 standard is selected then the program provides an option to use an increased value\(^95\) of \(\gamma_f\). For edge and corner columns with unbalanced moment about an axis parallel to the edge, the value can be increased to 1.0 if the factored shear force at the support doesn’t exceed 0.75\(\phi V_c\) for edge columns and 0.5\(\phi V_c\) for corner columns. For ACI 318-99, ACI 318-02, and ACI 318-05, condition that reinforcement ratio in the effective slab width doesn’t exceed 0.375\(\rho_b\) must also be satisfied to apply the increase. For interior columns and for edge columns with unbalanced moment perpendicular to the edge, \(\gamma_f\) can be increased 25% but the final value of \(\gamma_f\) cannot exceed 1.0. The increase can be applied if the shear doesn’t exceed 0.4\(\phi V_c\). Also, the net tensile strain in the effective slab has to exceed 0.010 for the ACI 318-08 and ACI 318-11. For earlier ACI 318 editions, the condition that reinforcement ratio does not exceed 0.375\(\rho_b\) applies.

spSlab calculates \(v_u\) as the absolute maximum of \(v_{AB}\) and \(v_{CD}\). Local effects of concentrated loads are not computed by spSlab and must be calculated manually.

**Shear Resistance at Corner Columns**

For the CSA A23.3 code, the program performs one-way shear resistance check in the vicinity of corner columns. For slabs with edge beams or drop panels a supplementary check including the contribution of these components should be performed manually.

For the CSA A23.3-94 edition, a critical shear section is located \(d/2\) from the column corner. The minimum length section is selected using an optimization algorithm which analyzes sections at different angles. The extension to the cantilevered portion is considered by a length not to exceed effective slab thickness \(d\).

For the CSA A23.3-04 edition, a critical shear section is located not further than \(d/2\) from the edge of the column or column capital. The extension to the cantilevered portion is considered by a length not to exceed effective slab thickness \(d\). The factored shear resistance is calculated as follows\(^96\):

\[
v_c = \beta \lambda \phi_v \sqrt{f_c'},\quad \text{Eq. 2-53}
\]

where:

\[
\beta = \text{factor accounting for shear resistance of cracked concrete}\(^97\)
\]

**Shear Resistance in Slab Bands**

When performing two-way shear analysis for models with non-continuous longitudinal slab bands, calculations are performed as follows. Punching shear around the column is checked using effective depth of the slab band on one side of the column and the depth of the extension drop panel on the other side of the column. On each four sides of the column the critical section is located \(1/2\) of the respective depth from the face of the column. Punching shear calculation around the drop panel/slab band assumes that the plane of critical section, which cuts perpendicularly through slab band, is located \(1/2\) of the slab band from the face of column. For three remaining column faces critical section is located \(1/2d\) of the slab measured from the respective edges of drop panel or slab band.

**One-Way Shear Analysis of Longitudinal Beams And Slabs**

When longitudinal beams are present in a span, the program computes the shear reinforcement requirements for the beams. Table “Longitudinal Beam Shear Reinforcement Required” in the program output provides values of \(V_{w}\), \(V_c\), and \(A V/s\) for selected segment locations of each span. Segment lengths are chosen not to exceed the beam section depth. The beginning of first segment and the end of last segment correspond to the locations of critical sections on the left and right support respectively. The critical sections are located at a distance \(d\), the effective beam depth, away from the column face at both the left and the right ends of the beam. However, if concentrated loads are present within distance \(d\) from the column face, critical section is selected at the column face.

---

\(^95\) ACI 318-11, 13.5.3.3; ACI 318-08, 13.5.3.3; ACI 318-05, 13.5.3.3; ACI 318-02, 13.5.3.3; ACI 318-99, 13.5.3.3; ACI 318-05, 13.5.3.3; ACI 318-02, 13.5.3.3; ACI 318-99, 13.5.3.3; ACI 318-05, 13.5.3.3; ACI 318-02, 13.5.3.3; ACI 318-99, 13.5.3.3;

\(^96\) CSA A23.3-04, 13.3.6.2

\(^97\) CSA A23.3-04, 11.3.6.2 and 11.3.6.3
Vu is computed from the load acting over the entire width of the design strip. The program makes no distinction between shallow beams (\(\alpha_f l_2/l_1 < 1\)) and deeper beams (\(\alpha_f l_2/l_1 > 1\)).

**Shear Calculations for ACI 318 and CSA A23.3-94**

Shear strength provided by concrete, \(V_c\), is computed by:

\[
V_c = \begin{cases} 
2\lambda\sqrt{f_c} b_w d & \text{for ACI 318}, \\
0.17\lambda\sqrt{f_c} b_w d & \text{for ACI 318M-11/08/05}, \\
\lambda\sqrt{f_c} b_w d/6 & \text{for ACI 318M-02/99}, \\
0.20\phi_c\lambda\sqrt{f_c} b_w d & \text{for CSA A23.3-94}.
\end{cases}
\]  
Eq. 2-54

where:

\(\phi_c\) = resistance factor for concrete\(^99\) equal to 0.60.

In CSA A23.3-94 design, for beams without minimum stirrup reinforcement and greater than 300 mm deep, \(V_c\) is calculated from the following equation\(^100\):

\[
V_c = \left(\frac{260}{1000 + d}\right)\lambda\phi_c\sqrt{f_c} b_w d \geq 0.10\lambda\phi_c\sqrt{f_c} b_w d.
\]  
Eq. 2-55

When \(V_u > \phi V_c/2\), the beam must be provided with at least a minimum shear reinforcement of\(^101\)

\[
A_{v,\min} = \begin{cases} 
\max\left(0.75\sqrt{f_c}, 50\right) & \text{for ACI 318-11/08/05/02}, \\
50 & \text{for ACI 318-99}, \\
\max\left(0.062\sqrt{f_c}, 0.35\right) & \text{for ACI 318M-11/08/05}, \\
\max\left(\sqrt{f_c}/16, 0.33\right) & \text{for ACI 318M-02}, \\
1/3 & \text{for ACI 318M-99}, \\
0.06\sqrt{f_c} & \text{for CSA A23.3-94}.
\end{cases}
\]  
Eq. 2-56

where

\(A_v\) = area of two legs of stirrups,
\(s\) = stirrups spacing,
\(b_w\) = longitudinal beam width,
\(f_{yt}\) = yield strength of the shear reinforcement.

When \(V_u > \phi V_c\), shear reinforcement must be provided so that:

\[
\frac{A_v}{s} = \begin{cases} 
\frac{V_u - \phi V_c}{\phi f_{yt} d} & \text{for ACI 318-11/08/05/02}, \\
\frac{V_u - V_c}{\phi f_{yt} d} & \text{for CSA A23.3-94}.
\end{cases}
\]  
Eq. 2-57

where:

\(^{98}\) ACI 318-11, 11.2.1.1; ACI 318-08, 11.2.1.1; ACI 318-05, 11.3.1.1; ACI 318-02, 11.3.1.1; ACI 318-99, 11.3.1.1; ACI 318M-08, 11.2.1.1; ACI 318M-05, 11.3.1.1; ACI 318M-02, 11.3.1.1; ACI 318M-99, 11.3.1.1; CSA A23.3-94, 11.3.5.1

\(^{99}\) CSA A23.3-94, 8.4.2

\(^{100}\) CSA A23.3-94, 11.3.5.2

\(^{101}\) ACI 318-11, 11.4.6.3; ACI 318-08, 11.4.6.3; ACI 318-05, 11.5.6.3; ACI 318-02, 11.5.5.2; ACI 318-99, 11.5.5.2; ACI 318M-08, 11.4.6.3; ACI 318M-05, 11.5.6.3; ACI 318M-02, 11.5.5.2; ACI 318M-99, 11.5.5.2; CSA A23.3-94, 11.2.8.4
Vu = factored shear force at the section being considered
d = effective depth of the beam at the same location
\( \phi \) = strength reduction factor for shear calculations\(^{102}\) equal to 0.85 for ACI 318-99 and equal to 0.75 for ACI 318-11, ACI 318-08, ACI 318-05, and ACI 318-02
\( \phi_s \) = resistance factor for reinforcement\(^{103}\) equal to 0.85

The capacity of shear reinforcement \( V_s \) is limited to \( V_{s,max} = 8\sqrt{f_{c}'}b_u d \) (\( V_{s,max} = 0.8\phi_c \sqrt{f_{c}'}b_u d \) for CSA A23.3-4). When \( V_u \) exceeds \( \phi V_c + \phi V_{s,max} \) (\( V_{c,max} \) for CSA A23.3-94), the beam section dimensions must be increased or a higher concrete strength must be provided.\(^{104}\)

When \( V_u \leq \phi 10 \sqrt{f_{c}'}b_u d \), the spacing is computed as:

\[
\frac{s}{A_s} = \frac{1}{A_{sb}}, \quad \text{Eq. 2-58}
\]

where

\( A_{sb} \) = total bar area of the two legged stirrup.

The maximum stirrup spacing for ACI codes\(^{105}\) must not exceed \( d/2 \) or 24 in when \( V_u \leq 6\sqrt{f_{c}'}b_u d \).

When \( V_u > 6\sqrt{f_{c}'}b_u d \), the maximum stirrup spacing must be reduced by half, to \( d/4 \) or 12 in.

When \( V_u > 10 \sqrt{f_{c}'}b_u d \), the beam section dimensions must be increased or a higher concrete strength must be provided.

For the CSA A23.3-94 standard\(^{106}\), maximum spacing must not exceed the smaller of 0.7 \( d \) and 600 mm when \( V_u < 0.1\phi_c f_{c}'b_u d \) or the smaller of 0.35 \( d \) and 300 mm when \( V_u \geq 0.1\phi_c f_{c}'b_u d \).

The minimum shear reinforcement requirement is waived\(^{107}\) for joist construction and for beams satisfying the following criteria:

For ACI 318-11 and ACI 318-08:

- Beams with depth not exceeding 10 in. [250 mm].
- Beams integral with slabs (assumed by the program for all beams in two-way systems and beams within one-way slabs with overall width larger than effective beam flange width), with beam depth not exceeding 24 in. [600 mm] and not greater than the larger of 2.5 times flange thickness and 0.5 times web width.

For ACI 318-05/02/99:

- Beams with depth not exceeding the largest of 10 in. [250 mm], 2.5 times flange thickness, and half of web width (rectangular beams are assumed by the program to have flange thickness equal to zero and web width equal to beam width).

For CSA A23.3-94:

- Beams with depth not exceeding 250 mm.

---

\( ^{102} \) ACI 318-11, 9.3.2.3; ACI 318-08, 9.3.2.3; ACI 318-05, 9.3.2.3; ACI 318-02, 9.3.2.3; ACI 318-99, 9.3.2.3

\( ^{103} \) CSA A23.3-94, 8.4.3

\( ^{104} \) ACI 318-11, 11.4.7.9; ACI 318-08, 11.4.7.9; ACI 318-05, 11.5.7.9; ACI 318-02, 11.5.6.9; ACI 318-99, 11.5.6.9; CSA A23.3-94, 11.3.4

\( ^{105} \) ACI 318-11, 11.4.5; ACI 318-08, 11.4.5; ACI 318-05, 11.5.5; ACI 318-02, 11.5.4; ACI 318-99, 11.5.4; CSA A23.3-94, 11.2.11

\( ^{106} \) CSA A23-3-94, 11.2.11

\( ^{107} \) ACI 318-11, 11.4.6.1; ACI 318-08, 11.4.6.1; ACI 318-05, 11.5.6.1; ACI 318-02, 11.5.5.1; ACI 318-99, 11.5.5.1; ACI 318M-08, 11.4.6.1; ACI 318M-05, 11.5.6.1; ACI 318M-02, 11.5.5.1; ACI 318M-99, 11.5.5.1; CSA A23.3-94, 11.2.8.1
Beams integral with slabs (assumed by the program for all beams in two-way systems and beams within one-way slabs with overall width larger than effective beam flange width), with beam depth not exceeding the larger of 600 mm and 0.5 times web width.

Shear Calculations for CSA A23.3-04

For CSA A23.3-04 code, the program calculates shear strength \( V_c \) provided by concrete from the following equation\(^{108}\):

\[
V_c = \phi_c \lambda \beta \sqrt{f'_c b_w d_v}, \quad \text{Eq. 2-59}
\]

where

- \( \phi_c \) = resistance factor for concrete equal to 0.65 for regular and 0.70 for precast concrete
- \( \lambda \) = factor to account for low-density concrete
- \( b_w \) = beam web width
- \( d_v \) = effective shear depth equal to greater of 0.9d or 0.72h
- \( \beta \) = factor accounting for shear resistance of cracked concrete
- \( \sqrt{f'_c} \) = 8 MPa.

When \( V_u > V_c \), the beam must be provided with at least minimum shear reinforcement\(^{109}\). Additionally, minimum shear reinforcement is required for beam sections with overall thickness exceeding 750 mm. Minimum area of shear reinforcement is calculated from the following formula\(^{110}\):

\[
A_v = 0.06 \sqrt{f'_c} b_w s \frac{b_w}{f_y}, \quad \text{Eq. 2-60}
\]

Shear strength provided by shear reinforcement, \( V_s \), is calculated from the following equation\(^{111}\):

\[
V_s = \phi_s A_v f_y d_v \cot(\theta) \frac{1}{s}, \quad \text{Eq. 2-61}
\]

where

- \( \phi_s \) = resistance factor for reinforcement steel\(^{112}\) equal to 0.85
- \( A_v \) = area of shear reinforcement within distance \( s \)
- \( f_y \) = yield strength of reinforcement
- \( d_v \) = effective shear depth equal to greater of 0.9d or 0.72h
- \( s \) = spacing of transverse reinforcement
- \( \theta \) = the angle of inclination of diagonal compressive stresses.

Spacing of transverse reinforcement, \( s \), must not exceed the smaller\(^{113}\) of 0.7d and 600 mm when \( V_u < 0.125 \phi_c f'_c b_w d \) or the smaller\(^{114}\) of 0.35 d and 300 mm when \( V_u > 0.125 \phi_c f'_c b_w d \).

The program recognizes special member types and assumes values of \( \beta = 0.21 \) and \( \theta = 42\text{deg} \) in the following cases\(^{115}\):

- Slabs (including slab bands for CSA code) having thickness not exceeding 350 mm.
- Beams having thickness not exceeding 250 mm.
- Concrete joist construction.

\(^{108}\) CSA A23.3-04, 11.3.4

\(^{109}\) CSA A23.3-04, 11.2.8.1

\(^{110}\) CSA A23.3-04, 11.2.8.2

\(^{111}\) CSA A23.3-04, 11.3.5.1

\(^{112}\) CSA A23.3-04, 8.4.3(a)

\(^{113}\) CSA A23.3-04, 11.3.8.1

\(^{114}\) CSA A23.3-04, 11.3.8.3

\(^{115}\) CSA A23.3-04, 11.3.6.2
Beams cast monolithically with the slab and having the depth below the slab not exceeding one-half of the width or 350mm.

For other general cases the program utilizes the so called simplified method. The value of $\theta$ is assumed as 35deg. For sections having or requiring at least minimum transverse reinforcement $\beta = 0.18$ is assumed. For sections with no transverse reinforcement the value of $\beta$ is calculated as follows\textsuperscript{116}:

$$\beta = \frac{230}{1000 + d_v}$$

\textbf{Eq. 2-62}

\textbf{Shear Distribution}

When no ribs are present, one way shear is proportioned to the slab and beam according to the following ratios:

$$\alpha_1 \ell_2 / \ell_1, \quad 1 - \alpha_1 \ell_2 / \ell_1$$

\textbf{Eq. 2-63}

When ribs are present (joist systems), one way shear is proportioned to the slab and beam according to the following ratios of cross-section areas:

$$\frac{A_{\text{ribs}}}{A_{\text{ribs}} + A_{\text{beam}}}, \quad \frac{A_{\text{Beam}}}{A_{\text{ribs}} + A_{\text{beam}}}$$

\textbf{Eq. 2-64}

Per requirement\textsuperscript{117} of CSA A23.3-04, the program allows distributing one-way shear in the slab between column and middle strips using the distribution factors which are proportional to the factors used for negative moment distribution. The fraction of the shear transferred to the beam remains unchanged irrespective of the use of this feature. This functionality is also provided for other design codes, to be selected at engineer’s discretion.

\textbf{One-Way Shear in Slab Bands}

One-way shear calculations in slab bands are done similar to shear in two-way slabs, except the column strip is substituted by the band strip. Shear forces are distributed between the band and the middle strip proportionally to negative moment distribution factors. Transverse reinforcement is not considered.

\textbf{Shear in Drop Panels}

When calculating one-way shear capacity for two-way solid and waffle slabs, the contribution of the drop panel cross-section can be optionally selected. For such slabs, the shear capacity is calculated in three regions, with increased $V_c$ values in support (drop panel) locations. In case shear is distributed into column and middle strips, drop panel contribution is divided according to the share of drop panel cross-section area in each strip.

\textbf{Torsion and Shear}

Torsion analysis can be engaged for beam and one way systems using the Torsion Analysis and Design check box located on the Solve Options tab in the Input | General Information dialog box.

As far as torsional analysis is concerned, it is assumed that columns provide perfectly rigid supports so there is no transfer of torsional moments between spans. Within a span, torsional moments are considered only if a longitudinal beam is present. Torsion can be induced by concentrated and redistributed torsional loads and also, in the case of a beam with unsymmetrical cross sections, by self weight and area loads. A T-section with different flange widths is an example of a cross section which is not symmetrical. It can be obtained if a beam and a slab with different left and right widths are combined in the same span. However, in order for a flange to be considered in the torsional analysis its thickness has to be greater than twice the cover. If a flange is wider than the effective width then only the effective width is taken into account.

The design for torsion is based on a thin-walled tube, space truss analogy. For the Canadian code the simplified method is used. The program allows both equilibrium and compatibility torsion conditions. In the equilibrium mode, which is assumed by default, unreduced total value of the torsional design moment is used

\textsuperscript{116} CSA A23.3-04, 11.3.6.3(b)

\textsuperscript{117} CSA A23.3-04, 13.3.6.1
in the design. In the compatibility mode\textsuperscript{118}, factored torsional moments that exceed cracking moment $T_{cr}$ (0.67 $T_{cr}$ for CSA) are reduced to the value of $T_{cr}$ (0.67 $T_{cr}$ for CSA). However, it is user’s responsibility to determine which mode is appropriate and the program does not perform any redistribution of internal forces if compatibility torsion is selected.

If torsion analysis is engaged then both torsion and shear actions contribute to the amount of required transverse (stirrup) reinforcement. However, additional longitudinal bars distributed along the perimeter of a cross-section are also required to provide torsional capacity.

For torsion design a span is divided into segments in the same way as for shear design. Governing values within a segment are used to design the whole segment. For stirrups, the governing values of torsional moment and shear force (acting simultaneously) will be these that produce the highest intensity of required stirrup area. On the other hand, the required area of longitudinal bars depends only on the torsional moment so the highest absolute value of torsional moment will govern. Since stirrup area depends both on shear and torsion whereas longitudinal bar area depends only on torsion, the governing values for stirrups and longitudinal bars can occur at different locations within a segment and for different load combinations. Governing values along with their location and associated load combination are provided in the design results report.

Effect of torsion within a segment will be neglected if the factored torsional moment, $T_u$, at every segment location is less than one fourth of the torsion cracking moment, $T_{cr}$, which equals:

for ACI code\textsuperscript{119}
\[
T_{cr} = 4 \phi \lambda \sqrt{\frac{f_c' A_{cp}^2}{p_{cp}}}, \quad \text{Eq. 2-65}
\]

for CSA A23.3-94 code\textsuperscript{120}
\[
T_{cr} = 0.4 \phi_c \lambda \sqrt{\frac{f_c' A_{cp}^2}{p_{cp}}}, \quad \text{Eq. 2-66}
\]

for CSA A23.3-04 code\textsuperscript{121}
\[
T_{cr} = 0.38 \phi_c \lambda \sqrt{\frac{f_c' A_{cp}^2}{p_{cp}}}. \quad \text{Eq. 2-67}
\]

$A_{cp}$ denotes the area enclosed by outside perimeter of concrete section and $p_{cp}$ is equal to the outside perimeter of concrete section.

To be adequate for torsion design, a section has to be proportioned in such a way that combined shear stress due to shear and torsion does not exceed the limit value specified by the code. In ACI code this condition reads as\textsuperscript{122}:
\[
\left( \frac{V_u}{b_w d} \right)^2 + \left( \frac{T_u p_h}{1.7 A_{oh}^2} \right)^2 \leq \phi \left( \frac{V_c}{b_w d} + 8 \sqrt{f_c'} \right), \quad \text{Eq. 2-68}
\]

The simplified method of CSA A23.3-94 standard defines this relation as\textsuperscript{123}:

\textsuperscript{118} ACI 318-11, 11.6.2.2; ACI 318-08, 11.6.2.2; ACI 318-05, 11.6.2.2; ACI 318-02, 11.6.2.2; ACI 318-99, 11.6.2.2; CSA A23.3-04, 11.2.9.2; CSA A23.3-94, 11.2.9.2
\textsuperscript{119} ACI 318-08, R11.5.1; ACI 318-05, R11.6.1; ACI 318-02, R11.6.1; ACI 318-99, R11.6.1;
\textsuperscript{120} CSA A23.3-94, 11.2.9.1
\textsuperscript{121} CSA A23.3-04, 11.2.9.1
\textsuperscript{122} ACI 318-11, 11.5.3.1; ACI 318-08, 11.5.3.1; ACI 318-05, 11.6.3.1; ACI 318-02, 11.6.3.1; ACI 318-99, 11.6.3.1;
\textsuperscript{123} CSA A23.3-94, 11.3.9.8
\[
\frac{V_u}{b_u d} + \frac{T_u P_h}{A_{oh}} \leq 0.25 \phi_c f'_c.
\]
Eq. 2-69

Similar requirement for CSA A23.3-04 reads as follows\textsuperscript{124}:

\[
\left(\frac{V_u}{b_u d}\right)^2 + \frac{\left(T_u P_h/1.7 A_{oh}^2\right)^2}{A_{oh}} \leq 0.25 \phi_c f'_c.
\]
Eq. 2-70

In above relations, \(A_{oh}\) is the area enclosed by centerline of the outermost closed transverse reinforcement and \(p_h\) is the perimeter of that area. By default, flanges do not contribute to \(A_{oh}\) and \(p_h\). For sections with flanges, flanges will only be taken into account for \(A_{oh}\) and \(p_h\) if the option to include stirrups in flanges is engaged in the torsion design. In the program output, the combined stress (left hand side of the above inequalities) is denoted as \(f_t\) and the limit value as \(\phi_{vt}\).

The required intensity of stirrup area to provide required torsional capacity is calculated from the following formula\textsuperscript{125}:

\[
\frac{A_s}{s} = \begin{cases} 
\frac{T_u}{2 \phi_s A_{st} f'_s} & \text{for ACI-318,} \\
\frac{T_u}{2 \phi_s A_{st} f'_s} & \text{for CSA A23.3-94,} \\
\frac{T_u}{2 \phi_s A_{st} f'_s \cot \theta} & \text{for CSA A23.3-04,}
\end{cases}
\]
Eq. 2-71

where the gross area enclosed by the shear path\textsuperscript{126}, \(A_o\), is taken as \(0.85 A_{oh}\). \(A_s/s\) is the quantity per stirrup leg. Concrete shear and torsion strength reduction factor\textsuperscript{127}, \(\phi_s\) for ACI-318 codes is equal to 0.75 for the 99 edition and 0.75 for later editions.

The total requirement for stirrup intensity combining shear and torsion equals\textsuperscript{128}

\[
\frac{A_{s} + 2l}{s} = \frac{A_y}{s} + 2 \frac{A_1}{s}.
\]
Eq. 2-72

This value cannot be taken less than minimum stirrup area required by the codes. The minimum code requirements can be written in the following form\textsuperscript{129}:

\textsuperscript{124} CSA A23.3-04, 11.3.10.4(b)

\textsuperscript{125} ACI 318-11, 11.5.3.6; ACI 318-08, 11.5.3.6; ACI 318-05, 11.6.3.6; ACI 318-02, 11.6.3.6; ACI 318-99, 11.6.3.6; CSA A23.3-04, 11.3.10.3; CSA A23.3-94, 11.3.9.4

\textsuperscript{126} CSA A23.3-04, 11.3.10.3; CSA A23.3-94, 11.3.9.7

\textsuperscript{127} ACI 318-11, 9.3.2.3; ACI 318-08, 9.3.2.3; ACI 318-05, 9.3.2.3; ACI 318-02, 9.3.2.3; ACI 318-99, 9.3.2.3

\textsuperscript{128} ACI 318-11, R11.5.2.8; ACI 318-08, R11.5.3.8; ACI 318-05, R11.6.3.8; ACI 318-02, R11.6.3.8; ACI 318-99, R11.6.3.8

\textsuperscript{129} ACI 318-11, 11.5.5.2; ACI 318-08, 11.5.5.2; ACI 318-05, 11.5.5.2; ACI 318-02, 11.5.5.2; ACI 318-99, 11.5.5.2; ACI 318M-11, 11.5.5.2; ACI 318M-08, 11.5.5.2; ACI 318M-05, 11.5.5.2; ACI 318M-02, 11.5.5.2; ACI 318M-99, 11.5.5.2; CSA A23.3-04, 11.2.8.2; CSA A23.3-94, 11.2.8.4
In addition to stirrup spacing requirement defined for shear, program imposes one more torsion specific requirement for all ACI codes\textsuperscript{130} which limits the spacing to the smallest of $\frac{p_h}{8}$, and 12 in [300 mm]. Based on the total required stirrup area intensity and spacing requirements, the program attempts to select stirrups taking also into account that if stirrups with more than two legs have to be used then the area of an outer leg must not be less than $A_{v+2t}$.

**Additional Longitudinal Reinforcement for ACI 318 and CSA A23.3-94**

The area of additional longitudinal reinforcement, $A_{\ell}$, is calculated from\textsuperscript{131}

$$A_{\ell} = \frac{t_u p_h}{2 \phi A_o f_y}.$$  \hspace{1cm} \text{Eq. 2-74}

For ACI code it is also checked against the following minimum value\textsuperscript{132}:

$$A_{\ell,\text{min}} = \frac{5 \sqrt{f_y} A_{cp}}{f_y} \left( \frac{A_1}{s} \right) \frac{p_h}{f_y},$$  \hspace{1cm} \text{Eq. 2-75}

where $A_1 / s$ is calculated from Eq. 2-56 but is not taken less than $25 b_w / f_y$. Longitudinal bars are selected in such a way that their area is not less than $A_{\ell} \geq A_{\ell,\text{min}}$ and that number of longitudinal bars in a section is enough to provide a bar in every corner of a stirrup and preserve spacing between bars not higher than 12 in [300 mm]. Also, bar sizes are selected not to have diameter less than No. 3 bar and not less than 1/24 of stirrup spacing for ACI codes\textsuperscript{133} and 1/16 for CSA standard\textsuperscript{134}.

**Additional Longitudinal Reinforcement for CSA A23.3-04**

The additional longitudinal reinforcement, $A_{\ell}$, will only be calculated for CSA A23.3-04 if option \texttt{COMBINED M-V-T REINF. DESIGN} is unchecked in the Solve Options dialog window. If this option is checked (default setting) then no additional longitudinal reinforcement is calculated because the regular top and bottom reinforcement will automatically be proportioned to resist combined action of flexure, shear and torsion.

Proportioning of longitudinal reinforcement for sections subjected to combined shear and torsion in flexural regions is based on the requirement that the resistance of the longitudinal reinforcement has to be greater or equal to the axial force that can be developed in this reinforcement. In sections with no axial action ($N_e = 0$ and $V_p = 0$) that force is equal to\textsuperscript{135}:

\begin{equation*}
\max\left(0.75\sqrt{f'_c}, 0.5\right) \text{ for ACI 318-11/08/05/02,} \\
50 \text{ for ACI 318-99,} \\
\max\left(0.062\sqrt{f'_c}, 0.35\right) \text{ for ACI 318M-11/08/05,} \\
\max\left(\frac{f'_c}{16}, 0.33\right) \text{ for ACI 318M-02,} \\
0.33 \text{ for ACI 318M-99,} \\
0.06 \sqrt{f'_c} \text{ for CSA A23.3-04/94.}
\end{equation*}

\textsuperscript{130} ACI 318-11, 11.5.6.1; ACI 318-08, 11.5.6.1; ACI 318-05, 11.6.6.1; ACI 318-02, 11.6.6.1; ACI 318-99, 11.6.6.1

\textsuperscript{131} ACI 318-11, 11.5.3.7; ACI 318-08, 11.5.3.7; ACI 318-05, 11.6.3.7; ACI 318-02, 11.6.3.7; ACI 318-99, 11.6.3.7; CSA A23.3-94, 11.3.9.5

\textsuperscript{132} ACI 318-11, 11.5.5.3; ACI 318-08, 11.5.5.3; ACI 318-05, 11.6.5.3; ACI 318-02, 11.6.5.3; ACI 318-99, 11.6.5.3

\textsuperscript{133} ACI 318-11, 11.5.6.2; ACI 318-08, 11.5.6.2; ACI 318-05, 11.6.6.2; ACI 318-02, 11.6.6.2; ACI 318-99, 11.6.6.2

\textsuperscript{134} CSA A23.3-04, 11.2.7; CSA A23.3-94, 11.2.7

\textsuperscript{135} CSA A23.3-04, 11.3.9.2, 11.3.9.3, 11.3.10.6
• flexural tension side

\[
F_{lt} = \frac{M_f}{d_y} + \cot \theta \left[ \sqrt{\left( V_f - 0.5V_s \right)^2 + \left( \frac{0.45p_T T_f}{2A_o} \right)^2} \right] \text{ Eq. 2-76}
\]

\[
= F_{lt,\text{flexure}} + F_{lt,\text{shear}}
\]

• flexural compression side

\[
F_{lc} = \frac{M_f}{d_y} + \cot \theta \left[ \sqrt{\left( V_f - 0.5V_s \right)^2 + \left( \frac{0.45p_T T_f}{2A_o} \right)^2} \right] \text{ Eq. 2-77}
\]

\[
= F_{lc,\text{flexure}} + F_{lc,\text{shear}}
\]

These forces can be decomposed into flexure and shear components. The flexure components, \(F_{lt,\text{flexure}}\) and \(F_{lc,\text{flexure}}\), account for the action of the bending moment, \(M_f\), whereas the shear components, \(F_{lt,\text{shear}}\) and \(F_{lc,\text{shear}}\), account for the action of the shear force, \(V_f\), and the torsional moment, \(T_f\). The amounts of reinforcement needed to resist the flexure components are calculated separately in the flexure design procedure. The total amount of the additional longitudinal reinforcement, \(A_f\), needed to resist shear and torsion will be determined as follows:

\[
A_f = \frac{F_{lt,\text{shear}} + F_{lc,\text{shear}}}{\phi_f \sigma_y} = \frac{2 \cot \theta \left[ \sqrt{\left( V_f - 0.5V_s \right)^2 + \left( \frac{0.45p_T T_f}{2A_o} \right)^2} \right]}{\phi_f \sigma_y} \text{ Eq. 2-78}
\]

If only torsion is present (\(V_f = 0\) and \(V_s = 0\)), then (assuming \(\theta = 35^\circ\)) \(A_f\) would reduce to

\[
A_f = 2 \cot 35^\circ \left( \frac{0.45p_T T_f}{2A_o} \phi_f \sigma_y \right) = 1.285 \left( \frac{p_T T_f}{2A_o} \phi_f \sigma_y \right) \text{ Eq. 2-79}
\]

which is comparable (and conservative) to the additional amount of longitudinal reinforcement due to torsion required in accordance with the previous edition of the CSA A23.3 standard.

Investigation mode

In the investigation mode when transverse and longitudinal reinforcement is input by the user, the program checks the combined shear and torsional capacity of the system in terms of required and provided reinforcement area. In other words, the provided area of reinforcement is compared to the area of reinforcement required to resist applied loads. This is a different approach than for flexure and shear actions without coupling where design forces are directly compared to capacity. In the case where torsion and shear stirrup requirements are combined, the approach of comparing total reinforcement area is more convenient since it does not require dividing stirrup area into a part that resists torsion only and a part that resists shear only. For consistency, additional longitudinal reinforcement required for torsion and shear is also checked in terms of provided and required area. Other requirements, e.g. bar or stirrup spacing, number of longitudinal bars, area of stirrup outer leg, and combined stresses in concrete due to shear and torsion are checked also. Exceeded capacity and other conditions are flagged in the Design Results section of the report.

\[136\] See Eq. 7-42, pp 294 in Ref. [13]
\[137\] CSA A23.3-04, 11.3.6.3
\[138\] CSA A23.3-94, 11.3.9.5
Area of Reinforcement

The program calculates the required area of reinforcement (top and bottom) based on the values of bending moment envelope within the clear span. For rectangular sections with no compression reinforcement, the design flexural strength of the column strip, middle strip and beam must equal the factored design moment:

\[ M_u = \phi f_y A_s \left( d - \frac{A_s f_y}{2(0.85f'_c)b} \right). \quad \text{Eq. 2-80} \]

The reinforcement can therefore be computed from:

\[ A_s = \frac{0.85f'_c b}{f_y} \left( d - \frac{d^2 - \frac{2M_u}{\phi 0.85f'_c b}}{2} \right). \quad \text{Eq. 2-81} \]

For CSA A23.3

\[ M_t = \phi f_y A_s \left( d - \frac{\phi f_y A_s f_y}{2\alpha f_y f'_c b} \right). \quad \text{Eq. 2-82} \]

The effective depth of the section is taken as the overall section depth minus the distance from the extreme tension fiber to the tension reinforcement centroid. The column strip depth may include all or part of the drop panel depth. The drop depth will not be included in the effective depth of the column strip when the drop does not extend at least one-sixth the center-to-center span length in all directions, or when the drop depth below the slab is less than one-quarter the slab depth. If the drop extends at least one-sixth the center-to-center span length and the drop depth is greater than one-quarter the distance from the edge of the drop panel to the face of the column or column capital, the excess depth will not be included in the column strip effective depth. If the drop width is less than the column strip width, the drop width will be used in the computation of the required reinforcement.

When computing negative slab reinforcement and additional reinforcement for negative unbalanced moments over the supports, the contribution of the depth of transverse beam can be optionally selected. The contribution of transverse beam will be considered, if it extends beyond the critical section and if its depth exceeds the depth of the drop panel. The increase of the slab thickness is limited to \( \frac{1}{4} \) of the extent of the transverse beam beyond the face of support, identical to design depth limitations for drop panels. If transverse beam depth exceeds the limit, excess depth is disregarded in the reinforcement calculations.

For two-way slabs with beams, an option exists when designing reinforcement for positive bending moments, to include a portion of slab as beam flanges\(^{139}\) (T-Section). The width of the column strip is then decreased accordingly. The extent of the flanges on each side is limited to four times slab thickness and not more that the projection of the beam under the slab. When this option is not selected, beam geometry is treated as rectangular. When calculating required reinforcement for negative bending moments the geometry of the beam is treated as rectangular, having beam width equal to web width. However, when a T-Section is selected, reinforcing bar design is performed assuming that they are distributed across the beam width including the flanges.

For the ACI 318-99 code the strength reduction factor for flexure calculations is specified as \( \phi = 0.90 \).\(^{140}\) For the ACI 318-11, ACI 318-08, ACI 318-05, and ACI 318-02 codes the strength reduction factor for tension-controlled sections (\( \varepsilon_t \geq 0.005 \)) is equal \( \phi = 0.90 \). For transition sections (\( f_y / E_s \leq \varepsilon_t \leq 0.005 \)) the strength reduction factor can be linearly interpolated by the formula\(^{141}\):

\[ \phi = 0.65 + \frac{0.90 - 0.65}{0.005 - f_y / E_s}(\varepsilon_t - f_y / E_s). \quad \text{Eq. 2-83} \]

---

\(^{139}\) See footnote 49

\(^{140}\) ACI 318-99, 9.3.2

\(^{141}\) ACI 318-11, 9.3.2; ACI 318-08, 9.3.2; ACI 318-05, 9.3.2; ACI 318-02, 9.3.2
ACI 318-11, ACI 318-08, ACI 318-05, and ACI 318-02 codes specify the strength reduction factor for compression controlled sections \( (\varepsilon_t < f'_c E_s) \) as equal \( \phi = 0.65 \). The reduction factors for transition or compression controlled sections have application primarily in investigation mode of the program. In design mode the program performs the calculations assuming a tension controlled section \( (\varepsilon_t \geq 0.005) \) or a section with compressive reinforcement (if enabled).

The ACI 318-99 code\(^{142}\) requires keeping the steel ratio below the maximum value, \( \rho_{\text{max}} \), equal to 75\% of steel ratio producing balanced strain condition, \( \rho_b \), where:\(^{143}\)

\[
\rho_b = 0.85\beta_1 \frac{f'_c}{f_y} \frac{87}{87 + f_y}, \quad \text{Eq. 2-84}
\]

with

\[
\beta_1 = \begin{cases} 
0.85 & \text{for } f'_c \leq 4\text{ ksi}, \\
0.65 & \text{for } f'_c \geq 8\text{ ksi}, \\
1.05 - 0.05f'_c & \text{for } 4\text{ ksi} < f'_c < 8\text{ ksi}.
\end{cases}
\]

For CSA code the value of \( \rho_{\text{max}} \) equals \( \rho_b \) and is calculated as follows\(^{144}\):

\[
\rho_{\text{max}} = \rho_b = \alpha_1 \beta_1 \frac{f'_c}{f_y} \frac{700}{700 + f_y}, \quad \text{Eq. 2-85}
\]

where

\[
\alpha_1 = 0.85 - 0.0015 f'_c \geq 0.67, \\
\beta_1 = 0.97 - 0.0025 f'_c \geq 0.67.
\]

The ACI 318-11, ACI 318-08, ACI 318-05, and ACI 318-02 codes control the amount of reinforcement by limiting the value of net tensile strain \( (\varepsilon_t \geq 0.004) \). The program satisfies this condition by assuming a tensioned controlled section with \( \varepsilon_t \geq 0.005 \). From this assumption the equivalent maximum reinforcement ratio for rectangular section can be written as:

\[
\rho_{\text{max}} = \frac{0.003}{0.003 + 0.005} \frac{0.85\beta_1 f'_c}{f_y}, \quad \text{Eq. 2-86}
\]

If the calculated reinforcement exceeds the maximum allowed, a message will appear in the output. In such cases, it is recommended that the engineer review the slab thickness to ensure a more satisfactory design. If compression reinforcement calculations are enabled, the program will attempt to add compression reinforcement to the section. The program is capable to design compressive reinforcement for any design strip (column, middle, and beam) including also unbalanced moment strip\(^{146}\).

The amount of reinforcement provided will not be less than the code prescribed minimum. For the ACI 318 code, the minimum ratio of reinforcement area to the gross sectional area of the slab strip using Grade 60 reinforcement is taken as 0.0018. When reinforcement yield strength exceeds 60 ksi, the minimum ratio is set to 0.0015×60 / \( f_y \). For reinforcement with yield strength less than 60 ksi, the minimum ratio is set to 0.0020. In no case will this ratio be less than 0.0014 (See Table 2-5)\(^{147}\). The CSA Standard requires a minimum ratio

---

\(^{142}\) ACI 318-99, 10.3.3  
\(^{143}\) ACI 318-99, 8.4.3  
\(^{144}\) CSA A23.3-04, 10.5.2; CSA A23.3-94, 10.5.2; Eq. 4-24, pp 110 in Ref. [13]  
\(^{145}\) ACI 318-11, 10.3.5; ACI 318-08, 10.3.5; ACI 318-05, 10.3.5; ACI 318-02, 10.3.5  
\(^{146}\) ACI 318-11, 13.5.3.2; ACI 318-08, 13.5.3.2; ACI 318-05, 13.5.3.2; ACI 318-02, 13.5.3.2; ACI 318-99, 13.5.3.2; CSA A23.3-04, 13.5.3; CSA A23.3-94, 13.11.2  
\(^{147}\) ACI 318-11, 7.12.2.1; ACI 318-08, 7.12.2.1; ACI 318-05, 7.12.2.1; ACI 318-02, 7.12.2.1; ACI 318-99, 7.12.2.1
of slab reinforcement area to gross sectional area of the slab strip equal to 0.002 for all grades of reinforcement.\(^{148}\)

<table>
<thead>
<tr>
<th>(f_y) (ksi)</th>
<th>(A_s/A_g)</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 60</td>
<td>0.0020</td>
</tr>
<tr>
<td>(\geq 60)</td>
<td>(0.0018 \times 60 / f_y \geq 0.0014)</td>
</tr>
</tbody>
</table>

\(\textbf{Table 2-5. Minimum Ratios of Reinforcement to Gross Concrete Area}\)

According to ACI code for beams and positive moment regions of joist slabs, minimum reinforcement provided will not be less than:\(^{149}\)

\[
A_{s,\text{min}} = \frac{3\sqrt{f_y}}{f_y} b_w d \quad \text{Eq. 2-87}
\]

and not less than \(200b_w d / f_y\) where \(b_w\) is the web width of the section. For statically determinate sections with flange in tension, \(b_w\) is replaced by the smaller of \(2b_w\) and the width of the flange.

Similar equation prescribed by CSA A23.3 code has the form:\(^{150}\)

\[
A_{s,\text{min}} = \frac{0.2\sqrt{f_c}}{f_y} b_t h \quad \text{Eq. 2-88}
\]

where \(b_t\) is the width of the tension zone of the section. Additionally, for T-sections having flange in tension the CSA code limits value of \(b_t\) to 1.5\(b_w\) for single sided flanges and to 2.5\(b_w\) for double sided flanges.

When designing reinforcement for longitudinal slab bands according to CSA code, program assumes identical minimum steel requirements as for beams.

**Design for Combined Flexure, Shear, and Torsion**

CSA A23.3-04 requires, in proportioning of longitudinal reinforcement, to include additional tension forces caused by shear and torsion.\(^{151}\) To achieve this, the program calculates forces developed in the longitudinal reinforcement due to flexure, shear, and torsion.

On the flexural tension side the force in longitudinal reinforcement is equal to:\(^{152}\)

\[
F_t = \frac{|M_t|}{d_v} + \cot \Theta \sqrt{\left(|V_t| - 0.5 V_s\right)^2 + \left(\frac{0.45 p_{th} T_{th}}{2A_o}\right)^2} \quad \text{Eq. 2-89}
\]

On the flexural compression side the force in longitudinal reinforcement is equal to:\(^{153}\)

\[
F_c = \cot \Theta \sqrt{\left(|V_t| + 0.5 V_s\right)^2 + \left(\frac{0.45 p_{th} T_{th}}{2A_o}\right)^2} - \frac{|M_t|}{d_v} \quad \text{Eq. 2-90}
\]

but not less than zero.

For these forces, longitudinal reinforcement area is calculated from the following equations:\(^{154}\)

---

148 CSA A23.3-04, 7.8.1; CSA A23.3-94, 7.8.1
149 ACI 318-11, 10.5.1; ACI 318-08, 10.5.1; ACI 318-05, 10.5.1; ACI 318-02, 10.5.1; ACI 318-99, 10.5.1
150 CSA A23.3-04, 10.5.1.2(b); CSA A23.3-94, 10.5.1.2(b)
151 CSA A23.3-04, 11.3.9
152 CSA A23.3-04, 11.3.9.2 and 11.3.10.6
153 CSA A23.3-04, 11.3.9.3 and 11.3.10.6
154 CSA A23.3-04, 11.3.9.1
\[ A_{ht} = \frac{F_h}{\phi_c f_y} \]  
Eq. 2-91

\[ A_{hc} = \frac{F_c}{\phi_c f_y} \]  
Eq. 2-92

Taking into account both positive and negative bending moments (resulting from all load combinations and load patterns) and checking against area of steel required for flexure only, the final areas of top and bottom reinforcement can be calculated from:

\[
A_{\text{top}} = \begin{cases} 
\max \{A_s, A_h\} & \text{if } M_f \geq 0 \\
\max \{A_s, A_h\} & \text{if } M_f < 0 
\end{cases} 
\]  
Eq. 2-93

\[
A_{\text{bot}} = \begin{cases} 
\max \{A_s, A_h\} & \text{if } M_f \geq 0 \\
\max \{A_s, A_h\} & \text{if } M_f < 0 
\end{cases} 
\]  
Eq. 2-94

**Reinforcement Selection**

According to ACI-318 code\(^{155}\), the default minimum clear spacing of reinforcement for both slabs and beams is taken as the larger of the two prescribed minima of one bar diameter, \(d_b\), or 1 in. According to CSA code\(^{156}\), the default minimum clear spacing of reinforcement for both slabs and beams is taken as the larger of the two prescribed minima of 1.4 times the bar diameter, \(d_b\), or 1.2 in (30mm). The user may select a clear spacing greater than the default value to take into account tolerances for reinforcement placement\(^{157}\) and other project specific considerations.

For two-way systems, the maximum spacing of reinforcement is kept at two times the slab thickness for the ACI code\(^{158}\) and three times the slab thickness for the CSA code\(^{159}\), but no more than 18 in. or 500 mm respectively. For joist systems the limit is increased to 5 times the slab thickness\(^{160}\). When calculating negative support reinforcement for the CSA code\(^{161}\), the program assumes that banded reinforcement over supports is spaced at a maximum of 1.5 \(h_s\) and no more than 250 mm.

For one-way slabs, the maximum spacing is limited to\(^{162}\) the smaller of three times the slab thickness and 18 in. [500 mm]. Additionally, the maximum spacing of reinforcement, \(s\), in beams and one-way slabs is selected so that the following crack control requirements of the ACI and the CSA codes\(^{163}\) are met:

\[
s \leq \min \left( \frac{900,000}{f_y} - 2.5 \ c_c, \frac{480,000}{f_y} \right) \]  
(ACI 318-11/08/05)

\[
s \leq \min \left( \frac{900}{f_y} - 2.5 \ c_c, \frac{432}{f_y} \right) \]  
(ACI 318-02/99)  
Eq. 2-95

\[
0.6 \ f_y \left( d_c A \right)^{\frac{1}{3}} \leq z_{\text{max}} \]  
(CSA A23.3-04/94)

where:

\(^{155}\) ACI 318-11, 7.6.1; ACI 318-08, 7.6.1; ACI 318-05, 7.6.1; ACI 318-02, 7.6.1; ACI 318-99, 7.6.1

\(^{156}\) CSA A23.3-04, Annex A, 6.6.5.2; CSA A23.3-94, Annex A, A12.5.2

\(^{157}\) See ACI 317-06 (Ref. [6])

\(^{158}\) ACI 318-11, 13.3.2; ACI 318-08, 13.3.2; ACI 318-05, 13.3.2; ACI 318-02, 13.3.2; ACI 318-99, 13.3.2

\(^{159}\) CSA A23.3-04, 13.10.4; CSA A23.3-94, 13.11.3(b)

\(^{160}\) ACI 318-11, 7.12.2; ACI 318-08, 7.12.2; ACI 318-05, 7.12.2; ACI 318-02, 7.12.2; ACI 318-99, 7.12.2; CSA A23.3-04, 7.8.3; CSA A23.3-94, 7.8.3

\(^{161}\) CSA A23.3-04, 13.10.4; CSA A23.3-94, 13.11.3(a)

\(^{162}\) ACI 318-11, 7.6.5; ACI 318-08, 7.6.5; ACI 318-05, 7.6.5; ACI 318-02, 7.6.5; ACI 318-99, 7.6.5; CSA A23.3-04, 7.4.1.2; CSA A23.3-94, 7.4.1.2

\(^{163}\) ACI 318-11, 10.6.4; ACI 318-08, 10.6.4; ACI 318-05, 10.6.4; ACI 318-02, 10.6.4; ACI 318-99, 10.6.4; CSA A23.3-04, 10.6.1; CSA A23.3-94, 10.6.1
\[ cc = \text{least distance from the surface of bar to the tension face}, \]
\[ dc = \text{distance from extreme tension fiber to center of the closest longitudinal bar} \]
\[ A = \text{effective tension area of concrete surrounding the flexural tension reinforcement and extending from the extreme tension fiber to the centroid of the flexural tension reinforcement and an equal distance past that centroid, divided by the number of bars or wires} \]
\[ z_{\text{max}} = 30000 \text{ N/mm for interior exposure or 25000 N/mm for exterior exposure, multiplied by a factor of 1.2 for epoxy-coated reinforcement} \]

An iterative process is performed to determine the number of bars and bar size. The initial number of bars is determined by dividing the total reinforcement area required, \( A_s \), by the area of one bar, \( A_{sb} \), of the input minimum bar size. Next, the spacing is determined. If the minimum spacing limitations are violated, the bar size is increased and the iterative process is repeated until all bars sizes have been checked. If the maximum spacing limitations are not met, the number of bars required to satisfy these limitations is computed and the iteration process terminates.

\[ w_{\text{bend}} = \left( 1 - \frac{\sqrt{2}}{2} \right) \left( r - \frac{d_b}{2} \right), \quad \text{Eq. 2-96} \]

where
\[ d_b = \text{diameter of the longitudinal bar} \]
\[ r = \text{inside radius of bend for stirrup} \]

---

\(^{164}\) ACI 318-11, 7.2.2; ACI 318-08, 7.2.2; ACI 318-05, 7.2.2; ACI 318-02, 7.2.2; ACI 318-99, 7.2.2; CSA A23.3-04, 7.1.1 and Table 16 in Annex A; CSA A23.3-94, 7.1.1 and Table 16 in Annex A
Bar-length computations are performed for two-way slabs and longitudinal beams. For top reinforcement at the supports, the length for long bars is given by:

$$\ell_{\text{long}} = \max \left( \max \left( \ell_{50\%} + \ell_{\text{cr, long}}, \ell_{\text{fos}} + \ell_{\text{cr, long}} \right), \right) + \max \{ d, 12d_b, \ell_n / 16 \},$$  
Eq. 2-97

and the length for short bars is given by:

$$\ell_{\text{short}} = \max \left( \max \left( \ell_{50\%} + \max \{ d, 12d_b \} \right), \right) + \max \{ \ell_{\text{fos}} + \ell_{\text{cr, short}} \},$$  
Eq. 2-98

where:

- $\ell_{50\%}$ = maximum distance to the points of 50% demand,
- $\ell_{\text{pi}}$ = maximum distance to the points of inflection (P.I.),
- $\ell_d$ = bar development length$^{165}$,
- $d$ = effective depth,
- $d_b$ = bar diameter,
- $\ell_n$ = clear span length,
- $\ell_{\text{fos}}$ = distance to the face of support (column),
- $\ell_{\text{cr}}$ = minimum code prescribed extension.

These bar lengths are then compared and adjusted if necessary to the minimum requirements specified by the code.$^{166}$ Additionally the program may select continuous top bars in those spans where steel is required by calculation in mid-span at top.

If the computed bar lengths overlap, it is recommended that such reinforcement be run continuously. The printed bar lengths do not include hooks or portions of bars bent down into spandrel beams or other bar-bend configurations. If a bar starts (or ends) at a column support the length of the bar is measured from (or to) the center line of the column. The selection of bar lengths for positive reinforcement for flat plates, flat slabs, and beam-supported slabs, is based strictly on the minimum values of the code.

---

$^{165}$ Chapter 12 in ACI 318-11, ACI 318-08, ACI 318-05, ACI 318-02, and ACI 318-99; CSA A23.3-04, Clause 12.2; CSA A23.3-94, Clause 12.2

$^{166}$ Figure 13.3.8 in ACI 318-11, ACI 318-08, ACI 318-05, ACI 318-02, and ACI 318-99; CSA A23.3-04, Figure 13.1; CSA A23.3-94, Figure 13.1
The development length depends on the following factors: concrete cover, minimum transverse reinforcement, special transverse reinforcement, layer location bar size and bar clear spacing. The development length is calculated from the general expression\textsuperscript{167} below, but not less \textsuperscript{168} than 12 in [300 mm]:

\[
\ell_d = d_b \frac{f_y}{\sqrt{f'_c}} \psi_t \psi_e \psi_s \left( \frac{\psi_d + K_{tr}}{d_b} \right) \times \begin{cases} 
\frac{3}{40\lambda} & \text{for ACI 318-11/08}, \\
\frac{1}{1.1\lambda} & \text{for ACI 318M-11/08}, \\
\frac{3\lambda}{40} & \text{for ACI 318-05/02/99}, \\
\frac{1.1}{\lambda} & \text{for ACI 318M-05/02/99}, \\
\frac{1.15\pi\lambda}{4} & \text{for CSA A23.3-04/94},
\end{cases}
\]

Eq. 2-99

where:

- \(\psi_t\) = reinforcement location factor equal to 1.3 if more than 12 in [300 mm] of fresh concrete is cast in the member below the development length or splice, or equal to 1.0 otherwise,
- \(\psi_e\) = coating factor equal to 1.0 for uncoated reinforcement; for epoxy coated reinforcement with covers less than 3\(d_b\) or clear spacing less than 6\(d_b\) the factor is equal to 1.5 and for all other epoxy coated bars it equals 1.2,
- \(\psi_s\) = reinforcement size factor equal to 1.0 for bars #7 [22] and larger or equal to 0.8 for bars #6 [19] and smaller if ACI 318 [ACI 318M] is selected; for CSA A23.3 the factor is equal to 1.0 for bars 25M and larger or equal to 0.8 for bars 20M and smaller,
- \(\lambda\) = lightweight aggregate concrete factor equal to 1.0 for normal concrete and:
  - 0.75 for lightweight concrete per ACI 318-11 and ACI 318-08
  - 1.3 for lightweight concrete per ACI 318-05/02/99
  - 1.3 for low density concrete per CSA A23.3-04/94
  - 1.2 for semi low density concrete per CSA A23.3-04/94
- \(K_{tr}\) = transverse reinforcement index conservatively assumed zero,
- \(d_b\) = smaller of the distance from bar surface to the closest concrete surface and one-half (two thirds for CSA\textsuperscript{169}) center-to-center bar spacing.\textsuperscript{170}

Additionally, the product of \(\psi_t\psi_e\) is not taken greater than 1.7 and the development length, \(\ell_d\), is reduced\textsuperscript{171} by the factor of \(A_{s,req} / A_{s,prov}\) where the provided area of flexural reinforcement, \(A_{s,prov}\), exceeds the area required by analysis, \(A_{s,req}\).

Concentration and Additional Reinforcement at Support

spSlab computes the fraction of the unbalanced moment, \(\gamma_f M_u\), that must be transferred by flexure within an effective slab width (a band) equal to the column width plus one and one-half the slab or drop panel depth (1.5\(h\)) on either side of the column where:\textsuperscript{172}

\[
\gamma_f = \frac{1}{1 + \frac{2}{3}\sqrt{b_1 / b_2}}
\]

Eq. 2-100

\textsuperscript{167} ACI 318-11, 12.2.3; ACI 318-08, 12.2.3; ACI 318-05, 12.2.3; ACI 318-02, 12.2.3; ACI 318-99, 12.2.3; ACI 318M-11,12.2.3; ACI 318M-08, 12.2.3; ACI 318M-05, 12.2.3; ACI 318M-02, 12.2.3; ACI 318M-99, 12.2.3; CSA A23.3-04, 12.2.2; CSA A23.3-94, 12.2.2

\textsuperscript{168} ACI 318-11, 12.2.1; ACI 318-08, 12.2.1; ACI 318-05, 12.2.1; ACI 318M-05, 12.2.1; ACI 318M-02, 12.2.1; ACI 318M-99, 12.2.1; CSA A23.3-04, 12.2.1; CSA A23.3-94, 12.2.1

\textsuperscript{169} Denoted as \(d_{cs}\) in CSA A23.3-04, 2.3 and CSA A23.3-94, 12.0

\textsuperscript{170} ACI 318-05, 2.1; ACI 318-02, 2.1; ACI 318-99, 12.2.4

\textsuperscript{171} ACI 318-11, 12.2.5; ACI 318-08, 12.2.5; ACI 318-05, 12.2.5; ACI 318-02, 12.2.5; ACI 318-99, 12.2.5; CSA A23.3-04, 12.2.5; CSA A23.3-94, 12.2.5

\textsuperscript{172} ACI 318-11, 13.5.3.2; ACI 318-08, 13.5.3.2; ACI 318-05, 13.5.3.2; ACI 318-02, 13.5.3.2; ACI 318-99, 13.5.3.2; CSA A23.3-04, 13.3.5.3; CSA A23.3-94, 13.11.2 and 13.4.5.3
The amount of reinforcement required to resist this moment is computed. The amount of reinforcement already provided for flexure is then computed from the bar schedule (i.e. the number of bars that fall within the effective slab width multiplied by the area of each bar). Depending on load conditions, additional negative or positive reinforcement may be required. If the reinforcement area provided for flexure is greater than or equal to the reinforcement requirements to resist moment transfer by flexure, no additional reinforcement is provided, and the number of additional bars will be set to 0. If the amount of reinforcement provided for flexure is less than that required for moment transfer by flexure, additional reinforcement is required. The additional reinforcement is the difference between that required for unbalanced moment transfer by flexure and that provided for design bending moment in the slab, and it is selected based on the bar size already provided at the support.

For ACI codes the value of $\gamma_f$ on selected supports can be automatically adjusted to the maximum permitted value. The corresponding value of $\gamma_v = 1 - \gamma_f$ is adjusted accordingly. This option allows relaxing stress levels for two-way shear around the columns by transferring increased part of the unbalanced moment through flexure. The adjustment is performed independently for each load case and pattern. If for given load case the corresponding two-way shear $V_u$ exceeds the appropriate limits $0.75\phi V_c$ at an edge support, $0.5\phi V_c$ at a corner support, or $0.4\phi V_c$ at an interior support, adjustment of both factors is not performed. When the adjustment of $\gamma_f$ and $\gamma_v$ factors is selected, the reinforcement calculated within the transfer width should be limited according to the code to reinforcement ratio $\rho < 0.375\rho_b$, as stipulated in ACI 318-99/02/05, or limitation of net tensile strain $\varepsilon_t > 0.010$, as required by ACI 318-11 and ACI 318-08. Violation of this requirement is reported by the software as exceeding maximum allowable reinforcement indicating that the option to adjust the factor $\gamma_f$ should be turned off by the user at the support where the violation occurs.

It should be noted that the ACI code requires either concentration of reinforcement over the column by closer spacing, or additional reinforcement, to resist the transfer moment within the effective slab width. spSlab satisfies this requirement by providing additional reinforcement without concentrating existing reinforcement.

When computing additional reinforcement for the transfer of negative and positive unbalanced moments over the supports through flexure in systems with longitudinal beams, the contribution of the longitudinal beam cross-section can be optionally selected. If selected, this contribution will be considered. For CSA designs this functionality extends also to design of banded reinforcement in $b_b$ strip.

The CSA A23.3 code requires at least one-third of the total negative reinforcement for the entire design strip at interior supports to be concentrated in the band width, $b_b$, extending 1.5 $h_s$ from the sides of the columns. The program fulfills this requirement by concentrating a portion of reinforcement assigned to the design strip that includes width $b_b$. This strip will typically be the column strip. However, if longitudinal slab bands or slab-band-like beams wider than band width $b_b$ are present, then reinforcement assigned to these elements is concentrated. At exterior supports, the total negative reinforcement is placed in the $b_b$ band width or if a beam narrower than $b_b$ is present, then the total reinforcement is placed within the beam width. The reinforcement in the $b_b$ and the remaining portions of the design strip is also checked for compliance with spacing and minimum reinforcement requirements.

**Structural Integrity Reinforcement**

Enhancing redundancy and ductility is necessary in the event of damage to a major supporting element resulting from an abnormal shock or blast loading event.

Minor changes in reinforcement detailing typically result in substantial enhancement in the overall integrity of a structure by confining the resulting damage to a small area and improving the resistance to progressive collapse.

---

173 ACI 318-11, 13.5.3.3; ACI 318-05, 13.5.3.3; ACI 318-02, 13.5.3.3; ACI 318-99, 13.5.3.3
174 ACI 318-11, 13.5.3.3; ACI 318-08, 13.5.3.3
175 ACI 318-11, 13.5.3.4; ACI 318-08, 13.5.3.4; ACI 318-05, 13.5.3.4; ACI 318-02, 13.5.3.4; ACI 318-99, 13.5.3.4
176 CSA A23.3-04, 13.11.2.7; CSA A23.3-94, 13.12.2.1
177 CSA A23.3-04, 13.10.3; CSA A23.3-94, 13.12.2.2, 13.13.4.2
178 CSA A23.3-04, 13.12.2.2; CSA A23.3-94, 13.13.2.2
The ACI code requires all bottom bars in the column strip to extend continuously (or with splices) in the entire span and at least two of these bars to pass within the column core and to be anchored at exterior supports. In continuous beams, including longitudinal beams in two-way slab systems, spSlab and spBeam design reinforcement that satisfies ACI requirements for structural integrity. In perimeter (exterior) beams, at least one sixth of the negative tension reinforcement and not less that two bars are continuous. Also, at least one fourth of the positive tension reinforcement and not less than two bars are continuous in all beams.

For the CSA code, the program performs calculation of the amount of integrity reinforcement at slab column connections. The integrity reinforcement is required for slabs without beams. Integrity reinforcement is not required if there are beams containing shear reinforcement in all spans framing into the column. Otherwise, the sum of all bottom reinforcement connecting the slab to the column on all faces of the periphery should consist of at least two bars and meet the condition:

\[ \sum A_{sb} \geq \frac{2V_{se}}{f_y} \]  

Eq. 2-101

where \( V_{se} \) is the larger of shear force transmitted to column or column capital due to specified (unfactored) loads and shear force corresponding to twice the self-weight of the slab.

**Corner Reinforcement**

The program performs calculation of the amount of reinforcement in exterior corners of slabs with stiff edge beams (\( \alpha > 1.0 \)). This reinforcement is required within a region equal to 1/5 of the shorter span. The amount of corner reinforcement is calculated from the moment per unit width intensity corresponding to the maximum positive moment in span. The code allows the corner reinforcement to be placed at top and bottom of the slab in bands parallel to the sides of the slab edges.

**Deflections**

**Instantaneous Deflections**

Instantaneous deflections are obtained directly by the program from elastic analysis of the defined system for two load levels. The first corresponds to dead load only, while the second corresponds to dead load plus live load on all spans. The deflection occurring when the live load is applied can be computed as the total load deflection due to the dead and the live load minus the dead load deflection. Depending on the option selected by the user, the program will calculate flexural stiffness of the members based on either gross moment of inertia or the effective moment of inertia which allows taking cracking into account.

**Cracking**

When calculating the deflections for effective (cracked) section properties, the frame solution is obtained for two load levels: dead load only and dead load plus live load combined. Flexural stiffness is assumed corresponding to the load level.

A reduction in the flexural stiffness caused by cracking leads to an increase in deflections. Several methods of deflection analyses taking cracking into account are reviewed in Ref. [19]. The program uses the approach based on the effective moment of inertia as permitted by the code.
The effective moment of inertia, \( I_e \), developed by Branson (Ref. [14]) and incorporated into the code equals:

\[
I_e = \left( \frac{M_{cr}}{M_{\max}} \right)^3 I_g + \left[ 1 - \left( \frac{M_{cr}}{M_{\max}} \right)^3 \right] I_{cr},
\]

Eq. 2-102

where:

- \( I_g \) = moment of inertia of the gross uncracked concrete section,
- \( I_{cr} \) = moment of inertia of the cracked transformed concrete section\(^{186}\),
- \( M_{cr} \) = cracking moment,
- \( M_{\max} \) = maximum bending moment at the load level for which the deflection is computed.

To calculate \( I_e \) for two-way slabs, the values of all terms for the full width of the equivalent frame are used in Eq. 2-102. This approach averages the effects of cracking in the column and middle strips.

The value of \( I_e \) at midspan for a simple span and at support for a cantilever is taken\(^{187}\) to calculate flexural stiffness of a member. For other conditions, an averaged effective moment of inertia, \( I_{e,avg} \) is used. For spans with both ends continuous, \( I_{frame} \) is given by\(^{188}\)

\[
I_{e,avg} = 0.70 I_e^+ + 0.15 \left( I_{e,l}^- + I_{e,r}^- \right),
\]

Eq. 2-103

where:

- \( I_e^+ \) = effective moment of inertia for the positive moment region,
- \( I_{e,l}^- \) = effective moment of inertia for the negative moment region at the left support,
- \( I_{e,r}^- \) = effective moment of inertia for the negative moment region at the right support.

For spans with one end continuous the value of \( I_{frame} \) is given by\(^{189}\):

\[
I_{e,avg} = 0.85 I_e^+ + 0.15 I_e^-,
\]

Eq. 2-104

where:

- \( I_e^+ \) = effective moment of inertia for the positive moment region,
- \( I_e^- \) = effective moment of inertia for the negative moment region at the continuous end.

**Long-Term Deflections**

The program estimates additional long-term deflection resulting from creep and shrinkage, \( \Delta_{cs} \), by multiplying the immediate deflection due to sustained load, \( \Delta_{sust} \), by the factor, \( \lambda_{\Delta} \), equal to\(^{190}\)

\[
\lambda_{\Delta} = \frac{\zeta}{1 + 50 \rho},
\]

Eq. 2-105

where:

- \( \zeta \) = time dependant factor with the maximum value of 2.0 (the actual value is interpolated from the values and the chart given in the code\(^{191}\) based on the load duration specified by the user in the input).

---

\(^{186}\) See formulas for various cross sections in Table 10-2 in Ref. [15]
\(^{187}\) ACI 318-11, 9.5.2.4; ACI 318-08, 9.5.2.4; ACI 318-05, 9.5.2.4; ACI 318-02, 9.5.2.4; ACI 318-99, 9.5.2.4
\(^{188}\) ACI 435R-95 (Ref. [16]), 2.5.1, Eq. (2.15a); CSA A23.3-04, 9.8.2.4(a); CSA A23.3-94, 9.8.2.4, Eq. 9.3
\(^{189}\) ACI 435R-95 (Ref. [16]), 2.5.1, Eq. (2.15b); CSA A23.3-04, 9.8.2.4(b); CSA A23.3-94, 9.8.2.4, Eq. 9.4
\(^{190}\) ACI 318-11, 9.5.2.5; ACI 318-08, 9.5.2.5; ACI 318-05, 9.5.2.5; ACI 318-02, 9.5.2.5; ACI 318-99, 9.5.2.5; CSA A23.3-04, 9.8.2.5; CSA A23.3-94, 9.8.2.5A23.3
\(^{191}\) Fig. R9.5.2.5 in ACI 318-11, ACI 318-08; ACI 318-05; ACI 318-02, and ACI 318-99; Fig. N9.8.2.6 in CSA A23.3-04 and CSA A23.3-94
Deflection due to the sustained load, $\Delta_{sust}$, consists of the deflection induced by the dead load (including self weight), $\Delta_{dead}$, and the deflection $\Delta_{ls}$ which is induced by that portion of the live load which is declared as sustained in the input by the user. Thus

$$\Delta_{sust} = \Delta_{dead} + \Delta_{ls}, \quad \text{Eq. 2-106}$$

and

$$\Delta_{cs} = \Delta_{sust} \lambda_A. \quad \text{Eq. 2-107}$$

The program calculates incremental deflection which occurs after partitions are installed in two ways. In the first approach, it is assumed that the live load has been applied before installing the partitions and the incremental deflection equals\(^{192}\)

$$\Delta_{cs+ls} = \Delta_{cs} + (\Delta_{live} - \Delta_{ls}), \quad \text{Eq. 2-108}$$

In the second approach, the assumption is that the full live load, including the sustained portion of the live load, has been applied after the partitions are installed which results in the incremental deflection equal to\(^{193}\)

$$\Delta_{cs+ls} = \Delta_{cs} + \Delta_{live}, \quad \text{Eq. 2-109}$$

The total long-term deflection $\Delta_{total}$ is also calculated as\(^{194}\)

$$\Delta_{total} = \Delta_{sust} (1 + \lambda_A) + (\Delta_{l} - \Delta_{ls}), \quad \text{Eq. 2-110}$$

**Deflections of two-way systems**

Calculation of deflections of reinforced concrete two-way slabs is complicated by a large number of significant parameters such as: the aspect ratio of the panels, the vertical and torsional deflection of supporting beams, the stiffening effect of drop panels and column capitals, cracking, and the time-dependent nature of the material response. Based on studies (Ref. [17]–[19]), an approximate method consistent with the equivalent frame method was developed (Ref. [20]) to estimate the column and middle strip deflections.

Calculation of the midspan deflection of the column strip or the middle strip is based on the M/EI ratio\(^{195}\) of the strip to that of the full-width panel:

$$\Delta_{strip} = \Delta_{frame} \frac{M_{strip}}{M_{frame}} \frac{E_c I_{g,frame}}{E_c I_{g,strip}}, \quad \text{Eq. 2-111}$$

where $\Delta_{frame}$ is taken from the equivalent frame analysis assuming gross section (un-cracked) or effective (cracked) section properties.

The ratio ($M_{strip}/M_{frame}$) can be considered as a lateral distribution factor, LDF. For ACI and CSA A23.3-94 codes the lateral distribution factor, LDF, at an exterior negative moment region is:

$$\text{LDF}_{\text{neg, ext}} = 100 - 10 \beta_1 + 12 \beta_2 \left( \alpha_{f1} \frac{\ell_f}{\ell} \right) \left( 1 - \frac{\ell_f}{\ell} \right). \quad \text{Eq. 2-112}$$

The LDF at an interior negative moment region is:

$$\text{LDF}_{\text{neg, int}} = 75 - 30 \left( \alpha_{f1} \frac{\ell_f}{\ell} \right) \left( 1 - \frac{\ell_f}{\ell} \right). \quad \text{Eq. 2-113}$$

---

\(^{192}\) CSA A23.3-04 N9.8.2.5, CSA A23.3-94 N9.8.2.5

\(^{193}\) See Example 10.1 in Ref. [15]

\(^{194}\) CSA A23.3-04 N9.8.2.5; CSA A23.3-94 N9.8.2.5

\(^{195}\) Referred to as “Ratio” in the Maximum Instantaneous Deflections - Direction of Analysis Table, Deflection Section in the Design Results part of the Results Report
The LDF at a positive moment region is:

\[
\text{LDF}_{\text{pos}} = 60 + 30 \left( \alpha_{f1} \frac{\ell_2}{\ell_1} \left( 1.5 - \frac{\ell_2}{\ell_1} \right) \right),
\]

where:

\[\alpha_{f1} = \text{the ratio of flexure stiffness of a beam section to the flexural stiffness of a width of slab bounded laterally by centerlines of adjacent panels on either side of the beam},\]

\[\beta_1 = \text{ratio of torsional stiffness of an edge beam section to the flexural stiffness of a width of slab equal to the span length of the beam, center-to-center of the supports (see Eq. 2-30).}\]

For CSA A23.3-04 code lateral distribution factors are based on tabulated values presented earlier in the chapter.

When \(\alpha_{f1} \ell_2 / \ell_1\) is greater than 1.0, \(\alpha_{f1} \ell_2 / \ell_1\) will be set equal to 1.0.

The column and middle strip LDF’s can be computed by:

\[
\text{LDF}_c = \frac{\text{LDF}_{\text{pos}} + \text{LDF}_{\text{neg},l} + \text{LDF}_{\text{neg},r}}{2}, \quad \text{Eq. 2-115}
\]

\[
\text{LDF}_{\text{m}} = 100 - \text{LDF}_c, \quad \text{Eq. 2-116}
\]

where:

\[
\text{LDF}_{\text{neg},l} = \text{LDF for the negative moment region at the left end of the span}
\]

\[
\text{LDF}_{\text{neg},r} = \text{LDF for the negative moment region at the right end of the span}
\]

\[\Delta = \Delta_{cx} + \Delta_{my} = \Delta_{cy} + \Delta_{mx}\]

\[\text{Figure 2-22 Deflection computation for a square panel}\]
The deflections should be used in conjunction with the deflections obtained from an analysis in the transverse
direction. For square panels ($\ell_1 = \ell_2$), the midpanel deflection is obtained from the following equation as
shown in Figure 2-22:

$$\Delta = \Delta_{cy} + \Delta_{mx} = \Delta_{cx} + \Delta_{my}.$$  
Eq. 2-117

For rectangular panels, ($\ell_1 \neq \ell_2$), the mid panel deflection is obtained from:

$$\Delta = \frac{\Delta_{cy} + \Delta_{mx} + \Delta_{my} + \Delta_{cx}}{2}.$$  
Eq. 2-118

**Material Quantities**

The program computes concrete and reinforcing steel quantities. The quantity of concrete is based on an
average of the slab, drop, and beam sizes. The total quantity of reinforcing steel computed by the program
corresponds to the actual bar sizes and lengths required by design. No allowance is made for bar hooks,
anchorage embedment, and so forth. It should be noted that the quantity of reinforcement printed by the
program pertains to bending in one direction only. In practice, the total amount of reinforcement for the
structure should also include the quantities obtained for the appropriate transverse equivalent frames.
References

[1] Building Code Requirements for Structural Concrete (ACI 318-11) and Commentary (ACI 318R-11), American Concrete Institute, 2011
[2] Building Code Requirements for Structural Concrete (ACI 318-08) and Commentary (ACI 318R-08), American Concrete Institute, 2008
[3] Building Code Requirements for Structural Concrete (ACI 318-05) and Commentary (ACI 318R-05), American Concrete Institute, 2005
[4] Building Code Requirements for Structural Concrete (ACI 318-02) and Commentary (ACI 318R-02), American Concrete Institute, 2002
[5] Building Code Requirements for Structural Concrete (ACI 318-99) and Commentary (ACI 318R-99), American Concrete Institute, 1999
[16] Control of Deflection in Concrete Structures (ACI 435R-95), Reported by ACI Committee 435, American Concrete Institute, 1995 (Reapproved 2000).
Chapter 3

spSlab/spBeam Interface

Main Window

The main screen will appear after the spSlab is started as shown above. The main screen consists of a title bar, menu line, tool bar, five view windows and status bar. The program name and current data file name is shown in the title bar. All the menu commands can be accessed from the menu line and some frequently used commands also can be accessed from the buttons in the tool bar. The four view windows show the geometry of a floor system and the loads on it. Plan view, side view, elevated view and isometric view are available. The status bar shows the current state of the program.

Title Bar

The title bar displays the program name, and following the hyphen, displays the name of the current data file you are using. If the data you are currently working on has not been saved into a file, the word spSlab1 (spBeam1 for spBeam) is displayed in the title bar. If you start a new data file by clicking the NEW button on the most left of the tool bar, the next data file is named as spSlab2 (spBeam2 for spBeam), and so on.

Menu Bar

Located directly below the title bar is the menu line. spSlab commands are listed in the pop-up menus located in the menu line. These menu commands allow you to perform functions that create, view, and ultimately design the floor system.

In the spSlab program there are seven main pull-down menus: File, Input, Solve, View, Options, Windows, and Help. To access a menu item using the mouse, place the arrow cursor on the menu item you want and click the left mouse button. Each menu item can also be selected with the keyboard keys by simultaneously
pressing the ALT key and the underlined letter of the menu you want to open. For example, to open the File menu, press ALT + F. To close a menu without selecting a command, move the cursor to any blank area on the screen and click the left mouse button. Press ESC key to close a menu using the keyboard keys.

To select a command from a menu with the mouse, place the arrow on the item you want, and click the left mouse button. In some cases, you will be told to double click on a selection, that is, press the mouse button twice, quickly. Anytime you have to wait, for example, when loading the program or designing the system, the mouse cursor becomes an hourglass cursor. It will return to its original state when the task is completed.

To select a command from a menu using the keyboard, use the down arrow key to highlight your choice and press ENTER key or press the keyboard key of the command’s underlined letter. The space bar is also equivalent to pressing the left mouse button.

Special instructions for inputting with the keyboard keys are given wherever necessary.

**Tool Bar**

Located directly below the menu line is the tool bar. Some frequently used buttons can be found in the tool bar. A description of the corresponding button is shown in the status bar (on the bottom of the window) when the mouse cursor is moving over this button. In addition to the description in the status bar, a brief tip is shown in a light yellow colored pop-up window close to the corresponding button when a mouse cursor is hanging over the button for a short period of time. Exactly the same functions or features can be accessed from either the menu items or tool bar buttons.

The tool bar can be changed from docking status to floating status by single clicking the left mouse button on the tool bar and dragging it away from the docking position to any other positions on the screen. A floating tool bar can be resized by clicking and dragging its borders.

To restore the tool bar to the docking status, single click the left mouse button on the tool bar and drag it to the location that is directly below the menu line and release the mouse button.

**View Windows**

A total of 10 view windows can be used to show Plan, Elevated, Side and Isometric views of the geometry, as well as Loads, Shear and Moment, Moment Capacity, Shear Capacity, Deflection, and Reinforcement.

**Status Bar**

Status bar is always on the bottom of the main window. The status bar shows the current status of the data file and the coordinate values of the mouse cursor position. Depending on the active view window, different information of the mouse cursor will appear in the status bar.

**File Menu**

The File menu is used for saving or retrieving data, printing, and exiting. The File menu contains the following commands: New, Open, Close, Save, Save As, Print Preview, Print Results, Print Setup, Recent Files and Exit.

**New**

The New command clears any data input and returns to the default values. Thus, you are able to create a new data file. However, before you can begin a new data file, spSlab will ask whether you want to save the current data. Answering YES will save the old data and begin a new data file. Answering NO will discard any changes to the data and begin a new data file. Answering CANCEL will return you to spSlab so that you can continue to work with the current data.
Open

The Open command allows you to load an existing spSlab data file. The dialog box that appears shows you a listing of all the files with the extension contained in the default data directory or in the current directory (if a default data directory was not specified). This box also enables you to change the current drive and directory. If you are currently working on a data file and select the Open command, spSlab will ask whether you want to save the current data. Answering Yes will save the old data and display the Open dialog box. Answering No will discard any changes to the data and display the Open dialog box. Answering CANCEL will return you to spSlab so that you can continue to work with the current data.

Close

The Close command allows you to close the current spSlab data file. If you are currently working on a data file and select the Open command, spSlab will ask whether you want to save the current data. Answering Yes will save the old data and display the Open dialog box. Answering No will discard any changes to the data and display the Open dialog box. Answering CANCEL will return you to spSlab so that you can continue to work with the current data.

Save

The Save command saves the changes you’ve made to the current data under that same filename. The new data overwrites the old data, and you cannot retrieve the old data. It is a good practice to periodically save while inputting data. If a data file is untitled, the Save As dialog box will appear.

Save As

The Save As command allows you to name or rename a data file. Use Save As when you want to save both the original data and any changes you’ve currently made to the data. The original data remains under the old filename. If a file of the same name exists, the program will ask if you would like to overwrite the file.

Print Preview

The Print Preview command allows you to preview and print the current view window (floor system geometry in the plan, elevated, and isometric views, prints the shear and moment diagrams, and prints the deflected shapes). To obtain a view window you must first perform the design, then select what you want to view from the View menu. You may have more than one view windows opened. The current view window is the one activated and on top of the others on your screen. Selecting this command closes the spSlab main window and opens the print preview window as shown below. On the print preview window, press the ZOOM IN or ZOOM OUT buttons or simply click the left mouse button on the preview window to magnify or reduce the size of the preview paper. Press the NEXT PAGE button if more than one page needs to be printed. Press the PRINT button to print the view. The printer could be a local printer, which is connected to your computer directly, or a network printer. Press the CLOSE button to close the preview window and go back to spSlab.
Print Results

The Print Results command allows you to send the analysis and/or design results to the printer. Selecting this command will show the Results Report Setup dialog box. By selecting items in the Selection group prior to performing the print, you can print selected sections of the data instead of the entire analysis. Option Include Non-redistributed Internal Forces is available only for beams/one-way slab systems if moment redistribution is engaged. It allows including in the report non-redistributed internal forces in addition to redistributed values which are printed by default.

Printer Setup

The Printer Setup command brings up the Windows printer setup box which allows the user to select the printer to send the output to and to change the settings of the printer.

Recent Files

This list contains the data files that are used recently and can be accessed quickly from the menu by a single click. The most recently used one is on the top of the list. Up to four files can be listed.
Exit

The Exit command ends the spSlab session and returns you to Windows. If you have made any changes to your data and have not saved them, spSlab will first ask whether you want to save or abandon any changes you’ve made before you exit.

Input Menu

The Input menu allows you to enter and modify data for the floor system. The Input menu contains the following commands: Data Input Wizard, General Information, Material Properties, Spans, Supports, Reinforcement Criteria, Reinforcing Bars, Load Cases, Load Combinations, Span Loads, Support Loads and Displacements, and Lateral Effects.

Data Input Wizard

The Data Input Wizard command is designed to make the inputting process easier. By selecting Data Input Wizard, a logical sequence of dialog boxes will automatically be displayed allowing you to enter data for your floor system.

General Information

The General Information consists of three tabs: General Information, Solve Options, and Span Control.

The General Information tab will allow you to enter the project name, frame name, engineer name, design code, reinforcement database, run mode, and number of supports. You must always use the General Information tab before doing any further inputting since it affects the availability of other commands in this menu.

The Span Control tab provides commands for span manipulation such as inserting new spans, copying spans, moving spans, and deleting spans.

The Solve Options command allows you to specify design options and deflection calculations options. Please note that design options for two-way systems are different from beams/one-way slab systems. To take effect, this command must be used prior to Execute.
Material Properties

The Material Properties command enables you to input material property requirements for concrete and reinforcement. Concrete density, compressive strength, Young’s modulus, rupture modulus, as well as the longitudinal and shear reinforcement yield levels, are required.

Spans

The Spans menu allows you to input geometric dimensions for slabs, longitudinal beams, and ribs.

Supports

The Supports menu allows you to input geometric dimensions for columns, drop panels, column capitals, and transverse beams. The percentage of the actual column joint stiffness to be used in the analysis to
determine the joint moments and shears can be modified on the **Columns** tab. The **Drop Panels** tab is available if two-way system is selected and the **Moment Redistribution** tab is available only for beams/one-way slab systems if moment redistribution is engaged in the **General Information** window.

**Reinforcement Criteria**

The **Reinforcement Criteria** menu allows you to specify the distance to reinforcement, reinforcement bar sizes, bar spacing, and reinforcing ratio for both slabs and beams. For beams it also allows you to specify criteria for stirrups, side cover and distance between layers of reinforcement if more than one layer is needed.

**Reinforcement Bars**

For two-way floor systems, the **Reinforcement Bars** menu allows you to specify the longitudinal reinforcement arrangement information for column strip, middle strip, and beam, as well as shear reinforcing information for beams.

For beams/one-way slab systems, flexural bars, stirrups, and torsional longitudinal reinforcement can be specified. The **Reinforcement Bars** menu is disabled if Run Mode of Design is selected from the **General Information** dialog box. Select the Run Mode of Investigation from the **General Information** dialog box to enable it.
Load Cases

The Load Cases menu allows you to specify load cases. Up to six load cases can be added and only one live load case is allowed.

Load Combinations

The Load Combinations menu allows you to specify load combinations as shown in Figure 3-34. Up to twenty load combinations can be added.

Span Loads

The Span Loads menu allows you to enter superimposed area loads, line loads, point loads, and moments.
Support Loads and Displacements

The Support Loads and Displacements menu allows you to enter prescribed displacements and rotations of supports as well as concentrated loads applied directly at support locations.

Lateral Effects

The Lateral Effects menu allows you to enter the lateral loads as moments acting on the two ends of each span.

Solve Menu

The Solve menu contains commands that enable you to perform the analysis and/or design of the floor system and view the results. The Solve menu contains the following commands: Execute and Report.
Execute

The **Execute** command executes the solver portion of spSlab. If some data is still required when this command is executed, spSlab will respond with an "Invalid Model!" error message. The missing data must be completed before execution. A status window pops up and shows the status during the execution. If the execution is not successful, an error message will be shown and the execution is terminated.

Results Report

The **Results Report** command brings up a window with text results of the analysis and/or design as shown below. From this window, results can be copied to clipboard or printed using **Copy** and **Print** command buttons.

To change the content of report, select items [1] through [8] from the combo box. Item **Customize** brings up the Results Report Setup window described earlier (**Print Results**, page 3-4). It will allow you to generate a report with multiple item selected.

View Menu

The **View** menu commands enable you to modify the floor system’s appearance on the screen to suit your viewing needs and enable you to view the result diagrams. The **View** menu contains the following commands: **Zoom**, **Pan**, **Restore**, **Plan View**, **Elevated View**, **Side View**, **Isometric View**, **Change View Angles**, **View Options**, **Loads**, **Internal Forces**, **Moment Capacity**, **Shear Capacity**, **Reinforcement**, **Deflection** and **Duplicate Active View**.

Zoom

The **Zoom** menu contains a cascade sub-menu, which enables you to zoom in and out on any portion of your floor system. Select **Window** from the sub-menu and use the mouse to specify a zooming region; the program will enlarge the portion you select. Select the **In(2x)** or **Out(0.5x)** to enlarge or reduce the model by two times, respectively.

Pan

The **Pan** command allows you to move your model on the plane of the screen. You may move the model in any direction. The mouse cursor is changed to a palm shape once the **Pan** command is selected. Press and hold the left mouse button on the view window and drag to the new location. After the mouse button is
released, the model is moved in the same distance and direction as the mouse cursor from the original position.

**Restore**

The **Restore** command will redraw the floor system in full size. If you have altered your screen view using the **Zoom** command, select **Restore** to restore the figure’s original proportions.

**Plan View**

Select **Plan View** command to show the plan view window.

**Elevated View**

Select **Elevated View** command to show the elevated view window.

**Side View**

Select **Side View** command to show the side view window.

**Isometric View**

Select **Isometric View** command to show the isometric view window.

**Change View Angles**

The **Change View Angle** command allows you to modify the angle at which the floor system is displayed in the Isometric View. The default angles are set at -45 about the X axis and 45 about the Z axis. A more convenient way to change the view angle is to use the keyboard short cut CTRL + ARROW KEYS. To rotate around Z axis, press CTRL + ← or CTRL + →. To rotate around X axis, press CTRL + ↑ or CTRL + ↓.

**View Options**

The **View Options** command allows you to view selected members of the floor system in the view windows. Clicking the left mouse button on the check boxes next to the items in the dialog box, or tabbing to the member type and pressing the space bar will toggle the selection. spSlab will draw any members that contain a ✓ in the box.

**Loads**

Select **Loads** command to show the load view window.

**Internal Forces**

Select **Internal Forces** command to show the shear, moment, and torsion (for beams/one-way slab systems only) diagram view window. The analysis and/or design must be performed before selecting this command. Otherwise “Problem Not Solved” message will be shown instead.

**Moment Capacity**

Select **Moment Capacity** command to show the moment capacity diagram view window. The analysis and/or design must be performed before selecting this command. Otherwise “Problem Not Solved” will be shown instead.

**Shear Capacity**

Select **Shear Capacity** command to show the shear capacity diagram view window. The analysis and/or design must be performed before selecting this command. Otherwise “Problem Not Solved” will be shown instead.
Reinforcement

Select **Reinforcement** command to show the reinforcement view window. The analysis and/or design must be performed before selecting this command. Otherwise “Problem Not Solved” will be shown instead.

Deflection

Select **Deflection** command to show the deflection diagram view window. The analysis and/or design must be performed before selecting this command. Otherwise “Problem Not Solved” will be shown instead.

Duplicate Active View

Select **Duplicate Active View** to make a copy of the current active view window.

Options Menu

The **Options** menu allows you to change the startup options of the spSlab program to suit your needs. The **Options** menu contains the following commands: **Colors**, **Startup Defaults**, **Rebar Database**, **Toolbar**, and **Status Bar**.

Colors

The **Colors** command allows you to change the background color, member color, load color, text color, diagram color, etc. You may save the new colors as default setting, which will be used when spSlab is executed in the future.

Fonts

The **Fonts** command allows you to select properties of the font that will be used in the graphical output window and printout, **Graphical Output**, as well as in the text result window and output, **Text Output**. Please note that for the Text Output only nonproportional (fixed width) fonts can be used.
Startup Defaults

The Startup Defaults command allows you to enter engineer name, change the default design code, reinforcement database, and the data directory which is where the program looks for data when it is executed.

Note: Default values of various design parameters (e.g. minimum and maximum bar spacing and reinforcement ratio, Young modulus, rupture modulus, etc.) assumed by the program depend on the design code selected in this dialog box. Subsequent change of the design code in the General Information dialog box does not reset values of these parameters to the default values corresponding to the newly selected code. It may, however, convert these values to different units if the code change is accompanied by a change of units.

Reinforcement Database

The Rebar Database command allows you to view the pre-defined reinforcement information and define your own database. The user-defined database can be selected from the General Information dialog box.

Toolbar

Check the Toolbar command with a ✓ sign to show the tool bar. Select the command again to clear the ✓ sign to hide the tool bar. The tool bar is shown by default.

Status Bar

Check the Status Bar command with a ✓ sign to show the status bar. Select the command again to clear the ✓ sign to hide the status bar. The status bar is shown by default.

Window Menu

This menu enables you to arrange view windows shown on screen. The Window menu contains the following commands: Cascade, Tile Horizontal and Tile Vertical.

Cascade

The Cascade command displays all the open windows in the same size, arranging them on top of each other so that the title bar of each is visible. The current active view widow will be on the top after the execution of the Cascade command.

Tile Horizontal

The Tile Horizontal command arranges all open windows horizontally so that no window overlaps another. The current active view widow will be on the most left or on the upper-left corner of the screen after the execution of the Tile Horizontal command.

Tile Vertical

The Tile Vertical command arranges all open windows vertically so that no window overlaps another. The current active view widow will be on the most left or on the upper-left corner of the screen after the execution of the Tile Vertical command.
Window List

The remaining menu items are in a list of the windows that are available for viewing. Selecting any window from this menu will bring up or restore the window to its previous size and position if it was minimized.

Help Menu

The Help menu includes commands that enable you to obtain online help for the program and show the copyright and registration information about your software. The Help menu contains three commands: Help Topics, Context Help and About spSlab.

Help Topics

The Help Topics command shows the Windows Help window with a table of contents. Select a topic of your interest to display information about that item. More information on the help system can be obtained from the Microsoft Windows manual.

Context Help

The Context Help command enters the program into the context-sensitive help mode which is indicated by a question mark (?) attached to the mouse cursor. In this mode, the user can click the element for which information is needed and the program will display the help topic associated with this element. More information on the help system can be obtained from the Microsoft Windows manual.

spSlab/spBeam Manual

The spSlab/spBeam Manual command opens spSlab/spBeam Manual in the default PDF viewer.

Check for Updates

The Check for Updates command checks if a newer version of the program is available. Internet connection is required.

About spSlab/spBeam

The About spSlab command shows the version number of the program, the licensing information, and the copyright information. In the case of a trial license, the expiration date is given as well as the locking code which is needed to obtain a standalone license.

Control Menu

All the view windows have one pull-down menu located in the upper left hand corner of the open window. This is the Control menu. To access the Control menu, press CTRL + F6 to cycle through the windows and press ALT + - (hyphen), to open the Control menu of the desired window. The following is a list and a brief description of the commands in this menu.
**Restore**

The *Restore* command will restore a window or an icon to its previous size and position. This menu item is available when the window is iconized or maximized.

![Plan View](image)

**Move**

The *Move* command moves the window to a new location. Select *Move* and use the ARROW KEYS to move the window in the desired direction and select ENTER to accept the new location.

**Size**

The *Size* command resizes a window. Select *Size* and use the ARROW KEYS to move the border of the window in the desired direction and select ENTER to accept the new size.

**Minimize**

The *Minimize* command reduces a window to an icon and positions it at the bottom of the screen.

**Maximize**

The *Maximize* command enlarges a window to fit your entire screen.

**Close**

The *Close* command is used to close a window and return it to an icon and the bottom of the screen.

**Next**

The *Next* command switches among open windows and icons.

**Program Toolbar**

- Close the current data file if there is one and start a new data file. The equivalent menu command is *File/New*.
- Open an existing data file on hard disk. The equivalent menu command is *File/Open*.
- Save the current data file to hard disk. The equivalent menu command is *File/Save*. If you have not changed the default file name (spSlab1, spSlab2, etc.), the equivalent menu command is *File/Save As*.
- Print view window. The equivalent menu command is *File/Print View*.
- Print results. The equivalent menu command is *File/Print Results*.
- Copy Bitmap to clipboard. The bitmap then can be pasted to a word processing or presentation software such as Microsoft Word or Microsoft PowerPoint.
- Copy Metafile to clipboard. The metafile then can be pasted to a word processing or presentation software such as Microsoft Word or Microsoft PowerPoint.
- Open the Data Input Wizard. The Data Input Wizard will guide you to enter the necessary input to your project. The equivalent menu command is *Input/Data Input Wizard*.
- Enter general information. The equivalent menu command is *Input/General Information*.
- Enter material properties. The equivalent menu command is *Input/Material Properties*.
Enter span geometry information for slabs, longitudinal beams, and ribs. The equivalent menu command is **Input/Spans**.
Enter support information for columns, drop panels, column capitals, and transverse beams. The equivalent menu command is **Input/Support**.
Enter reinforcement criteria for slab and ribs, and beams. The equivalent menu command is **Input/Reinforcement Criteria**.
Enter reinforcing bar information for column strips, middle strips, beams, and beam stirrups. This button is disabled if Design run mode is selected from the General Information dialog box. The equivalent menu command is **Input/Reinforcing Bars**.
Enter load cases. The equivalent menu command is **Input/Load Cases**.
Enter load combinations. The equivalent menu command is **Input/Load Combinations**.
Enter span loads. The equivalent menu command is **Input/Span Loads**.
Enter support loads and displacements. The equivalent menu command is **Input/Support Loads and Displacements**.
Enter lateral effects. The equivalent menu command is **Input/Lateral Effects**.
View plan geometry. The equivalent menu command is **View/Plan View**.
View elevated geometry. The equivalent menu command is **View/Elevated View**.
View side geometry. The equivalent menu command is **View/Side View**.
View isometric geometry. The equivalent menu command is **View/Isometric View**.
Execute the analysis and/or design. The equivalent menu command is **Solve/Execute**.
View results. The equivalent menu command is **Solve/Report**.
View loads. The equivalent menu command is **View/Loads**.
View internal forces within the whole system or a single span. The equivalent menu command is **View/Internal Forces**.
View moment capacity of the whole geometry or a single span. The equivalent menu command is **View/Moment Capacity**.
View shear capacity of the whole geometry or a single span. The equivalent menu command is **View/Shear Capacity**.
View deflection of the whole geometry or a single span. The equivalent menu command is **View/Deflection**.
View flexure reinforcement for beam strip, middle strips, and column strips. View shear reinforcement for beam strips. The equivalent menu command is **View/Reinforcement**.
Zoom in view window to magnify the system. The equivalent menu command is **View/Zoom/In(2x)**.
Zoom out view window to reduce the system. The equivalent menu command is **View/Zoom/Out(0.5x)**.
Zoom any part of a view window. The equivalent menu command is **View/Zoom/Window**.
Move the model in the screen plane. The equivalent menu command is **View/Pan**.
Restore a view window. The equivalent menu command is **View/Redraw**.
Chapter 4

Operating spSlab/spBeam

Working with Data Files (menu File)

Creating a New Data File

When you first load spSlab you will have a new file ready for input. The data will not have a filename associated with it, therefore, "spSlab1" will appear in the title bar. If a new data file is created after the "spSlab1", the new data file will be named as "spSlab2", and so on.

To start a new data file:

1. If you are already in the program and in an existing file, select NEW button □ or New menu command to clear your screen and return you to the default settings. If existing data has been changed prior to executing the New command, spSlab will ask if you would like to save the data.
2. After New is selected, Auto Input command in the Input menu may be used. This command guides you through the inputting process by automatically displaying all the dialog boxes necessary to design your floor system. You may cancel the auto input mode by selecting CANCEL button from any dialog box.
3. After you enter data through the Input menu, use the Save As command to give the file a name.

Opening Existing Data File

spSlab allows you to open data files that were saved at an earlier time including files from pcaSlab v1.5x/2.0x/2.5x or pcaBeam v1.5x/2.0x/2.5x. For ADOSS data files, see the next section.

To open an existing data file:

1. Select Open command from the File menu or click the OPEN button □ to bring in an existing spSlab data file. The dialog box of Figure 4-1 will be displayed. All the files with an .slb extension contained in the current drive and directory will be displayed in the list box. This dialog box also enables you to change the current drive and directory.

![Figure 4-1 Open dialog box](image)

2. Type in the name of the file you want to open. You may also select a file from the provided list with the mouse or using the keyboard by tabbing to the list and using the up and down arrow keys.
3. Press OPEN to exit the dialog box and allow spSlab to read the data. You may combine steps 2 and 3 of this procedure by double clicking the left mouse button over the desired file from the provided list.

Importing ADOSS and PCA-Beam Data File

spSlab and spBeam allow you to open ADOSS v6.0x/7.0x and PCA-Beam v1.0x data files that were saved at an earlier time.

To open an existing ADOSS or PCA-Beam data file:
1. Select **Open** command from the **File** menu or click the **Open** button. The dialog box of Figure 4-2 will be displayed. Select the type of the file you want to open and all files of the selected type contained in the current drive and directory will be displayed in the list box. This dialog box also enables you to change the current drive and directory.

![Figure 4-2 Importing ADOSS or PCA-Beam data file dialog box](image)

2. Type in the name of the file you want to open. You may also select a file from the provided list with the mouse or using the keyboard by tabbing to the list and using the up and down arrow keys.

3. Press **OPEN** to exit the dialog box and allow spSlab to read the data. You may combine steps 2 and 3 of this procedure by double clicking the left mouse button over the desired file from the provided list.

Note: The extension name of an ADOSS v6.0x/7.0x file is .ADS and the extension name of a PCA-Beam v1.01 file is .BMS. Both pcaSlab and pcaBeam v1.5x use files with the .SLB extension.

**Saving Data File**

To save your data with the same filename:

1. Select the **Save** command from the **File** menu or simply click the **SAVE** button. If the data has not been modified since the last save or **Save As** command was executed, this option will not be available. The file will be updated and the **Save** command and button will be shaded gray.

To give your data a new filename:

1. If you have not saved your data yet, select the **Save** or **Save As** command from the **File** menu. Either command will have the same effect. If you would like to save a data file that currently has a filename with a new filename, select the **Save As** command. The dialog box of Figure 4-3 will appear. When no filename has been given to the current data, the default filename is "spSlab1.slb", and it is highlighted in the edit box.

![Figure 4-3 Save As dialog box](image)

2. Type a new name to overwrite the current name.

3. Press **SAVE** to exit the dialog box and save the data into the filename specified.
**Most Recently Used Files (MRU)**

The Most Recently Used Files (MRU) list shows the four data files that were opened most recently. Selecting a data file from this list makes it easier and faster to open the file. The list is empty when the program is executed for the first time.

**Specifying Model Data (menu Input)**

**Data Input Wizard**

The Data Input Wizard is designed to make the inputting process easier. By selecting the Data Input Wizard from Input menu or selecting \(\sum\) from the tool bar, a logical sequence of dialog boxes will automatically be displayed allowing you to enter data for your floor system.

**Defining General Information**

The General Information command allows you to enter labels, design code, reinforcement database, run mode, and the frame information needed by spSlab to proceed with the input process. You must choose this command before doing any further inputting since this command affects the availability of the commands in the Input menu.

To enter general information:

1. Select the General Information command from the Input menu or click the \(\sum\) button from the tool bar. The dialog box of Figure 4-5 will appear.
2. Enter the project name, frame name, and engineer name in the Label frame box.
3. Select the building standard you want your floor system to be designed to (ACI 318-11, ACI 318M-11, ACI 318-08, ACI 318M-08, ACI 318-05, ACI 318M-05, ACI 318-02, ACI 318M-02, ACI 318-99, ACI 318M-99, CSA A23.3-04, CSA A23.3-04E, CSA A23.3-94, CSA A23.3-94E) from the Option frame box.

**Figure 4-5 General Information dialog box (a) two-way system (b) beam and one-way system**
4. Select the DESIGN or INVESTIGATION from the RUN MODE frame box.
5. In the FRAME box, enter the Number of supports of the frame. The default number of supports is 2. The minimum and maximum number of spans is 1 and 20 spans, respectively. Therefore the minimum number of supports is 2 and the maximum number of supports is 21.
6. Check the LEFT CANTILEVER and/or RIGHT CANTILEVER check boxes if left cantilever and/or right cantilever exist in the frame respectively.
7. In the FLOOR SYSTEM frame box, select TWO-WAY or BEAMS/ONE-WAY slab option.
8. Select NONE, LONGITUDINAL, or TRANSVERSE in SLAB BAND box if a two-way floor system is selected for the CSA A23.3-94 design code.
9. Check the DISTANCE LOCATION AS RATIO OF SPAN if the locations of loads need to be entered as a ratio of the length of a span.
10. Press Ok button to exit the dialog box and allow spSlab to use the new data. If using the Auto Input, click the NEXT button to the next dialog box.

**Defining Solve Option**

The Solve Options command allows you to select options and specify parameters that affect the analysis and design results. Please be advised that changing these settings involves engineering judgment and it has to be done cautiously. To take effect, this command must be used prior to the Execute command. The set of parameters is different for two-way and one-way systems.

**Two-way systems**

To specify solve options for two-way systems:

1. Enter the live load pattern ratio.
2. Check COMPRESSION REINFORCEMENT checkbox if it is to be considered when needed.
3. Check USER SLAB STRIP WIDTH to enable manual input of column strip width.
4. Check USER DISTRIBUTION FACTORS to enable manual input of moment distribution factors.
5. Check DECREMENTAL REINFORCEMENT DESIGN to use alternative reinforcement design algorithm.
6. Check COMBINED M-V-T REINF. DESIGN to proportion longitudinal reinforcement for combined action of flexure, shear, and torsion. This option is available only when CSA A23.3-04 is selected.
7. Check ONE-WAY SHEAR IN DROP PANELS to include drop panel cross-section in slab one-way shear capacity calculations in support locations.
8. Check DISTRIBUTE SHEAR TO SLAB STRIPS to distribute slab one-way shear between column and middle strips in proportion to moment distribution factors.
9. Check BEAM T-SECTION DESIGN to include portions of slab as flanges in beam cross-section for reinforcement design.
10. Check LONG. BM. SUPT. DESIGN to include cross-section of longitudinal beam in reinforcement design for unbalanced moments over supports. This feature can be useful for slabs having wide longitudinal beams. When used together with USER DISTRIBUTION FACTORS, it can produce solutions consistent with the solutions for models with longitudinal slab bands for CSA A23.3-04 code.
11. Check TRANS. BM. SUPT. DESIGN to include cross-section of transverse beam in reinforcement design for negative moments and unbalanced moments over supports. This feature is useful for slabs having wide transverse beams. When used together with USER DISTRIBUTION FACTORS, it can produce solutions consistent with the solutions for systems with transverse slab bands for CSA A23.3-04 code.
12. Enter the multiplier that defines the distance between a column face and a free edge of a slab, within which a segment of punching shear critical section is to be ignored.
13. Choose if GROSS (UNCRAKCED) or EFFECTIVE (CRACKED) sections are to be considered in the deflection calculations.
14. Choose if in the case of a section with flanges in the negative moment region, only the web (RECTANGULAR SECTION) or the whole section (T-SECTION) is to be used to calculate the gross moment of inertia (Ig) and the cracking moment.
15. Check **CALCULATE LONG-TERM DEFLECTIONS** checkbox if you want the program to calculate long-term deflections. Provide the duration of load in months and the percentage of the live load which is considered as sustained load.

**One way/beam systems**

To specify solve options for beams/one-way slab systems:

1. Enter the live load pattern ratio. The default value for beams/one-way slab systems is 100%.
2. Check **COMPRESSION REINFORCEMENT** checkbox if it is to be considered when needed.
3. Check **DECREMENTAL REINFORCEMENT DESIGN** to use alternative reinforcement design algorithm.
4. Check **COMBINED M-V-T REINF. DESIGN** to proportion longitudinal reinforcement for combined action of flexure, shear, and torsion. This option is available only when CSA A23.3-04 is selected.
5. Check **EFFECTIVE FLANGE WIDTH** if instead of the full flange width only the effective flange width is to be considered in the flexural design.
6. Check **RIGID BEAM-COLUMN JOINT** to consider beam-column joint as rigid.
7. Check **TORSION ANALYSIS AND DESIGN** if they are to be included in the solution. This option has to be checked for the **TORSION TYPE** and **STIRRUPS IN FLANGES** options to be enabled. Also torsional loads will only be available in the **TYPE** combo box of the **SPAN LOADS** dialog box if this option is checked.
8. Check **MOMENT REDISTRIBUTION** checkbox if it is to be considered in the analysis. This option has to be checked for the **MOMENT REDISTRIBUTION** tab to be available in the **SUPPORT DATA** dialog box.
9. If **TORSION ANALYSIS AND DESIGN** is checked then select if **EQUILIBRIUM** or **COMPATIBILITY** torsion is to be considered and if for sections with flanges **STIRRUPS IN FLANGES** can be considered.
10. Choose if **GROSS (UNCRAKED)** or **EFFECTIVE (CRACKED)** sections are to be considered in the deflection calculations.
11. Choose if in the case of a section with flanges in the negative moment region, only the web (**RECTANGULAR SECTION**) or the whole section (**T-SECTION**) is to be used to calculate the gross moment of inertia (Ig) and the cracking moment.
12. Check **CALCULATE LONG-TERM DEFLECTIONS** checkbox if you want the program to calculate long-term deflections. Provide the duration of load in months and the percentage of the live load which is considered as sustained load.

**Using Span Control**

The **Span Control** tab allows you to perform different operations on the spans that your system consists of. These operations include inserting new spans with default parameters, creating new spans by copying existing spans, moving spans to change span sequence, and deleting spans. The result of an operation depends on the
span selected as well as on the selected support. Spans can be selected using the Span Control List and columns using the Support Selection radio buttons.

Additionally before the Span Control window is closed all changes made to the spans can be revoked using the RESET ALL button. The RESTORE button can be used to bring back a span removed using the DELETE button. To insert a new span with default dimensions:

1. In the Span Control List select the span next to which you want to insert a new span.
2. Select whether the Left Support or the Right Support of the newly created span will be inserted.
3. Press INSERT BEFORE button to insert the new span left to the selected span or INSERT AFTER button to insert the new span on the right side of the currently selected span.

Examples of the insert operations are presented in Figure 4-8. Assuming that Span 2 is always selected the resulting systems will depend on whether INSERT AFTER or INSERT BEFORE was used and whether LEFT COLUMN or RIGHT COLUMN was selected. Newly inserted span and column are denoted with an “x”.

To copy a span:

1. In the Span Control List select the span you want to copy.
2. Select whether the Left Support or the Right Support of the copied span will be copied with the span.
3. Press INSERT BEFORE button to place the copied span left to the selected span or INSERT AFTER button to place the copied span on the right side of the currently selected span.

Examples of the insert operations are presented in Figure 4-9. Assuming that Span 2 is always selected the resulting systems will depend on whether COPY AFTER or COPY BEFORE was used and whether LEFT COLUMN or RIGHT COLUMN was selected. Newly created span and column are denoted with the prime sign.
Figure 4-8 Inserting a new span using Span Control

To move a span:
1. In the Span Control List select the span you want to move.
2. Select whether the Left Support or the Right Support of the moved span will be moved with the span.
3. Press Move Before button to move the span to the left or Move After button to move the span to the right side.

Figure 4-9 Copying a span using Span Control
Examples of the move operations are presented in Figure 4-10. Assuming that Span 2 is always selected the resulting systems will depend on whether MOVE AFTER or MOVE BEFORE was used and whether LEFT COLUMN or RIGHT COLUMN was selected.

![Figure 4-10 Moving a span using Span Control](image)

To delete a span:
1. In the SPAN CONTROL LIST select the span you want to delete.
2. Select whether the LEFT SUPPORT or the RIGHT SUPPORT of the deleted span will be removed with the span.
3. Press the DELETE button to delete the selected span.

Examples of the delete operations are presented in Figure 4-11. Assuming that Span 2 is always selected the resulting systems will depend on whether LEFT COLUMN or RIGHT COLUMN was selected.

![Figure 4-11 Deleting a span using Span Control](image)

**Defining Material Properties**

The Material Properties command from the Input menu allows you to input material properties of the concrete and the reinforcement. There are two tabs in this dialog box. One is for concrete and the other is for reinforcing steel. This command must be executed in order to perform a design of the floor system. Use the tab key to get to each edit box then type in your values, or use your mouse and click directly on the desired
tab and box, then type in your values. Refer to "Material Properties" for a detailed explanation of the default values.

To define material properties:

1. Select the **Material Properties** command from the **Input** menu or click the button on the tool bar. The dialog box of Figure 4-12 will appear.

![Concrete Properties dialog box](image)

**Figure 4-12 Concrete Properties dialog box**

2. Click the **Concrete** tab and enter the concrete density for the following members: Slabs, Beams, and Columns.

3. Enter the concrete compressive strength. By entering a value for the compressive strength, values for Young’s modulus and rupture modulus will automatically be computed for the slabs, beams, and columns. Young’s modulus and rupture modulus will automatically be shown in the corresponding text boxes.

4. If you have values for the rupture modulus, $f_r$, enter the values in the text boxes for the slabs, beams, and columns. Default values are computed based on $f'_c$. These values will be used for deflection analysis. A large value for the rupture modulus will produce a deflection analysis based on gross, non-cracked, sections. The CSA A23.3 standard requires\(^{196}\) that for the calculation of deflections half the value of rupture modulus be used. spSlab defaults to this value of the rupture modulus for the slab (both one-way and two-way) and beam concrete in CSA A23.3-04 design runs and for two-way slabs in CSA A23.3-94 design runs. For beams and one-way slabs per CSA A23.3-94, however, the full value of rupture modulus has to be used and the program will provide it as default in this case. It is strongly recommended, however, that the user verifies what value of $f_r$ is actually entered in the program since the default value can be inadvertently overwritten or carried over from a previous run.

5. If precast concrete is used, check **PRECAST CONCRETE** checkbox.

6. Click the **Reinforcing Steel** tab as shown in Figure 4-13.

![Reinforcing Steel Properties dialog box](image)

**Figure 4-13 Reinforcing Steel Properties dialog box**

\(^{196}\) CSA A23.3-04, 9.8.2.3; CSA A23.3-94, 13.3.6
7. Enter the yield stress of flexure steel.
8. Enter the yield stress of stirrups.
9. Enter the Young’s modulus for flexural steel and stirrups.
10. Select whether the main reinforcement is epoxy-coated by clicking the left mouse button on the box or tabbing to the box and pressing the SPACE BAR. This selection affects development lengths.
11. Press Ok button to exit the dialog box so that spSlab will use these material properties. If using the Auto Input, click the NEXT button to the next dialog box.

**Defining Slabs/Flanges**

The **Spans** command from the Input menu is available for all floor systems. Span numbers, which are determined from the number of supports entered in the General Information box, are automatically filled into the **Span** drop-down list in the **Span Data** dialog box.

To input slab geometry:

1. Select the **Spans** command from the Input menu or click the button on the tool bar. Click the left mouse button on the **Slabs** tab. The dialog box of Figure 4-14 will appear.
2. Select the number of the span, for which dimensions will be entered, from the **Span** drop-down list.
3. Select the span location from the **Location** drop-down list. Three types of locations are available: Interior, Exterior Left, and Exterior Right. The "left" and "right" are defined as you look along the direction of analysis. If a span has design strips on both sides it should be an "Interior" span. If a span has only a left design strip, it should be an "Exterior Right" span. If a span has only a right design strip, it should be an "Exterior Left" span.
4. Enter the slab thickness of the span.
5. Enter the span length from column centerline to column centerline or edge to column centerline for the two cantilever spans in the Length edit box. If the program detects a cantilever span length less than one-half the column dimension in the direction of analysis, an error message will pop up when the frame is analyzed. If a partial load is affected by the span length, a message warns the user of this condition.
6. Enter the span design width in the transverse direction of analysis on the left and right side of the column (see Figure 4-15). These distances are usually one-half the distance to the next transverse column or edge of the slab for exterior spans. The left and right designations are arbitrary. Both interior and exterior spans may be used in a design strip. An exterior width will automatically be designated by spSlab by entering a width value less than or equal to the transverse column dimension. Exterior sides do not contribute to the attached torsional stiffness, although they do contribute to loading. spSlab will use the total width entered for weight and superimposed loading but will use code allowed dimensions for flange width and stiffness computations.
7. Press the MODIFY button to update the slab geometry.
8. Repeat steps 2 through 7 until all the spans have been updated. You can use the COPY button as a shortcut.
9. Press OK button to exit the dialog box and allow spSlab to use the updated slab geometry.

**Defining Longitudinal Beams**

Longitudinal beam dimensions are required for the beam-supported slab. Span numbers, which are determined from the number of supports entered in the General Information box, are automatically filled into the **Span** drop-down list.

To input geometry for beam-supported slab system:

1. Select the **Spans** command from the **Input** menu or click the button on the tool bar. Click the left mouse button on the **Longitudinal Beams** tab. The dialog box of Figure 4-16 will appear.
2. Select the span number from the **Span** drop-down list.
3. Enter the width of the beam (Figure 4-17).
4. Enter the depth of the beam from the top of the slab (Figure 4-17).
5. Press the MODIFY button to update the longitudinal beam geometry.

6. Repeat steps 2 through 6 until all the beams have been updated. You can use the COPY button as a shortcut.
7. Press OK button to exit the dialog box so that spSlab will use the new beam geometry.
Defining Ribs

For joist systems, you must define the rib geometry. The ribs are assumed to be the same throughout the strip.

To enter rib geometry:

1. Select the **Spans** command from the **Input** menu or click the button on the tool bar. Click the left mouse button on the **Ribs** tab. The dialog box of Figure 4-18 will appear.

2. Select the span number from the **Span** drop-down list.
3. Enter the spacing between ribs at the bottom for clear rib spacing (see Figure 4-19).
4. Enter the width at the bottom for rib width (see Figure 4-19).
5. Enter the depth of the rib below the slab for Rib depth (see Figure 4-19).
6. Press OK button to exit the dialog box so that spSlab can use the rib geometry.

**Defining Longitudinal Bands**

The Longitudinal Bands property page (Figure 4-20) allows inputting the width and depth of longitudinal bands in each span. The procedure is identical to the described earlier input of dimensions of longitudinal beams. It is not required to input bands for every span. Spans where slab bands are not defined are modeled similar to regular two-way systems. Longitudinal slab bands can also be extended to adjacent spans using drop panels.

To input geometry for longitudinal slab band:

1. Select the Spans command from the Input menu or click the button on the tool bar. Click the left mouse button on the Longitudinal Bands tab. The dialog box of Figure 4-20 will appear.
2. Select the span number from the Span drop-down list.
3. Enter the width of the band.
4. Enter the depth of the band from the top of the slab.
5. Press the MODIFY button to update the longitudinal beam geometry.
6. Repeat steps 2 through 6 until all the slab bands have been updated. You can use the COPY button as a shortcut.
7. Press OK button to exit the dialog box so that spSlab will use the slab band geometry.

![Figure 4-20 Longitudinal Bands Geometry dialog box](image)

**User Defined Column Strip Widths**

User has the ability to manually adjust column strip widths if the two-way floor system option is selected in Solve Options. In this case the Slab/Flanges property page (Figure 4-21) will contain additional field for inputting column strip width. The values of middle and beam strip widths are recalculated internally.

To manually adjust column strip widths:

1. Enable check box User Slab Strip Width under Solve Options dialog window.
2. Follow the procedure described in section Defining Slabs/Flanges.
3. Enter additional values of column strip width for each span.
User Defined Moment Distribution Factors

User has the ability to manually adjust moment distribution factors if the two-way floor system option is selected in Solve Options. In such case the Moment Distribution property page (Figure 4-22) will become available under Span Data dialog window. This dialog contains fields for inputting distribution factors in column and beam strips. The distribution factors for middle strip are recalculated internally.

To input Moment Distribution Factors:

1. Enable check box User Distribution Factors under Solve Options dialog window.
2. Select the Spans command from the Input menu or click the button on the tool bar. Click the left mouse button on the Moment Distribution tab. The dialog box of Figure 4-22 will appear.
3. Select the number of the span, for which values will be entered, from the Span drop-down list.
4. Enter moment distribution values in edit boxes.
5. Press the MODIFY button to update the slab geometry.
6. Repeat steps 2 through 5 until all the spans have been updated. You can use the COPY button as a shortcut.
7. Press OK button to exit the dialog box and allow spSlab to use the updated information.

Figure 4-21 User Defined Column Strip Widths

Figure 4-22 User Defined Moment Distribution Factors
Defining Columns

Column data is optional. If no column is specified at the joints the joint is assumed hinged. You will be allowed to enter column dimensions above and below.

To input column/capital geometry:

1. Select the Supports command from the Input menu or click the button on the tool bar. The dialog box of Figure 4-23 will appear. Click on the Columns tab.

2. Enter stiffness share of the column which determines the percentage of the column stiffness used in the analysis. When the percentage lies between zero and 100%, the joint stiffness contribution by the column is multiplied by that percentage. Zero stiffness share indicates a pin support. Value of 999 indicates a support with fully fixed rotation. The default value is 100%, i.e. the actual column stiffness.

3. Enter the column height above, which is the distance from the top of the design floor to the top of the floor above (see Figure 4-23). spSlab obtains the clear column height above by subtracting the average slab depth from the height given. Only the slab is considered for the floor system above. A zero dimension for the column heights above and below will create a pin condition.

4. Enter the column height below, which is the distance from the design floor to the top of the floor below (see Figure 4-24). To obtain a clear column height below, the slab/drop/beam depth is subtracted from the height given. A zero dimension for the column heights above and below will create a pin condition.
5. Enter a value for c1, the column dimension in the direction of analysis (see Figure 4-24).
6. Enter a value for c2, the column dimension perpendicular to the direction of analysis (see Figure 4-24).
   Round columns are specified with a zero input for c2; c1 is then taken as the diameter.
7. Select whether spSlab should compute punching shear around column.
8. Select whether spSlab should compute increased value of $\gamma_f$ factor and corresponding decreased $\gamma_v$ factor (for ACI code only).
9. Press the MODIFY button to update the column geometry.
10. Repeat steps 2 through 9 until all the columns and capitals have been updated. You can use the COPY button as a shortcut.
11. Press OK button to exit the dialog box so that spSlab will use the new data.

**Defining Drop Panels**

Drops are available for the flat slab or waffle slab systems and can be defined at all the support locations. The drop length and width dimensions are computed by spSlab, based on slab span dimensions, when the "Standard" is selected in the Type drop-down list.

To input drop geometry:

1. Select the Supports command from the Input menu or click the button then click on the Drop Panels tab. The dialog box of Figure 4-25 will appear.
2. Select whether spSlab should compute the drop dimensions or the dimensions will be user specified. If spSlab is to compute the dimensions, the "Standard" option should be selected from the Type drop-down list and then only the drop depth will be available. When the "Standard drop" option is selected spSlab will calculate drop panel dimensions in accordance with ACI 318 Clause 13.3.7. Similar requirements contained in previous editions of the CSA A23.3 Standard have been removed from the 1994 edition. As a result, the ACI minimum specifications for drop panels are also used in CSA A23.3 runs when the "Standard Drops" option is selected. If you would like to specify drop dimensions other than those computed by spSlab, you must select "User-defined" from the Type drop-down list.

![Figure 4-25 Drop Panel Geometry dialog box](https://example.com/figure4-25.png)

3. Enter the dimension in the direction of analysis from the column centerline to the edge of the drop left of the column (see Figure 4-26). If this is a standard drop, this dimension will not be available and the length left is set equal to the slab span length left/6 for interior columns or the left cantilever length for the first column.
4. Enter the width dimension in the transverse direction (see Figure 4-26). If this is a standard drop, this dimension will not be available and the width is set equal to slab width/3.
5. In order for spSlab to recognize drops, drop depths are required for the flat slab systems even if Standard Drop is selected. Enter the depth of the drop from the span with the smaller slab depth (see Figure 4-26).
For waffle slab systems, the depth is automatically assumed to be equal to the rib depth below the slab and is not displayed. A value entered will be considered to exist below the rib depth during calculations.

6. Select whether spSlab should compute punching shear around drop panel.

7. Press the MODIFY button to update the drop geometry.

8. Repeat steps 2 through 6 until all the drop dimensions have been updated. You can use the COPY button as a shortcut.

9. Press OK button to exit the dialog box so that spSlab will use the new drop geometry.

---

**Defining Column Capitals**

To input column capital geometry:

1. Select the **Supports** command from the **Input** menu or click the button on the tool bar. Click left mouse button on the **Column Capitals** tab to activate it. The dialog box of Figure 4-27 will appear.
2. Select the support number from the Support drop-down list.
3. Enter the capital depth which is the distance from the bottom of the soffit (slab, drop, or beam), to the bottom of the capital.
4. Enter the capital side slope which is the rate of depth to extension of the capital and it must be greater than 1 and smaller than 50 (see Figure 4-28).

![Figure 4-28 Required Capital Dimensions](image)

**Defining Transverse Beams**

The Transverse Beam command allows you to input the width, depth, and offset (eccentricity) of transverse beams at each column. This command is optional.

To input transverse beam geometry:

1. Select the Support command from the Input menu. Select Transverse Beams tab from the Support Data dialog box. The dialog box of Figure 4-29 will appear.
2. Enter the width of the transverse beam (see Figure 4-30)
3. Enter the depth of the transverse beam which is taken from the top of the slab to the bottom of the beam (see Figure 4-30)
4. Enter the eccentricity, which is measured from the joint centerline, positive to the right, and negative to the left of the joint (See Figure 4-30).
5. Press the MODIFY button to update the transverse beam dimensions.
6. Repeat steps 2 through 5 until all the beams have been updated. You can use the COPY button as a shortcut (see "Entering the Structure Geometry" earlier in this chapter for help on the COPY button).

![Figure 4-29 Transverse Beam Geometry dialog box](image)
7. Press OK button to exit the dialog box so that spSlab will use the new beam geometry.

![Diagram of transverse beam dimensions](image)

*Figure 4-30 Required Transverse Beam Dimensions*

**Defining Transverse Bands**

The Transverse Bands property page (Figure 4-31) allows inputting the width, depth, and offset (eccentricity) of transverse bands at each column. It is not required to input bands for every support. Supports where slab bands are not defined are modeled similar to regular two-way systems.

![Transverse Band Geometry dialog box](image)

*Figure 4-31 Transverse Band Geometry dialog box*

To input transverse band geometry:

1. Select the **Support** command from the **Input** menu. Select **Transverse Bands** tab from the **Support Data** dialog box. The dialog box of Figure 4-31 will appear.
2. Enter the width of the transverse band (see Figure 4-31)
3. Enter the depth of the transverse band which is taken from the top of the slab to the bottom of the band (see Figure 4-31)
4. Enter the eccentricity, which is measured from the joint centerline, positive to the right, and negative to the left of the joint (See Figure 4-31).
5. Press the MODIFY button to update the transverse band dimensions.
6. Repeat steps 2 through 5 until all the beams have been updated. You can use the COPY button as a shortcut (see "Entering the Structure Geometry" earlier in this chapter for help on the COPY button).
7. Press OK button to exit the dialog box so that spSlab will use the new band geometry.
**Defining Boundary Conditions**

By default spSlab assumes that column-slab/beam joints can only rotate and that they do not undergo any translational displacements. Rotation of a joint is affected by the stiffness of elements it connects i.e. slabs/beams, transverse beams, and columns. Columns are assumed by default to be fixed at their far ends as shown in Figure 2-6. These default assumptions can be altered using the **Boundary Conditions** command.

![Figure 4-32 Boundary Conditions dialog box](image)

By specifying vertical spring support constant with $K_z$ value other than 0, you can allow the joint to displace vertically. This movement is then controlled by the stiffness of the spring $K_z$ in addition to the stiffness of the column below. The column above is assumed not to constrain the vertical movement of the joint. Additional rotational spring support can be applied to the joint by specifying the value of $K_{ry}$. Also the far end column conditions can be selected as either fixed or pinned as shown in Figure 4-33 (b). All elements controlling the displacements of a joint are shown in Figure 4-33 (a).

![Figure 4-33 (a) Elements controlling joint displacement (b) Far End Column Boundary Conditions](image)

To input boundary conditions:

1. Select the **Support** command from the **Input** menu. Select **Boundary Conditions** tab from the **Support Data** dialog box. The dialog box of Figure 4-32 will appear.

2. Select support number

3. Enter value of $K_z$ to allow vertical displacement of the support and to add translational spring support (see Figure 4-33 (a))

4. Enter value of $K_{ry}$ to add rotational spring support (see Figure 4-33 (a))

5. Select far end support conditions for the column above and below the joint (see Figure 4-33 (b))

6. Press the **MODIFY** button to update the boundary conditions.

7. Repeat steps 2 through 5 until all the joints have been updated. You can use the **COPY** button as a shortcut (see "Entering the Structure Geometry" earlier in this chapter for help on the **COPY** button).

8. Press **OK** button to exit the dialog box so that the program will use the new boundary conditions.
Defining Moment Redistribution Factors

This command is only available for beams/one-way slab systems when MOMENT REDISTRIBUTION option is checked in the General Information dialog box.

To input moment redistribution factors:

1. Select the Support command from the Input menu. Select Moment Redistribution tab from the Support Data dialog box. The dialog box of Figure 4-34 will appear.
2. Select support number
3. Enter the maximum value of the redistribution factors you want to allow on the left and the right side of the support. Please note that actual value used is determined by the program when the problem is being solved and that the check against the code specified limit is also performed.
4. Press the MODIFY button to update the redistribution factor limits.
5. Repeat steps 2 through 5 until all the supports have been updated. Please note that supports connecting to cantilevers will not be available since moment redistribution is not allowed there. You can use the COPY button as a shortcut (see "Entering the Structure Geometry" earlier in this chapter for help on the COPY button).
6. Press OK button to exit the dialog box so that spSlab will use the new moment redistribution limits.

![Figure 4-34 Moment Redistribution dialog box](image)

Defining Reinforcement Criteria for Slabs and Ribs

In order for spSlab to select the reinforcement, you must define the slab and rib reinforcement, bar sizes, location, and minimum spacing dimensions. See "Area of Reinforcement" and "Reinforcement Selection" in Method of Solution for a discussion of the reinforcement computations.

To define reinforcement Criteria for Slabs and Ribs:

1. Select the Reinforcement Criteria command from the Input menu or click the button on the tool bar. Select Slabs and Ribs tab by clicking the left mouse button on the tab title. The dialog boxes of Figure 4-35 will appear.
2. For slabs and ribs, enter the clear covers for top and bottom reinforcing bars. For the top reinforcement, this distance is from the top of the slab to the top of the top bars. For the bottom reinforcement, this distance is from the bottom of the slab to the bottom of the bottom bars (see Figure 4-36). The default value is 1.5 in. [40mm] for both input items.
3. Enter the minimum bar size to start the iteration for determining flexural reinforcement.
4. Enter the maximum bar size. This number will be used as a stop in the iteration for determining flexural bars in beams.
Figure 4-35 Slab and Rib Reinforcement dialog boxes

5. Enter minimum bar spacing for slab and rib flexural reinforcement. This number should be based on aggregate size or detailing considerations. Default spacing is 6 in. [150mm] for slabs and ribs.

6. Enter maximum bar spacing for slab and rib flexural reinforcement. Default spacing is 18 in. [500 mm] for slabs and ribs.

7. Enter minimum Reinforcement Ratio for slab and rib flexural reinforcement. Default ratio is 0.14% [0.20%] for slabs and ribs. If the user specified value is smaller than 0.14%, 0.14% is used by spSlab. If the user specified value is greater than 0.14%, the specified value is used by spSlab.

8. Enter maximum Reinforcement Ratio for slab and rib flexural reinforcement. Default ratio is 5% for slabs and ribs.

9. If the top bars have more than 12 in. [300 mm] of concrete below them, check the corresponding check box.

10. Press Ok button to exit the dialog box and allow spSlab to use the new data.

Defining Reinforcement Criteria for Beams

In order for spSlab to select the reinforcement, you must define the beam reinforcement, bar sizes, location, and minimum spacing dimensions. See "Area of Reinforcement" and "Reinforcement Selection" in the Method of Solution for a discussion of the reinforcement computations.

To define reinforcement criteria for beams:

1. Select the Reinforcement Criteria command from the Input menu or click the \( \text{\textcopyright} \) button on the tool bar. Select Beams tab by clicking the left mouse button on the tab title. The dialog boxes of Figure 4-37 will appear.

2. Enter the covers for top and bottom reinforcing bars for beams. For the top reinforcement, this distance is from the top of the beam to the top of the top bars; and for the bottom reinforcement, this distance is from the bottom of the beam to the bottom of the bottom bars (see Figure 4-38). The default value is 1.5 in. [40mm] for both input items.
3. Enter the side cover which is measured from the side face of a beam to the face of the stirrup (see Figure 2-20). The default value is 1.5 in [40 mm].

4. Enter the minimum bar size for top and bottom bars and stirrups to start the iteration for determining flexural reinforcement.

5. Enter the maximum bar size for top and bottom bars and stirrups. This number will be used as a stop in the iteration for determining flexural bars in beams.

6. Enter the minimum bar spacing for beam flexural reinforcement and stirrups. This number should be based on aggregate size or detailing considerations. The default minimum reinforcement bar spacing is 1 in. [25 mm] and the default stirrup spacing is 6 in. [150 mm]

7. Enter the maximum bar spacing for beam flexural reinforcement and stirrups. The default maximum reinforcement spacing is 18 in. [500 mm] and the default maximum stirrup spacing is 18 in. [450 mm]

8. Enter the minimum Reinforcement Ratio for beam flexural reinforcement. Default ratio is 0.14% [0.20%] for beams. If the user specified value is smaller than 0.14%, 0.14% is used by spSlab. If the user specified value is greater than 0.14%, the specified value is used by spSlab.

9. Enter the maximum Reinforcement Ratio for beam flexural reinforcement. Default ratio is 5% for beams.

10. Enter the clear distance between bar layers to use if the program needs to distribute flexural bars in multiple layers. Default distance is 1 in. [30 mm] for beams.

11. Enter the distance from face of support (FOS) to first stirrup. The default value is 3.0 in [75 mm].

12. If the top bars have more than 12 in. [300 mm] of concrete below them, check the corresponding check box.

13. Press OK button to exit the dialog box and allow spSlab to use the new data.
Defining Column Strip Bars for Two-Way Slab Systems

The reinforcing bar size, number of bars, bar length, etc. can be defined by users if the Run Mode of Investigation and two-way floor system are selected in the General Information dialog box. This menu item is not available if Run Mode of Design is selected in the General Information dialog box.

To define column strip bars:

1. Select Reinforcing Bars from the Input menu or click the button on the tool bar. Select the Column Strip Bars tab by clicking the tab title or use the tab key on the keyboard to toggle to the tab title then select the Column Strip Bars tab using the arrow keys. The dialog boxes of Figure 4-39 will appear.

![Figure 4-39 Defining Column Strip Bars](image)

2. Select the span for which reinforcing bars will be defined from the Span list box on the upper left corner. The length of the selected span will be shown right above the ADD button.

3. Select bar size from the Bar Size drop-down list.

4. Define the number of reinforcing bars in the selected span by entering the number in the Number of Bars input box.

5. Define the length of the reinforcing bars by entering the length in the Length input box. The unit of the length is foot [m].

6. Define the types of the reinforcing bars in the selected span by selecting from the Type drop-down list, which is right below the Bar Size drop-down list. Five types are available: Top Left, Top Right, Top Continuous, Bottom Continuous and Bottom Discontinuous.

7. Define the cover by entering the number in the Cover input box. The unit of cover is inch [mm].

8. Press ADD button to add the new data into the list box below the buttons.

9. Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use the SPAN COPY button below the Span list to simply copy the data of one span to other spans.

10. If the reinforcing data of a span needs to be modified, select the data from the data list box on the lower part of the dialog box then modify the data as mentioned above. Press MODIFY button when finished to update the corresponding data in the data list box.

11. To delete the reinforcing data for a span, select the data of the span from the data list box then press the DELETE button.

12. Press OK button to exit the dialog box so that spSlab will use these reinforcing bar properties.

Defining Middle Strip Bars for Two-Way Slab Systems

The reinforcing bar size, number of bars, bar length, etc., can be defined by users if the Run Mode of Investigation and two-way floor system are selected in the General Information dialog box. This menu item is not available if Run Mode of Design is selected in the General Information dialog box.

To define middle strip bars:
1. Select **Reinforcing Bars** from the **Input** menu or click the 📨 button on the tool bar. Select the **Middle Strip Bars** tab by clicking the tab title or use the tab key on the keyboard to toggle to the tab title then select the **Middle Strip Bars** tab using the arrow keys. The dialog boxes of Figure 4-40 will appear.

![Figure 4-40 Defining Middle Strip Bars](image)

2. Select the span for which reinforcing bars will be defined from the Span list box on the upper left corner. The length of the selected span will be shown right above the ADD button.

3. Select bar size from the **Bar Size** drop-down list.

4. Define the number of reinforcing bars in the selected span by entering the number in the Number of Bars input box.

5. Define the length of the reinforcing bars by entering the length in the Length input box. The unit of the length is foot [m].

6. Define the Types of the reinforcing bars in the selected span by selecting from the drop-down list, which is right below the **Bar Size** drop-down list. Five types are available: Top Left, Top Right, Top Continuous, Bottom Continuous and Bottom Discontinuous.

7. Define the cover by entering the number in the Cover input box. The unit of cover is inch [mm].

8. Press ADD button to add the new data into the list box below the buttons.

9. Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use the **SPAN COPY** button below the Span list to simply copy the data of one span to other spans.

10. If the reinforcing data of a span needs to be modified, select the data from the data list box on the lower part of the dialog box then modify the data as mentioned above. Press **MODIFY** button when finished to update the corresponding data in the data list.

11. To delete the reinforcing data for a span, select the data of the span from the data list box then press the **DELETE** button.

12. Press **OK** button to exit the dialog box so that spSlab will use these reinforcing bar properties.

**Defining Beam Bars for Two-Way Slab Systems**

The reinforcing bar size, number of bars, bar length, etc. can be defined by users if the Run Mode of Investigation and two-way floor system are selected in the **General Information** dialog box. This menu item is not available if **Run Mode** of **Design** is selected in the **General Information** dialog box.

To define beam bars:

1. Select **Reinforcing Bars** from the **Input** menu or click the 📨 button from the tool bar. Select the **Beam Bars** tab by clicking the tab title or use the tab key on the keyboard to toggle to the tab title then select the **Beam Bars** tab using the arrow keys. The dialog boxes of Figure 4-41 will appear.
2. Select the span for which reinforcing bars will be defined from the Span list box on the upper left corner. The length of the selected span will be shown right above the ADD button.

3. Select bar size from the Bar Size drop-down list.

4. Define the number of reinforcing bars in the selected span by entering the number in the Number of Bars input box.

5. Define the length of the reinforcing bars by entering the length in the Length input box. The unit of the length is foot [m].

6. Define the types of the reinforcing bars in the selected span by selecting from the Type drop-down list, which is right below the Bar Size drop-down list. Five types are available: Top Left, Top Right, Top Continuous, Bottom Continuous and Bottom Discontinuous.

7. Define the cover by entering the number in the Cover input box. The unit of cover is inch [mm].

8. Press ADD button to add the new data into the list box below the buttons.

9. Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use the SPAN COPY button below the Span list to simply copy the data of one span to other spans.

10. If the reinforcing data of a span needs to be modified, select the data from the data list box on the lower part of the dialog box then modify the data as mentioned above. Press MODIFY button when finished to update the corresponding data in the data list.

11. To delete the reinforcing data for a span, select the data of the span from the data list box then press the DELETE button.

12. Press OK button to exit the dialog box so that spSlab will use these reinforcing bar properties.

**Defining Beam Stirrups for Two-Way Slab Systems**

The stirrup size, number of stirrups, etc. can be defined by users if the Run Mode of Investigation and two-way floor system are selected in the General Information dialog box. This menu item is not available if Run Mode of Design is selected in the General Information dialog box.

To define beam stirrups:

1. Select Reinforcing Bars from the Input menu or click the button from the tool bar. Select the Beam Stirrups tab by clicking the tab title or use the tab key on the keyboard to toggle to the tab title then select the Beam Stirrups tab using the arrow keys. The dialog boxes of Figure 4-42 will appear.
2. Select the span for which stirrups will be defined from the Span list box on the upper left corner. The length of the selected span will be shown right above the ADD button.

3. Enter the amount of stirrups of the selected span in the Count input box. (see Note)

4. Select stirrup size from the Size drop-down list.

5. Enter the spacing of the stirrups of the selected span in the Spacing input box. The unit of spacing is inch [mm].

6. Enter the number of legs in the Leg input box.

7. For first stirrup set modify the default location of first stirrup if required.

8. Press ADD button to add the new data into the list box below the buttons.

9. Repeat steps 2 to 8 to define stirrups for all the spans. You may use the Span COPY button below the Span list to simply copy the data of one span to other spans.

10. In order to mirror stirrup set or sets at the end of the span use APPEND button.

11. If the stirrup data of a span needs to be modified, select the data from the data list box on the lower part of the dialog box then modify the data as mentioned above. Press MODIFY button when finished to update the corresponding data in the data list.

12. To delete the stirrup data for a span, select the data of the span from the data list box then press the DELETE button.

13. Press OK button to exit the dialog box so that spSlab will use these reinforcing bar properties.

Note: If stirrups do not apply in a part of a span, the Count should be set to 0 (zero) and the Spacing should be the length of the part of the span where no stirrups are defined. For example, the following configuration shows stirrups in the left and right ends of a span with an empty space (46.0 in. long, no stirrups) in the middle part of the span.

<table>
<thead>
<tr>
<th>Count</th>
<th>Bar Size</th>
<th>Spacing</th>
<th>Legs</th>
</tr>
</thead>
<tbody>
<tr>
<td>32</td>
<td>#5</td>
<td>4.50</td>
<td>2</td>
</tr>
<tr>
<td>0</td>
<td>#5</td>
<td>46.0</td>
<td>2</td>
</tr>
<tr>
<td>32</td>
<td>#5</td>
<td>4.50</td>
<td>2</td>
</tr>
</tbody>
</table>

**Defining Flexure Bars for Beams and One-Way Slab Systems**

The reinforcing bar size, number of bars, bar length, etc. for one-way beam systems can be defined by users if the Run Mode of Investigation and beams/one-way slab floor system are selected in the General Information dialog box. This menu item is not available if Run Mode of Design is selected in the General Information dialog box.
Defining Flexure Bars for Beams/One-Way Slab Systems

To define flexure bars for beams in beams/one-way slab systems follow the steps described in section Defining Beam Bars.

Defining Stirrups for Beams and One-Way Slab Systems

The stirrup size, number of stirrups, etc. for beams/one-way slab systems can be defined by users if the Run Mode of Investigation and beams/one-way slab floor system are selected in the General Information dialog box. This menu item is not available if Run Mode of Design is selected in the General Information dialog box.

Defining Torsional Longitudinal Bars for Beams

The torsional longitudinal reinforcement bars are distributed along the perimeter of the section in addition to the flexure bars. They can be defined by users if the Run Mode of Investigation, beams/one-way slab floor system, and torsional analysis and design are selected in the General Information dialog box. This menu item is not available if Run Mode of Design is selected in the General Information dialog box.

To define torsional longitudinal bars for beams in beams/one-way slab systems:
1. Select Reinforcing Bars from the Input menu or click the button from the tool bar. Select the Torsion Bars tab by clicking the tab title or use the tab key on the keyboard to toggle to the tab title then select the Torsion Bars tab using the arrow keys. The dialog boxes of Figure 4-45 will appear.

![Figure 4-45 Defining Torsion Bars for Beams in Beams/One-Way Slab Systems](image)

2. Select the span for which reinforcing bars will be defined from the Span list box on the upper left corner. The length of the selected span will be shown right above the ADD button.

3. Select bar size from the Bar Size drop-down list.

4. Define the type of the reinforcing bars in the selected span by selecting from the Type drop-down list, which is right below the Bar Size drop-down list. Two types are available: Continuous and Discontinuous.

5. Define the number of reinforcing bars in the selected span by entering the number in the Number of Bars input box.

6. Define the cover by entering the number in the Cover input box. The unit of cover is inch [mm].

7. For discontinued bars, define the length and the starting point of the reinforcing bars by entering the values in the Start and Length input boxes. The unit of both is foot [m].

8. Press ADD button to add the new data into the list box below the buttons.

9. Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use the SPAN COPY button below the Span list to simply copy the data of one span to other spans.

10. If the reinforcing data of a span needs to be modified, select the data from the data list box on the lower part of the dialog box then modify the data as mentioned above. Press MODIFY button when finished to update the corresponding data in the data list.

11. To delete the reinforcing data for a span, select the data of the span from the data list box then press the DELETE button.

12. Press OK button to exit the dialog box so that spSlab will use these reinforcing bar properties.

**Defining Load Cases**

Up to 6 load cases of dead load, live load or lateral load can be defined in the Load Cases dialog box. The default five load case labels (types) are SELF (dead load), Dead (dead load), Live (live load), Wind (wind load), and EQ (seismic load).

To define load cases:

1. Select Load Cases command from the Input menu or click the button on the tool bar. Dialog box as in Figure 4-46 will appear.

2. Enter a name for the new load case in the Label edit box. The name could be any character string defined by the user.
3. Select the type of the new load case from the **Type** drop-down list. The available types are Dead Load, Live Load and Lateral Load.

![Figure 4-46 Defining Load Cases](image)

4. Press ADD button to add the new load case into the load case list box on the lower part of the dialog box.

5. Repeat steps 2 to 4 to define all the load cases. The maximum number of load cases is 6. Once the maximum number is reached, the ADD button will be disabled.

6. To enter reserved load case SELF press the SELFWEIGHT button.

7. To modify an existing load case, select the load case from the load case list box then change the label or type the selected load case as mentioned above and press the MODIFY button.

8. To delete an existing load case, select the load case from the load case list box then press the DELETE button.

9. Press OK button to exit the dialog box so that spSlab will use these load cases.

   Note: Only one case of live load can be defined. Load case label must be unique for each of the load cases. To ignore self weight in both strength and deflection calculations remove load case SELF from the list of load cases.

**Defining Load Combinations**

spSlab allows you to change the magnification factors applied to the load cases. The default values depend on the code selected with the General Information command.

To define load factors:

1. Select **Load Combinations** from the **Input** menu or click the ![button](image) from the tool bar. The dialog box of Figure 4-47 will appear if the ACI code was selected in the **GENERAL INFORMATION** dialog box.

![Figure 4-47 Define Load Combinations](image)
2. The load cases and the corresponding factors that are defined in the Load Cases dialog box are shown on the top of the Load Combinations dialog box.

3. Enter the load factors for each of the load cases in the input box below the corresponding load case label.

4. Press the Add button to add the combination defined above into the big list box in the lower part of the dialog box.

5. Repeat steps 2 to 4 to define all the load combinations. Up to fifty load combinations may be defined. All the combinations are indexed automatically from U1 to U50.

6. To change the factors of an existing combination, select the load combination from the load combination list box on the lower part of the dialog box then change the factors as mentioned above. Press the Modify button when finished to update the data in the load combination list box.

7. To delete an existing combination, select the load combination from the load combination list box then press the Delete button.

8. Select OK button when all the desired load factors have been modified to exit so that spSlab will use the new data.

**Span Loads**

spSlab computes the self weight of the floor system. Other loads applied to the structure have to be specified by the user. There are several types of applied loads that may be entered. They are found in the Input menu. Surface loads are placed over the entire strip. Partial loads consist of uniform or trapezoidal loads, concentrated loads, and concentrated moments that may exist anywhere within the span length. For beams/one-way slab systems torsional loads can be defined either as concentrated or distributed torques.

![Figure 4-48 Span Load Types](image)

**Note:** The loads shown in the Figure 4-48 are all positive and may not match the typical sign conventions.

The following table describes input for the span load types shown in Figure 4-48.

<table>
<thead>
<tr>
<th>Load Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$W_a$</td>
<td>For uniformly distributed loads, $W_a$ is the intensity of the load in units of lbs/ft [kN/m], positive $W_a$ is downward. For trapezoidal loads, $W_a$ is the intensity at the left end in units of lbs/ft [kN/m], positive $W_a$ is downward. For concentrated force, $W_a$ is the force $P$ in units of kips [kN], positive $W_a$ is downward. For concentrated moments, $W_a$ is the moment $M$ in units of ft-kips [kNm], positive $W_a$ is clockwise. For concentrated torque, $W_a$ is the external torque $T$ in units of ft-kips [kNm], positive $W_a$ is such that applying the right hand screw rule the torque vector points to the right. For distributed torque, $W_a$ is the external torque intensity $T_a$ in units of ft-kips/ft [kNm/m], positive $W_a$ is such that applying the right hand screw rule the torque vector points to the right.</td>
</tr>
<tr>
<td>$W_b$</td>
<td>For trapezoidal loads, $W_b$ is the intensity at the right end in units of lbs/ft [kN/m], positive $W_b$ is downward. For</td>
</tr>
</tbody>
</table>
### Defining Area Load on Span

Area loads are uniform loads acting over the entire strip. These loads have units of lb/ft² [kN/m²].

To input area loads:

1. Select the **Span Loads** command from the **Input** menu or click the button on the tool bar. Select the **AREA LOAD** from the **TYPE** drop-down list on the **SPAN LOADS** dialog box. The dialog box of Figure 4-49 will appear.

![Figure 4-49 Defining Area Load on Span](image)

2. Select the load case from the **CURRENT CASE** list box on the upper left corner as shown in the dialog above.
3. Select the span on which the area loads will be applied from the **SPAN** drop-down list.
4. Enter the unfactored superimposed area load magnitude acting over the entire area of the strip in the **Magnitude** edit box. Positive surface loads act downward.
5. Press the **ADD** button to update the area loads in the area load list box on the lower part of the dialog box.
6. Repeat steps 2 through 5 until the loads have been updated. You can use the **COPY** button as a shortcut.
7. To change the data of an existing area load, select the area load from the area load list box then change the magnitude as mentioned above. Press the **MODIFY** button when finished to update the data in the area load list box.

---

| \( W_b \) | The distributed torque, \( W_b \) is the external torque intensity \( T_b \) in units of ft-kips/ft \([\text{kNm/m}]\), positive \( W_b \) is such that applying the right hand screw rule the torque vector points to the right. For all the other partial load types, \( W_b \) is not available.
| --- | --- |
| \( L_a \) | For distributed loads, \( L_a \) is the distance where the load begins from the centerline of the column at the left of the span, in units of ft \([\text{m}]\). For concentrated loads and moments, \( L_a \) is the distance where the load exists from the centerline of the column at the left of the span in units of ft \([\text{m}]\).
| \( L_b \) | For distributed loads, \( L_b \) is the distance where the load ends from the centerline of the column at the left of the span, in units of ft \([\text{m}]\). For concentrated loads and moments, \( L_b \) is unavailable. Note: Although the particular loading may not actually act over the entire transverse width, all line loading is converted internally by spSlab to act over the full width of the slab. In the design direction, partial loads given as acting over less than 1/20 of the span length will be averaged over 1/20 by the program.
8. To delete an existing area load, select the load from the area load list box then press the DELETE button.
9. Press OK button to exit the dialog box so that spSlab will use the new data.

**Defining Line Load on Span**

You may enter uniform or trapezoidal loads that do not span from column centerline to column centerline in the direction of analysis. These loads are called line loads and are input through the SPAN LOADS dialog of the Input menu. Partial loads are assumed to act over the entire strip width.

To input line loads:
1. Select the Span Loads command from the Input menu or click the button on the tool bar. Select the LINE LOAD from the TYPE drop-down list. The dialog box of Figure 4-50 will appear.
2. Select the load case of the line load that will be defined from the Current Case list box.
3. From the Span drop-down list, select the span number of the span whose line loads you would like to input.
4. Define unfactored load values and their locations in the corresponding text boxes.

![Figure 4-50 Defining Line Load on Span](image)

5. Select Add to add the line load defined into the line load list box.
6. Repeat steps 2 through 5 until all the line loads have been entered then press OK button to exit the dialog box so that spSlab will use the new loads.

To change line loads data:
1. Select the line load you want to change from the line load list box on the lower part of the dialog box by clicking the left mouse button on the load or tabbing to the list box and using the arrow up and down keys.
2. Make your changes to the load by modifying the load type, the load magnitude, and/or location.
3. Select Modify to replace the old data with the new data.

To delete line load data:
1. Select the line load you want to delete from the line load list box by clicking the left mouse button on the load or tabbing to the list box and using the arrow up and down keys.
2. Press the DELETE button.

**Defining Point Force on Span**

You may enter concentrated vertical loads. These loads are input through the Span Load command of the Input menu. Point loads are assumed to act over the entire strip width.

To input point loads:
1. Select the Span Loads command from the Input menu or click the button on the tool bar. Select the Point Force from the Type drop-down list. The dialog box of Figure 4-51 will appear.
Figure 4-51 Defining Point Forces on Span

2. Select the load case of the point force that will be defined from the Current Case list box.
3. From the Span drop-down list, select the span number of the span whose point loads you would like to input.
4. Define unfactored load values and their locations in the corresponding text boxes.
5. Select Add to add the point load defined into the point load list box on the lower part of the dialog box.
6. Repeat steps 2 through 5 until all the point loads have been entered then press OK button to exit the dialog box so that spSlab will use the new loads.

To change point load data:
1. Select the point force you want to change from the point load list box by clicking the left mouse button on the load or tabbing to the list box and using the arrow up and down keys.
2. Make your changes to the load by modifying the load type, the load magnitude, and/or location.
3. Select Modify to replace the old data with the new data.

To delete point load data:
1. Select the point force you want to delete from the point load list box to the right by clicking the left mouse button on the load or tabbing to the list box and using the arrow up and down keys.
2. Press the DELETE button.

Defining Point Moment on Span

You may enter concentrated moment. This load is input through the Span Load command of the Input menu. Point moments are assumed to act over the entire strip width.

To input point moments:
1. Select the Span Loads command from the Input menu or click the button on the tool bar. Select the Point Moment from the Type drop-down list. The dialog box of Figure 4-52 will appear.
2. Select the load case of the point moment that will be defined from the Current Case list box.
3. From the Span drop-down list, select the span number of the span whose point moments you would like to input.
4. Define unfactored moment values and their locations in the corresponding text boxes.
5. Select Add to add the point moment defined into the point moment list box on the lower part of the dialog box.
6. Repeat steps 2 through 5 until all the point moments have been entered then press OK button to exit the dialog box so that spSlab will use the new moments.
Figure 4-52 Defining Point Moments on Span

To change point load data:
1. Select the point moment you want to change from the point moment list box by clicking the left mouse button on the load or tabbing to the list box and using the arrow up and down keys.
2. Make your changes to the moment by modifying the moment type, the moment magnitude, and/or location.
3. Select Modify to replace the old data with the new data.

To delete point load data:
1. Select the point moment you want to delete from the point moment list box to the right by clicking the left mouse button on the load or tabbing to the list box and using the arrow up and down keys.
2. Press the DELETE button.

**Defining Line Torque on Span**

You may enter line torque for beams/one-way slab systems if Torsion Analysis and Design is selected in the GENERAL INFORMATION dialog box. This load is input through the Span Load command of the Input menu.

To input line loads:
1. Select the Span Loads command from the Input menu or click the button on the tool bar. Select the LINE TORQUE from the TYPE drop-down list. The dialog box of Figure 4-53 will appear.
2. Select the load case of the line load that will be defined from the CURRENT CASE list box.
3. From the Span drop-down list, select the span number of the span whose line loads you would like to input.
4. Define unfactored torque values and their locations in the corresponding text boxes.
5. Select **Add** to add the line torque defined into the list box.
6. Repeat steps 2 through 5 until all the line torques have been entered. Then press **OK** button to exit the dialog box so that spSlab will use the new loads.

To change line torque data:
1. Select the line torque you want to change from the load list box on the lower part of the dialog box by clicking the left mouse button on the load or tabbing to the list box and using the arrow up and down keys.
2. Make your changes to the load by modifying the load type, the load magnitude, and/or location.
3. Select **Modify** to replace the old data with the new data.

To delete line torque data:
1. Select the line torque you want to delete from the load list box by clicking the left mouse button on the load or tabbing to the list box and using the arrow up and down keys.
2. Press the **DELETE** button.

**Defining Point Torque on Span**

You may enter point torque for beams/one-way slab systems if Torsion Analysis and Design is selected in the **GENERAL INFORMATION** dialog box. This load is input through the **Span Load** command of the **Input** menu.

To input point torque:
1. Select the **Span Loads** command from the **Input** menu or click the **** button on the tool bar. Select the **POINT TORQUE** from the **TYPE** drop-down list. The dialog box of Figure 4-54 will appear.
2. Select the load case of the point torque that will be defined from the **CURRENT CASE** list box.
3. From the **SPAN** drop-down list, select the span number of the span whose point moments you would like to input.
4. Define unfactored torque values and their locations in the corresponding text boxes.
5. Select **ADD** to add the point torque defined into the list box on the lower part of the dialog box.
6. Repeat steps 2 through 5 until all the point torques have been entered. Then press **OK** button to exit the dialog box so that spSlab will use the new torques.

![Figure 4-54 Defining Point Torque on Span](image)

To change point torque data:
1. Select the point torque you want to change from the list box by clicking the left mouse button on the load or tabbing to the list box and using the arrow up and down keys.
2. Make your changes to the moment by modifying the torque magnitude, and/or location.
3. Select **MODIFY** to replace the old data with the new data.

To delete point torque data:
1. Select the point moment you want to delete from the point moment list box by clicking the left mouse button on the load or tabbing to the list box and using the arrow up and down keys.
2. Press the DELETE button.

**Defining Support Loads and Displacements**

You may enter prescribed support displacements and rotations as well as apply concentrated forces and moments to the system at support locations. These loads are input through the **Support Loads and Displacements** command of the **Input** menu.

To input support loads and displacements:

1. Select the **Support Loads and Displacements** command from the **Input** menu or click the button on the tool bar. The dialog box of Figure 4-55 will appear.

![Figure 4-55 Defining Support Loads and Displacements](image)

2. Select the load case of the support loads and displacements that will be defined from the **CURRENT CASE** list box.
3. From the **SUPPORT** drop-down list, select the support number of the support whose loads you would like to input.
4. Define unfactored values of the displacement, rotation, forces, and moment.
5. Select **Add** to add the support loads and displacements defined into the load list box on the lower part of the dialog box.
6. Repeat steps 2 through 5 until all the support loads and displacements have been entered then press OK button to exit the dialog box so that spSlab will use the new moments.

To change support and displacement loads data:

1. Select the entry you want to change from the load list box by clicking the left mouse button on the load or tabbing to the list box and using the arrow up and down keys.
2. Make your changes to the values.
3. Select **Modify** to replace the old data with the new data.

To delete support and displacement load data:

1. Select the entry you want to delete from the load list box by clicking the left mouse button on the load or tabbing to the list box and using the arrow up and down keys.
2. Press the DELETE button.

**Defining Lateral Effects**

spSlab can combine the gravity load analysis with a lateral load analysis. Lateral loads are entered as joint moments obtained elsewhere by a frame analysis. The joint moments are combined with the gravity load moments to produce load patterns 5 through 8.
To input lateral load moments:

1. Define at least one lateral load case from the **Load Cases** dialog box.
2. Select **Lateral Effects** from the **Input** menu. If no lateral case is defined this command is disabled. Once selected, Figure 4-56 will appear.

![Lateral Load Effects](image)

**Figure 4-56 Lateral Moment dialog box**

3. Select load cases from the **CURRENT CASE** list box. At least one lateral load case must be defined in the **LOAD CASES** dialog box before you can see the load case in the **CURRENT CASE** list box.
4. Select span number on which lateral loads will be defined from the **SPAN** drop-down list.
5. Enter the moments at the left end and right end of the span in the Moment at Left and Moment at Right input boxes, respectively.
6. Press the **ADD** button to add the lateral load defined above into the lateral load list box in the lower part of the dialog box.
7. Repeat steps 2 through 5 to define all the lateral loads.
8. To change an existing lateral load, select the load from the lateral load list box then change the moments as mentioned above. Press the **MODIFY** button when finished to update the data in the lateral load list box.
9. To delete an existing lateral load, select the load from the lateral load list box then press the **DELETE** button.
10. Select OK button when all the desired lateral loads have been modified to exit so that spSlab will use the new data.

**Executing Calculations (menu Solve)**

**Execute**

The **Execute** command starts the design portion of spSlab after you have finished inputting all the data.

To design the system:

Select the **Execute** command from the **Solve** menu or click the button on the tool bar. If any data required to analyze and design the system has not been input prior to executing this command, spSlab will display an "Invalid model!" message. You must complete the data before execution.

An analysis status window shows the current state of the execution as shown in Figure 4-57. If the state of each of the computations is OK, the analysis is successful. If any error is encountered ERROR will be shown and the computation is terminated.
Operating spSlab/spBeam  4-39

**Viewing Results Report**

Once the analysis and/or design is performed, you can view the results, shear and moment diagrams, and deflected shapes. This section provides procedures performing these functions.

To view the analysis and design results:

1. Select **Report** command from the **Solve** menu or click the button from the tool bar. A dialog box similar to Figure 4-58 will appear.

![Figure 4-58 View and Print Results dialog box](image)

2. Select the results you want to view from the drop-down list. The contents of the results box will be changed based on your selection. The Customize option allows for more than one result selection to be viewed in the results report.

3. Press the **COPY** button to copy the current results into the Windows clipboard. Then you may use CTRL + V to paste the contents of the clipboard to any other editors such as Word or Notepad.

4. Press the **CLOSE** button to close the result dialog box.

**Saving Results Report**

Analysis and design results are automatically saved to a text file named "InputFileName.out" in the same folder as the project data file (.slb file). The contents of the .out file depends on which option is selected from the drop-down list on the **Results Report** dialog box.

For example, if the input file name is "Example 1 - PCA Notes on ACI 318-08 Example 8-2.slb" and Input Echo is selected from the **Results Report** dialog box as shown in Figure 4-59, an output text file named "Example 1 - PCA Notes on ACI 318-08 Example 8-2.out" is generated automatically in the same directory where the input file is located.
Operating spSlab/spBeam

4-40

Figure 4-59 Input Echo is selected from Results Report dialog box

The output files are text files that can be opened, edited, and printed using Word or Wordpad as shown in Figure 4-60.

Figure 4-60 Output file is opened using Wordpad

Note: Once another option is selected from the Results Report dialog box, the contents of the .out file is changed based on the selection.

Output files (.out file) may not be in proper format if opened using Microsoft Notepad. Please use Word or Wordpad.
**View Program Output (menu View)**

**Zooming in on Floor System**
In order to view the floor system in greater detail, spSlab allows you to magnify a portion of the floor system for closer analysis.

Using zoom with a magnifier:
1. Select **Zoom** from the **View** menu then a sub menu appears beside the **View** menu.
2. Select **Window** from the sub menu. Notice that the **Window** command is checked and the cursor is changed to a magnifier. The other way to magnify window is to click the \( \mathbb{R} \) button on the tool bar.
3. Move the cross cursor to the upper left corner of the portion of the system you want to enlarge.
4. Press and hold down the left mouse button while dragging the cursor to the lower right portion of the system enclosing the desired area within the dashed box.
5. Release the mouse to enlarge that portion.

Using **Zoom In** and **Zoom Out** command:
1. Select **Zoom** from the **View** menu and a sub menu appears.
2. Select the **In(2x)** menu command from the sub menu. The current active window will be magnified by two times. The other way to do this is to click the \( \mathbb{R} \) button on the tool bar.
3. Select the **Out(0.5x)** menu command from the sub menu. The current active window will be reduced by two times. The other way to do this is to click the \( \mathbb{R} \) button on the tool bar.

Note: To return to original (default) zoom, select **Restore** from the **View** menu, or select \( \mathbb{R} \) from tool bar. To move model in a view window, use **Pan** from the **View** menu, or select \( \mathbb{R} \) from tool bar.

**Change Isometric View Angle**
You can modify the X and Z angles at which the floor system is displayed in the isometric view window. By default, the floor system is viewed at -45° about the X axis and 45° about the Z axis. The right hand rule is used to determine the angle of rotation about the X and Z axes and the X axis is always rotated first.

To change angles:
1. Select **Change View Angle** from the **View** menu. The dialog box of Figure 4-61 appears displaying the currently set angles.

![Figure 4-61 Isometric View dialog box](image)

2. Change the angles of rotation about the X and Z axes. The X axis is rotated first then the Z axis is rotated. The floor system is rotated about the axis using the right hand rule.
3. Select Ok button to accept the new angles and to modify the isometric view.

Note: A more convenient way to change the view angles instantly without entering angles in the dialog box is to use the keyboard shortcut CTRL + ARROW Keys. For example, press CTRL + ← and CTRL + → to rotate the floor system around Z axis and press CTRL + ↑ or CTRL + ↓ to rotate around X axis.

**Viewing Specific Member Type**
In order to see the floor system members in greater detail, you can select specific member types to view by enabling and disabling them.
To select member type:

1. Select the View Options command from the View menu. The dialog box of Figure 4-62 will appear showing the currently displayed member types. Depending on the floor system, some of the member types will be shaded gray and unavailable.

2. To hide a member type from a view of the floor system you must remove the ✓ sign from the check box. Click the left mouse button on the check box of the member type you would like to hide. To view a previously hidden member type, click the left mouse button on the check box to add the ✓ sign to the check box.

3. Select OK button to view only the selected member types.

Figure 4-62 View Options dialog box

Plan View

To switch to plan view:

1. Select the Plan View command from the View menu or click button on the tool bar. The dialog box of Figure 4-63 will appear.

Figure 4-63 Plan View Window

2. Right click on the view window to show the pop-up menu. You may save the current view window as bitmap (BMP) file or metafile (EMF) on the Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively. You may also select the commands from the pop-up menu to zoom in or zoom out the view window and preview it before printing it out.

Figure 4-64 Pop-up Menu of View Window
3. Select the **Options** command from the pop-up menu, and then you may decide what geometry members need to be shown on the view window as shown in Figure 4-65. To hide a member type from a view of the floor system you must remove the ✓ sign from the check box. Click the left mouse button on the check box of the member type you would like to hide. To view a previously hidden member type, click the left mouse button on the check box to add the ✓ sign to the check box.

4. Select Ok button to view only the selected member types.

![Figure 4-65 Geometry Options of Plan View](image)

**Elevated View**

To switch to elevated view:

1. Select the **Elevated View** command from the **View** menu or click button from the tool bar. The dialog box of Figure 4-66 will appear.

![Figure 4-66 Elevated View Window](image)

2. Right click on the view window to show the pop-up menu. You may save the current view window as bitmap (BMP) file or metafile (EMF) onto the Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively. You may also select the commands from the pop-up menu to zoom in or zoom out the view window and preview it before printing it out.

![Figure 4-67 Pop-up Menu of View Window](image)

3. Select the **Options** command from the pop-up menu, and then you may decide what geometry members need to be shown on the view window as shown in Figure 4-68. To hide a member type from a view of the floor system you must remove the ✓ sign from the check box. Click the left mouse button on the
check box of the member type you would like to hide. To view a previously hidden member type, click the left mouse button on the check box to add the ✓ sign to the check box.

4. Select OK button to view only the selected member types.

**Figure 4-68 Geometry Options of Elevated View**

**Side View**

To switch to side view:

1. Select the **Elevated View** command from the View menu or click button from the tool bar. The dialog box of Figure 4-69 will appear.

**Figure 4-69 Side View Window**

2. Right click on the view window to show the pop-up menu. You may save the current view window as bitmap (BMP) file or metafile (EMF) onto the Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively. You may also select the commands from the pop-up menu to zoom in or zoom out the view window and preview it before printing it out.

**Figure 4-70 Pop-up Menu of View Window**

3. Select the **Options** command from the pop-up menu, and then you may decide what geometry members need to be shown on the view window as shown in Figure 4-71. To hide a member type from a view of the floor system you must remove the ✓ sign from the check box. Click the left mouse button on the check box of the member type you would like to hide. To view a previously hidden member type, click the left mouse button on the check box to add the ✓ sign to the check box.
4. Select Ok button to view only the selected member types.

**Isometric View**

To switch to isometric view:

1. Select the Isometric View command from the View menu or click button on the tool bar. The dialog box of Figure 4-72 will appear.

2. Right click on the view window to show the pop-up menu. You may save the current view window as bitmap (BMP) file or metafile (EMF) onto the Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively. You may also select the commands from the pop-up menu to zoom in or zoom out the view window and preview it before printing it out.

3. Select the Options command from the pop-up menu, and then you may decide what geometry members need to be shown on the view window as shown in Figure 4-74. To hide a member type from a view of the floor system you must remove the 

\[ \checkmark \]

sign from the check box. Click the left mouse button on the check box of the member type you would like to hide. To view a previously hidden member type, click the left mouse button on the check box to add the 

\[ \checkmark \]

sign to the check box.
4. Select Ok button to view only the selected member types.

**Loads**

To show the loads:

1. Select the **Loads** command from the **View** menu or click button from the tool bar. The dialog box of Figure 4-75 will appear.

2. Right click on the view window to show the pop-up menu. You may save the current view window as bitmap (BMP) file or metafile (EMF) onto the Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively. You may also select the commands from the pop-up menu to zoom in or zoom out the view window and preview it before printing it out.

3. Select the **Options** command from the pop-up menu, and then you may decide what kind of loads need to be shown on the view window as shown in Figure 4-77. To hide a load case, load type, or live load pattern you must remove the ✓ sign from the check box. Click the left mouse button on the check box of the member type you would like to hide. To view a previously hidden load type, click the left mouse button on the check box to add the ✓ sign to the check box.
4. If you want to hide the load values, remove the check mark before SHOW VALUES check box.
5. If you want to hide the load units, remove the check mark before SHOW UNITS check box.
6. Select OK button to view only the selected member types.

**View Graphical Results**

**Viewing Internal Forces Diagrams**

Once the design has been performed, you may view the shear, moment, and internal torque (beams/one-way slab systems with torsion) diagrams for any span at any available load combination.

To view shears and moments diagram:

1. Select the Internal Forces command from the View menu or click the button on the tool bar. A view window similar to Figure 4-78 will appear. The upper half view window shows the shear diagram and the lower half the view window shows the moment diagram. If torsion is enabled for beams/one-way slab systems than internal torque diagram will also be shown in this window.

2. The current coordinate values can be captured based on the position of the mouse cursor. The status bar in Figure 4-79 shows the name of the diagram, two coordinate values of the current mouse cursor position, and the current design code used in the project.

3. Click the right mouse button anywhere on the view window to show the pop-up menu. You may Restore, Zoom, Pan or Print View directly by selecting commands from this pop-up menu.
4. Click the Options command from the pop-up menu to change the span for which the internal forces diagrams will be shown and to choose if legend will be displayed or not. Figure 4-80 shows the OPTIONS dialog box. Select a span number from the SHOW DIAGRAM FOR drop-down list and select a load
Envelope or combination from the SELECT LOAD COMBINATIONS check list box. Use DRAW LEGEND checkbox to control whether legend is drawn or not. Press the OK button to close the dialog box and redraw the view windows.

![Internal Forces Diagram Options](image)

**Figure 4-80 View Internal Forces Diagram Options**

Note: The pop-up menu can be accessed from each of the view windows of spSlab.

The **Restore** command cannot be executed in the pop-up menu until the **Zoom** or **Pan** command is stopped by pressing the ESC key. Without stopping the **Zoom/Pan** command, one can only restore a view using the **Restore** command in View menu or button in the tool bar. This occurs in all spSlab view windows.

**Viewing Moment Capacity**

Once the design has been performed, you may view the moment capacity diagrams for any span at any available loading pattern. The moment capacity window will be split in half horizontally. The middle strip moment capacity will occupy the upper half and the column strip moment capacity will occupy the lower half where each diagram will be scaled to fill the entire half of the window.

To view moment capacity:

1. Select the **Moment Capacity** command from the View menu or click the button on the tool bar. A view window similar to Figure 4-81 will appear.
2. Right click on the Moment Capacity view window and select **Options** command from the pop-up menu. A dialog box similar to Figure 4-82 will appear.
3. The current coordinate values can be captured based on the position of the mouse cursor. The status bar shows the name of the diagram, two coordinate values of the current mouse cursor position, and the current design code used in the project.

![Moment Capacity Diagram](image)

**Figure 4-81 View Moment Capacity Diagram**

4. Click the right mouse button anywhere on the view window to show the pop-up menu. You may **Restore**, **Zoom**, **Pan** or **Print View** directly by selecting commands from this pop-up menu.
5. Click the **Options** command from the pop-up menu to change the span for which the moment capacity will be shown. Select which span will be shown in the **SHOW DIAGRAM FOR** drop-down list. Use **DRAW LEGEND** checkbox to control whether legend is drawn or not. Select which part of the selected span will be shown in the **Show frame box**.

To view capacity of longitudinal reinforcement, use **COMBINED M-V-T** checkbox (Figure 4-82b) for beams designed or investigated per CSA A23.3-04\(^{197}\) with Combined M-V-T option.

6. Press the **Ok** button to close the dialog box and redraw the view windows.

---

**Figure 4-82 View Moment Capacity Option dialog box (a) two-way system (b) beam with M-V-T option selected in Solve Options (CSA A23.3-04 only)**

**Viewing Shear Capacity**

Once the design has been performed, you may view the slab shear capacity diagrams for any span at any available loading pattern.

To view shear capacity:

1. Select the **Shear Capacity** command from the View menu or click the [ ] button on the tool bar. A view window similar to Figure 4-83 will appear.

---

**Figure 4-83 View Shear Capacity**

2. Right click on the Shear Capacity view window and select **Options** command from the pop-up menu. A dialog box similar to Figure 4-84 will appear.

---

\(^{197}\) CSA A23.3-04, 11.3.9.2, 11.3.9.3, 11.3.10.6
3. The current coordinate values can be captured based on the position of the mouse cursor. The status bar shows the name of the diagram, two coordinate values of the current mouse cursor position, and the current design code used in the project.

4. Click the right mouse button anywhere on the view window to show the pop-up menu. You may **Restore**, **Zoom**, **Pan** or **Print View** directly by selecting commands from this pop-up menu.

5. Click the **Options** command from the pop-up menu to change the span for which the shear capacity will be shown. Select which span will be shown in the **SHOW DIAGRAM FOR** drop-down list. Use **DRAW LEGEND** checkbox and **CRITICAL SECTION** checkbox to control if the legend and critical sections are drawn or not. Select which part of the selected span will be shown in the **SHOW frame box**.

6. Press the Ok button to close the dialog box and redraw the view windows.

**Viewing Reinforcement**

Once the design has been performed, you may view the reinforcement diagrams for any span at any available loading pattern. The reinforcement window will be split in half horizontally. The middle strip reinforcement will occupy the upper half, and the column strip reinforcement will occupy the lower half where each diagram will be scaled to fill the entire half of the window.

To view reinforcement:

1. Select the **Reinforcement** command from the **View** menu or click the button on the tool bar. A view window similar to Figure 4-85 will appear.

2. Right click on the Reinforcements view window and select **Options** command from the pop-up menu. A dialog box similar to Figure 4-86 will appear.

*Figure 4-84 View Shear Capacity Option dialog box (a) One-way and two-way system (b) Two-way system with shear distributed to slab strips*

*Figure 4-85 View Reinforcement*
3. The current coordinate values can be captured based on the position of the mouse cursor. The status bar shows the name of the diagram, coordinate value of the current mouse cursor position in the design direction, and the current design code used in the project.

4. Click the right mouse button anywhere on the view window to show the pop-up menu. You may Restore, Zoom, Pan or Print View directly by selecting commands from this pop-up menu.

5. Click the Options command from the pop-up menu to change the span for which the shear capacity will be shown. Select the span you want to show from the Show diagram for drop-down list. Select which part of the selected span will be shown from the Show frame box. Checking the SHOW REBAR LABELS will show labels beside each reinforcement on the view. Similarly bar length can be included by checking INCLUDE BAR LENGTH. Bar labels can also be arranged vertically if ROTATE BAR LABELS is checked. Set the vertical scale (relative to the horizontal scale which is set automatically) to which members are drawn in the SLAB THICKNESS SCALE edit box.

6. Press the OK button to close the dialog box and redraw the view windows.

Viewing Deflected Shapes
Once the design has been performed, you may view the deflection shapes for any span at any available loading pattern.

To view the deflection shapes:
1. Select the Deflection command from the View menu or click the button on the tool bar. A view window similar to Figure 4-87 will appear.
2. Right click on the deflection view window and select Options command from the pop-up menu. A dialog box similar to Figure 4-88 will appear.
3. The current coordinate values can be captured based on the position of the mouse cursor. The status bar shows the name of the diagram, two coordinate values of the current mouse cursor position, and the current design code used in the project.

4. Click the right mouse button anywhere on the view window to show the pop-up menu. You may **Restore**, **Zoom**, **Pan** or **Print View** directly by selecting commands from this pop-up menu.

![Figure 4-88 View Deflection Option dialog box](image)

5. Click the **Options** command from the pop-up menu to change the span for which the deflection will be shown. Select the span you want to show from the **SHOW DIAGRAM FOR** drop-down list. Check the **Draw Legend** checkbox to include the legend in the drawing. Enter the scale factor in the **SCALE FACTOR** edit box. The bigger the scale factor, the more apparent the deflections will be on the diagram.

6. Press the **OK** button to close the dialog box and redraw the view windows.

**Print Results**

**Printing Analysis and Design Results**

Once the analysis and/or design is performed, you can print the results. This section provides procedures for performing these functions.

To print the analysis and design results:

1. Select **Report** command from the **Solve** menu or click the button from the tool bar. A dialog box similar to Figure 4-89 will appear.

![Figure 4-89 View and Print Results dialog box](image)

2. Select the results you want to view from the drop-down list. The contents of the results list box will be changed based on your selection.

3. Press the **PRINT** button on the dialog box to print the results through a printer. The printer could be a local printer which is connected to your computer directly, or a network printer.

4. Press the **CLOSE** button to close the result dialog box.

**Printing Current View Window**

Once the design has been performed, you may print the diagrams and views for any span at any available loading pattern by selecting the **Print View** command from the **File** menu.

To print a displaying window:
1. To select the diagram or view you want to print, single click the left mouse button on the diagram or view window.

2. Select the **Print View** command from the **File** menu. A print preview window similar to Figure 4-90 will be shown.

![Figure 4-90 Print Preview Window](image)

3. Press the **ZOOM IN** or **ZOOM OUT** buttons or simply click the left mouse button on the preview to magnify or reduce the size of the preview paper.

4. Press the **NEXT PAGE** button if more than one page need to be printed.

5. Press the **PRINT** button to print the view. The printer could be a local printer which is connected to your computer directly, or a network printer.

6. Press the **CLOSE** button to close the preview window and go back to spSlab.

---

**Print Preview**

The **Print Preview** command allows you to preview and print the current view window (floor system geometry in the plan, elevated and isometric views, prints the shear and moment diagrams, and the deflected shapes).

1. To obtain a view window you must first perform the design, then select what you want to view from the **View** menu. You may have more than one view window opened. The current view window is the one activated and on top of the others on your screen.

2. Selecting this command closes the spSlab main window and opens the print preview window as shown in Figure 4-90.

3. On the print preview window, press the **ZOOM IN** or **ZOOM OUT** buttons or simply click the left mouse button on the preview window to magnify or reduce the size of the preview paper.

4. Press the **NEXT PAGE** button if more than one page needs to be printed.

5. Press the **PRINT** button to print the view. The printer could be a local printer which is connected to your computer directly, or a network printer.
6. Press the CLOSE button to close the preview window and go back to spSlab.

**Copy Graphs to Clipboard**

**Copy Bitmap (BMP format)**

spSlab can copy any of the ten view windows onto Windows clipboard as bitmap. The bitmap on clipboard can then be pasted into Microsoft Word or other Windows applications including presentation software such as Microsoft PowerPoint.

To copy view window to clipboard as bitmap:
1. Select the view window that will be copied by single clicking left mouse button on it.
2. Select \[\text{Copy}\] from the tool bar to copy the selected view window to clipboard.
3. Switch to other word processing software, such as Microsoft Word, then press the CTRL + V to paste the bitmap on clipboard to a Word file.

**Copy Metafile (EMF format)**

Since bitmap files cannot easily be resized or re-proportioned without significant distortion to the image, metafiles are generally used for situations requiring scalability of the image.

Advantages of metafiles are:
- Large, simply structured images require less memory than bitmaps for display and make optimal use of the resolution of the output device.
- Metafiles can be resized with none of the distortion which normally accompanies resizing of bitmaps.
- A metafile can contain SelectPalette statements, allowing custom palettes to be displayed in applications such as Microsoft Word.

The Enhanced MetaFile (EMF) format is an extension of the Windows metafiles format developed for use with 32 bit Windows applications. It is only available to native 32 bit applications.

To copy view window to clipboard as Enhanced MetaFile (EMF):
1. Select the view window that will be copied by single clicking left mouse button on it.
2. Select \[\text{Copy}\] from the tool bar to copy the selected view window to clipboard.
3. Switch to other word processing software, such as Microsoft Word, then press the CTRL + V to paste the bitmap on clipboard to a Word file.

**Customizing Program (menu Options)**

**Changing Colors**

Colors can be changed for background of views, geometry items such as slabs and beams, text on views, result diagrams, etc.

To change colors:
1. Select Colors command from the Options menu. Figure 4-91 will appear.
2. From the General frame box on the left side, select the item whose color needs to be changed from the list box.
3. Select a color from the Change color to drop-down list. Once a new color is selected from the drop-down list the color in the list box above the drop-down list is updated instantly.
4. From the Results category box on the right side, select the item whose color needs to be changed from the list box.
5. Select a color from the Change color to drop-down list. Once a new color is selected from the drop-down list the color in the list box above the drop-down list is updated instantly.
6. If you want to print views in black and white, select the Print Black and White check box.
7. If you want to save the settings as default, select the **Save** setting for future use check box.

![Figure 4-91 Changing Colors dialog box](image)

8. Input the line thickness in the Printed Line Thickness edit box. The diagram line thickness will be based on the number you input.

9. Press the OK button to save the settings and close the dialog box.

**Changing Fonts**

Fonts can be selected separately for both the graphical output and the text output via **Options|Font** command.

To change the graphical output font:

1. Select the **Font|Graphical Output** command from the **Options** menu. A view window similar to Figure 4-92 will appear.

![Figure 4-92 Changing Graphical Output Font dialog box](image)

2. Select the font, font style and size from the lists. Font sizes different from those on the list can be typed in the **Size** text box.

3. In the **Effect** frame select if strikeout and/or underline effect have to be applied. Alternatively to the **Color** dialog box, the font color can be chosen in this dialog box too.

4. The script of the font by default is Western and should not be changed.

5. Press the Ok button to save the new setting and close the dialog box.

To change the text output font follow the same procedure as for the graphical output font except that font effects are not available for text output and the list of fonts only contains non-proportional fonts which are suitable for tabulated text output (Figure 4-93).
Changing Startup Defaults

To change the startup defaults:

1. Select the **Startup Defaults** command from the **Options** menu. A view window similar to Figure 4-94 will appear.

2. Input the name of the engineer in the **Engineer edit box**. The name of the engineer will be shown on the view print.

3. Select the design code from the **Design code** drop-down list. Fourteen design codes are available: ACI 318-11, ACI 318M-11, ACI 318-08, ACI 318M-08, ACI 318-05, ACI 318M-05, ACI 318-02, ACI 318M-02, ACI 318-99, ACI 318M-99, CSA A23.3-04, CSA A23.3-04E, CSA A23.3-94 and CSA A23.3-94E.

4. Select the rebar database from the **Rebar database** drop-down list. Four defined databases are available: ASTM A615, ASTM A615M, CSA G30.18 and prEN 10080. If you would like to use rebar defined by yourself, select the **User Defined** from the drop-down list. You may define your own rebar database by selecting the **Rebar Database** from the **Options** menu.

5. Press the **OK** button to save the new setting and close the dialog box.

Changing Rebar Database

User can define his own reinforcement database. The defined database, such as ASTM A615M, cannot be changed.

To change the reinforcement database:

1. Select the **Rebar Database** from the **Options** menu. Figure 4-95 will appear.

2. Select **User-defined** from the **Current Bar Set** drop-down list. Rebar data of the other databases can only be viewed and cannot be changed.
3. To select the reinforcement that needs to be changed from the reinforcement list box, single click the left mouse button on it. The size, diameter, area, and weight of the selected bar are shown in the corresponding text boxes, respectively.

4. Enter the new values of bar size, diameter, area, and weight.

5. Press the ADD button to add the bar as a new bar into the reinforcement list box on the lower part of the dialog box. If any data inconsistency is found by spSlab, an error of "Inconsistent bar data" will be shown.

6. Press the MODIFY button to update an existing bar.

7. To delete a bar, select the bar from the reinforcement list box then click the DELETE button.

8. After finishing the definitions of your own reinforcement database, you may save them into a file on the hard drive by pressing the SAVE TO FILE button and specifying a file name for your database. This file can be imported into spSlab by pressing the READ FROM FILE button.

**Working with View Windows (menu Window)**

**Cascade**

The Cascade command displays all the open windows in the same size, arranging them on top of each other so that the title bar of each is visible. The current active view window will be on the top after the execution of the Cascade command.

**Tile Horizontal**

The Tile Horizontal command arranges all open windows horizontally so that no window overlaps another. The current active view window will be on the most left or on the upper-left corner of the screen after the execution of the Tile Horizontal command.

**Tile Vertical**

The Tile Vertical command arranges all open windows vertically so that no window overlaps another. The current active view window will be on the most left or on the upper-left corner of the screen after the execution of the Tile Vertical command.

**Remaining Commands**

The remaining menu items are in a list of the windows that are available for viewing. Selecting any window from this menu will restore the window to its previous size and position from an icon.
Obtaining Help Information (menu Help)

Opening Table of Contents of the Help System
To open table of contents of the Help system:
1. Select Help Topics from the Help menu.
2. Select the chapter you need from the content tree view in the left pane of the Help window. The contents of the selected chapter appear in the right pane of the Help window.

Displaying Help Topic Associated with Selected Element
To display the topic associated with the selected element:
1. Select Context Help from the Help menu. The mouse cursor changes to ?
2. Click the element for which you need information about. The program will display the topic which is associated with the element you clicked.

Displaying the Manual
To display the manual:
1. Select spSlab Manual from the Help menu.
2. The manual will be displayed in the default PDF file viewer.

Checking for Updates
To check if a newer version of the program is available:
1. Select Check for Updates from the Help menu.
2. Click Next to have the program connect to StructurePoint server and check if a version newer than the one currently running is available.
3. If a newer version is available then the program will prompt the user to visit the StructurePoint website at www.StructurePoint.org where the newer version can be requested or downloaded.

Obtaining Information about the Program
The following information about the program is displayed in the ABOUT SPSLAB dialog box:
- program version and short description
- licensing information
- the copyright information

The licensing information depends on the type of license being used. If it is a trial license then the LICENSE EXP field shows when the trial period expires and the LOCKING CODE field displays a unique fingerprint of the computer on which the program is running. This locking code needs to be provided to StructurePoint in order to generate a permanent license. For other, non-trial licenses, license ID is displayed. You may be asked to provide this ID when you contact StructurePoint for technical support.

To obtain the information about the program:
1. Select the About spSlab command from the Help menu. A dialog box of Figure 4-96 will appear.
2. Press OK button to exit the dialog box.
Figure 4-96 About spSlab dialog boxes with (a) a trial license (b) a network license
Chapter 5

Output Description

Output Elements

spSlab generates the text and graphical output of the input data and the results of the calculations. The text output is generated when user opens the Results Report dialog window. An ASCII text file is generated in the same sub-folder as the input data file. The name of the output file is created by adding the extension ".OUT" to the name of the input data file. Depending on the report options selected, the text output will contain a selection of the following sections (see the illustrated examples in the following chapter):

- Program Information
- [1] Input Echo
- [2] Design Results
- [3] Column Axial Forces And Moments
- [4] Internal Forces – Load Cases
- [5] Internal Forces – Load Combinations
- [6] Internal Forces – Envelopes
- [7] Deflections
- [8] Required Reinforcement

Program Version

The program version number appears at the top of each report page along with the licensing and copyright information. Additionally, legal disclaimer is displayed on the first page of the text output.

Input Echo

Section Input Echo reports the data used in the analysis. spSlab defaults common data; all other data must be input. Carefully check the contents of the section and compare it with the intended design model. The following paragraphs describe the blocks included in the section.

General Information

This block is similar in its content to the dialog window General Information. It contains the information on project input data file name, project description, selected design code and units, selected reinforcement database, calculation mode (design or investigation), number of supports, cantilevers. The selections available in the SOLVE OPTIONS dialog box are also listed in this block.

Material Properties

This block contains the information on concrete properties for slabs, beams and columns. It also contains the information on reinforcing steel properties for slabs and beams.

Reinforcement Database

This block lists the properties of the bars from the bar table selected for the project. Bar diameter, cross-section area and unit weight for each bar are reported. The values reported are consistent with the units used in particular model.
**Span Data**

This block is similar in its content to the dialog window Span Data. The block is divided into two parts. First part reports the span-by-span geometry of the concrete slab (length, left and right side width, depth and code required minimum thickness). The second part contains the span-by-span geometry of longitudinal beams and ribs (for joist slabs).

**Support Data**

This block is similar in its content to the dialog window Support Data. The block is divided into four parts. The first part reports the geometry of top and bottom columns and the stiffness share factor. For circular column the transverse dimension C2 is reported as zero. The second part contains the geometry of drop panels: thickness, lengths, widths. If dimensions of a drop panel are invalid it will be marked. Invalid or excessive drop panel geometry is not used in the analysis. The third part contains the geometry of column capitals: depth, slope (depth/extension ratio), extensions. The fourth part contains the geometry of transverse beams: width depth, eccentricity (offset) from column centroid.

**Load Data**

This block contains the complete information on load input. The block is divided into three parts. The first part reports the defined load cases, load combinations and corresponding load factors. This part summarizes the contents of the dialog windows Load Cases and Load Combinations. The second part reports the magnitudes of defined span loads. It summarizes the contents of the dialog window Span Loads. The third part reports the magnitudes of lateral actions (joint moments) if defined in the model. It summarizes the contents of the dialog window Lateral Load Effects.

**Reinforcement Criteria**

This block is similar in its content to the dialog window Reinforcement Criteria. The block is divided into three parts. The first part reports the requirements for slab and rib bars. The second part reports the requirements for longitudinal beams. Both parts contain the information on bar sizes, covers, spacing, and user selected allowable steel percentages. The requirements for top and bottom bars are given. For longitudinal beams additionally the criteria for transverse bars (stirrups) are listed.

**Reinforcing Bars**

This block is available only when Investigation Mode is selected. This block is similar in its content to the dialog window Reinforcing Bars. The block is divided into three parts. The first part reports the span-by-span user selected top bars for column, middle and beam strips accordingly. Similarly, the second part reports the user selected bottom bars for column, middle and beam. For longitudinal bars the program reports bar sizes, lengths and concrete cover. The third part presents the beam transverse reinforcement (stirrups) defined by the user.

Note: When switching from Design Mode to Investigation Mode, spSlab automatically assumes the results of the Design Mode as an input for Investigation Mode.

**Design Results**

**Strip Widths and Distribution Factors**

This block is available only for two-way systems. It contains the information on design strip widths, moment distribution factors, and shear distribution factors (for CSA A23.3-04 standard and optionally for other standards if distribution of shear to slab strips is selected).

**Top Reinforcement**

This block is available only when Design Mode is selected. It reports the negative reinforcement requirements. The block contains the values of corresponding design strip widths (column, middle, and
beam), maximum factored design moments per strip and critical location, minimum and maximum steel areas, spacing for bars selected based on required reinforcement area, steel areas required by ultimate condition, selected bar sizes and numbers. The quantities are given for left, center and right location of each span. For a detailed discussion, see Chapter 2, "Area of Reinforcement".

Note: This block does not include reinforcement quantities necessary to transfer unbalanced moments at supports. In case of CSA standard, the reported spacing is averaged between reinforcement placed in the \( b_b \) band and in the remaining portion of the column strip outside of the \( b_b \) band.

**Top Bar Details**

The block contains a span-by-span listing of the longitudinal bars selected in column, middle and beam strips. This reinforcement schedule is intended as a guide for bar placement. In more complex cases the bar schedule selected by the program may have to be adjusted by the user for constructability reasons. The selected bar sizes are limited by user specified minimum and maximum sizes. Bar sizes and numbers are selected to satisfy the minimum and required steel areas in conjunction with the bar spacing requirements of the code. The program calculates the bar lengths based on the computed inflection points and the recommended minima of the code. The bar lengths are adjusted by appropriate development lengths. Hooks and bends are not included in bar length tables and figures. For beams bars are placed in single a layer (see Figure 2-21), provided there is sufficient beam width. For a detailed discussion, see Chapter 4, "Reinforcement Selection".

Note: This block does not include additional reinforcement bars necessary to transfer negative unbalanced moment at supports.

**Band Reinforcement at Supports**

Available only when the CSA code is selected, this section describes how the negative reinforcement in column strips should be concentrated over supports. It reports the total width of the strip from which reinforcement is concentrated, the width of the \( b_b \) band, and the remaining width. The total width of the subdivided strip will be equal to the column strip width when no wide beams (width greater than \( b_b \)) and no slab bands are present. If either one is present then its width will be used. If a beam narrower than \( b_b \) frames into an exterior support then both the total strip width and the \( b_b \) width will be reduced to the beam width.

The section also gives the area of reinforcement and the number of bars required in each strip. The sum of number of bars in the band strip and in the remaining strip should be equal to the total number of bars over each support in the strip from which the bars were concentrated. The total number of bars in this strip should also be consistent with the number of bars listed in the Top Bar Details table.

Note: This output block does not include additional reinforcement bars necessary to transfer negative unbalanced moment at supports.

**Bottom Reinforcement**

This block is available only when Design Mode is selected. It reports the positive reinforcement requirements. The block contains the values of corresponding design strip widths (column, middle, and beam), maximum factored design moments per strip and critical location, minimum and maximum steel areas, spacing for bars selected based on required reinforcement area, steel areas required by ultimate condition, selected bar sizes and numbers. The quantities are given for mid-span regions of each span. For a detailed discussion, see Chapter 2, "Area of Reinforcement".

**Bottom Bar Details**

This block contains a span-by-span listing of the longitudinal bars selected in column, middle and beam strips. The reinforcement schedule is intended as a guide for bar placement. In more complex cases the bar schedule selected by the program may have to be adjusted by the user for constructability reasons. The selected bar sizes are limited by user specified minimum and maximum sizes. Bar sizes and numbers are selected to satisfy the minimum and required steel areas in conjunction with the bar spacing requirements of the code. The program calculates the bar lengths based on the computed inflection points and the recommended minima of the code. The bar lengths are adjusted by appropriate development lengths. Hooks and bends are not included in bar length tables and figures. For beams bars are placed in single a layer
(see Figure 2-21), provided there is sufficient beam width. For a detailed discussion, see Chapter 2, "Reinforcement Selection".

Flexural Capacity

This block lists the selected top and bottom steel areas and corresponding negative and positive moment capacity values in each span. The data is subdivided between column, middle and beam strips. Each span is subdivided into segments reflecting the changes in geometry and bar placement.

Longitudinal Beam Shear Reinforcement Required

This block is available only when Design Mode is selected. It reports the requirements of transverse reinforcement for each longitudinal beam. The capacity of concrete cross-section $\phi V_c$ in each span is shown. The table contains the segmental values of the factored shear force $V_u$ and required intensity of stirrups ($A_v/s$). The segmental values cover the distance between left and right critical sections, and include locations where there is change of geometry of loading.

Longitudinal Beam Shear Reinforcement Details

This block is available only when Design Mode is selected. It is intended as a guide for stirrup placement. The output presents the program selected stirrup sizes, numbers, and spacing. Distances between groups of stirrups are also reported.

Beam Shear (and Torsion) Capacity

If torsion is not considered then this block lists the concrete section shear capacity $\phi V_c$, selected stirrup intensities and spacing, and corresponding beam shear capacity $\phi V_n$ values in each span. For CSA A23.3-04 code, the program additionally reports value of factor $\beta$. The maximum factored shear forces $V_u$ in beam strip along the span is also reported.

In the case of combined shear and torsion analysis (beams/one-way slab systems only), this block lists section properties, shear and torsion transverse reinforcement capacity, and longitudinal torsional reinforcement capacity. The provided and required capacities are expressed in terms of the provided and required areas of reinforcement.

Slab Shear Capacity

This block lists the values of one-way slab shear capacity $\phi V_c$ in each span. For CSA A23.3-04 code, the program additionally reports value of factor $\beta$. The maximum factored shear force $V_u$ and the location of the critical section $X_u$ are also reported.

Flexural Transfer of Unbalanced Moments at Supports

There are two blocks reporting the design values for additional reinforcement necessary to transfer unbalanced support moments. One block is for negative unbalanced moments and the other for positive unbalanced moment. These blocks contain the results for critical (effective) section width as per the code, width of the effective section on the tension side (for negative unbalanced moments) or on the compression side (for positive unbalanced moments), distances to the centroids of tension and compression reinforcement (if compression reinforcement option is selected), the maximum negative or positive unbalanced moment, the corresponding load combination and governing load pattern, the reinforcing steel areas provided and additional steel required. The provided reinforcement area (main longitudinal bars) is reduced by the ratio of critical (effective) strip width to total strip width and does not include the required area due to unbalanced moments. The additional reinforcement is the difference between that required by unbalanced moment transfer by flexure and that provided for design bending moment. When additional reinforcement is required, it is selected based on the bar sizes already provided at the support. For a detailed discussion, see Chapter 2, "Area of Reinforcement" and "Additional Reinforcement at Support".

Punching Shear Around Columns

The block contains two tables with values pertaining to punching shear check in critical sections around the columns. The first table lists geometrical properties of punching shear critical section. The reported properties
of the critical section are overall dimensions in the direction of analysis, \( b_1 \), and in the perpendicular direction, \( b_2 \), perimeter, \( b_0 \), location of centroid with respect to column center line, \( d_{avg} \), average distance from the slab bottom to centroid of the slab tension reinforcement, \( CG \), distance from centroid to the left, \( c_{left} \), and right, \( c_{right} \), edge of critical section, area of concrete resisting shear transfer, \( A_c \), and moment of inertia of critical section, \( J_c \). The second table lists two sets of punching shear calculations – direct shear alone and direct shear with moment transfer. The output contains the values of the allowable shear stress \( \phi v_c \), reactions \( V_u \), unbalanced moments \( M_{unbal} \), governing load pattern, fraction of unbalanced moment \( \phi v \), punching shear stress \( v_u \). The calculation for moment transfer adjusts the unbalanced moment to the centroid of the critical section. The "shear transfer" is the unbalanced moment multiplied by \( \gamma v \). When calculated shear stress \( v_u \) exceeds the allowable value \( \phi v_c \), the program prints a warning flags for this support. For a detailed discussion, see Chapter 2, "Shear Analysis of Slabs".

**Punching Shear Around Drops**

The block contains two tables with values pertaining to punching shear check in a critical section around the drop panels. The first table lists geometrical properties of punching shear critical section (see description in the Punching shear around Columns block). The second table displays the reactions \( V_u \), governing load pattern, the punching shear stress around the drop \( v_u \), and the allowable shear stress \( \phi v_c \). When calculated shear stress \( v_u \) exceeds the allowable value \( \phi v_c \), the program prints a warning flags for this drop panel. For a detailed discussion, see Chapter 2, "Shear Analysis of Slabs".

**Integrity Reinforcement at Supports**

This section is available only when the CSA code is selected. It lists the shear transferred to the column and the minimum area of bottom reinforcement crossing one face of the periphery of a column and connecting slab to the column to provide structural integrity. For a detailed discussion, see Chapter 2, "Integrity Reinforcement".

**Corner Reinforcement**

This block refers to the reinforcement required in the exterior corners of a slab with beams between columns. The ratio of flexural stiffness of beam section to flexural stiffness of slab is listed as well as the area of reinforcement and the distance over which the reinforcement is required. The area applies to each layer of reinforcement in each direction. For a detailed discussion, see Chapter 2, "Slab Corners".

**Shear Resistance at Corner Columns**

This section is available only when the CSA code is selected. It reports results of one-way shear check at corner columns. The results include the factored shear resistance and the factored shear force at the column. Also, the minimum length of the critical shear section and the angle at which the minimum length is obtained are listed. For a detailed discussion, see Chapter 2, "Shear Resistance at Corner Columns" in “Shear Analysis of Slabs”.

**Deflections**

This block lists the summary of section properties, maximum instantaneous deflections and maximum long-term deflections, if they are selected in solution options. Also, if a solution option "Gross (uncracked) sections" is selected, only gross moment of inertia, \( I_g \), is reported in the section properties table and the values of all deflections reported are based on gross section properties. If solution option "Effective (cracked) sections" is used, the values of deflections reported are based on averaged effective moments of inertia, \( I_{e,avg} \), which are then reported in the section properties table together with other properties of cracked sections. For a detailed discussion, see Chapter 2, "Deflection Calculation".

**Material Takeoff**

This block lists the approximate total and unit quantities of concrete, and reinforcement. Note that the reinforcement estimate is for one direction only and ignores items such as hooks, bends, and waste. For a detailed discussion, see Chapter 2, "Material Quantities".
**Column Axial Forces and Moments**

Section Column Axial Forces and Moments presents the summary of axial forces (reactions) and bending moments in bottom and top columns and in springs attached to the column-slab joints. Also, moments at far ends of columns are reported. All reported values represent forces and moments at column ends, i.e. at joint level (not at slab or drop panel surface level). If moment redistribution is selected (beams/one-way slab systems only) both redistributed and un-redistributed values can be included. The values reported represent the loading of a single floor only. Any actions on the columns from the floors above must be added to this story’s actions to properly analyze/design the columns. The output contains column axial forces and moments due to all load cases, including all live load patterns, and all load combinations. Positive axial forces mean compression and positive moments mean that fibers on the left hand side are in tension for top columns and for bottom column fibers on the right hand side are in tension. Also, reactions of additional translational and rotational springs applied at joints are reported in this block. Positive values mean upward translational spring reaction and clockwise rotational spring reaction.

**Internal Forces - Load Cases**

This section presents the summary of unfactored bending moments and shear forces for individual load cases including selfweight, dead load, live load and lateral cases. The reported values are presented using span-by-span segmental approach. If moment redistribution is selected (beams/one-way slab systems only) both redistributed and un-redistributed values can be included.

**Internal Forces - Load Combinations**

This section presents the summary of bending moments and shear forces for each load combination. The reported values for each load combination are presented using span-by-span segmental approach. The negative and positive values of bending moments and shear forces are presented in separate columns in order to provide consistent format with enveloped output. If moment redistribution is selected (beams/one-way slab systems only) both redistributed and un-redistributed values can be included.

**Internal Forces - Envelopes**

This section presents the summary of bending moments and shear forces for envelope of all load combinations. The reported values are presented using span-by-span segmental approach. The negative and positive values of bending moments and shear forces are presented in separate columns for user convenience. The factored values presented in this section are used for design purposes (longitudinal and transverse reinforcement). If moment redistribution is selected (beams/one-way slab systems only) both redistributed and un-redistributed values can be included.

**Deflections**

This section presents the summary of deflections for unfactored (service) load cases including selfweight and dead load (DL), live load (LL) and combined (DL+LL) load cases. The reported values are presented using span-by-span segmental approach. If solution option "Gross (uncracked) sections" is selected, the values of deflections reported are based on gross section properties. If solution option "Effective (cracked) sections" is used, the values of deflections reported are based on substitute effective moment of inertia of the section. For a detailed discussion, see Chapter 2, "Deflection Calculation".

**Required Reinforcement**

This section presents the summary of enveloped design moments and the required areas of longitudinal reinforcement required for flexure. If combined M-V-T option (available only for beam design/investigation per CSA A23.3-04) is selected in the Solve Option window then longitudinal reinforcement required for combined flexure, shear, and torsion (M-V-T) is also reported with the corresponding values of bending moment, shear force, and torsional moment. The values are tabulated for every design strip at every design segment.
Graphical Output

spSlab provides the following graphical output features:

- Diagrams of Internal Forces,
- Moment (and longitudinal reinforcement capacity due to combined M-V-T action, available only for beams designed/investigated per CSA A23.3-04) Capacity Diagram,
- Shear (and Torsion) Capacity Diagram,
- Deflection Diagram,
- Reinforcement Diagram.

These diagram windows can be customized. The Options dialog allows selecting either a single span or all spans. Other elements of the graphs can also be modified. spSlab print preview of the current graphical window. The user has also the choice to export the graphics to a metafile or bitmap file.

Detailed information on using the graphical output features is included in chapter "Operating the Program".
Chapter 6

Examples

In this chapter several examples are presented to demonstrate capabilities of the program. Generally program results match closely the results found in the referenced text books. When discrepancies are observed, they result from variations in assumptions and solutions methods, and numerical accuracy.

Both beams/one-way slab systems as well as two-way slab systems are presented in the examples. The output of beams/one-way slab examples shows that spBeam program was used to solve them. This is to illustrate that spBeam program is available as a limited version of spSlab including only beams/one-way slab capabilities.

Example 1 Spandrel beam with moment redistribution

Problem description

Determine the required reinforcement for the spandrel beam at an intermediate floor level as shown, using moment redistribution to reduce total reinforcement required. (Note: the self weight is already included in the specified dead load below.) This example refers to Example 8-2 from PCA Notes on ACI 318-08 Building Code Requirements for Structural Concrete, Portland Cement Association, 2008.

Columns: 16 × 16 in.
Story height: 10 ft
Spandrel beam: 12 × 16 in.
f'_c = 4000 psi
f_y = 60,000 psi
DL = 1167 lb/ft
LL = 450 lb/ft

![Figure 6-1 Example spandrel beam problem](image)

Preparing Input

1. From the Input menu, select General Information. A dialog box appears.
   - In the LABELS section, input the names of the project, frame, and engineer.
   - In the FRAME section, input 4 for NO OF SUPPORTS.
• In the **FLOOR SYSTEM** section, click the radial button next to **ONE WAY / BEAM**.

• Leave all other options in the **General Information** tab to their default settings of ACI 318-11 design code, ASTM A615 reinforcement, and **DESIGN** run mode option.

• In the **Solve Options** tab, click the check box next to **MOMENT REDISTRIBUTION**. Press **OK**.

2. Nothing needs to be changed in the **Material Properties** dialog box.

3. From the **Input** menu, select **Spans**. A dialog box appears.
   - Under the **Slabs/Flanges** tab, input 25 for **LENGTH**, 0 for **THICKNESS**, and 0 for **WIDTH LEFT** and **WIDTH RIGHT**. Press **MODIFY**.
   - Press the drop down arrow next to **SPAN** and select **Span 2**. Input 15 for **LENGTH**, 0 for **THICKNESS**, and 0 for **WIDTH LEFT** and **WIDTH RIGHT**. Press **MODIFY**.
   - Press the drop down arrow next to **SPAN** and select **Span 3**. Input 20 for **LENGTH**, 0 for **THICKNESS**, and 0 for **WIDTH LEFT** and **WIDTH RIGHT**. Press **MODIFY**.
   - Select the **Longitudinal Beams** tab. Input 12 for **WIDTH** and 16 for **DEPTH**. Press **MODIFY**.
   - Press **COPY**. Press the **CHECK ALL** button. Press **OK**.
   - Press **OK** again.
4. From the **Input** menu, select **Supports**. A dialog box appears.
   - Under the **Columns** tab, input 16 for both the c1 and c2 values in both the **ABOVE** and **BELOW** rows. Press **MODIFY**. (Note: the default **HEIGHT ABOVE** and **HEIGHT BELOW** values of 10 are correct.)
   - Press **COPY**. Press the **CHECK ALL** button. Press **OK**.
   - Under the **Moment Redistribution** tab, click on **SUPPORT 2** in the list in the bottom half of the **SUPPORT DATA** dialog box.
   - Input 20 for both the **LEFT** and **RIGHT REDISTRIBUTION LIMITS**. Press **MODIFY**.
   - Press **COPY**. Click the check box next to **SPAN 3**. Press **OK**.
   - Press **OK** again.

5. From the **Input** menu, select **Reinforcement Criteria**. A dialog box appears.
   - Under the **Beams** tab, select #8 for **MIN BAR SIZE** for **TOP BARS** and **BOTTOM BARS**.
   - Press **OK**.
6. From the Input menu, select Load Cases. A dialog box appears.
   - Since we are not considering lateral forces, click on WIND in the LABEL column on the list in the bottom half of the LOAD CASES dialog box and press the DELETE button.
   - Click on EQ in the LABEL column and press the DELETE button. Press OK.

7. From the Input menu, select Load Combinations. A dialog box appears.
   - Delete all the load combinations by clicking anywhere on the list in the bottom half of the LOAD COMBINATIONS dialog box and pressing the DELETE button. Repeat this procedure until all the load combinations are gone.
   - Input 0 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE field. Press ADD.
   - Press OK.

• Press the drop down arrow next to Type, and select Line Load.
• Input 1167 for both the Start and End Magnitude.
• Input 25 for the End Location. Press ADD.
• Use the drop down arrow next to Span to select Span 2. Keep the Start and End Magnitudes of 1167 lb/ft but change the End Location to 15. Click the ADD button.
• Again use the drop down arrow next to Span to select Span 3. Keep the Start and End Magnitudes of 1167 lb/ft but change the End Location to 20. Click the ADD button.

9. In the top left corner of the Span Loads dialog box, there is a section called Current Case. Click on Live.
• Use the drop down arrow next to Span to select Span 1.
• Making sure that Line Load is still the selected Load Type, input 450 for both the Start and End Magnitude.
• Input 25 for the End Location. Press ADD.
• Use the drop down arrow next to Span to select Span 2. Keep the Start and End Magnitudes of 450 lb/ft but change the End Location to 15. Click the ADD button.
• Again use the drop down arrow next to Span to select Span 3. Keep the Start and End Magnitudes of 1167 lb/ft but change the End Location to 20. Click the ADD button.
• Press OK.

10. From the Solve menu, select Execute. Press Close.
11. From the Solve menu, select Results Report.
• Use the scroll bars to scroll through the results file.
• Use the ARROW keys or the mouse wheel to browse through different parts of the results quickly. Press the CLOSE button to close the RESULTS REPORT dialog box and return to spBeam.

12. To view diagrams, select **Loads, Internal Forces, Moment Capacity, Shear Capacity, Deflection**, or **Reinforcement** from the **View** menu. Right click in any of these diagrams to get new copy, printing, or display options.

13. You may print the results file by selecting **Print Results** from the **File** menu. To print any of the diagrams you selected to view, use the **Print Preview** command found by right clicking in the diagram’s window. After viewing the results, you may decide to investigate the input beams under the same loads but with a modified reinforcement configuration.

14. From the **Input** menu, select **General Information**. In the **General Information** dialog box change the **RUN MODE** option to **INVESTIGATION**. Do not change any of the other options. Press **OK**

15. From the **Input** menu, select the different commands under **Reinforcement Criteria** and **Reinforcing Bars** to modify the reinforcement configuration computed by the program.

16. Repeat steps 10 and subsequent to perform the investigation and view the results.
**Text Output**

**spBeam v3.50 (TM)**

A Computer Program for Analysis, Design, and Investigation of Reinforced Concrete Beams and One-way Slab Systems
Copyright © 1992-2011, STRUCTUREPOINT, LLC
All rights reserved

Licensee stated above acknowledges that STRUCTUREPOINT (SP) is not and cannot be responsible for either the accuracy or adequacy of the material supplied as input for processing by the spBeam computer program. Furthermore, STRUCTUREPOINT neither makes any warranty expressed nor implied with respect to the correctness of the output prepared by the spBeam program. Although STRUCTUREPOINT has endeavored to produce spBeam error free the program is not and cannot be certified infallible. The final and only responsibility for analysis, design or engineering documents prepared in connection with the use of the spBeam program.

[1] INPUT ECHO

---

General Information

File name: C:\Program Files\StructurePoint\spBeam\Examples\Manual\Example 1 - PCA Notes on ACI 318-08 Example 8-2.slb
Project: spLab/spBeam Manual, Example 1
Frame: PCA Notes on ACI 318-08, Example 8-2
Engineer: StructurePoint
Code: ACI 318-11
Reinforcement Database: ASTM A615
Mode: Design
Number of supports = 4
Floor System: One-Way/Beam

Live load pattern ratio = 100%
Deflections are based on cracked section properties.
In negative moment regions, f_y and f_y_o do NOT include flange/slab contribution (if available)
Long-term deflections are calculated for load duration of 60 months.
0% of live load is sustained.
Compression reinforcement calculations NOT selected.
Default incremental rebar design selected.
Moment redistribution selected.
Effective flange width calculations NOT selected.
Rigid beam-column joint NOT selected.
Torsion analysis and design NOT selected.

Material Properties

<table>
<thead>
<tr>
<th>Slabs</th>
<th>Beams</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wc   = 150</td>
<td>150 lb/ft3</td>
<td></td>
</tr>
<tr>
<td>f_y  = 4 ksi</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E_c  = 3834 ksi</td>
<td></td>
<td></td>
</tr>
<tr>
<td>f_r  = 0.4743 ksi</td>
<td></td>
<td></td>
</tr>
<tr>
<td>f_y  = 60 ksi, Bars are not epoxy-coated</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E_s  = 29000 ksi</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Reinforcement Database

<table>
<thead>
<tr>
<th>Size</th>
<th>Db (in)</th>
<th>Ab (in^2)</th>
<th>Wb (lb/ft)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>0.38</td>
<td>0.11</td>
<td>0.38</td>
</tr>
<tr>
<td>6</td>
<td>0.63</td>
<td>0.31</td>
<td>1.04</td>
</tr>
<tr>
<td>8</td>
<td>0.88</td>
<td>0.40</td>
<td>2.04</td>
</tr>
<tr>
<td>10</td>
<td>1.13</td>
<td>1.00</td>
<td>3.40</td>
</tr>
<tr>
<td>14</td>
<td>1.41</td>
<td>1.56</td>
<td>5.31</td>
</tr>
<tr>
<td>18</td>
<td>2.26</td>
<td>4.00</td>
<td>13.60</td>
</tr>
</tbody>
</table>

Span Data...
Slabs

<table>
<thead>
<tr>
<th>Span Loc</th>
<th>lb</th>
<th>L1</th>
<th>t</th>
<th>wL</th>
<th>wr</th>
<th>Min</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Int</td>
<td>25.00</td>
<td>0.00</td>
<td>0.500</td>
<td>0.500</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>2 Int</td>
<td>15.000</td>
<td>0.00</td>
<td>0.500</td>
<td>0.500</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>3 Int</td>
<td>20.000</td>
<td>0.00</td>
<td>0.500</td>
<td>0.500</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

Ribs and Longitudinal Beams

<table>
<thead>
<tr>
<th>Span</th>
<th>b</th>
<th>h</th>
<th>Sp</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>2</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

NOTES:
*b - Span depth is less than minimum. Deflection check required.

Support Data

Columns

<table>
<thead>
<tr>
<th>Supp</th>
<th>clb</th>
<th>c2b</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>16.00</td>
<td>10.00</td>
</tr>
<tr>
<td>2</td>
<td>16.00</td>
<td>10.00</td>
</tr>
<tr>
<td>3</td>
<td>16.00</td>
<td>10.00</td>
</tr>
<tr>
<td>4</td>
<td>16.00</td>
<td>10.00</td>
</tr>
</tbody>
</table>

Moment Redistribution Limits

<table>
<thead>
<tr>
<th>Supp</th>
<th>Left[%]</th>
<th>Right[%]</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Boundary Conditions

<table>
<thead>
<tr>
<th>Supp</th>
<th>Kx (kip/ft); Kxy (kip-in/ft)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Fixed</td>
</tr>
<tr>
<td>2</td>
<td>Fixed</td>
</tr>
<tr>
<td>3</td>
<td>Fixed</td>
</tr>
<tr>
<td>4</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

Load Data

Load Cases and Combinations

<table>
<thead>
<tr>
<th>Case</th>
<th>SELF</th>
<th>Dead</th>
<th>Live</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>DEAD</td>
<td>DEAD</td>
<td>LIVE</td>
</tr>
<tr>
<td>D1</td>
<td>0.000</td>
<td>1.200</td>
<td>1.600</td>
</tr>
</tbody>
</table>

Line Loads

<table>
<thead>
<tr>
<th>Case/Patt</th>
<th>Span</th>
<th>lb</th>
<th>Mb</th>
<th>lb</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELF</td>
<td>1</td>
<td>200.00</td>
<td>0.000</td>
<td>200.00</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>200.00</td>
<td>0.000</td>
<td>200.00</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>200.00</td>
<td>0.000</td>
<td>200.00</td>
</tr>
<tr>
<td>Dead</td>
<td>1</td>
<td>1167.00</td>
<td>0.000</td>
<td>1167.00</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>1167.00</td>
<td>0.000</td>
<td>1167.00</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>1167.00</td>
<td>0.000</td>
<td>1167.00</td>
</tr>
<tr>
<td>Live</td>
<td>1</td>
<td>450.00</td>
<td>0.000</td>
<td>450.00</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>450.00</td>
<td>0.000</td>
<td>450.00</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>450.00</td>
<td>0.000</td>
<td>450.00</td>
</tr>
<tr>
<td>Live/Odd</td>
<td>1</td>
<td>450.00</td>
<td>0.000</td>
<td>450.00</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>450.00</td>
<td>0.000</td>
<td>450.00</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>450.00</td>
<td>0.000</td>
<td>450.00</td>
</tr>
<tr>
<td>Live/Even</td>
<td>2</td>
<td>450.00</td>
<td>0.000</td>
<td>450.00</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>450.00</td>
<td>0.000</td>
<td>450.00</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>450.00</td>
<td>0.000</td>
<td>450.00</td>
</tr>
</tbody>
</table>

Reinforcement Criteria
Slabs and Ribs

<table>
<thead>
<tr>
<th>Top bars</th>
<th>Bottom bars</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min</td>
<td>Max</td>
</tr>
</tbody>
</table>

Bar Size
- $\#5$
- $\#8$

Bar spacing
- $1.00$ 18.00
- $1.00$ 18.00

Reinf. ratio
- $0.14$ 5.00
- $0.14$ 5.00

Cores
- $1.00$ 1.50

There is NOT more than 12 in of concrete below top bars.

Beams

<table>
<thead>
<tr>
<th>Top bars</th>
<th>Bottom bars</th>
<th>Stirrups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min</td>
<td>Max</td>
<td>Min</td>
</tr>
</tbody>
</table>

Bar Size
- $\#8$
- $\#8$

Bar spacing
- $1.00$ 18.00
- $1.00$ 18.00

Reinf. ratio
- $0.14$ 5.00
- $0.14$ 5.00

Cores
- $1.00$ 1.50

Layer dist.
- $1.00$ 1.00

No. of legs
- $2$ 6

Side cover
- $1.50$ in

1st Stirrup
- $3.00$ in

There is NOT more than 12 in of concrete below top bars.

(2) DESIGN RESULTS

Moment Redistribution Factors

| Units: Org.Mu (k-ft) | Supp | Side | Org.Mu | Iter.# | Applied Factor(%) | User Limit(%) | Applied Limit(%)
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td>83.53</td>
<td>3</td>
<td>0.03794</td>
<td>17.96</td>
<td></td>
</tr>
<tr>
<td>2 Left</td>
<td></td>
<td>91.92</td>
<td>6</td>
<td>0.01924</td>
<td>15.26</td>
<td>20.00</td>
<td>15.26</td>
</tr>
<tr>
<td>2 Right</td>
<td></td>
<td></td>
<td>41.57</td>
<td>2</td>
<td>0.01646</td>
<td>20.00</td>
<td>20.00</td>
</tr>
<tr>
<td>3 Left</td>
<td></td>
<td></td>
<td>32.97</td>
<td>2</td>
<td>0.01506</td>
<td>20.00</td>
<td>20.00</td>
</tr>
<tr>
<td>3 Right</td>
<td></td>
<td></td>
<td>57.21</td>
<td>2</td>
<td>0.02390</td>
<td>20.00</td>
<td>20.00</td>
</tr>
<tr>
<td>4 Left</td>
<td></td>
<td></td>
<td>49.30</td>
<td>2</td>
<td>0.03446</td>
<td>20.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Top Reinforcement

<table>
<thead>
<tr>
<th>Units: Width (ft), Min. Xmax (k-ft), Xmax (ft), As (in^2), Sp (in)</th>
<th>Span Zone</th>
<th>Width</th>
<th>Xmax</th>
<th>Xmax</th>
<th>AsMin</th>
<th>AsMax</th>
<th>AsReq</th>
<th>Sp</th>
<th>Prov</th>
<th>Bars</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1 Left</td>
<td>1.00</td>
<td>83.10</td>
<td>0.667</td>
<td>0.560</td>
<td>3.034</td>
<td>1.426</td>
<td>6.311</td>
<td>2-$#8$</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Midspan</td>
<td>1.50</td>
<td>12.50</td>
<td>0.000</td>
<td>0.000</td>
<td>3.034</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Right</td>
<td>1.00</td>
<td>75.67</td>
<td>24.333</td>
<td>0.560</td>
<td>3.034</td>
<td>1.288</td>
<td>6.311</td>
<td>2-$#8$</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 Left</td>
<td>1.00</td>
<td>31.23</td>
<td>0.667</td>
<td>0.560</td>
<td>3.034</td>
<td>0.509</td>
<td>6.311</td>
<td>2-$#8$*3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Midspan</td>
<td>1.00</td>
<td>7.500</td>
<td>0.000</td>
<td>0.000</td>
<td>3.034</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Right</td>
<td>1.00</td>
<td>24.35</td>
<td>14.333</td>
<td>0.525</td>
<td>3.034</td>
<td>0.395</td>
<td>6.311</td>
<td>2-$#8$*3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3 Left</td>
<td>1.00</td>
<td>43.44</td>
<td>0.667</td>
<td>0.560</td>
<td>3.034</td>
<td>0.717</td>
<td>6.311</td>
<td>2-$#8$</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Midspan</td>
<td>1.00</td>
<td>10.00</td>
<td>0.000</td>
<td>0.000</td>
<td>3.034</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Right</td>
<td>1.00</td>
<td>48.84</td>
<td>19.333</td>
<td>0.560</td>
<td>3.034</td>
<td>0.810</td>
<td>6.311</td>
<td>2-$#8$</td>
<td></td>
</tr>
</tbody>
</table>

Top Bar Details

<table>
<thead>
<tr>
<th>Units: Length (ft)</th>
<th>Span</th>
<th>Bars</th>
<th>Length</th>
<th>Left</th>
<th>Continuous</th>
<th>Left</th>
<th>Right</th>
<th>Bars</th>
<th>Length</th>
<th>Bars</th>
<th>Length</th>
<th>Bars</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1-$#8$</td>
<td>6.13</td>
<td>3.34</td>
<td>1-$#8$</td>
<td>5.88</td>
<td>3.09</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1-$#8$</td>
<td>4.82</td>
<td>1.83</td>
<td>1-$#8$</td>
<td>4.82</td>
<td>1.83</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1-$#8$</td>
<td>4.57</td>
<td>2.01</td>
<td>1-$#8$</td>
<td>4.57</td>
<td>2.01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Bottom Reinforcement

<table>
<thead>
<tr>
<th>Units: Width (ft), Min. Xmax (k-ft), Xmax (ft), As (in^2), Sp (in)</th>
<th>Span Width</th>
<th>Width</th>
<th>Xmax</th>
<th>Xmax</th>
<th>AsMin</th>
<th>AsMax</th>
<th>AsReq</th>
<th>Sp</th>
<th>Prov</th>
<th>Bars</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1.00</td>
<td>69.82</td>
<td>12.625</td>
<td>0.560</td>
<td>3.034</td>
<td>1.182</td>
<td>6.311</td>
<td>2-$#8$</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1.00</td>
<td>25.96</td>
<td>7.624</td>
<td>0.560</td>
<td>3.034</td>
<td>0.421</td>
<td>6.311</td>
<td>2-$#8$*3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1.00</td>
<td>47.12</td>
<td>9.876</td>
<td>0.560</td>
<td>3.034</td>
<td>0.780</td>
<td>6.311</td>
<td>2-$#8$</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Bottom Bar Details

**Units:** Start (ft), Length (ft)  
**Long Bars**  
<table>
<thead>
<tr>
<th>Span</th>
<th>Start Length</th>
<th>Base Start Length</th>
<th>Base Start Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2-#0</td>
<td>0.00</td>
<td>25.00</td>
</tr>
<tr>
<td>2</td>
<td>2-#8</td>
<td>0.00</td>
<td>15.00</td>
</tr>
<tr>
<td>3</td>
<td>2-#8</td>
<td>0.00</td>
<td>20.00</td>
</tr>
</tbody>
</table>

**Flexural Capacity**  

<table>
<thead>
<tr>
<th>Span</th>
<th>x (ft), A_x (in²), M_x (k*ft)</th>
<th>A_{Top}</th>
<th>A_{Bot}</th>
<th>Min-</th>
<th>Min+</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.000 1.58 1.58</td>
<td>-91.28</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.667 1.58 1.58</td>
<td>-91.28</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.668 1.58 1.58</td>
<td>-91.28</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.343 0.79 1.58</td>
<td>-47.70</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.456 0.79 1.58</td>
<td>-47.70</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>6.132 0.00 1.58</td>
<td>0.00</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.950 0.00 1.58</td>
<td>0.00</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>12.550 0.00 1.58</td>
<td>0.00</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>16.050 0.00 1.58</td>
<td>0.00</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>19.117 0.00 1.58</td>
<td>0.00</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>21.535 0.79 1.58</td>
<td>-47.70</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>23.332 0.79 1.58</td>
<td>-47.70</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>24.333 1.58 1.58</td>
<td>-91.28</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>25.000 1.58 1.58</td>
<td>-91.28</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0.000 1.58 1.58</td>
<td>-91.28</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.667 1.58 1.58</td>
<td>-91.28</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.883 1.58 1.58</td>
<td>-91.28</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.343 0.79 1.58</td>
<td>-47.70</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.456 0.79 1.58</td>
<td>-47.70</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4.815 0.00 1.58</td>
<td>0.00</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5.450 0.00 1.58</td>
<td>0.00</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>7.500 0.00 1.58</td>
<td>0.00</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>9.550 0.00 1.58</td>
<td>0.00</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>10.692 0.00 1.58</td>
<td>0.00</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>11.602 0.79 1.58</td>
<td>-47.70</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>13.167 0.79 1.58</td>
<td>-47.70</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>14.167 1.58 1.58</td>
<td>-91.28</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>14.333 1.58 1.58</td>
<td>-91.28</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15.000 1.58 1.58</td>
<td>-91.28</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0.000 1.58 1.58</td>
<td>-91.28</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.667 1.58 1.58</td>
<td>-91.28</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.668 1.58 1.58</td>
<td>-91.28</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.012 0.79 1.58</td>
<td>-47.70</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.226 0.79 1.58</td>
<td>-47.70</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4.571 0.00 1.58</td>
<td>0.00</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>7.200 0.00 1.58</td>
<td>0.00</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>10.000 0.00 1.58</td>
<td>0.00</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>12.800 0.00 1.58</td>
<td>0.00</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15.180 0.00 1.58</td>
<td>0.00</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>16.699 0.79 1.58</td>
<td>-47.70</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>17.813 0.79 1.58</td>
<td>-47.70</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>19.333 1.58 1.58</td>
<td>-91.28</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>19.333 1.58 1.58</td>
<td>-91.28</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>20.000 1.58 1.58</td>
<td>-91.28</td>
<td>91.28</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

# Longitudinal Beam Shear Reinforcement Required  

**Units:** d (in), Start, End, Yu (ft), PhlVo, Yu (kip), Av/s (in²/ft)  
<table>
<thead>
<tr>
<th>Span</th>
<th>d</th>
<th>PhlVo</th>
<th>Start</th>
<th>End</th>
<th>Yu</th>
<th>kip</th>
<th>Av/s</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>14.00</td>
<td>15.94</td>
<td>1.833</td>
<td>4.881</td>
<td>22.99</td>
<td>1.833</td>
<td>0.0112</td>
</tr>
<tr>
<td></td>
<td>4.881</td>
<td>7.929</td>
<td>16.53</td>
<td>4.881</td>
<td>0.0100</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>7.929</td>
<td>10.976</td>
<td>10.07</td>
<td>7.929</td>
<td>0.0100</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>10.976</td>
<td>14.024</td>
<td>3.61</td>
<td>10.976</td>
<td>0.0000</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>14.024</td>
<td>17.071</td>
<td>9.41</td>
<td>17.071</td>
<td>0.0100</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>17.071</td>
<td>20.119</td>
<td>15.87</td>
<td>20.119</td>
<td>0.0100</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>20.119</td>
<td>23.167</td>
<td>22.34</td>
<td>23.167</td>
<td>0.0102</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>14.00</td>
<td>15.94</td>
<td>1.833</td>
<td>3.452</td>
<td>12.91</td>
<td>1.833</td>
<td>0.0100</td>
</tr>
<tr>
<td></td>
<td>3.452</td>
<td>5.071</td>
<td>9.47</td>
<td>3.452</td>
<td>0.0100</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5.071</td>
<td>6.690</td>
<td>6.04</td>
<td>5.071</td>
<td>0.0000</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>6.690</td>
<td>8.310</td>
<td>2.61</td>
<td>6.690</td>
<td>0.0000</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.310</td>
<td>9.929</td>
<td>5.12</td>
<td>9.929</td>
<td>0.0000</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Longitudinal Beam Shear Reinforcement Details

Units: spacing & distance (in).
Span Size Stirrups (2 legs each unless otherwise noted)

<table>
<thead>
<tr>
<th>#</th>
<th>Size</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>#8</td>
<td>36.6</td>
</tr>
<tr>
<td>2</td>
<td>#8</td>
<td>58.3</td>
</tr>
<tr>
<td>3</td>
<td>#8</td>
<td>84.0</td>
</tr>
</tbody>
</table>

### Beam Shear Capacity

Units: d, Sp (in), Start, End, Xu (ft), PhiVc, PhiVn, Vu (kip), Av/s (in²/lin)

<table>
<thead>
<tr>
<th>Start</th>
<th>End</th>
<th>Av/s</th>
<th>Sp</th>
<th>PhiVn</th>
<th>Vu</th>
<th>Xu</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.00</td>
<td>15.94</td>
<td>0.000</td>
<td>0.000</td>
<td>0.017</td>
<td>6.9</td>
<td>36.03</td>
</tr>
<tr>
<td>10.97</td>
<td>14.02</td>
<td>0.019</td>
<td>6.9</td>
<td>36.03</td>
<td>22.99</td>
<td>1.833</td>
</tr>
<tr>
<td>14.02</td>
<td>24.08</td>
<td>0.033</td>
<td>6.9</td>
<td>36.03</td>
<td>22.24</td>
<td>13.167</td>
</tr>
<tr>
<td>24.08</td>
<td>25.00</td>
<td>0.033</td>
<td>6.9</td>
<td>36.03</td>
<td>26.22</td>
<td>25.000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Start</th>
<th>End</th>
<th>Av/s</th>
<th>Sp</th>
<th>PhiVn</th>
<th>Vu</th>
<th>Xu</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.00</td>
<td>15.94</td>
<td>0.000</td>
<td>0.000</td>
<td>0.017</td>
<td>6.9</td>
<td>36.03</td>
</tr>
<tr>
<td>10.97</td>
<td>14.02</td>
<td>0.019</td>
<td>6.9</td>
<td>36.03</td>
<td>12.91</td>
<td>1.833</td>
</tr>
<tr>
<td>14.02</td>
<td>24.08</td>
<td>0.033</td>
<td>6.9</td>
<td>36.03</td>
<td>11.98</td>
<td>13.167</td>
</tr>
<tr>
<td>24.08</td>
<td>25.00</td>
<td>0.033</td>
<td>6.9</td>
<td>36.03</td>
<td>15.87</td>
<td>15.000</td>
</tr>
</tbody>
</table>

### Slab Shear Capacity

Units: b, d (in), Xu (ft), PhiVc, Vu (kip)

<table>
<thead>
<tr>
<th>Start</th>
<th>End</th>
<th>Vu</th>
<th>Xu</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.00</td>
<td>15.94</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>10.97</td>
<td>14.02</td>
<td>0.019</td>
<td>6.9</td>
</tr>
<tr>
<td>14.02</td>
<td>24.08</td>
<td>0.033</td>
<td>6.9</td>
</tr>
<tr>
<td>24.08</td>
<td>25.00</td>
<td>0.033</td>
<td>6.9</td>
</tr>
</tbody>
</table>

### Deflections

**Section properties**

Units: Ig, Ior, Ie (in⁴), Mocr, Mmax (k-ft)

<table>
<thead>
<tr>
<th>Span</th>
<th>Dead</th>
<th>Dead+Live Zone</th>
<th>Ig</th>
<th>Ior</th>
<th>Mocr</th>
<th>Mmax</th>
<th>Load Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1465</td>
<td>1537 Midspan</td>
<td>4096</td>
<td>1442</td>
<td>20.24</td>
<td>44.81</td>
<td>1687</td>
</tr>
<tr>
<td>2</td>
<td>3859</td>
<td>3538 Left</td>
<td>4096</td>
<td>1442</td>
<td>20.24</td>
<td>-59.62</td>
<td>1546</td>
</tr>
<tr>
<td>3</td>
<td>2192</td>
<td>1761 Left</td>
<td>4096</td>
<td>1442</td>
<td>20.24</td>
<td>15.11</td>
<td>4096</td>
</tr>
</tbody>
</table>

### Maximum Instantaneous Deflections

Units: D (in)

<table>
<thead>
<tr>
<th>Span</th>
<th>Dead</th>
<th>Dlive</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.370</td>
<td>0.525</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0.009</td>
<td>0.013</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0.121</td>
<td>0.131</td>
<td></td>
</tr>
</tbody>
</table>

### Maximum Long-term Deflections

Time dependent factor for sustained loads = 2.000

<table>
<thead>
<tr>
<th>Span</th>
<th>D (in)</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.370</td>
<td>0.740</td>
</tr>
<tr>
<td>2</td>
<td>0.009</td>
<td>0.018</td>
</tr>
<tr>
<td>3</td>
<td>0.121</td>
<td>0.243</td>
</tr>
</tbody>
</table>
Reinforcement in the Direction of Analysis

<table>
<thead>
<tr>
<th></th>
<th>Top Bars</th>
<th></th>
<th>Bottom Bars</th>
<th></th>
<th>Stirrups</th>
<th></th>
<th>Total Steel</th>
<th></th>
<th>Concrete</th>
</tr>
</thead>
<tbody>
<tr>
<td>lb</td>
<td>119.7</td>
<td>2.00 lb/ft</td>
<td>1.995 lb/ft²</td>
<td>320.4</td>
<td>5.34 lb/ft</td>
<td>5.340 lb/ft²</td>
<td>542.1</td>
<td>9.04 lb/ft</td>
<td>9.035 lb/ft²</td>
</tr>
<tr>
<td>ft³</td>
<td>0.00</td>
<td>1.33 ft³/ft²</td>
<td>1.333 ft³/ft²</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>
Graphical Output

Loads

CASE/PATTERN: Live/All

CASE Dead

CASE SELF
Internal Forces

![Graph showing internal forces](image-url)
Moment Capacity

LEGEND:
- Envelope Curve
- Capacity Curve
- Support Centerline
- Face of Support

File: C:\Program Files\StructurePoint\spBeam\Examples\Manual\Example 1 - PCA Notes on ACI 318-08 Example 8-2.stb
Project: spSlab\spBeam Manual, Example 1
Frame: PCA Notes on ACI 318-08, Example 8-2
Engineer: StructurePoint
Code: ACI 318-11
Date: 12/22/11
Time: 09:17:45
Shear Capacity
Deflection

LEGEND:
- Dead Load
- Live Load
- Total Deflection

File: C:\Program Files\StructurePoint\spBeam\Examples\Manual\Example 1 - PCA Notes on ACI 318-08 Example 8-2.slb
Project: spSlab\spBeam Manual, Example 1
Frame: PCA Notes on ACI 318-08, Example 8-2
Engineer: StructurePoint
Code: ACI 318-11
Date: 12/22/11
Time: 09:19:58
Reinforcement

Flexural and Transverse Reinforcement
Example 2 Spandrel beam with torsion

Problem description
Design a precast, nonprestressed concrete spandrel beam for combined shear and torsion. Roof members are simply supported on spandrel ledge. Spandrel beams are connected to columns to transfer torsion. Continuity between spandrel beams is not provided. This example refers to Example 13-1 from PCA Notes on ACI 318-08 Building Code Requirements for Structural Concrete, Portland Cement Association, 2008.

Design Criteria:
Live load = 30 lb/ft²
Dead load = 90 lb/ft³ (double tee + topping + insulation + roofing)
$f_c' = 5000$ psi ($w_c = 150$ pcf)
$f_y = 60,000$ psi

Roof members are 10 ft wide double tee units, 30 in. deep with 2 in. topping. Design of these units is not included in this design example. For lateral support, alternate ends of roof members are fixed to supporting beams.
Preparing Input

1. From the Input menu, select General Information. A dialog box appears.
   - In the LABELS section, input the names of the project, frame, and engineer.
   - In the FRAME section, input 2 for NO OF SUPPORTS.
   - In the FLOOR SYSTEM section, click the radial button next to ONE WAY / BEAM.
   - Leave all other options in the General Information tab to their default settings of ACI 318-11 design code, ASTM A615 reinforcement, and DESIGN run mode option.
   - In the Solve Options tab, click the check box next to TORSION ANALYSIS AND DESIGN.
   - Under TORSION TYPE, click the radial button next to EQUILIBRIUM.
   - Under the heading STIRRUPS IN FLANGES, click the radial button next to YES.
   - Press OK.

2. From the Input menu, select Material Properties. A dialog box appears.
   - Input 5 for Comp. strength for both Slabs and Beams and Columns.
• Press OK.

3. From the **Input** menu, select **Spans**. A dialog box appears.
   - Under the **Slabs/Flanges** tab, input 40 for **LENGTH**, 16 for **THICKNESS**, and 0.667 for **WIDTH LEFT** and 1.333 **WIDTH RIGHT**. Press **MODIFY**.
   - Select the **Longitudinal Beams** tab. Input 16 for **WIDTH** and 48 for **DEPTH**. Press **MODIFY**.
   - Press OK.

4. From the **Input** menu, select **Supports**. A dialog box appears.
   - Under the **Columns** tab, input 0 for **STIFFNESS SHARE %**.
   - Next, input 16 for both the c1 and c2 values in both the **ABOVE** and **BELOW** rows. Press **MODIFY**. (Note: the default **HEIGHT ABOVE** and **HEIGHT BELOW** values of 10 are correct.)
   - Press **COPY**. Press the **CHECK ALL** button. Press **OK**.
   - Press **OK** again.
5. From the **Input** menu, select **Reinforcement**. A dialog box appears.
   - Under the **Slabs and Ribs** tab, change the **CLEAR COVER** for both **TOP** and **BOTTOM BARS** to 1.75.
   - Under the **Beams** tab, change the **CLEAR COVER** for both **TOP** and **BOTTOM BARS** again to 1.75.
   - Use the drop down arrow for **MINIMUM STIRRUP BAR SIZE** to select #4.
   - Press OK.

6. From the **Input** menu, select **Load Cases**. A dialog box appears.
   - Since we are not considering lateral forces, click on **WIND** in the **LABEL** column on the list in the bottom half of the **LOAD CASES** dialog box and press the **DELETE** button.
   - Click on **EQ** in the **LABEL** column and press the **DELETE** button.
   - Press OK.
7. From the **Input** menu, select **Load Combinations**. A dialog box appears.
   - Delete all the load combinations by clicking anywhere on the list in the bottom half of the LOAD COMBINATIONS dialog box and pressing the DELETE button. Repeat this procedure until all the load combinations are gone.
   - Input 0 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE field. Press ADD.
   - Press Ok.

8. From the **Input** menu, select **Span Loads**. A dialog box appears.
   - Press the drop down arrow next to **Type**, and select **LINE LOAD**.
   - Input 4080 for both the START and END MAGNITUDE. (Note: this value was obtained by converting the area loads on the roof and the beam’s self weight into line loads.)
   
   \[
   \text{Dead Load} = \text{Superimposed Load} + \text{Self Weight of Spandrel Beam} = \left(90 \text{ psf} \times \frac{70 \text{ ft}}{2}\right) + \left[(1.33 \text{ ft} \times 4.00 \text{ ft}) + (1.33 \text{ ft} \times 0.67 \text{ ft})\right] \times 150 \text{pcf} = 0.93 \text{kip/ft}
   \]
   - Input 40 for the END LOCATION. Press ADD.
   - Critical section for torsion is at the face of the support because of concentrated torques applied by the double tee stems at a distance less than d from the face of the support. The critical section for shear is also at the face of support because the load on the spandrel beam is not applied close to the top of the member and because the concentrated forces transferred by the double tee stems are at a distance less than d from the face of support. A small dummy load of 0.001 kips at the face of support is therefore introduced in order to move the critical section for shear from the default location of d away from the support to the face of the support.
   - Use the drop down arrow next to **Type**, and select **POINT FORCE**.
Input 0.001 for the MAGNITUDE and 0.667 for the LOCATION. Press ADD.

Use the drop down arrow next to TYPE, and select POINT FORCE.

Input 0.001 for the MAGNITUDE and 39.333 for the LOCATION. Press ADD.

Use the drop down arrow next to TYPE, and select LINE TORQUE.

Input 3.15 for both the START and END MAGNITUDE. (Note: this value was obtained by multiplying the superimposed line load by the moment arm of 12 in.)

\[
\text{Torsion Line Load (Dead)} = \left(90 \text{ psf} \times \frac{70 \text{ ft}}{2}\right) \times \frac{12 \text{ in}}{12 \text{ in/ft}} = 3.15 \text{kip} \cdot \text{ft/ft}
\]

Keep the END LOCATION of 40 and press ADD.

9. In the top left corner of the SPAN LOADS dialog box, there is a section called CURRENT CASE. Click on LIVE.

Use the drop down arrow next to TYPE to select LINE LOAD.

Input 1050 for both the START and END MAGNITUDE. (Note: this value was obtained by converting the area loads on the roof to line loads on the beam.)

\[
\text{Live Load} = 30 \text{ psf} \times \left(\frac{70 \text{ ft}}{2}\right) = 1050 \text{lb/ft}
\]

Input 40 for the END LOCATION. Press ADD.

Use the drop down arrow next to TYPE, and select LINE TORQUE.

Input 1.05 for both the START and END MAGNITUDE. (Note: this value was obtained by multiplying the live line load by the moment arm of 12 in.)

\[
\left[30 \text{ psf} \times \left(\frac{70 \text{ ft}}{2}\right)\right] \times \frac{12 \text{ in}}{12 \text{ in}/\text{ft}} = 1.05 \text{kip} \cdot \text{ft/ft}
\]

Input 40 for the END LOCATION. Press ADD.

Press OK.
10. From the **Solve** menu, select **Execute**. Press **CLOSE**.
11. From the **Solve** menu, select **Results Report**.
   - Use the scroll bars to scroll through the results file.
   - Use the ARROW keys or the mouse wheel to browse through different parts of the results quickly. Press the **CLOSE** button to close the RESULTS REPORT dialog box and return to spBeam.
12. To view diagrams, select **Loads**, **Internal Forces**, **Moment Capacity**, **Shear Capacity**, **Deflection**, or **Reinforcement** from the **View** menu. Right click in any of these diagrams to get new copy, printing, or display options.
13. You may print the results file by selecting **Print Results** from the **File** menu. To print any of the diagrams you selected to view, use the **Print Preview** command found by right clicking in the diagram’s window. After viewing the results, you may decide to investigate the input beams under the same loads but with a modified reinforcement configuration.
14. From the **Input** menu, select **General Information**. In the **General Information** dialog box change the **RUN MODE** option to **INVESTIGATION**. Do not change any of the other options. Press **OK**
15. From the **Input** menu, select the different commands under **Reinforcement Criteria** and **Reinforcing Bars** to modify the reinforcement configuration computed by the program.
16. Repeat steps 10 and subsequent to perform the investigation and view the results.
**Text Output**

spBeam v3.50 © StructurePoint 12-22-2011, 10:49:51 AM
Licensed to: StructurePoint, License ID: 00000-0000000-4-2A05D-2C8D0
C:\Program Files\StructurePoint\spBeam\Examples\Manual\Example 2 - PCA Notes on ACI 318-08 Example 13-1.slb Page 1

A Computer Program for Analysis, Design, and Investigation of Reinforced Concrete Beams and One-way Slab Systems
Copyright © 1992-2011, STRUCTUREPOINT, LLC
All rights reserved

Licensee stated above acknowledges that STRUCTUREPOINT (SP) is not and cannot be responsible for either the accuracy or adequacy of the material supplied as input for processing by the spBeam computer program. Furthermore, STRUCTUREPOINT neither makes any warranty expressed nor implied with respect to the correctness of the output prepared by the spBeam program. Although STRUCTUREPOINT has endeavored to produce spBeam error free the program is not and cannot be certified infallible. The final and only responsibility for analysis, design and engineering documents is the licensee's. Accordingly, STRUCTUREPOINT disclaims all responsibility in contract, negligence or other tort for any analysis, design or engineering documents prepared in connection with the use of the spBeam program.

[Table]

<table>
<thead>
<tr>
<th>Slabs/Beams</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>( w_0 ) =</td>
<td>150</td>
</tr>
<tr>
<td>( f'c ) =</td>
<td>5</td>
</tr>
<tr>
<td>( E_c ) =</td>
<td>4286.8</td>
</tr>
<tr>
<td>( f_{y} ) =</td>
<td>60 ksi</td>
</tr>
<tr>
<td>( f_{y} ) =</td>
<td>60 ksi</td>
</tr>
<tr>
<td>( E_s ) =</td>
<td>29000 ksi</td>
</tr>
</tbody>
</table>

**Material Properties**

<table>
<thead>
<tr>
<th>Units: Db (in), Ab (in^2), Wb (lb/in)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>9</td>
</tr>
<tr>
<td>11</td>
</tr>
<tr>
<td>18</td>
</tr>
</tbody>
</table>

Examples
Span Data

<table>
<thead>
<tr>
<th>Span Loc</th>
<th>L1</th>
<th>t</th>
<th>wL</th>
<th>wR</th>
<th>Min</th>
</tr>
</thead>
<tbody>
<tr>
<td>Int 1</td>
<td>40.00</td>
<td>16.00</td>
<td>16.00</td>
<td>0.667</td>
<td>1.333</td>
</tr>
</tbody>
</table>

Rib and Longitudinal Beams

<table>
<thead>
<tr>
<th>Span</th>
<th>b</th>
<th>h</th>
<th>Sp</th>
<th>Beams</th>
<th>Span</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>16.00</td>
<td>48.00</td>
</tr>
</tbody>
</table>

Support Data

<table>
<thead>
<tr>
<th>Supp</th>
<th>cLs</th>
<th>cLa</th>
<th>cLb</th>
<th>ccb</th>
<th>MB</th>
<th>Re?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>16.00</td>
<td>16.00</td>
<td>16.00</td>
<td>10.00</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>16.00</td>
<td>16.00</td>
<td>16.00</td>
<td>10.00</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Boundary Conditions

<table>
<thead>
<tr>
<th>Supp</th>
<th>kip/in)</th>
<th>kly (kip/ft)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>Fixed</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

Load Data

<table>
<thead>
<tr>
<th>Case/Patt Span</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELF</td>
<td>1</td>
</tr>
</tbody>
</table>

Line Loads

<table>
<thead>
<tr>
<th>Case/Patt Span</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELF</td>
<td>1</td>
</tr>
</tbody>
</table>

Point Forces

<table>
<thead>
<tr>
<th>Case/Patt Span</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELF</td>
<td>1</td>
</tr>
</tbody>
</table>

Line Torque

<table>
<thead>
<tr>
<th>Case/Patt Span</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELF</td>
<td>1</td>
</tr>
</tbody>
</table>

Reinforcement Criteria
Slabs and Ribs

<table>
<thead>
<tr>
<th>Bar Size</th>
<th>Min</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>$</td>
<td>$</td>
<td>$</td>
</tr>
</tbody>
</table>

Bar spacing 1.00 18.00 1.00 18.00 in

There is NOT more than 12 in of concrete below top bars.

Beams

<table>
<thead>
<tr>
<th>Bar Size</th>
<th>Min</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>$</td>
<td>$</td>
<td>$</td>
</tr>
</tbody>
</table>

Bar spacing 1.00 18.00 1.00 18.00 6.00 18.00 in

There is NOT more than 12 in of concrete below top bars.

[2] DESIGN RESULTS

Top Reinforcement

<table>
<thead>
<tr>
<th>Span Zone</th>
<th>Width</th>
<th>Min</th>
<th>Max</th>
<th>Xmax</th>
<th>As(\text{in}^2)</th>
<th>Sp(\text{in})</th>
<th>Bars</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Left</td>
<td>2.00</td>
<td>0.00</td>
<td>0.667</td>
<td>0.00</td>
<td>15.619</td>
<td>0.000</td>
<td>0.000---</td>
</tr>
<tr>
<td>Midspan</td>
<td>2.00</td>
<td>0.00</td>
<td>20.000</td>
<td>0.00</td>
<td>25.619</td>
<td>0.000</td>
<td>0.000---</td>
</tr>
<tr>
<td>Right</td>
<td>2.00</td>
<td>0.00</td>
<td>39.333</td>
<td>0.00</td>
<td>39.619</td>
<td>0.000</td>
<td>0.000---</td>
</tr>
</tbody>
</table>

Top Bar Details

<table>
<thead>
<tr>
<th>Units:</th>
<th>Length (ft)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>Continuous</td>
</tr>
<tr>
<td>Right</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Span</th>
<th>Bars</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Bottom Reinforcement

<table>
<thead>
<tr>
<th>Span Zone</th>
<th>Width</th>
<th>Xmax</th>
<th>As(\text{in}^2)</th>
<th>Sp(\text{in})</th>
<th>Bars</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Bottom Bar Details

<table>
<thead>
<tr>
<th>Units:</th>
<th>Start (ft), Length (ft)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long Bars</td>
<td>Short Bars</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Span</th>
<th>Bars</th>
<th>Start Length</th>
<th>End Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>6-#11</td>
<td>0.00</td>
<td>40.00</td>
</tr>
</tbody>
</table>

Flexural Capacity

<table>
<thead>
<tr>
<th>Units: $x$ (ft), As (\text{in}^2), \phiLM-\phiLM*</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

Longitudinal Beam Shear And Torsion Reinforcement Required

<table>
<thead>
<tr>
<th>Section properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Span</th>
<th>Acp</th>
<th>d</th>
<th>Acp</th>
<th>ph</th>
<th>Acp</th>
<th>ph</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>6-#11</td>
<td>142.00</td>
<td>132.00</td>
<td>896.000</td>
<td>899.000</td>
<td>585.650</td>
</tr>
</tbody>
</table>
### Required transverse reinforcement

**Units:** Start, End, $X_u$ (ft), $Y_u$ (kip), $T_u$ (k-ft), $v_f$ (ksi)

<table>
<thead>
<tr>
<th>Span</th>
<th>Start</th>
<th>End</th>
<th>$X_u$</th>
<th>$Y_u$</th>
<th>$T_u$</th>
<th>$v_f$</th>
<th>$X_u$ Comb/Patt</th>
<th>$A_v/s$</th>
<th>$A_y/s$</th>
<th>$A_v/s$ ($A_y/s$)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.687</td>
<td>6.190</td>
<td>148.79</td>
<td>108.65</td>
<td>0.298</td>
<td>0.67</td>
<td>U2/All</td>
<td>0.0362</td>
<td>0.0247</td>
<td>0.0857</td>
</tr>
<tr>
<td>6.190</td>
<td>11.714</td>
<td>106.28</td>
<td>77.61</td>
<td>0.213</td>
<td>6.19</td>
<td>U2/All</td>
<td>0.0151</td>
<td>0.0177</td>
<td>0.0054</td>
<td></td>
</tr>
<tr>
<td>11.714</td>
<td>17.238</td>
<td>63.77</td>
<td>46.56</td>
<td>0.128</td>
<td>11.71</td>
<td>U2/All</td>
<td>0.0000</td>
<td>0.0126</td>
<td>0.0212</td>
<td></td>
</tr>
<tr>
<td>17.238</td>
<td>22.762</td>
<td>21.26</td>
<td>15.52</td>
<td>0.043</td>
<td>17.24</td>
<td>U2/All</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>22.762</td>
<td>28.286</td>
<td>63.77</td>
<td>46.56</td>
<td>0.128</td>
<td>28.29</td>
<td>U2/All</td>
<td>0.0000</td>
<td>0.0106</td>
<td>0.0212</td>
<td></td>
</tr>
<tr>
<td>28.286</td>
<td>33.810</td>
<td>106.28</td>
<td>77.61</td>
<td>0.213</td>
<td>33.81</td>
<td>U2/All</td>
<td>0.0151</td>
<td>0.0177</td>
<td>0.0054</td>
<td></td>
</tr>
<tr>
<td>33.810</td>
<td>39.333</td>
<td>148.79</td>
<td>108.65</td>
<td>0.298</td>
<td>39.33</td>
<td>U2/All</td>
<td>0.0362</td>
<td>0.0247</td>
<td>0.0857</td>
<td></td>
</tr>
</tbody>
</table>

**NOTES:**
- *2* - Torsion ignored ($T_u < \Phi_{T/4}$).
- *5* - Minimum longitudinal reinforcement required.

### Required longitudinal reinforcement

**Units:** Start, End, $X_u$ (ft), $Y_u$ (kip), $T_u$ (k-ft), $A_1$ (in²)

<table>
<thead>
<tr>
<th>Span</th>
<th>Start</th>
<th>End</th>
<th>$X_u$</th>
<th>$Y_u$</th>
<th>$T_u$</th>
<th>$A_1$</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.687</td>
<td>6.190</td>
<td>148.79</td>
<td>108.65</td>
<td>0.67</td>
<td>3.265</td>
</tr>
<tr>
<td>6.190</td>
<td>11.714</td>
<td>106.28</td>
<td>77.61</td>
<td>0.213</td>
<td>6.19</td>
<td>U2/All</td>
</tr>
<tr>
<td>11.714</td>
<td>17.238</td>
<td>63.77</td>
<td>46.56</td>
<td>0.128</td>
<td>11.71</td>
<td>U2/All</td>
</tr>
<tr>
<td>17.238</td>
<td>22.762</td>
<td>21.26</td>
<td>15.52</td>
<td>0.043</td>
<td>17.24</td>
<td>U2/All</td>
</tr>
<tr>
<td>22.762</td>
<td>28.286</td>
<td>63.77</td>
<td>46.56</td>
<td>0.128</td>
<td>28.29</td>
<td>U2/All</td>
</tr>
<tr>
<td>28.286</td>
<td>33.810</td>
<td>106.28</td>
<td>77.61</td>
<td>0.213</td>
<td>33.81</td>
<td>U2/All</td>
</tr>
<tr>
<td>33.810</td>
<td>39.333</td>
<td>148.79</td>
<td>108.65</td>
<td>0.298</td>
<td>39.33</td>
<td>U2/All</td>
</tr>
</tbody>
</table>

**NOTES:**
- *2* - Torsion ignored ($T_u < \Phi_{T/4}$).
- *5* - Minimum longitudinal reinforcement required.

### Longitudinal Beam Shear Reinforcement Details

**Units:** spacing & distance (in).

<table>
<thead>
<tr>
<th>Span</th>
<th>Bars</th>
<th>Start Length</th>
<th>Bars</th>
<th>Start Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>

### Longitudinal Torsional Reinforcement Details

**Units:** $X_u$ (ft), $Y_u$ (kip), $A_1$ (in²)

### Beam Shear And Torsion Capacity

**Section properties**

### Beam shear and torsion reinforcement capacity in terms of provided and required area

<table>
<thead>
<tr>
<th>Span</th>
<th>Start</th>
<th>End</th>
<th>$A_v$ (2s)</th>
<th>$A_y$ (2s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.000</td>
<td>0.917</td>
<td>0.000</td>
<td>0.0389</td>
</tr>
<tr>
<td>0.917</td>
<td>6.190</td>
<td>0.600</td>
<td>6.66</td>
<td>0.0901</td>
</tr>
<tr>
<td>6.190</td>
<td>11.714</td>
<td>0.400</td>
<td>7.37</td>
<td>0.0543</td>
</tr>
<tr>
<td>11.714</td>
<td>17.238</td>
<td>0.400</td>
<td>11.05</td>
<td>0.0362</td>
</tr>
<tr>
<td>15.747</td>
<td>22.762</td>
<td>0.400</td>
<td>15.75</td>
<td>0.0326</td>
</tr>
<tr>
<td>22.762</td>
<td>28.286</td>
<td>0.400</td>
<td>24.25</td>
<td>0.0326</td>
</tr>
<tr>
<td>28.286</td>
<td>33.810</td>
<td>0.400</td>
<td>33.81</td>
<td>0.0543</td>
</tr>
<tr>
<td>33.810</td>
<td>39.333</td>
<td>0.600</td>
<td>40.00</td>
<td>0.0389</td>
</tr>
</tbody>
</table>

**NOTES:**
- *2* - Torsion ignored ($T_u < \Phi_{T/4}$).

### Beam torsion longitudinal reinforcement capacity in terms of provided and required area

<table>
<thead>
<tr>
<th>Span</th>
<th>Start</th>
<th>End</th>
<th>$A_v$ (2s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.000</td>
<td>0.917</td>
<td>0.000</td>
</tr>
<tr>
<td>0.917</td>
<td>6.190</td>
<td>0.600</td>
<td>6.66</td>
</tr>
<tr>
<td>6.190</td>
<td>11.714</td>
<td>0.400</td>
<td>7.37</td>
</tr>
<tr>
<td>11.714</td>
<td>17.238</td>
<td>0.400</td>
<td>11.05</td>
</tr>
<tr>
<td>17.238</td>
<td>22.762</td>
<td>0.400</td>
<td>17.24</td>
</tr>
<tr>
<td>22.762</td>
<td>28.286</td>
<td>0.400</td>
<td>22.76</td>
</tr>
<tr>
<td>28.286</td>
<td>33.810</td>
<td>0.400</td>
<td>28.28</td>
</tr>
<tr>
<td>33.810</td>
<td>39.333</td>
<td>0.600</td>
<td>33.81</td>
</tr>
<tr>
<td>39.333</td>
<td>44.740</td>
<td>44.740</td>
<td>44.74</td>
</tr>
</tbody>
</table>

**NOTES:**
- *2* - Torsion ignored ($T_u < \Phi_{T/4}$).
Slab Shear Capacity

Units: b, d (in), X, (ft), \( \Phi \), V, Vu (kip)

Span | b | d | Vratio | \( \Phi \) | V | Vu
-----|---|---|--------|-------|---|---
1 | 0.000 | 0.917 | 0.00 | 112.40 | UZ/All | 3.378
0.917 | 6.190 | 5.280 | 0.92 | 107.25 | UZ/All | 3.232
6.190 | 11.714 | 5.280 | 11.71 | 46.56 | UZ/All | 3.880 *5
11.714 | 15.747 | 5.280 | 14.97 | 29.25 | UZ/All | 4.400 *5
15.747 | 17.338 | 15.75 | 15.75 | 23.90 | UZ/All | 0.000 *2
17.338 | 22.762 | 17.24 | 15.52 | 0.000 | UZ/All | 0.000 *2
22.762 | 24.753 | 22.76 | 15.52 | UZ/All | 0.000 *2
24.753 | 28.286 | 5.280 | 24.64 | 26.08 | UZ/All | 4.400 *5
28.286 | 33.810 | 5.280 | 28.29 | 46.96 | UZ/All | 3.990 *5
33.810 | 39.083 | 5.280 | 39.08 | 107.25 | UZ/All | 3.232
39.083 | 40.00 | 40.00 | 112.40 | UZ/All | 3.378

Notes:
*2 - Torsion ignored (\( \Phi \) < \( \Phi \)Tur/4).
*5 - Minimum longitudinal reinforcement required.

Reflections

Section properties

<table>
<thead>
<tr>
<th>Span</th>
<th>Dead</th>
<th>Dead+Live</th>
<th>Zone</th>
<th>Ig</th>
<th>Ic</th>
<th>Mmax</th>
<th>Mmax</th>
<th>Ie,avg</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>83961</td>
<td>82835</td>
<td>Midspan</td>
<td>178274</td>
<td>81372</td>
<td>299.73</td>
<td>1002.67</td>
<td>83961</td>
</tr>
</tbody>
</table>

Maximum Instantaneous Deflections

Units: D (in)

<table>
<thead>
<tr>
<th>Span</th>
<th>Ddead</th>
<th>Dlive</th>
<th>Dtotal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.802</td>
<td>0.181</td>
<td>0.983</td>
</tr>
</tbody>
</table>

Maximum Long-term Deflections

Time dependent factor for sustained loads = 2.000

Units: D (in)

<table>
<thead>
<tr>
<th>Span</th>
<th>( \Delta )w</th>
<th>( \Delta )s-w</th>
<th>Dtotal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.002</td>
<td>2.000</td>
<td>1.604</td>
</tr>
</tbody>
</table>

Material Takeoff

Reinforcement in the Direction of Analysis

Top Bars: 0.0 lb || 0.00 lb/ft || 0.000 lb/ft^2
Bottom Bars: 1275.1 lb || 31.88 lb/ft || 15.939 lb/ft^2
Torsion Bars: 620.9 lb || 15.52 lb/ft || 7.761 lb/ft^2
Stirrups: 387.4 lb || 9.63 lb/ft || 4.843 lb/ft^2
Total Steel: 2283.4 lb || 57.05 lb/ft || 28.543 lb/ft^2
Concrete: 623.9 ft^3/ft || 6.22 ft^3/ft || 3.111 ft^3/ft^2
Graphical Output

Loads

CASE/PATTERN: Live/All

CASE: Dead

CASE: SELF

spBeam v3.50. Licensed to: StructurePoint License ID: 00000-00000-00-4-2A05D-2C0D0

File: C:\Program Files\StructurePoint\spBeam\Examples\Manual\Example 2 - PCA Notes on ACI 318-08 Example 13-1.stb

Project: spSlab\spBeam Manual, Example 2

Frame: PCA Notes on ACI 318-08, Example 13-1

Engineer: StructurePoint

Code: ACI 318-11

Date: 12/22/11

Time: 09:21:47
Internal Forces

![Internal Forces Diagram]

LEGEND:
- Envelope
Moment Capacity
Shear Capacity

Beam Shear and Torsion Capacity: Stirrup Intensity, in²/ln

Beam Shear and Torsion Capacity: Longitudinal Bar Area, in²

LEGEND:
- Demand - (A×+2A/s)
- Demand - A/s
- Demand - A/v
- Demand - A/l
- Provided - (A×+2A/s)
- Provided - A/s
- Provided - A/v
- Face of Support
- Critical Section

spBeam v3.50. Licensed to: StructurePoint License ID: 00000-000000-00-2A05D-2C8D0

File: C:\Program Files\StructurePoint\spBeam\Examples\Manual\Example 2 - PCA Notes on ACI 318-08 Example 13-1.stb
Project: spSlab\spBeam Manual, Example 2
Frame: PCA Notes on ACI 318-08, Example 13-1
Engineer: StructurePoint
Code: ACI 318-11
Date: 12/22/11
Time: 09:23:20
Deflection

File: C:\Program Files\StructurePoint\spBeam\Examples\Manual\Example 2 - PCA Notes on ACI 318-08 Example 13-1.stb
Project: spSlab\spBeam Manual, Example 2
Frame: PCA Notes on ACI 318-08, Example 13-1
Engineer: StructurePoint
Code: ACI 318-11
Date: 12/22/11
Time: 09:23:49
Reinforcement

Flexural and Transverse Reinforcement
Example 3 Design of a Continuous Beam

Problem description

The system shown in the following figure consists of five spans symmetric about the centerline. We will be designing beam ABCD assuming that the other half of the beam will be loaded and designed the same way. All beams have a width of 12 in. and a depth of 22 in. – including the 5 in. thick deck. Span length and widths are shown in the figure. Columns have a 12 in. × 12 in. cross-section and a length equal to a typical story height of 13 ft. The system will be analyzed and designed under a uniform live load of 130 psf and a dead load that consists of the slab system’s own weight plus 80 psf. Use $f' _c = 4\text{ ksi}$, $f_y = 60\text{ ksi}$, and $\gamma_{\text{concrete}} = 150 \text{ pcf}$. This example refers to example 16.1 from *Structural Concrete: Theory and Design* by Hassoun and Al-Manaseer, Third Edition, 2008.

Preparing Input

1. From the Input menu, select General Information. A dialog box appears.
   - In the LABELS section, input the names of the project, frame, and engineer.
   - In the FRAME section, input 6 for NO OF SUPPORTS as the spBeam models the entire continuous beam.
   - In the FLOOR SYSTEM section, click the radial button next to ONE-WAY / BEAM.
   - Leave all other options in the General Information tab to their default settings of ACI 318-11 design code, ASTM A615 reinforcement, and DESIGN run mode option.
   - In the Solve Options tab, keep the default settings. Press OK.
2. Nothing needs to be changed in the **Material Properties** menu.

3. From the **Input** menu, select **Spans**. A dialog box appears.
   - Under the **Slabs/Flanges** tab, input 24 for **LENGTH**, 5 for **THICKNESS**, and 0 for **WIDTH LEFT** and **WIDTH RIGHT**. Press **MODIFY**. (Note: Since the slab has no width, we must convert the area loads to line loads along the beam and also add the self-weight of the slab to the dead load. This calculation will be shown in Step 8.)
   - Press **COPY**. Select the check box next to Span 5. Press **OK**. This will give Span 5 the same geometry as Span 1.
   - Press the drop down arrow next to **SPAN** and select Span 2. Input 26 for **LENGTH**, 5 for **THICKNESS**, and 0 for **WIDTH LEFT** and **WIDTH RIGHT**. Press **MODIFY**.
   - Press **COPY**. Unselect the check box next to Span 1 and select the check boxes next to Spans 3 and 4. Press **OK**.
   - Select the **Longitudinal Beams** tab. Input 12 for **WIDTH** and 22 for **DEPTH**. Press **MODIFY**.
   - Press **COPY**. Press the **CHECK ALL** button. Press **OK**.
   - Press **OK** again.
4. From the **Input** menu, select **Supports**. A dialog box appears.
   - Under the **Columns** tab, input 13 for both **HEIGHT ABOVE** and **HEIGHT BELOW**. Press MODIFY. (Note: the default c1 and c2 values for both the column above and below the support can be left alone since all the columns’ cross sections are 12 in. × 12 in.)
   - Press COPY. Press the CHECK ALL button. Press OK.
   - Press Ok again.

5. From the **Input** menu, select **Reinforcement Criteria**. A dialog box appears.
   - Under the **Beams** tab, use the drop down arrows to change both the **MIN** and **MAX BAR SIZE** for **TOP BARS** to #9.
   - Use the drop down arrows to change both the **MIN** and **MAX BAR SIZE** for **BOTTOM BARS** to #8. Press OK.
6. From the Input menu, select Load Cases. A dialog box appears.
   - Since we are not considering lateral forces, click on WIND in the LABEL column on the list in the bottom half of the LOAD CASES dialog box and press the DELETE button.
   - Click on EQ in the LABEL column and press the DELETE button. Press OK.

7. From the Input menu, select Load Combinations. A dialog box appears.
   - Delete all the load combinations by clicking anywhere on the list in the bottom half of the LOAD COMBINATIONS dialog box and pressing the DELETE button. Repeat this procedure until all the load combinations are gone.
   - Input 1.2 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE field. Press ADD.
   - Press OK.

• Press the drop down arrow next to TYPE, and select LINE LOAD.

• Input 1647.5 for both the START and END MAGNITUDE. (Note: This value was obtained by converting the area loads of the slab’s self weight (without the beam) and superimposed dead load into a line load.)

Dead Load = \[
\left(\frac{\frac{5}{12} \text{ft} \times 150 \text{pcf} \times 12 \text{ft}}{144 \text{in}^2/\text{ft}^2}\right) - \left(\frac{\frac{5\text{in}}{12} \times 12 \text{in} \times \frac{80 \text{psf} \times 12 \text{ft}}{12 \text{ft}} \times \frac{150 \text{pcf}}{12 \text{ft}}\right) = \\
= 1647.5 \text{lb/ft}
\]

• Input 24 for the END LOCATION. Press ADD.

• Click on SPAN 1 on the list in the bottom half of the SPAN LOADS dialog box. Press the COPY button. (Note: there is a CASE COPY button that should not be pressed.)

• Click the check box next to SPAN 5 and press OK.

• Back in the SPAN LOADS dialog box, use the drop down arrow next to SPAN to select SPAN 2. Keep the START and END MAGNITUDES of 1647.5 lb/ft but change the END LOCATION to 26. Click the ADD button.

• Click on SPAN 2 in the list at the bottom half of the SPAN LOADS dialog box. Press the COPY button.

• Click the check boxes next to SPAN 3 and 4. Press OK.

9. In the top left corner of the SPAN LOADS dialog box, there is a section called CURRENT CASE. Click on LIVE.

• Use the drop down arrow next to SPAN to select SPAN 1.

• Making sure that LINE LOAD is still the selected LOAD TYPE, input 1560 for both the START and END MAGNITUDE.

Live Load = (130psf \times 12\text{ft}) = 1560\text{lb/ft}

• Input 24 for the END LOCATION. Press ADD.

• Click on SPAN 1 on the list in the bottom half of the SPAN LOADS dialog box. Press the COPY button. (Note: the CASE COPY button should not be pressed.)

• Click the check box next to SPAN 5 and press OK.

• Back in the SPAN LOADS dialog box, use the drop down arrow next to SPANS to select SPAN 2. Keep the START and END MAGNITUDES of 1560 lb/ft but change the END LOCATION to 26. Click the ADD button.

• Click on SPAN 2 in the list at the bottom half of the SPAN LOADS dialog box. Press the COPY button.
• Click the check boxes next to SPAN 3 AND 4. Press OK.
• Press OK again.

10. From the Solve menu, select Execute. Press CLOSE.
11. From the Solve menu, select Results Report.
   • Use the scroll bars to scroll through the results file.
   • Use the ARROW keys or the mouse wheel to browse through different parts of the results quickly. Press the CLOSE button to close the RESULTS REPORT dialog box and return to spBeam.
12. To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear Capacity, Deflection, or Reinforcement from the View menu. Right click in any of these diagrams to get new copy, printing, or display options.
13. You may print the results file by selecting Print Results from the File menu. To print any of the diagrams you selected to view, use the Print Preview command found by right clicking in the diagram’s window. After viewing the results, you may decide to investigate the input beams under the same loads but with a modified reinforcement configuration.
14. From the Input menu, select General Information. In the General Information dialog box change the RUN MODE option to INVESTIGATION. Do not change any of the other options. Press OK
15. From the Input menu, select the different commands under Reinforcement Criteria and Reinforcing Bars to modify the reinforcement configuration computed by the program.
16. Repeat steps 10 and subsequent to perform the investigation and view the results.
Licensee stated above acknowledges that STRUCTUREPOINT (SP) is not and cannot be responsible for either the accuracy or adequacy of the material supplied as input for processing by the spBeam computer program. Furthermore, STRUCTUREPOINT neither makes any warranty expressed nor implied with respect to the correctness of the output prepared by the spBeam program. Although STRUCTUREPOINT has endeavored to produce spBeam error free the program is not and cannot be certified infallible. The final and only responsibility for analysis, design and engineering documents is the licensee’s. Accordingly, STRUCTUREPOINT disclaims all responsibility in contract, negligence or other tort for any analysis, design or engineering documents prepared in connection with the use of the spBeam program.

[1] INPUT ECHO

General Information

File name: C:\Program Files\StructurePoint\spBeam\Example...\Example 3 - Structural Concrete by Hassoun Example 16.1.slb
Project: spLab/spBeam Manual Example 3
Frame: Structural Concrete by Hassoun and Al-Manaseer, 2008, Ex 16.1
Engineer: StructurePoint
Code: ACI 318-11
Reinforcement Database: ASTM A615
Mode: Design
Number of supports = 6
Floor System: One-Way/Beam

Live load pattern ratio = 100%
Deflections are based on cracked section properties.
In negative moment regions, fy and fcr DO NOT include flange/slab contribution (if available)
Long-term deflections are calculated for load duration of 60 months.
0% of live load is sustained.
Compression reinforcement calculations NOT selected.
Default incremental rebar design selected.
Moment redistribution NOT selected.
Effective flange width calculations NOT selected.
Rigid beam-column joint NOT selected.
Torsion analysis and design NOT selected.

Material Properties

<table>
<thead>
<tr>
<th>Slabs/Beams</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>wc = 150 kg/m³</td>
<td>150 lb/ft³</td>
</tr>
<tr>
<td>f'c = 4 ksi</td>
<td>3 ksi</td>
</tr>
<tr>
<td>E = 0.474 ksi</td>
<td>0.474 ksi</td>
</tr>
<tr>
<td>fyy = 60 ksi</td>
<td>Bars are not epoxy-coated</td>
</tr>
<tr>
<td>fytt = 60 ksi</td>
<td></td>
</tr>
<tr>
<td>Es = 25000 ksi</td>
<td></td>
</tr>
</tbody>
</table>

Reinforcement Database

<table>
<thead>
<tr>
<th>Unit</th>
<th>$D_1$</th>
<th>$D_2$</th>
<th>$D_3$</th>
<th>$W_1$</th>
<th>$W_2$</th>
<th>$W_3$</th>
</tr>
</thead>
<tbody>
<tr>
<td>$S_1$</td>
<td>0.38</td>
<td>0.11</td>
<td>0.38</td>
<td>0.50</td>
<td>0.20</td>
<td>0.67</td>
</tr>
<tr>
<td>$S_2$</td>
<td>0.63</td>
<td>0.31</td>
<td>1.04</td>
<td>0.75</td>
<td>0.44</td>
<td>1.50</td>
</tr>
<tr>
<td>$S_3$</td>
<td>0.88</td>
<td>0.60</td>
<td>2.04</td>
<td>1.00</td>
<td>0.79</td>
<td>2.67</td>
</tr>
<tr>
<td>$S_4$</td>
<td>1.13</td>
<td>1.00</td>
<td>3.40</td>
<td>1.27</td>
<td>1.27</td>
<td>4.10</td>
</tr>
<tr>
<td>$S_5$</td>
<td>1.41</td>
<td>1.56</td>
<td>5.31</td>
<td>1.69</td>
<td>2.25</td>
<td>7.65</td>
</tr>
<tr>
<td>$S_6$</td>
<td>2.26</td>
<td>4.00</td>
<td>13.60</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Span Data
### Slabs

<table>
<thead>
<tr>
<th>Span Loc</th>
<th>Span L</th>
<th>t</th>
<th>Ew</th>
<th>Wr</th>
<th>Hmin</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>24.000</td>
<td>5.00</td>
<td>0.500</td>
<td>0.500</td>
<td>0.00</td>
</tr>
<tr>
<td>2</td>
<td>26.000</td>
<td>5.00</td>
<td>0.500</td>
<td>0.500</td>
<td>0.00</td>
</tr>
<tr>
<td>3</td>
<td>26.000</td>
<td>5.00</td>
<td>0.500</td>
<td>0.500</td>
<td>0.00</td>
</tr>
<tr>
<td>4</td>
<td>26.000</td>
<td>5.00</td>
<td>0.500</td>
<td>0.500</td>
<td>0.00</td>
</tr>
<tr>
<td>5</td>
<td>24.000</td>
<td>5.00</td>
<td>0.500</td>
<td>0.500</td>
<td>0.00</td>
</tr>
</tbody>
</table>

### Ribs and Longitudinal Beams

<table>
<thead>
<tr>
<th>Span</th>
<th>b</th>
<th>h</th>
<th>Sp</th>
<th>Mu (lb-in)</th>
<th>Hu (kip)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>12.00</td>
<td>22.00</td>
</tr>
<tr>
<td>2</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>12.00</td>
<td>22.00</td>
</tr>
<tr>
<td>3</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>12.00</td>
<td>22.00</td>
</tr>
<tr>
<td>4</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>12.00</td>
<td>22.00</td>
</tr>
<tr>
<td>5</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>12.00</td>
<td>22.00</td>
</tr>
</tbody>
</table>

### Support Data

<table>
<thead>
<tr>
<th>Supp</th>
<th>c1a</th>
<th>c2a</th>
<th>c1b</th>
<th>c2b</th>
<th>Ha</th>
<th>Hb (ft)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>12.00</td>
<td>12.00</td>
<td>13.00</td>
<td>12.00</td>
<td>12.00</td>
<td>13.00</td>
</tr>
<tr>
<td>2</td>
<td>12.00</td>
<td>12.00</td>
<td>13.00</td>
<td>12.00</td>
<td>12.00</td>
<td>13.00</td>
</tr>
<tr>
<td>3</td>
<td>12.00</td>
<td>12.00</td>
<td>13.00</td>
<td>12.00</td>
<td>12.00</td>
<td>13.00</td>
</tr>
<tr>
<td>4</td>
<td>12.00</td>
<td>12.00</td>
<td>13.00</td>
<td>12.00</td>
<td>12.00</td>
<td>13.00</td>
</tr>
<tr>
<td>5</td>
<td>12.00</td>
<td>12.00</td>
<td>13.00</td>
<td>12.00</td>
<td>12.00</td>
<td>13.00</td>
</tr>
<tr>
<td>6</td>
<td>12.00</td>
<td>12.00</td>
<td>13.00</td>
<td>12.00</td>
<td>12.00</td>
<td>13.00</td>
</tr>
</tbody>
</table>

### Boundary Conditions

<table>
<thead>
<tr>
<th>Supp</th>
<th>Spring Fs</th>
<th>Spring Key</th>
<th>Par End A</th>
<th>Par End B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>Fixed</td>
<td>Fixed</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>0</td>
<td>Fixed</td>
<td>Fixed</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>Fixed</td>
<td>Fixed</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>0</td>
<td>Fixed</td>
<td>Fixed</td>
</tr>
<tr>
<td>5</td>
<td>0</td>
<td>0</td>
<td>Fixed</td>
<td>Fixed</td>
</tr>
<tr>
<td>6</td>
<td>0</td>
<td>0</td>
<td>Fixed</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

### Load Data

<table>
<thead>
<tr>
<th>Case/Fatt Span</th>
<th>Wa</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELF</td>
<td>62.50</td>
</tr>
<tr>
<td>2</td>
<td>62.50</td>
</tr>
<tr>
<td>3</td>
<td>62.50</td>
</tr>
<tr>
<td>4</td>
<td>62.50</td>
</tr>
<tr>
<td>5</td>
<td>62.50</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Case/Fatt Span</th>
<th>Wa</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELF</td>
<td>212.50</td>
</tr>
<tr>
<td>2</td>
<td>212.50</td>
</tr>
<tr>
<td>3</td>
<td>212.50</td>
</tr>
<tr>
<td>4</td>
<td>212.50</td>
</tr>
<tr>
<td>5</td>
<td>212.50</td>
</tr>
<tr>
<td>Dead</td>
<td>1647.50</td>
</tr>
<tr>
<td>2</td>
<td>1647.50</td>
</tr>
<tr>
<td>3</td>
<td>1647.50</td>
</tr>
<tr>
<td>4</td>
<td>1647.50</td>
</tr>
<tr>
<td>5</td>
<td>1647.50</td>
</tr>
</tbody>
</table>
### Top Reinforcement

**Units:** Width (ft), Max (k-ft), Min (k-ft), As (in²/ft), Sp (in)

<table>
<thead>
<tr>
<th>Span Zone</th>
<th>Width</th>
<th>Max</th>
<th>Min</th>
<th>AsMin</th>
<th>AsMax</th>
<th>AsReq</th>
<th>Sp/Prov</th>
<th>Bars</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 Left</td>
<td>1.00</td>
<td>77.75</td>
<td>500</td>
<td>0.500</td>
<td>0.797</td>
<td>4.321</td>
<td>0.896</td>
<td>6.220</td>
</tr>
<tr>
<td>Midspan</td>
<td>1.00</td>
<td>0.00</td>
<td>12.00</td>
<td>0.000</td>
<td>4.321</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
</tr>
<tr>
<td>Right</td>
<td>1.00</td>
<td>263.45</td>
<td>23.50</td>
<td>0.776</td>
<td>4.206</td>
<td>3.504</td>
<td>3.110</td>
<td>4-#9 2L</td>
</tr>
<tr>
<td>2 Left</td>
<td>1.00</td>
<td>0.00</td>
<td>13.00</td>
<td>0.000</td>
<td>4.321</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
</tr>
<tr>
<td>Midspan</td>
<td>1.00</td>
<td>263.45</td>
<td>25.50</td>
<td>0.776</td>
<td>4.206</td>
<td>3.504</td>
<td>3.110</td>
<td>4-#9 2L</td>
</tr>
<tr>
<td>Right</td>
<td>1.00</td>
<td>263.45</td>
<td>25.50</td>
<td>0.776</td>
<td>4.206</td>
<td>3.504</td>
<td>3.110</td>
<td>4-#9 2L</td>
</tr>
<tr>
<td>3 Left</td>
<td>1.00</td>
<td>263.44</td>
<td>0.500</td>
<td>0.776</td>
<td>4.206</td>
<td>3.504</td>
<td>3.110</td>
<td>4-#9 2L</td>
</tr>
<tr>
<td>Midspan</td>
<td>1.00</td>
<td>0.00</td>
<td>13.00</td>
<td>0.000</td>
<td>4.321</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
</tr>
<tr>
<td>Right</td>
<td>1.00</td>
<td>263.45</td>
<td>25.50</td>
<td>0.776</td>
<td>4.206</td>
<td>3.504</td>
<td>3.110</td>
<td>4-#9 2L</td>
</tr>
<tr>
<td>4 Left</td>
<td>1.00</td>
<td>0.00</td>
<td>13.00</td>
<td>0.000</td>
<td>4.321</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
</tr>
<tr>
<td>Midspan</td>
<td>1.00</td>
<td>263.45</td>
<td>25.50</td>
<td>0.776</td>
<td>4.206</td>
<td>3.504</td>
<td>3.110</td>
<td>4-#9 2L</td>
</tr>
<tr>
<td>Right</td>
<td>1.00</td>
<td>263.45</td>
<td>25.50</td>
<td>0.776</td>
<td>4.206</td>
<td>3.504</td>
<td>3.110</td>
<td>4-#9 2L</td>
</tr>
<tr>
<td>5 Left</td>
<td>1.00</td>
<td>263.44</td>
<td>0.500</td>
<td>0.776</td>
<td>4.206</td>
<td>3.504</td>
<td>3.110</td>
<td>4-#9 2L</td>
</tr>
<tr>
<td>Midspan</td>
<td>1.00</td>
<td>0.00</td>
<td>13.00</td>
<td>0.000</td>
<td>4.321</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
</tr>
<tr>
<td>Right</td>
<td>1.00</td>
<td>263.45</td>
<td>25.50</td>
<td>0.776</td>
<td>4.206</td>
<td>3.504</td>
<td>3.110</td>
<td>4-#9 2L</td>
</tr>
</tbody>
</table>

### Top Bar Details

**Units:** Length (ft)

<table>
<thead>
<tr>
<th>Span</th>
<th>Bars</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-#9</td>
<td>3.91</td>
<td>2.14</td>
</tr>
</tbody>
</table>

---

Examples 6-45
### Bottom Reinforcement

| Units: Width (ft), Min (k-ft), Max (k-ft), A$_s$ (in$^2$), Sp (in) |
|-----------------|-----------------|-----------------|-----------------|-----------------|
| 1               | 1.00            | 183.86          | 11.000          | 0.800           | 4.335           | 2.225           | 3.155           | 3-#8            |
| 2               | 1.00            | 171.61          | 13.250          | 0.800           | 4.335           | 2.063           | 3.155           | 3-#8            |
| 3               | 1.00            | 177.76          | 13.000          | 0.800           | 4.335           | 2.144           | 3.155           | 3-#8            |
| 4               | 1.00            | 171.61          | 12.750          | 0.800           | 4.335           | 2.063           | 3.155           | 3-#8            |
| 5               | 1.00            | 183.86          | 13.000          | 0.800           | 4.335           | 2.225           | 3.155           | 3-#8            |

### Bottom Bar Details

<table>
<thead>
<tr>
<th>Units: Start (ft), Length (ft)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Span</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
</tbody>
</table>

### Flexural Capacity

<table>
<thead>
<tr>
<th>Units: x (ft), A$<em>s$ (in$^2$), Phi$</em>{Min}$ (k-ft)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Span</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>0.500</td>
</tr>
<tr>
<td>0.501</td>
</tr>
<tr>
<td>2.139</td>
</tr>
<tr>
<td>2.273</td>
</tr>
<tr>
<td>2.852</td>
</tr>
<tr>
<td>3.911</td>
</tr>
<tr>
<td>6.380</td>
</tr>
<tr>
<td>8.550</td>
</tr>
<tr>
<td>12.000</td>
</tr>
<tr>
<td>14.383</td>
</tr>
<tr>
<td>15.450</td>
</tr>
<tr>
<td>15.497</td>
</tr>
<tr>
<td>18.688</td>
</tr>
<tr>
<td>19.025</td>
</tr>
<tr>
<td>19.194</td>
</tr>
<tr>
<td>23.499</td>
</tr>
<tr>
<td>23.500</td>
</tr>
<tr>
<td>24.000</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>0.500</td>
</tr>
<tr>
<td>0.501</td>
</tr>
<tr>
<td>4.791</td>
</tr>
<tr>
<td>5.955</td>
</tr>
<tr>
<td>6.977</td>
</tr>
<tr>
<td>9.231</td>
</tr>
<tr>
<td>9.250</td>
</tr>
<tr>
<td>10.367</td>
</tr>
<tr>
<td>13.000</td>
</tr>
<tr>
<td>15.633</td>
</tr>
<tr>
<td>16.750</td>
</tr>
<tr>
<td>17.150</td>
</tr>
<tr>
<td>19.843</td>
</tr>
<tr>
<td>20.422</td>
</tr>
<tr>
<td>21.269</td>
</tr>
<tr>
<td>25.499</td>
</tr>
<tr>
<td>25.500</td>
</tr>
<tr>
<td>26.000</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>Example</td>
</tr>
<tr>
<td>---------</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>11</td>
</tr>
<tr>
<td>12</td>
</tr>
<tr>
<td>13</td>
</tr>
<tr>
<td>14</td>
</tr>
<tr>
<td>15</td>
</tr>
<tr>
<td>16</td>
</tr>
<tr>
<td>17</td>
</tr>
<tr>
<td>18</td>
</tr>
<tr>
<td>19</td>
</tr>
<tr>
<td>20</td>
</tr>
<tr>
<td>21</td>
</tr>
<tr>
<td>22</td>
</tr>
<tr>
<td>23</td>
</tr>
<tr>
<td>24</td>
</tr>
<tr>
<td>25</td>
</tr>
<tr>
<td>26</td>
</tr>
<tr>
<td>27</td>
</tr>
<tr>
<td>28</td>
</tr>
<tr>
<td>29</td>
</tr>
<tr>
<td>30</td>
</tr>
<tr>
<td>31</td>
</tr>
<tr>
<td>32</td>
</tr>
<tr>
<td>33</td>
</tr>
<tr>
<td>34</td>
</tr>
<tr>
<td>35</td>
</tr>
<tr>
<td>36</td>
</tr>
<tr>
<td>37</td>
</tr>
<tr>
<td>38</td>
</tr>
<tr>
<td>39</td>
</tr>
<tr>
<td>40</td>
</tr>
<tr>
<td>41</td>
</tr>
<tr>
<td>42</td>
</tr>
<tr>
<td>43</td>
</tr>
<tr>
<td>44</td>
</tr>
<tr>
<td>45</td>
</tr>
<tr>
<td>46</td>
</tr>
<tr>
<td>47</td>
</tr>
</tbody>
</table>

### Longitudinal Beam Shear Reinforcement Required

<table>
<thead>
<tr>
<th>Units: d (in), Start, End, Xo (ft), PhIVo, Vu (kip), Av's (in^2/lin)</th>
<th>Start</th>
<th>End</th>
<th>d</th>
<th>PhIVo</th>
<th>Vu</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>19.40</td>
<td>22.09</td>
<td>2.117</td>
<td>4.941</td>
<td>42.36</td>
</tr>
<tr>
<td>2</td>
<td>19.40</td>
<td>22.09</td>
<td>2.117</td>
<td>5.226</td>
<td>55.52</td>
</tr>
<tr>
<td>3</td>
<td>19.40</td>
<td>22.09</td>
<td>2.117</td>
<td>5.226</td>
<td>55.45</td>
</tr>
</tbody>
</table>

### Structural Concrete by Hassoun Example 16.1.slb

Page 5
### Longitudinal Beam Shear Reinforcement Details

<table>
<thead>
<tr>
<th>Span</th>
<th>7 8 7.7 + 14 8 5.7 + 4 8 8.5 + 10 8 5.3</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3 10 8 5.7 + 8 8 9.3 + 37 3.3 + 8 8.9 + 10 8 5.7</td>
</tr>
<tr>
<td>2</td>
<td>3 10 8 5.7 + 8 8 9.3 + 37 3.3 + 8 8.9 + 10 8 5.7</td>
</tr>
<tr>
<td>3</td>
<td>3 10 8 5.7 + 8 8 9.3 + 37 3.3 + 8 8.9 + 10 8 5.7</td>
</tr>
<tr>
<td>4</td>
<td>3 10 8 5.7 + 8 8 9.3 + 37 3.3 + 8 8.9 + 10 8 5.7</td>
</tr>
<tr>
<td>5</td>
<td>3 10 8 5.3 + 4 8 8.5 + 14 8 9.7 + 7 8 7.7</td>
</tr>
</tbody>
</table>

### Beam Shear Capacity

<table>
<thead>
<tr>
<th>Span</th>
<th>d</th>
<th>PhiVc</th>
<th>Start</th>
<th>End</th>
<th>Av/e</th>
<th>Sp</th>
<th>PhiVn</th>
<th>Vu</th>
<th>(kip)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.000</td>
<td>0.750</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>46.92</td>
<td>52.53</td>
<td>6.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.750</td>
<td>4.941</td>
<td>0.0236</td>
<td>7.7</td>
<td>46.92</td>
<td>42.36</td>
<td>2.117</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4.941</td>
<td>16.236</td>
<td>0.0227</td>
<td>9.7</td>
<td>41.93</td>
<td>29.27</td>
<td>16.236</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>16.236</td>
<td>19.059</td>
<td>0.0260</td>
<td>8.5</td>
<td>44.77</td>
<td>42.83</td>
<td>19.059</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>19.059</td>
<td>23.520</td>
<td>0.0416</td>
<td>5.3</td>
<td>56.39</td>
<td>21.883</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>23.520</td>
<td>24.000</td>
<td>-----</td>
<td>-----</td>
<td>66.56</td>
<td>24.000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0.000</td>
<td>0.750</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>56.06</td>
<td>65.69</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.750</td>
<td>5.226</td>
<td>0.0389</td>
<td>5.7</td>
<td>56.06</td>
<td>55.52</td>
<td>2.117</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5.226</td>
<td>11.445</td>
<td>0.0236</td>
<td>9.3</td>
<td>42.68</td>
<td>40.59</td>
<td>5.226</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>14.555</td>
<td>20.774</td>
<td>0.0236</td>
<td>9.3</td>
<td>42.68</td>
<td>40.51</td>
<td>20.774</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>20.774</td>
<td>25.250</td>
<td>0.0389</td>
<td>5.7</td>
<td>56.06</td>
<td>55.52</td>
<td>25.250</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>25.250</td>
<td>26.000</td>
<td>-----</td>
<td>-----</td>
<td>65.62</td>
<td>26.000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0.000</td>
<td>0.750</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>56.06</td>
<td>65.62</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.750</td>
<td>5.226</td>
<td>0.0389</td>
<td>5.7</td>
<td>56.06</td>
<td>55.45</td>
<td>2.117</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5.226</td>
<td>11.445</td>
<td>0.0236</td>
<td>9.3</td>
<td>42.68</td>
<td>40.51</td>
<td>5.226</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>14.555</td>
<td>20.774</td>
<td>0.0236</td>
<td>9.3</td>
<td>42.68</td>
<td>40.51</td>
<td>20.774</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>20.774</td>
<td>25.250</td>
<td>0.0389</td>
<td>5.7</td>
<td>56.06</td>
<td>55.52</td>
<td>25.250</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>25.250</td>
<td>26.000</td>
<td>-----</td>
<td>-----</td>
<td>65.62</td>
<td>26.000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0.000</td>
<td>0.750</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>56.06</td>
<td>65.33</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.750</td>
<td>5.226</td>
<td>0.0389</td>
<td>5.7</td>
<td>56.06</td>
<td>55.16</td>
<td>2.117</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5.226</td>
<td>11.445</td>
<td>0.0236</td>
<td>9.3</td>
<td>42.68</td>
<td>40.23</td>
<td>5.226</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>14.555</td>
<td>20.774</td>
<td>0.0236</td>
<td>9.3</td>
<td>42.68</td>
<td>40.59</td>
<td>20.774</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>20.774</td>
<td>25.250</td>
<td>0.0389</td>
<td>5.7</td>
<td>56.06</td>
<td>55.52</td>
<td>25.250</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>25.250</td>
<td>26.000</td>
<td>-----</td>
<td>-----</td>
<td>65.69</td>
<td>26.000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>0.000</td>
<td>0.750</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>66.27</td>
<td>66.56</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.750</td>
<td>4.941</td>
<td>0.0416</td>
<td>5.3</td>
<td>58.38</td>
<td>56.39</td>
<td>2.117</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4.941</td>
<td>7.764</td>
<td>0.0260</td>
<td>8.5</td>
<td>44.77</td>
<td>42.83</td>
<td>4.941</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>7.764</td>
<td>19.059</td>
<td>0.0227</td>
<td>9.7</td>
<td>41.93</td>
<td>29.27</td>
<td>7.764</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>19.059</td>
<td>23.520</td>
<td>0.0284</td>
<td>7.7</td>
<td>46.92</td>
<td>42.36</td>
<td>21.883</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>23.520</td>
<td>24.000</td>
<td>-----</td>
<td>-----</td>
<td>56.53</td>
<td>24.000</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Slab Shear Capacity

<table>
<thead>
<tr>
<th>Span</th>
<th>d</th>
<th>PhiVc</th>
<th>Start</th>
<th>End</th>
<th>Av/e</th>
<th>Sp</th>
<th>PhiVn</th>
<th>Vu</th>
<th>(kip)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>---</td>
<td>Not checked</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>2</td>
<td>---</td>
<td>Not checked</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>3</td>
<td>---</td>
<td>Not checked</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>4</td>
<td>---</td>
<td>Not checked</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>5</td>
<td>---</td>
<td>Not checked</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>

### Reflections

Section properties
### Maximum Instantaneous Deflections

Unites: D (in)

<table>
<thead>
<tr>
<th>Span</th>
<th>Live</th>
<th>Dead</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.203</td>
<td>0.192</td>
<td>0.395</td>
</tr>
<tr>
<td>2</td>
<td>0.186</td>
<td>0.143</td>
<td>0.332</td>
</tr>
<tr>
<td>3</td>
<td>0.187</td>
<td>0.153</td>
<td>0.340</td>
</tr>
<tr>
<td>4</td>
<td>0.186</td>
<td>0.143</td>
<td>0.333</td>
</tr>
<tr>
<td>5</td>
<td>0.203</td>
<td>0.192</td>
<td>0.395</td>
</tr>
</tbody>
</table>

### Maximum Long-term Deflections

Time dependent factor for sustained loads = 2.000

<table>
<thead>
<tr>
<th>Span</th>
<th>Lambda</th>
<th>Dead</th>
<th>Live</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2.000</td>
<td>0.384</td>
<td>0.587</td>
<td>0.779</td>
</tr>
<tr>
<td>2</td>
<td>2.086</td>
<td>0.472</td>
<td>0.615</td>
<td>0.797</td>
</tr>
<tr>
<td>3</td>
<td>2.000</td>
<td>0.384</td>
<td>0.587</td>
<td>0.779</td>
</tr>
<tr>
<td>4</td>
<td>2.086</td>
<td>0.472</td>
<td>0.615</td>
<td>0.797</td>
</tr>
<tr>
<td>5</td>
<td>2.000</td>
<td>0.384</td>
<td>0.587</td>
<td>0.779</td>
</tr>
</tbody>
</table>

### Material Takeoff

**Reinforcement in the Direction of Analysis**

- Top Bars: 850.9 lb >= 6.75 lb/ft => 6.753 lb/ft\(^2\)
- Bottom Bars: 977.4 lb >= 6.96 lb/ft => 6.964 lb/ft\(^2\)
- Stirrups: 312.3 lb >= 2.46 lb/ft => 2.479 lb/ft\(^2\)
- Total Steel: 2040.7 lb >= 16.20 lb/ft => 16.196 lb/ft\(^2\)
- Concrete: 178.5 ft\(^3\)/ft => 1.42 ft\(^3\)/ft => 1.417 ft\(^3\)/ft\(^2\)
Graphical Output

Loads

CASE: Dead

CASE: SELF
Internal Forces

LEGEND
- Envelope

File: C:\Program Files\StructurePoint\spBeam\Examples\Manual\Example 3 - Structural Concrete by Hassoun Example 16.1.sib
Project: spBeam\Manual Example 3
Frame: Structural Concrete by Hassoun and Al-Manasir, 2008, Ex 16.1
Engineer: StructurePoint
Code: ACI 318-11
Date: 12/22/11
Time: 09:27:09
Moment Capacity

File: C:\Program Files\StructurePoint\spBeam\Examples\Manual\Example 3 - Structural Concrete by Hasson and Al-Manasir, 2008, Ex 16.1
Project: spBeam\spBeam Manual Example 3
Frame: Structural Concrete by Hasson and Al-Manasir, 2008, Ex 16.1
Engineer: StructurePoint
Code: ACI 318-11
Date: 12/22/11
Time: 09:28:19
Deflection
Flexural Rebar

Flexural Reinforcement
Transverse Rebar
Example 4 Flat Plate Floor System

Problem description

An office building is planned using a flat plate floor system with the column layout as shown in figure below. No beams, drop panels, or column capitals are permitted. Specified live load is 100 psf and dead load will include the weight of the slab plus an allowance of 20 psf for finish floor plus suspended loads. The columns will be 18 in. square, and the floor-to-floor height of the structure will be 12 ft. The slab thickness will be 8.5 in. according to ACI Code. Design the interior panel C, using material strengths $f_y = 60,000$ psi and $f'c = 4000$ psi. Straight-bar reinforcement will be used. This example refers to Example 13-3 from Design of Concrete Structures by Nilson, Darwin, and Dolan, Thirteenth Edition, 2004

Preparing Input

1. From the Input menu, select General Information. A dialog box appears.
   - In the LABELS section, input the names of the project, frame, and engineer.
   - In the FRAME section, input 4 for NO OF SUPPORTS. Then, Click the check boxes next to LEFT CANTILEVER and RIGHT CANTILEVER.
   - In the FLOOR SYSTEM section, click the radial button next to TWO-WAY.
   - Leave all other options in the General Information tab to their default settings of ACI 318-11 design code, ASTM A615 reinforcement, and DESIGN run mode option.
2. Nothing needs to be changed in the **Material Properties** menu.

3. From the **Input** menu, select **Spans**. A dialog box appears.
   - Under the **Slabs/Flanges** tab, for Span No. 1 input 0.75 for LENGTH, 8.5 for THICKNESS, and 11 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY.
   - Press COPY. Click the check box next to SPAN NO. 5. Press OK.
   - Under the **Slabs/Flanges** tab, for Span No. 2 input 22 for LENGTH, 8.5 for THICKNESS, and 11 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY.
   - Click the check boxes next to SPAN NO. 3, and SPAN NO. 4. Press OK.
   - Press OK again.
4. From the **Input** menu, select **Supports**. A dialog box appears.
   - Under the **Columns** tab, input 1.2 for the **HEIGHT** in both the **ABOVE** and **BELOW** rows.
   - Input 1.8 for both the **c1** and **c2** values in both the **ABOVE** and **BELOW** rows. Press **MODIFY**.
   - Press **COPY**. Press the **CHECK ALL** button. Press **OK**.
   - Press **OK** again.

5. From the **Input** menu, select **Reinforcement Criteria**.
   - Use the drop down arrow next to **MAX BAR SIZE** for both **TOP BARS** and **BOTTOM BARS** to select **#6** bars.
   - Press **OK**.
6. From the **Input** menu, select **Load Cases**. A dialog box appears.
   - Since we are not considering snow loads, click on **SNOW** in the **LABEL** column on the list in the bottom half of the **LOAD CASES** dialog box and press the **DELETE** button.
   - Since we are not considering lateral forces, click on **WIND** in the **LABEL** column on the list in the bottom half of the **LOAD CASES** dialog box and press the **DELETE** button.
   - Click on **EQ** in the **LABEL** column and press the **DELETE** button. Press **OK**.

7. From the **Input** menu, select **Load Combinations**. A dialog box appears.
   - Delete all the load combinations by clicking anywhere on the list in the bottom half of the **LOAD COMBINATIONS** dialog box and pressing the **DELETE** button. Repeat this procedure until all the load combinations are deleted.
   - Input 1.2 in the **SELF** field, 1.2 in the **DEAD** field, and 1.6 in the **LIVE** field. Press **ADD**.
   - Press **OK**.
8. From the **Input** menu, select **Span Loads**. A dialog box appears.
   - Input 20 for the MAGNITUDE. Press ADD.
   - Press COPY. Press the CHECK ALL button. Press OK.
   - In the top left corner of the **SPAN LOADS** dialog box, there is a section called **CURRENT CASE**. Click on **LIVE**.
   - Input 100 for **MAGNITUDE**. Press ADD.
   - Press COPY. Press the CHECK ALL button. Press OK.
   - Press OK again.

9. From the **Solve** menu, select **Execute**. Press CLOSE.
10. From the **Solve** menu, select **Results Report**.
   - Use the scroll bars to scroll through the results file.
   - Use the ARROW keys or the mouse wheel to browse through different parts of the results quickly. Press the CLOSE button to close the RESULTS REPORT dialog box and return to spBeam.

11. To view diagrams, select **Loads, Internal Forces, Moment Capacity, Shear Capacity, Deflection, or Reinforcement** from the **View** menu. Right click in any of these diagrams to get new copy, printing, or display options.

12. You may print the results file by selecting **Print Results** from the **File** menu. To print any of the diagrams you selected to view, use the **Print Preview** command found by right clicking in the diagram’s window. After viewing the results, you may decide to investigate the input beams under the same loads but with a modified reinforcement configuration.

13. From the **Input** menu, select **General Information**. In the **General Information** dialog box change the RUN MODE option to INVESTIGATION. Do not change any of the other options. Press OK.

14. From the **Input** menu, select the different commands under **Reinforcement Criteria** and **Reinforcing Bars** to modify the reinforcement configuration computed by the program.

15. Repeat steps 10 and subsequent to perform the investigation and view the results.
A Computer Program for Analysis, Design, and Investigation of Reinforced Concrete Beams, One-way and Two-way Slab Systems

Copyright © 2003-2011, STRUCTUREPOINT, LLC
All rights reserved

Licensee stated above acknowledges that STRUCTUREPOINT (SP) is not and cannot be responsible for either the accuracy or adequacy of the material supplied as input for processing by the spslab computer program. Furthermore, STRUCTUREPOINT neither makes any warranty expressed nor implied with respect to the correctness of the output prepared by the spslab program. Although STRUCTUREPOINT has endeavored to produce spslab error free the program is not and cannot be certified infallible. The final and only responsibility for analysis, design and engineering documents is the licensee’s. Accordingly, STRUCTUREPOINT disclaims all responsibility in contract, negligence or other tort for any analysis, design or engineering documents prepared in connection with the use of the spslab program.

[1] INPUT ECHO

General Information

File name: c:\Program Files\StructurePoint\Example 4 - Design of Concrete Structures by Nilson Example 13.3.slb
Project: spslab/spbeam Manual, Example 4
Frame: Design of Concrete Structures by Nilson, Darwin, and Dolan, 2004, Example 13.3
Engineer: StructurePoint
Code: ACI 318-11
Reinforcement Database: AASHTO A615
Mode: Design
Number of supports = 4 + Left cantilever + Right cantilever
Floor System: Two-Way
Live load pattern ratio = 75%
Minimum free edge for punching shear = 4 times slab thickness
Deflections are based on cracked section properties.
In negative moment regime, tg and Mcr DO NOT include flange/slab contribution (if available)
Long-term deflections are calculated for load duration of 60 months.
0% of live load is sustained.
Compression reinforcement calculations NOT selected.
Default incremental rebar design selected.
User-defined slab strip widths NOT selected.
User-defined distribution factors NOT selected.
One-way shear in drop panel NOT selected.
Distribution of shear to strips NOT selected.
Beam T-section design NOT selected.
Longitudinal beam contribution in negative reinforcement design over support NOT selected.
Transverse beam contribution in negative reinforcement design over support NOT selected.

Material Properties

<table>
<thead>
<tr>
<th>Slabs</th>
<th>Beams</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>wc</td>
<td>150</td>
<td>150 lb/ft³</td>
</tr>
<tr>
<td>f'c</td>
<td>4</td>
<td>kai</td>
</tr>
<tr>
<td>Ec</td>
<td>3834.3</td>
<td>kai</td>
</tr>
<tr>
<td>fr</td>
<td>0.474342</td>
<td>kai</td>
</tr>
<tr>
<td>fy</td>
<td>60 kai</td>
<td>Bars are not epoxy-coated</td>
</tr>
<tr>
<td>fty</td>
<td>60 kai</td>
<td></td>
</tr>
<tr>
<td>Es</td>
<td>290000</td>
<td></td>
</tr>
</tbody>
</table>

Reinforcement Database

<table>
<thead>
<tr>
<th>Units: Db (in), Ab (in²), Wb (lb/ft³)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>$3</td>
</tr>
<tr>
<td>$7</td>
</tr>
</tbody>
</table>
### Span Data

<table>
<thead>
<tr>
<th>Span Loc</th>
<th>$L_1$</th>
<th>$t$</th>
<th>$w_L$</th>
<th>$w_R$</th>
<th>$t_{\text{min}}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Int</td>
<td>0.750</td>
<td>8.50</td>
<td>11.000</td>
<td>11.000</td>
<td>5.00 LC</td>
</tr>
<tr>
<td>2 Int</td>
<td>22.000</td>
<td>8.50</td>
<td>11.000</td>
<td>11.000</td>
<td>8.20</td>
</tr>
<tr>
<td>3 Int</td>
<td>22.000</td>
<td>8.50</td>
<td>11.000</td>
<td>11.000</td>
<td>7.45</td>
</tr>
<tr>
<td>4 Int</td>
<td>22.000</td>
<td>8.50</td>
<td>11.000</td>
<td>11.000</td>
<td>8.20</td>
</tr>
<tr>
<td>5 Int</td>
<td>0.750</td>
<td>8.50</td>
<td>11.000</td>
<td>11.000</td>
<td>5.00 RC</td>
</tr>
</tbody>
</table>

### Support Data

<table>
<thead>
<tr>
<th>Supp</th>
<th>$c_{\text{sa}}$</th>
<th>$c_{\text{sa}}$</th>
<th>$H_{\text{a}}$</th>
<th>$c_{\text{lb}}$</th>
<th>$c_{\text{lb}}$</th>
<th>$H_{\text{b}}$</th>
<th>$\text{Red}_X$</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>18.00</td>
<td>18.00</td>
<td>12.000</td>
<td>18.00</td>
<td>18.00</td>
<td>12.000</td>
<td>100</td>
</tr>
<tr>
<td>2</td>
<td>18.00</td>
<td>18.00</td>
<td>12.000</td>
<td>18.00</td>
<td>18.00</td>
<td>12.000</td>
<td>100</td>
</tr>
<tr>
<td>3</td>
<td>18.00</td>
<td>18.00</td>
<td>12.000</td>
<td>18.00</td>
<td>18.00</td>
<td>12.000</td>
<td>100</td>
</tr>
<tr>
<td>4</td>
<td>18.00</td>
<td>18.00</td>
<td>12.000</td>
<td>18.00</td>
<td>18.00</td>
<td>12.000</td>
<td>100</td>
</tr>
</tbody>
</table>

### Boundary Conditions

<table>
<thead>
<tr>
<th>Supp</th>
<th>$R_s$ (kip/in)</th>
<th>$K_r$ (kip-in/ft)</th>
<th>$A_{\text{far End A}}$</th>
<th>$A_{\text{far End B}}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>Fixed</td>
<td>Fixed</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>0</td>
<td>Fixed</td>
<td>Fixed</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>Fixed</td>
<td>Fixed</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>0</td>
<td>Fixed</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

### Load Data

<table>
<thead>
<tr>
<th>Case</th>
<th>SELF</th>
<th>Dead</th>
<th>Live</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>DEAD</td>
<td>DEAD</td>
<td>LIVE</td>
</tr>
<tr>
<td>U1</td>
<td>1.400</td>
<td>1.400</td>
<td>0.000</td>
</tr>
<tr>
<td>U2</td>
<td>1.200</td>
<td>1.200</td>
<td>1.600</td>
</tr>
</tbody>
</table>

### Area Loads

<table>
<thead>
<tr>
<th>Units</th>
<th>$W_a$ (lb/ft²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELF</td>
<td>166.25</td>
</tr>
<tr>
<td>2</td>
<td>166.25</td>
</tr>
<tr>
<td>3</td>
<td>166.25</td>
</tr>
<tr>
<td>4</td>
<td>166.25</td>
</tr>
<tr>
<td>5</td>
<td>166.25</td>
</tr>
<tr>
<td>Dead</td>
<td>20.00</td>
</tr>
<tr>
<td>3</td>
<td>20.00</td>
</tr>
<tr>
<td>4</td>
<td>20.00</td>
</tr>
<tr>
<td>5</td>
<td>20.00</td>
</tr>
<tr>
<td>Live</td>
<td>100.00</td>
</tr>
<tr>
<td>2</td>
<td>100.00</td>
</tr>
<tr>
<td>3</td>
<td>100.00</td>
</tr>
<tr>
<td>4</td>
<td>100.00</td>
</tr>
<tr>
<td>5</td>
<td>100.00</td>
</tr>
<tr>
<td>Live/Odd</td>
<td>75.00</td>
</tr>
<tr>
<td>3</td>
<td>75.00</td>
</tr>
<tr>
<td>4</td>
<td>75.00</td>
</tr>
<tr>
<td>5</td>
<td>75.00</td>
</tr>
<tr>
<td>Live/Even</td>
<td>75.00</td>
</tr>
<tr>
<td>2</td>
<td>75.00</td>
</tr>
<tr>
<td>4</td>
<td>75.00</td>
</tr>
<tr>
<td>Live/S1</td>
<td>75.00</td>
</tr>
<tr>
<td>1</td>
<td>75.00</td>
</tr>
<tr>
<td>Live/S2</td>
<td>75.00</td>
</tr>
<tr>
<td>2</td>
<td>75.00</td>
</tr>
<tr>
<td>3</td>
<td>75.00</td>
</tr>
<tr>
<td>Live/S3</td>
<td>75.00</td>
</tr>
<tr>
<td>2</td>
<td>75.00</td>
</tr>
<tr>
<td>3</td>
<td>75.00</td>
</tr>
<tr>
<td>4</td>
<td>75.00</td>
</tr>
<tr>
<td>Live/S4</td>
<td>75.00</td>
</tr>
<tr>
<td>2</td>
<td>75.00</td>
</tr>
<tr>
<td>3</td>
<td>75.00</td>
</tr>
</tbody>
</table>

### Reinforcement Criteria

| Slabs and Ribs |
### Design Results

*Unless otherwise noted, all results are in the direction of analysis only. Another analysis in the perpendicular direction has to be carried out for two-way slab systems.*

#### Strip Widths and Distribution Factors

<table>
<thead>
<tr>
<th>Units: Width (ft)</th>
<th>Strip</th>
<th>Span</th>
<th>Left** Width</th>
<th>Left** Moment Factor</th>
<th>Right** Width</th>
<th>Right** Moment Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>1</td>
<td>11.00</td>
<td>11.00</td>
<td>11.00</td>
<td>11.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2</td>
<td>11.00</td>
<td>11.00</td>
<td>11.00</td>
<td>11.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3</td>
<td>11.00</td>
<td>11.00</td>
<td>11.00</td>
<td>11.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4</td>
<td>11.00</td>
<td>11.00</td>
<td>11.00</td>
<td>11.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5</td>
<td>11.00</td>
<td>11.00</td>
<td>11.00</td>
<td>11.00</td>
</tr>
</tbody>
</table>

#### Top Reinforcement

<table>
<thead>
<tr>
<th>Units: Width (ft), $W$, $M_{max}$ (ft-lb), $A$ (in²), $S_p$ (in)</th>
<th>Strip</th>
<th>Zone</th>
<th>Width</th>
<th>$W_{max}$</th>
<th>$M_{max}$</th>
<th>$A_{min}$</th>
<th>$A_{max}$</th>
<th>$A_{req}$</th>
<th>$S_{p_{req}}$</th>
<th>$S_{p_{prov}}$</th>
<th>$S_p$</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Column Left</td>
<td>11.00</td>
<td>Midspan</td>
<td>11.00</td>
<td>0.61</td>
<td>0.402</td>
<td>2.020</td>
<td>15.945</td>
<td>0.020</td>
<td>16.500</td>
<td>8-5</td>
<td>3</td>
</tr>
<tr>
<td>1 Column Left</td>
<td>11.00</td>
<td>Right</td>
<td>11.00</td>
<td>1.37</td>
<td>0.619</td>
<td>2.020</td>
<td>15.945</td>
<td>0.045</td>
<td>16.500</td>
<td>8-5</td>
<td>3</td>
</tr>
<tr>
<td>2 Column Left</td>
<td>11.00</td>
<td>Midspan</td>
<td>11.00</td>
<td>0.00</td>
<td>0.000</td>
<td>2.020</td>
<td>15.945</td>
<td>0.000</td>
<td>16.500</td>
<td>8-5</td>
<td>3</td>
</tr>
<tr>
<td>2 Column Left</td>
<td>11.00</td>
<td>Right</td>
<td>11.00</td>
<td>0.00</td>
<td>0.619</td>
<td>2.020</td>
<td>15.945</td>
<td>0.000</td>
<td>16.500</td>
<td>8-5</td>
<td>3</td>
</tr>
<tr>
<td>3 Column Left</td>
<td>11.00</td>
<td>Midspan</td>
<td>11.00</td>
<td>0.36</td>
<td>1.500</td>
<td>2.020</td>
<td>15.945</td>
<td>0.012</td>
<td>16.500</td>
<td>8-5</td>
<td>3</td>
</tr>
<tr>
<td>3 Column Left</td>
<td>11.00</td>
<td>Right</td>
<td>11.00</td>
<td>0.36</td>
<td>1.000</td>
<td>2.020</td>
<td>15.945</td>
<td>0.000</td>
<td>16.500</td>
<td>8-5</td>
<td>3</td>
</tr>
<tr>
<td>4 Column Left</td>
<td>11.00</td>
<td>Midspan</td>
<td>11.00</td>
<td>0.00</td>
<td>0.000</td>
<td>2.020</td>
<td>15.945</td>
<td>0.000</td>
<td>16.500</td>
<td>8-5</td>
<td>3</td>
</tr>
<tr>
<td>4 Column Left</td>
<td>11.00</td>
<td>Right</td>
<td>11.00</td>
<td>0.00</td>
<td>0.000</td>
<td>2.020</td>
<td>15.945</td>
<td>0.000</td>
<td>16.500</td>
<td>8-5</td>
<td>3</td>
</tr>
</tbody>
</table>
### Top Bar Details

<table>
<thead>
<tr>
<th>Units: Length (ft)</th>
<th>Left</th>
<th>Continuous</th>
<th>Right</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Span</strong></td>
<td><strong>Bars Length</strong></td>
<td><strong>Bars Length</strong></td>
<td><strong>Bars Length</strong></td>
</tr>
<tr>
<td>1 Column</td>
<td>8-#5</td>
<td>0.75</td>
<td>1-#5</td>
</tr>
<tr>
<td>Middle</td>
<td>8-#5</td>
<td>0.75</td>
<td>---</td>
</tr>
<tr>
<td>2 Column</td>
<td>7-#5</td>
<td>4.85</td>
<td>---</td>
</tr>
<tr>
<td>Middle</td>
<td>8-#5</td>
<td>7.53</td>
<td>11-#5</td>
</tr>
<tr>
<td>3 Column</td>
<td>8-#5</td>
<td>4.85</td>
<td>---</td>
</tr>
<tr>
<td>Middle</td>
<td>8-#5</td>
<td>8.53</td>
<td>11-#5</td>
</tr>
<tr>
<td>4 Column</td>
<td>8-#5</td>
<td>5.26</td>
<td>---</td>
</tr>
<tr>
<td>Middle</td>
<td>8-#5</td>
<td>7.53</td>
<td>2-#5</td>
</tr>
<tr>
<td>5 Column</td>
<td>1-#5</td>
<td>0.75</td>
<td>---</td>
</tr>
<tr>
<td>Middle</td>
<td>8-#5</td>
<td>0.75</td>
<td>---</td>
</tr>
</tbody>
</table>

### Bottom Reinforcement

<table>
<thead>
<tr>
<th>Units: Width (ft), £max (k-ft), £max (ft), A_s (in^2), S_p (in)</th>
<th>Width</th>
<th>£max</th>
<th>£max</th>
<th>A_s</th>
<th>A_s</th>
<th>S_p</th>
<th>Bars</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Span</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 Column</td>
<td>11.00</td>
<td>0.00</td>
<td>0.309</td>
<td>0.00</td>
<td>15.945</td>
<td>0.000</td>
<td>---</td>
</tr>
<tr>
<td>Middle</td>
<td>11.00</td>
<td>0.00</td>
<td>0.309</td>
<td>0.00</td>
<td>15.945</td>
<td>0.000</td>
<td>---</td>
</tr>
<tr>
<td>2 Column</td>
<td>11.00</td>
<td>115.71</td>
<td>9.750</td>
<td>2.020</td>
<td>15.945</td>
<td>4.005</td>
<td>10.154</td>
</tr>
<tr>
<td>Middle</td>
<td>11.00</td>
<td>77.14</td>
<td>9.750</td>
<td>2.020</td>
<td>15.945</td>
<td>2.630</td>
<td>14.667</td>
</tr>
<tr>
<td>3 Column</td>
<td>11.00</td>
<td>80.78</td>
<td>11.000</td>
<td>2.020</td>
<td>15.945</td>
<td>2.761</td>
<td>14.667</td>
</tr>
<tr>
<td>Middle</td>
<td>11.00</td>
<td>53.86</td>
<td>11.000</td>
<td>2.020</td>
<td>15.945</td>
<td>1.823</td>
<td>15.945</td>
</tr>
<tr>
<td>4 Column</td>
<td>11.00</td>
<td>115.71</td>
<td>12.250</td>
<td>2.020</td>
<td>15.945</td>
<td>4.005</td>
<td>10.154</td>
</tr>
<tr>
<td>Middle</td>
<td>11.00</td>
<td>77.14</td>
<td>12.250</td>
<td>2.020</td>
<td>15.945</td>
<td>2.633</td>
<td>14.667</td>
</tr>
<tr>
<td>5 Column</td>
<td>11.00</td>
<td>0.00</td>
<td>0.441</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Middle</td>
<td>11.00</td>
<td>0.00</td>
<td>0.441</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

**NOTES:**
- *3 - Design governed by minimum reinforcement.
- *5 - Number of bars governed by maximum allowable spacing.

### Bottom Bar Details

<table>
<thead>
<tr>
<th>Units: Start (ft), Length (ft)</th>
<th>Long Bars</th>
<th>Short Bars</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Span</strong></td>
<td><strong>Bars Start</strong></td>
<td><strong>Length</strong></td>
</tr>
<tr>
<td>1 Column</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Middle</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>2 Column</td>
<td>13-#5</td>
<td>22.00</td>
</tr>
<tr>
<td>Middle</td>
<td>7-#5</td>
<td>22.00</td>
</tr>
<tr>
<td>3 Column</td>
<td>9-#5</td>
<td>22.00</td>
</tr>
<tr>
<td>Middle</td>
<td>7-#5</td>
<td>22.00</td>
</tr>
<tr>
<td>4 Column</td>
<td>13-#5</td>
<td>22.00</td>
</tr>
<tr>
<td>Middle</td>
<td>7-#5</td>
<td>22.00</td>
</tr>
<tr>
<td>5 Column</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Middle</td>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>

### Flexural Capacity

<table>
<thead>
<tr>
<th>Units: x (ft), A_s (in^2), F_l_m (k-ft)</th>
<th>x A_sTop A_sBot</th>
<th>F_l_m</th>
<th>F_l_m+</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Span</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6-66</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Examples**
### Slab Shear Capacity

<table>
<thead>
<tr>
<th>Units: b, d (in), Xu (ft), Vf/ Vu, Vu (kip)</th>
<th>Espan</th>
<th>b</th>
<th>d</th>
<th>Vratio</th>
<th>Vf/ Vu</th>
<th>Vu</th>
<th>Xu</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>264.00</td>
<td>6.69</td>
<td>1.000</td>
<td>167.49</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>264.00</td>
<td>6.69</td>
<td>1.000</td>
<td>167.49</td>
<td>75.38</td>
<td>20.69</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>264.00</td>
<td>6.69</td>
<td>1.000</td>
<td>167.49</td>
<td>66.42</td>
<td>20.69</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>264.00</td>
<td>6.69</td>
<td>1.000</td>
<td>167.49</td>
<td>75.38</td>
<td>1.31</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>264.00</td>
<td>6.69</td>
<td>1.000</td>
<td>167.49</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

### Flexural Transfer of Negative Unbalanced Moment at Supports

<table>
<thead>
<tr>
<th>Units: Width (in), Mumb (k-ft), As (in²)</th>
<th>Supp</th>
<th>Width</th>
<th>Width-c</th>
<th>d</th>
<th>Numb Comb Pat</th>
<th>GammaF</th>
<th>Asreq</th>
<th>Asprov</th>
<th>Add Bars</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>43.50</td>
<td>43.50</td>
<td>6.69</td>
<td>127.20</td>
<td>02</td>
<td>All</td>
<td>0.617</td>
<td>2.957</td>
<td>0.919</td>
</tr>
<tr>
<td>2</td>
<td>43.50</td>
<td>43.50</td>
<td>6.69</td>
<td>63.54</td>
<td>02</td>
<td>Even</td>
<td>0.600</td>
<td>1.320</td>
<td>2.350</td>
</tr>
<tr>
<td>3</td>
<td>43.50</td>
<td>43.50</td>
<td>6.69</td>
<td>63.54</td>
<td>02</td>
<td>Even</td>
<td>0.600</td>
<td>1.320</td>
<td>2.350</td>
</tr>
<tr>
<td>4</td>
<td>43.50</td>
<td>43.50</td>
<td>6.69</td>
<td>127.20</td>
<td>02</td>
<td>All</td>
<td>0.617</td>
<td>2.957</td>
<td>0.919</td>
</tr>
</tbody>
</table>

### Punching Shear Around Columns

#### Critical Section Properties

<table>
<thead>
<tr>
<th>Supp</th>
<th>b1, b2, b0, davg, C0, C(left), c(right) (in), Ac (in²), Jc (in⁴)</th>
<th>Ac</th>
<th>Jc</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>23.34</td>
<td>24.69</td>
<td>67.38</td>
</tr>
<tr>
<td>2</td>
<td>24.69</td>
<td>24.69</td>
<td>98.75</td>
</tr>
<tr>
<td>3</td>
<td>24.69</td>
<td>24.69</td>
<td>98.75</td>
</tr>
<tr>
<td>4</td>
<td>23.34</td>
<td>24.69</td>
<td>67.38</td>
</tr>
</tbody>
</table>

#### Punching Shear Results

<table>
<thead>
<tr>
<th>Supp</th>
<th>yu (kip), Mumb (k-ft), vu (psi), Phi-vc (psi)</th>
<th>Vu</th>
<th>Vu</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>70.43</td>
<td>156.3</td>
<td>94.43</td>
</tr>
<tr>
<td>2</td>
<td>158.40</td>
<td>235.9</td>
<td>-28.64</td>
</tr>
<tr>
<td>3</td>
<td>158.40</td>
<td>235.9</td>
<td>28.64</td>
</tr>
<tr>
<td>4</td>
<td>70.43</td>
<td>156.3</td>
<td>-94.43</td>
</tr>
</tbody>
</table>

### Deflections

#### Section Properties

<table>
<thead>
<tr>
<th>Units: Ig, Ioc, Io (in⁴), Mocr, Mmax (k-ft)</th>
<th>Dead</th>
<th>Dead+Live</th>
<th>Load Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ig</td>
<td>Ioc</td>
<td>Mocr</td>
<td>Mmax</td>
</tr>
<tr>
<td>1</td>
<td>13511</td>
<td>13511</td>
<td>Right</td>
</tr>
<tr>
<td>2</td>
<td>13274</td>
<td>9772</td>
<td>Left</td>
</tr>
<tr>
<td>3</td>
<td>13511</td>
<td>10795</td>
<td>Left</td>
</tr>
</tbody>
</table>

The image contains a page from a document discussing the design of concrete structures, with tables and calculations related to slab shear capacity, flexural transfer of moments, punching shear around columns, and deflections. The page includes various calculations and formulas relevant to structural engineering.
### Maximum Instantaneous Deflections - Direction of Analysis

<table>
<thead>
<tr>
<th>Span</th>
<th>Ddead</th>
<th>Dlive</th>
<th>Dtotal</th>
<th>Top</th>
<th>Bottom</th>
<th>Left</th>
<th>Right</th>
<th>Middle</th>
<th>Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-0.009</td>
<td>-0.010</td>
<td>-0.019</td>
<td>Column</td>
<td>6755.38</td>
<td>0.800</td>
<td>1.600</td>
<td>-0.015</td>
<td>0.016</td>
</tr>
<tr>
<td>2</td>
<td>0.099</td>
<td>0.119</td>
<td>0.218</td>
<td>Column</td>
<td>6755.38</td>
<td>0.738</td>
<td>1.475</td>
<td>0.146</td>
<td>0.175</td>
</tr>
<tr>
<td>3</td>
<td>0.039</td>
<td>0.048</td>
<td>0.088</td>
<td>Column</td>
<td>6755.38</td>
<td>0.670</td>
<td>1.350</td>
<td>0.053</td>
<td>0.065</td>
</tr>
<tr>
<td>4</td>
<td>0.099</td>
<td>0.119</td>
<td>0.218</td>
<td>Column</td>
<td>6755.38</td>
<td>0.325</td>
<td>0.650</td>
<td>0.026</td>
<td>0.031</td>
</tr>
<tr>
<td>5</td>
<td>-0.009</td>
<td>-0.010</td>
<td>-0.019</td>
<td>Column</td>
<td>6755.38</td>
<td>0.800</td>
<td>1.600</td>
<td>-0.015</td>
<td>0.016</td>
</tr>
</tbody>
</table>

### Maximum Long-term Deflections - Direction of Analysis

<table>
<thead>
<tr>
<th>Span</th>
<th>Dtotal</th>
<th>Ddead</th>
<th>Dlive</th>
<th>Dtotal</th>
<th>Ddead</th>
<th>Dlive</th>
<th>Dtotal</th>
<th>Ddead</th>
<th>Dlive</th>
<th>Dtotal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-0.015</td>
<td>2.000</td>
<td>-0.030</td>
<td>-0.046</td>
<td>0.046</td>
<td>-0.046</td>
<td>0.046</td>
<td>2.000</td>
<td>-0.007</td>
<td>-0.011</td>
</tr>
<tr>
<td>2</td>
<td>0.146</td>
<td>2.000</td>
<td>0.291</td>
<td>0.467</td>
<td>0.467</td>
<td>0.467</td>
<td>0.467</td>
<td>2.000</td>
<td>0.104</td>
<td>0.166</td>
</tr>
<tr>
<td>3</td>
<td>0.053</td>
<td>2.000</td>
<td>0.106</td>
<td>0.171</td>
<td>0.171</td>
<td>0.171</td>
<td>0.171</td>
<td>2.000</td>
<td>0.051</td>
<td>0.083</td>
</tr>
<tr>
<td>4</td>
<td>0.146</td>
<td>2.000</td>
<td>0.291</td>
<td>0.467</td>
<td>0.467</td>
<td>0.467</td>
<td>0.467</td>
<td>2.000</td>
<td>0.104</td>
<td>0.166</td>
</tr>
<tr>
<td>5</td>
<td>-0.015</td>
<td>2.000</td>
<td>-0.030</td>
<td>-0.046</td>
<td>0.046</td>
<td>-0.046</td>
<td>0.046</td>
<td>2.000</td>
<td>-0.007</td>
<td>-0.011</td>
</tr>
</tbody>
</table>

### Material Takeoff

**Reinforcement in the Direction of Analysis**

- **Top Bars:** 113.1 lb => 16.85 lb/ft => 0.766 lb/ft²
- **Bottom Bars:** 137.1 lb => 20.43 lb/ft => 0.929 lb/ft²
- **Stirrups:** 0.0 lb => 0.00 lb/ft => 0.000 lb/ft²
- **Total Steel:** 254.2 lb => 37.28 lb/ft => 1.694 lb/ft²
- **Concrete:** 1051.9 ft³ => 15.98 ft³/ft => 0.708 ft³/ft²
Graphical Output

Loads
Moment Capacity

![Graph showing moment capacity](image)

LEGEND:
- Envelope Curve
- Capacity Curve
- Support Cantilever
- Face of Support

---

File: C:\Program Files\StructurePoint\spSlab\Examples\Manual\Example4 - Design of Concrete Structures by Nilson Example 13.3.spb
Project: spSlab\spBeam Manual, Example 4
Frame: Design of Concrete Structures by Nilson, Darwin, and Dolan, 2004, Example 13.3
Engineer: StructurePoint
Code: ACI 318-11
Date: 12/22/11
Time: 09:38:54
Shear Capacity
**Example 5 Two-way slab system**

**Problem description**
Using the Equivalent Frame Method, determine design moments for the slab system in the direction shown, for an intermediate floor. This example refers to Example 20-2 from *PCA Notes on ACI 318-08 Building Code Requirements for Structural Concrete*, Portland Cement Association, 2008.

![Diagram of slab system]

Story height = 12 ft
Edge beam dimensions = 14 × 27 in.
Interior beam dimensions = 14 × 20 in.
Column dimensions = 18 × 18 in.
Service live load = 100 psf
Dead load = self weight

\[ f'_{c} = 4000 \text{ psi (for all members), normal weight concrete} \]

\[ f_{y} = 60,000 \text{ psi} \]

**Preparing Input**
1. From the Input menu, select General Information. A dialog box appears.
   - In the LABELS section, input the names of the project, frame, and engineer.
   - In the FRAME section, input 4 for NO OF SUPPORTS. Then, Click the check boxes next to LEFT CANTILEVER and RIGHT CANTILEVER.
   - In the FLOOR SYSTEM section, click the radial button next to TWO-WAY.
   - Leave all other options in the General Information tab to their default settings of ACI 318-11 design code, ASTM A615 reinforcement, and DESIGN run mode option.
2. Nothing needs to be changed in the **Material Properties** menu.

3. From the **Input** menu, select **Spans**. A dialog box appears.
   - Under the **Slabs/Flanges** tab, for Span No. 1 input 0.75 for **LENGTH**, 6 for **THICKNESS**, and 11 for **WIDTH LEFT** and **WIDTH RIGHT**. Press **MODIFY**.
   - Press **COPY**. Click the check box next to **SPAN NO. 5**. Press **OK**.
   - Under the **Slabs/Flanges** tab, for Span No. 2 input 17.5 for **LENGTH**, 6 for **THICKNESS**, and 11 for **WIDTH LEFT** and **WIDTH RIGHT**. Press **MODIFY**.
   - Press **COPY**. Click the check boxes next to **SPAN NO. 3** and **SPAN NO. 4**. Press **OK**.
   - Select the **Longitudinal Beams** tab. Input 14 for **WIDTH** and 20 for **DEPTH**. Press **MODIFY**.
   - Press **COPY**. Press the **CHECK ALL** button. Press **OK**.
   - Press **OK** again.
4. From the **Input** menu, select **Supports**. A dialog box appears.

- Under the **Columns** tab, input 12 for the \textit{HEIGHT} in both the \textit{ABOVE} and \textit{BELOW} rows.
- Input 18 for both the \textit{C1} and \textit{C2} values in both the \textit{ABOVE} and \textit{BELOW} rows. Press **MODIFY**.
- Press **COPY**. Press the **CHECK ALL** button. Press **OK**.
- Under the **Transverse Beams** tab, input 14 for \textit{WIDTH} and 27 for \textit{DEPTH}. Press **MODIFY**.
- Press **COPY**. Click the check box next to \textit{SUPPORT 4}. Press **OK**.
- Use the drop down arrow next to \textit{SUPPORT} to select \textit{SUPPORT 2}.
- Input 14 for \textit{WIDTH} and 20 for \textit{DEPTH}. Press **MODIFY**.
- Press **COPY**. Click the check box next to \textit{SUPPORT 3} and unclick the check box next to \textit{SUPPORT 1}. Press **OK**.
- Press **OK** again.
5. Nothing needs to be changed in the Reinforcement menu.

6. From the Input menu, select Load Cases. A dialog box appears.
   - Since the Self weight is to be entered under DEAD Load Label to match the Reference’s input, click on SELF in the LABEL column on the top of the list of the LOAD CASES dialog box and press the DELETE button.
   - Since we are not considering snow loads, click on SNOW in the LABEL column on the list in the bottom half of the LOAD CASES dialog box and press the DELETE button.
   - Since we are not considering lateral forces, click on WIND in the LABEL column on the list in the bottom half of the LOAD CASES dialog box and press the DELETE button.
   - Click on EQ in the LABEL column and press the DELETE button. Press OK.

7. From the Input menu, select Load Combinations. A dialog box appears.
- Delete all the load combinations by clicking anywhere on the list in the bottom half of the LOAD COMBINATIONS dialog box and pressing the DELETE button. Repeat this procedure until all the load combinations are gone.
- Input 1.2 in the DEAD field, and 1.6 in the LIVE field. Press ADD.
- Press OK.


- In the top left corner of the SPAN LOADS dialog box, there is a section called CURRENT CASE. Click on DEAD.
- Input 84.3 for MAGNITUDE. Press ADD.
- Press COPY. Press the CHECK ALL button. Press OK.
- Then, click on LIVE in the CURRENT CASE section.
- Input 100 for MAGNITUDE. Press ADD.
- Press COPY. Press the CHECK ALL button. Press OK.
- Press OK again.
9. From the **Solve** menu, select **Execute**. Press **CLOSE**.

10. From the **Solve** menu, select **Results Report**.
    - Use the scroll bars to scroll through the results file.
    - Use the ARROW keys or the mouse wheel to browse through different parts of the results quickly. Press the **CLOSE** button to close the **RESULTS REPORT** dialog box and return to spBeam.

11. To view diagrams, select **Loads**, **Internal Forces**, **Moment Capacity**, **Shear Capacity**, **Deflection**, or **Reinforcement** from the **View** menu. Right click in any of these diagrams to get new copy, printing, or display options.

12. You may print the results file by selecting **Print Results** from the **File** menu. To print any of the diagrams you selected to view, use the **Print Preview** command found by right clicking in the diagram’s window. After viewing the results, you may decide to investigate the input beams under the same loads but with a modified reinforcement configuration.

13. From the **Input** menu, select **General Information**. In the **General Information** dialog box change the **RUN MODE** option to **INVESTIGATION**. Do not change any of the other options. Press **OK**.

14. From the **Input** menu, select the different commands under **Reinforcement Criteria** and **Reinforcing Bars** to modify the reinforcement configuration computed by the program.

15. Repeat steps 10 and subsequent to perform the investigation and view the results.
A Computer Program for Analysis, Design, and Investigation of Reinforced Concrete Beams, One-way and Two-way Slab Systems
Copyright © 2003-2011, STRUCTUREPOINT, LLC
All rights reserved

Licensee stated above acknowledges that STRUCTUREPOINT (SP) is not and cannot be responsible for either the accuracy or adequacy of the material supplied as input for processing by the spSlab computer program. Furthermore, STRUCTUREPOINT neither makes any warranty expressed nor implied with respect to the correctness of the output prepared by the spSlab program. Although STRUCTUREPOINT has endeavored to produce spSlab error free the program is not and cannot be certified as infallible. The final and only responsibility for analysis, design and engineering occurs in the licensee’s. Accordingly, STRUCTUREPOINT disclaims all responsibility in contract, negligence or other tort for any analysis, design or engineering documents prepared in connection with the use of the spSlab program.

[1] INPUT ECHO

General Information

File name: c:\Program Files\StructurePoint\spSlab\Exam...\Example 5 - PCA Notes on ACI 318-08 Example 20-2.slb
Project: spSlab\spBeam Manual, Example 5
Frame: PCA Notes on ACI 318-08, Example 20-2
Engineer: StructurePoint
Code: ACI 318-11
Reinforcement Database: ASTM A615
Node: Design
Number of supports = 4 + Left cantilever + Right cantilever
Floor System: Two-Way
Live load pattern ratio = 75%
Minimum free edge for punching shear = 4 times slab thickness
Deflections are based on cracked section properties.
In negative moment regime, t, g and Mcr DO NOT include flange/slab contribution (if available)
Long-term deflections are calculated for load duration of 40 months. 0% of live load is sustained.
Compression reinforcement calculations NOT selected.
Default incremental rebar design selected.
User-defined slab strip widths NOT selected.
User-defined distribution factors NOT selected.
One-way shear in drop panel NOT selected.
Distribution of shear to strips NOT selected.
Beam T-section design NOT selected.
Longitudinal beam contribution in negative reinforcement design over support NOT selected.
Transverse beam contribution in negative reinforcement design over support NOT selected.

Material Properties

Slab|Beams | Columns
---|-------|-------
wc | 150 | 150 lb/ft3
f'c | 4 | ksi
f | 3834.3 | ksi
fr | 0.47434 | ksi
fy | 60 ksi, Bars are not epoxy-coated
fyt | 60 ksi
Es | 29000 ksi

Reinforcement Database

Units: Db (in), Ab (in^2), Wb (lb/ft)

<table>
<thead>
<tr>
<th>Size</th>
<th>Db</th>
<th>Ab</th>
<th>Wb</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>0.38</td>
<td>0.11</td>
<td>0.038</td>
</tr>
<tr>
<td>5</td>
<td>0.11</td>
<td>0.20</td>
<td>0.20</td>
</tr>
<tr>
<td>7</td>
<td>0.75</td>
<td>1.50</td>
<td>1.50</td>
</tr>
<tr>
<td>9</td>
<td>1.00</td>
<td>1.27</td>
<td>1.27</td>
</tr>
<tr>
<td>10</td>
<td>1.27</td>
<td>4.30</td>
<td>4.30</td>
</tr>
</tbody>
</table>
### Span Data

**Slabs**

Units: L1, W1, WR (ft); t, Hmin (in)

<table>
<thead>
<tr>
<th>Span</th>
<th>L1</th>
<th>W1</th>
<th>WR</th>
<th>t</th>
<th>Hmin</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1.41</td>
<td>1.56</td>
<td>5.31</td>
<td>1.69</td>
<td>2.25</td>
</tr>
<tr>
<td>2</td>
<td>2.26</td>
<td>4.00</td>
<td>13.60</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Ribs and Longitudinal Beams

Units: b, h, Sp (in)

<table>
<thead>
<tr>
<th>Span</th>
<th>b</th>
<th>h</th>
<th>Sp</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.00</td>
<td>0.00</td>
<td>14.00</td>
</tr>
<tr>
<td>2</td>
<td>0.00</td>
<td>0.00</td>
<td>14.00</td>
</tr>
<tr>
<td>3</td>
<td>0.00</td>
<td>0.00</td>
<td>14.00</td>
</tr>
<tr>
<td>4</td>
<td>0.00</td>
<td>0.00</td>
<td>14.00</td>
</tr>
<tr>
<td>5</td>
<td>0.00</td>
<td>0.00</td>
<td>14.00</td>
</tr>
</tbody>
</table>

### Support Data

**Columns**

Units: clm, c2a, clb, c2b (in); Mz, Mb (ft)

<table>
<thead>
<tr>
<th>Supp</th>
<th>clm</th>
<th>c2a</th>
<th>clb</th>
<th>c2b</th>
<th>Mz</th>
<th>Mb</th>
<th>Red#</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>18.00</td>
<td>18.00</td>
<td>12.00</td>
<td>18.00</td>
<td>18.00</td>
<td>12.00</td>
<td>100</td>
</tr>
<tr>
<td>2</td>
<td>18.00</td>
<td>18.00</td>
<td>12.00</td>
<td>18.00</td>
<td>18.00</td>
<td>12.00</td>
<td>100</td>
</tr>
<tr>
<td>3</td>
<td>18.00</td>
<td>18.00</td>
<td>12.00</td>
<td>18.00</td>
<td>18.00</td>
<td>12.00</td>
<td>100</td>
</tr>
<tr>
<td>4</td>
<td>18.00</td>
<td>18.00</td>
<td>12.00</td>
<td>18.00</td>
<td>18.00</td>
<td>12.00</td>
<td>100</td>
</tr>
</tbody>
</table>

### Transverse Beams

Units: b, h, Eco (in)

<table>
<thead>
<tr>
<th>Supp</th>
<th>b</th>
<th>h</th>
<th>Eco</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>14.00</td>
<td>27.00</td>
<td>0.00</td>
</tr>
<tr>
<td>2</td>
<td>14.00</td>
<td>20.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3</td>
<td>14.00</td>
<td>20.00</td>
<td>0.00</td>
</tr>
<tr>
<td>4</td>
<td>14.00</td>
<td>27.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

### Boundary Conditions

Units: Es (kip/in); Kry (kip-in/rd)

<table>
<thead>
<tr>
<th>Supp</th>
<th>Spring Es</th>
<th>Spring Kry</th>
<th>Far End A</th>
<th>Far End B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>Fixed</td>
<td>Fixed</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>0</td>
<td>Fixed</td>
<td>Fixed</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>Fixed</td>
<td>Fixed</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>0</td>
<td>Fixed</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

### Load Data

**Load Cases and Combinations**

<table>
<thead>
<tr>
<th>Case</th>
<th>Dead</th>
<th>Live</th>
</tr>
</thead>
<tbody>
<tr>
<td>D1</td>
<td>1.200</td>
<td>1.600</td>
</tr>
</tbody>
</table>

### Area Loads

Units: Wa (lb/ft2)

<table>
<thead>
<tr>
<th>Case/Fat Span</th>
<th>Wa</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dead 1</td>
<td>84.30</td>
</tr>
<tr>
<td>2</td>
<td>84.30</td>
</tr>
<tr>
<td>3</td>
<td>84.30</td>
</tr>
<tr>
<td>4</td>
<td>84.30</td>
</tr>
<tr>
<td>5</td>
<td>84.30</td>
</tr>
<tr>
<td>Live 1</td>
<td>100.00</td>
</tr>
<tr>
<td>2</td>
<td>100.00</td>
</tr>
<tr>
<td>3</td>
<td>100.00</td>
</tr>
<tr>
<td>4</td>
<td>100.00</td>
</tr>
<tr>
<td>5</td>
<td>100.00</td>
</tr>
<tr>
<td>Live/Odd 1</td>
<td>75.00</td>
</tr>
<tr>
<td>3</td>
<td>75.00</td>
</tr>
</tbody>
</table>
### Reinforcement Criteria

**Slabs and Ribs**

<table>
<thead>
<tr>
<th>Bar Size</th>
<th>$5$</th>
<th>$8$</th>
<th>$5$</th>
<th>$8$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
</tr>
<tr>
<td>Max</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
</tr>
</tbody>
</table>

Reinforcement not more than 12 in of concrete below top bars.

**Beams**

<table>
<thead>
<tr>
<th>Bar Size</th>
<th>$5$</th>
<th>$8$</th>
<th>$5$</th>
<th>$8$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
</tr>
<tr>
<td>Max</td>
<td>6.00</td>
<td>6.00</td>
<td>6.00</td>
<td>6.00</td>
</tr>
</tbody>
</table>

Reinforcement not more than 12 in of concrete below top bars.

---

### Design Results

*Unless otherwise noted, all results are in the direction of analysis only. Another analysis in the perpendicular direction has to be carried out for two-way slab systems.

### Strip Widths and Distribution Factors

#### Units: Width (ft)

<table>
<thead>
<tr>
<th>Span Strip</th>
<th>Left**</th>
<th>Right**</th>
<th>Moment Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Column</td>
<td>0.22</td>
<td>0.19</td>
<td>0.98</td>
</tr>
<tr>
<td>Middle</td>
<td>0.22</td>
<td>0.19</td>
<td>0.98</td>
</tr>
<tr>
<td>Beam</td>
<td>0.90</td>
<td>0.85</td>
<td>0.90</td>
</tr>
<tr>
<td>2 Column</td>
<td>0.19</td>
<td>0.16</td>
<td>0.98</td>
</tr>
<tr>
<td>Middle</td>
<td>0.19</td>
<td>0.16</td>
<td>0.98</td>
</tr>
<tr>
<td>Beam</td>
<td>0.85</td>
<td>0.87</td>
<td>0.90</td>
</tr>
<tr>
<td>3 Column</td>
<td>0.19</td>
<td>0.16</td>
<td>0.98</td>
</tr>
<tr>
<td>Middle</td>
<td>0.19</td>
<td>0.16</td>
<td>0.98</td>
</tr>
<tr>
<td>Beam</td>
<td>0.87</td>
<td>0.89</td>
<td>0.90</td>
</tr>
<tr>
<td>4 Column</td>
<td>0.19</td>
<td>0.16</td>
<td>0.98</td>
</tr>
<tr>
<td>Middle</td>
<td>0.19</td>
<td>0.16</td>
<td>0.98</td>
</tr>
<tr>
<td>Beam</td>
<td>0.89</td>
<td>0.91</td>
<td>0.90</td>
</tr>
<tr>
<td>5 Column</td>
<td>0.19</td>
<td>0.16</td>
<td>0.98</td>
</tr>
<tr>
<td>Middle</td>
<td>0.19</td>
<td>0.16</td>
<td>0.98</td>
</tr>
<tr>
<td>Beam</td>
<td>0.91</td>
<td>0.93</td>
<td>0.90</td>
</tr>
</tbody>
</table>

*Used for bottom reinforcement. **Used for top reinforcement.

### Top Reinforcement

<table>
<thead>
<tr>
<th>Span Strip</th>
<th>Width</th>
<th>Moment Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Column</td>
<td>0.217</td>
<td>0.98</td>
</tr>
<tr>
<td>Midspace</td>
<td>0.217</td>
<td>0.98</td>
</tr>
<tr>
<td>Right</td>
<td>0.19</td>
<td>0.98</td>
</tr>
<tr>
<td>Midspace</td>
<td>0.217</td>
<td>0.98</td>
</tr>
<tr>
<td>Middle</td>
<td>0.217</td>
<td>0.98</td>
</tr>
<tr>
<td>Midspace</td>
<td>0.217</td>
<td>0.98</td>
</tr>
</tbody>
</table>

---

**Examples**
### Top Bar Details

#### Units: Length (ft)

<table>
<thead>
<tr>
<th>Span Strip</th>
<th>Left</th>
<th>Continuous</th>
<th>Right</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 Column</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Middle</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Beam</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 Column</td>
<td>3.75</td>
<td>4-5</td>
<td>1.75</td>
</tr>
<tr>
<td>M14</td>
<td></td>
<td>14-5</td>
<td>17.50</td>
</tr>
<tr>
<td>Beam</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 Column</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Middle</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Beam</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 Column</td>
<td>6.75</td>
<td>4-5</td>
<td>1.75</td>
</tr>
<tr>
<td>M14</td>
<td></td>
<td>14-5</td>
<td>3.75</td>
</tr>
<tr>
<td>Beam</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5 Column</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Notes:
- +3 - Design governed by minimum reinforcement.
- *5 - Number of bars governed by maximum allowable spacing.
<table>
<thead>
<tr>
<th>Span Strip</th>
<th>Width</th>
<th>Xmax</th>
<th>Xmax</th>
<th>AmMin</th>
<th>AmMax</th>
<th>AmReq</th>
<th>SpProv</th>
<th>Bars</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Column</td>
<td>1.17</td>
<td>0.00</td>
<td>0.411</td>
<td>0.039</td>
<td>0.039</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
</tr>
<tr>
<td>Beam</td>
<td>1.17</td>
<td>0.00</td>
<td>0.411</td>
<td>0.039</td>
<td>0.039</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
</tr>
<tr>
<td>2 Column</td>
<td>7.58</td>
<td>6.47</td>
<td>8.750</td>
<td>0.993</td>
<td>6.883</td>
<td>0.456</td>
<td>11.375</td>
<td>8-45<em>3</em>5</td>
</tr>
<tr>
<td>Beam</td>
<td>1.17</td>
<td>40.17</td>
<td>8.000</td>
<td>0.799</td>
<td>4.599</td>
<td>0.601</td>
<td>4.288</td>
<td>3-45<em>3</em>5</td>
</tr>
<tr>
<td>Beam</td>
<td>1.17</td>
<td>36.65</td>
<td>8.750</td>
<td>0.600</td>
<td>4.599</td>
<td>0.455</td>
<td>8.576</td>
<td>2-45<em>3</em>5</td>
</tr>
<tr>
<td>4 Column</td>
<td>7.50</td>
<td>8.50</td>
<td>9.500</td>
<td>0.993</td>
<td>6.883</td>
<td>0.456</td>
<td>11.375</td>
<td>8-45<em>3</em>5</td>
</tr>
<tr>
<td>Beam</td>
<td>1.17</td>
<td>48.17</td>
<td>9.500</td>
<td>0.799</td>
<td>4.599</td>
<td>0.601</td>
<td>4.288</td>
<td>3-45<em>3</em>5</td>
</tr>
<tr>
<td>5 Column</td>
<td>7.50</td>
<td>0.00</td>
<td>0.411</td>
<td>0.039</td>
<td>0.039</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
</tr>
<tr>
<td>Beam</td>
<td>1.17</td>
<td>0.00</td>
<td>0.411</td>
<td>0.039</td>
<td>0.039</td>
<td>0.000</td>
<td>0.000</td>
<td>---</td>
</tr>
</tbody>
</table>

**NOTES:**
*3 - Design governed by minimum reinforcement.
*5 - Number of bars governed by maximum allowable spacing.

**Bottom Bar Details**

<table>
<thead>
<tr>
<th>Span Strip</th>
<th>Bars Start</th>
<th>Length</th>
<th>Bars Start</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Column</td>
<td>1.17</td>
<td>0.00</td>
<td>17.50</td>
<td>17.50</td>
</tr>
<tr>
<td>Beam</td>
<td>1.17</td>
<td>0.00</td>
<td>17.50</td>
<td>17.50</td>
</tr>
<tr>
<td>2 Column</td>
<td>8-45</td>
<td>0.00</td>
<td>17.50</td>
<td>14.88</td>
</tr>
<tr>
<td>Beam</td>
<td>3-45</td>
<td>0.00</td>
<td>17.50</td>
<td>17.50</td>
</tr>
<tr>
<td>3 Column</td>
<td>8-45</td>
<td>0.00</td>
<td>17.50</td>
<td>12.25</td>
</tr>
<tr>
<td>Beam</td>
<td>2-45</td>
<td>0.00</td>
<td>17.50</td>
<td>17.50</td>
</tr>
<tr>
<td>4 Column</td>
<td>8-45</td>
<td>0.00</td>
<td>17.50</td>
<td>14.88</td>
</tr>
<tr>
<td>Beam</td>
<td>3-45</td>
<td>0.00</td>
<td>17.50</td>
<td>17.50</td>
</tr>
<tr>
<td>5 Column</td>
<td>1.17</td>
<td>0.00</td>
<td>17.50</td>
<td>17.50</td>
</tr>
</tbody>
</table>

**Flexural Capacity**

<table>
<thead>
<tr>
<th>Span Strip</th>
<th>x (ft)</th>
<th>Ax (in²)</th>
<th>PhiMn</th>
<th>PhiMn+</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Column</td>
<td>0.000</td>
<td>2.48</td>
<td>-44.05</td>
<td>0.00</td>
</tr>
<tr>
<td>Beam</td>
<td>0.000</td>
<td>2.48</td>
<td>-44.05</td>
<td>0.00</td>
</tr>
<tr>
<td>Middle</td>
<td>0.000</td>
<td>4.34</td>
<td>-77.08</td>
<td>0.00</td>
</tr>
<tr>
<td>Beam</td>
<td>0.000</td>
<td>4.34</td>
<td>-77.08</td>
<td>0.00</td>
</tr>
<tr>
<td>2 Column</td>
<td>0.000</td>
<td>2.48</td>
<td>-44.05</td>
<td>44.05</td>
</tr>
<tr>
<td>Beam</td>
<td>0.000</td>
<td>2.48</td>
<td>-44.05</td>
<td>44.05</td>
</tr>
<tr>
<td>Middle</td>
<td>0.000</td>
<td>4.34</td>
<td>-77.08</td>
<td>0.00</td>
</tr>
<tr>
<td>Beam</td>
<td>0.000</td>
<td>4.34</td>
<td>-77.08</td>
<td>0.00</td>
</tr>
</tbody>
</table>

**Units:** 
- x (ft), Ax (in²), PhiMn (k-ft)
- x AxTop, AxBot

---

**Example 5 - PCA Notes on ACI 318-08 Example 20-2.1e**

Page 5
<table>
<thead>
<tr>
<th></th>
<th>6-22.70</th>
<th>44.05</th>
<th>6-17.49</th>
<th>44.05</th>
<th>6-17.49</th>
<th>44.05</th>
<th>6-17.49</th>
<th>44.05</th>
</tr>
</thead>
<tbody>
<tr>
<td>Middle</td>
<td>1.24</td>
<td>2.48</td>
<td>-44.05</td>
<td>44.05</td>
<td>6.350</td>
<td>0.00</td>
<td>4.34</td>
<td>4.34</td>
</tr>
<tr>
<td></td>
<td>0.750</td>
<td>4.34</td>
<td>4.34</td>
<td>-77.08</td>
<td>77.08</td>
<td>2.750</td>
<td>4.34</td>
<td>4.34</td>
</tr>
<tr>
<td></td>
<td>3.750</td>
<td>0.00</td>
<td>4.34</td>
<td>0.00</td>
<td>77.08</td>
<td>6.350</td>
<td>0.00</td>
<td>4.34</td>
</tr>
<tr>
<td></td>
<td>6.720</td>
<td>0.00</td>
<td>4.34</td>
<td>0.00</td>
<td>77.08</td>
<td>10.750</td>
<td>0.00</td>
<td>4.34</td>
</tr>
<tr>
<td></td>
<td>11.150</td>
<td>1.74</td>
<td>4.34</td>
<td>-31.95</td>
<td>77.08</td>
<td>11.750</td>
<td>4.34</td>
<td>4.34</td>
</tr>
<tr>
<td></td>
<td>13.875</td>
<td>4.34</td>
<td>4.34</td>
<td>-77.08</td>
<td>77.08</td>
<td>14.875</td>
<td>4.34</td>
<td>2.17</td>
</tr>
<tr>
<td></td>
<td>16.750</td>
<td>4.34</td>
<td>2.17</td>
<td>-77.08</td>
<td>39.72</td>
<td>16.750</td>
<td>4.34</td>
<td>2.17</td>
</tr>
<tr>
<td>Beam</td>
<td>1.24</td>
<td>4.34</td>
<td>-77.08</td>
<td>39.72</td>
<td>0.00</td>
<td>0.93</td>
<td>0.93</td>
<td>-73.66</td>
</tr>
<tr>
<td></td>
<td>0.750</td>
<td>0.93</td>
<td>0.93</td>
<td>-73.66</td>
<td>73.66</td>
<td>3.266</td>
<td>0.93</td>
<td>0.93</td>
</tr>
<tr>
<td></td>
<td>4.266</td>
<td>0.00</td>
<td>0.93</td>
<td>0.00</td>
<td>73.66</td>
<td>6.350</td>
<td>0.00</td>
<td>0.93</td>
</tr>
<tr>
<td></td>
<td>8.750</td>
<td>0.00</td>
<td>0.93</td>
<td>0.00</td>
<td>73.66</td>
<td>10.234</td>
<td>0.00</td>
<td>0.93</td>
</tr>
<tr>
<td></td>
<td>11.150</td>
<td>0.80</td>
<td>0.93</td>
<td>-63.46</td>
<td>73.66</td>
<td>11.302</td>
<td>0.93</td>
<td>0.93</td>
</tr>
<tr>
<td></td>
<td>14.987</td>
<td>0.93</td>
<td>0.93</td>
<td>-73.66</td>
<td>73.66</td>
<td>16.054</td>
<td>1.24</td>
<td>0.93</td>
</tr>
<tr>
<td></td>
<td>16.750</td>
<td>1.24</td>
<td>0.93</td>
<td>-97.13</td>
<td>73.66</td>
<td>17.500</td>
<td>1.24</td>
<td>0.93</td>
</tr>
<tr>
<td>3 Column</td>
<td>0.000</td>
<td>2.48</td>
<td>2.48</td>
<td>-44.05</td>
<td>44.05</td>
<td>0.000</td>
<td>2.48</td>
<td>2.48</td>
</tr>
<tr>
<td></td>
<td>0.750</td>
<td>2.48</td>
<td>2.48</td>
<td>-44.05</td>
<td>44.05</td>
<td>6.350</td>
<td>2.48</td>
<td>2.48</td>
</tr>
<tr>
<td></td>
<td>8.750</td>
<td>2.48</td>
<td>2.48</td>
<td>-44.05</td>
<td>44.05</td>
<td>11.150</td>
<td>2.48</td>
<td>2.48</td>
</tr>
<tr>
<td></td>
<td>16.750</td>
<td>2.48</td>
<td>2.48</td>
<td>-44.05</td>
<td>44.05</td>
<td>17.500</td>
<td>2.48</td>
<td>2.48</td>
</tr>
<tr>
<td>Middle</td>
<td>0.000</td>
<td>4.34</td>
<td>2.17</td>
<td>-77.08</td>
<td>39.72</td>
<td>0.750</td>
<td>4.34</td>
<td>2.17</td>
</tr>
<tr>
<td></td>
<td>2.625</td>
<td>4.34</td>
<td>2.17</td>
<td>-77.08</td>
<td>39.72</td>
<td>3.625</td>
<td>4.34</td>
<td>4.34</td>
</tr>
<tr>
<td></td>
<td>6.350</td>
<td>4.34</td>
<td>4.34</td>
<td>-77.08</td>
<td>77.08</td>
<td>9.750</td>
<td>4.34</td>
<td>4.34</td>
</tr>
<tr>
<td></td>
<td>11.150</td>
<td>4.34</td>
<td>4.34</td>
<td>-77.08</td>
<td>77.08</td>
<td>13.875</td>
<td>4.34</td>
<td>4.34</td>
</tr>
<tr>
<td></td>
<td>14.875</td>
<td>4.34</td>
<td>4.34</td>
<td>-77.08</td>
<td>77.08</td>
<td>16.750</td>
<td>4.34</td>
<td>2.17</td>
</tr>
<tr>
<td>Beam</td>
<td>0.000</td>
<td>1.24</td>
<td>0.62</td>
<td>-97.13</td>
<td>49.65</td>
<td>0.750</td>
<td>1.24</td>
<td>0.62</td>
</tr>
<tr>
<td></td>
<td>1.246</td>
<td>1.24</td>
<td>0.62</td>
<td>-97.13</td>
<td>49.65</td>
<td>2.217</td>
<td>0.94</td>
<td>0.62</td>
</tr>
<tr>
<td></td>
<td>2.246</td>
<td>0.92</td>
<td>0.62</td>
<td>-72.95</td>
<td>49.65</td>
<td>3.217</td>
<td>0.62</td>
<td>0.62</td>
</tr>
<tr>
<td></td>
<td>6.350</td>
<td>0.62</td>
<td>0.62</td>
<td>-49.65</td>
<td>49.65</td>
<td>8.750</td>
<td>0.62</td>
<td>0.62</td>
</tr>
<tr>
<td></td>
<td>11.150</td>
<td>0.62</td>
<td>0.62</td>
<td>-49.65</td>
<td>49.65</td>
<td>14.283</td>
<td>0.62</td>
<td>0.62</td>
</tr>
<tr>
<td></td>
<td>15.254</td>
<td>0.92</td>
<td>0.62</td>
<td>-72.95</td>
<td>49.65</td>
<td>15.283</td>
<td>0.94</td>
<td>0.62</td>
</tr>
<tr>
<td></td>
<td>16.254</td>
<td>1.24</td>
<td>0.62</td>
<td>-97.13</td>
<td>49.65</td>
<td>16.750</td>
<td>1.24</td>
<td>0.62</td>
</tr>
<tr>
<td></td>
<td>17.500</td>
<td>1.24</td>
<td>0.62</td>
<td>-97.13</td>
<td>49.65</td>
<td>4 Column</td>
<td>0.000</td>
<td>2.48</td>
</tr>
<tr>
<td></td>
<td>0.750</td>
<td>2.48</td>
<td>2.48</td>
<td>-44.05</td>
<td>44.05</td>
<td>1.751</td>
<td>2.48</td>
<td>2.48</td>
</tr>
<tr>
<td></td>
<td>5.750</td>
<td>1.24</td>
<td>2.48</td>
<td>-22.70</td>
<td>44.05</td>
<td>6.350</td>
<td>0.50</td>
<td>2.48</td>
</tr>
<tr>
<td></td>
<td>6.750</td>
<td>0.00</td>
<td>2.48</td>
<td>0.00</td>
<td>44.05</td>
<td>8.750</td>
<td>0.00</td>
<td>2.48</td>
</tr>
<tr>
<td></td>
<td>11.150</td>
<td>0.00</td>
<td>2.48</td>
<td>0.00</td>
<td>44.05</td>
<td>13.750</td>
<td>0.00</td>
<td>2.48</td>
</tr>
<tr>
<td></td>
<td>16.750</td>
<td>1.24</td>
<td>2.48</td>
<td>-22.70</td>
<td>44.05</td>
<td>15.749</td>
<td>1.24</td>
<td>2.48</td>
</tr>
<tr>
<td></td>
<td>16.749</td>
<td>2.48</td>
<td>2.48</td>
<td>-44.05</td>
<td>44.05</td>
<td>16.750</td>
<td>2.48</td>
<td>2.48</td>
</tr>
<tr>
<td>Middle</td>
<td>0.000</td>
<td>4.34</td>
<td>2.17</td>
<td>-77.08</td>
<td>39.72</td>
<td>0.750</td>
<td>4.34</td>
<td>2.17</td>
</tr>
<tr>
<td></td>
<td>2.625</td>
<td>4.34</td>
<td>2.17</td>
<td>-77.08</td>
<td>39.72</td>
<td>3.625</td>
<td>4.34</td>
<td>4.34</td>
</tr>
<tr>
<td></td>
<td>6.350</td>
<td>4.34</td>
<td>4.34</td>
<td>-77.08</td>
<td>77.08</td>
<td>9.750</td>
<td>4.34</td>
<td>4.34</td>
</tr>
<tr>
<td></td>
<td>17.500</td>
<td>2.48</td>
<td>2.48</td>
<td>-44.05</td>
<td>44.05</td>
<td>6.350</td>
<td>1.74</td>
<td>4.34</td>
</tr>
</tbody>
</table>
6.750 0.00 4.34 0.00 77.08
8.750 0.00 4.34 0.00 77.08
11.150 0.00 4.34 0.00 77.08
13.750 0.00 4.34 0.00 77.08
14.750 4.34 4.34 -77.08 77.08
16.750 4.34 4.34 -77.08 77.08
17.500 4.34 4.34 -77.08 77.08
Beam 0.000 1.24 0.93 -97.13 73.66
0.750 1.24 0.93 -97.13 73.66
1.496 1.24 0.93 -97.13 73.66
2.243 0.93 0.93 -73.66 73.66
6.198 0.93 0.93 -73.66 73.66
6.250 0.80 0.93 -63.46 73.66
7.266 0.00 0.93 0.00 73.66
8.750 0.00 0.93 0.00 73.66
11.150 0.00 0.93 0.00 73.66
13.234 0.93 0.93 0.00 73.66
14.234 0.93 0.93 -73.66 73.66
16.750 0.93 0.93 -73.66 73.66
17.500 0.93 0.93 -73.66 73.66

5 Column
0.000 2.48 0.00 -44.05 0.00
0.131 2.48 0.00 -44.05 0.00
0.348 2.48 0.00 -44.05 0.00
0.375 2.48 0.00 -44.05 0.00
0.533 2.48 0.00 -44.05 0.00
0.750 2.48 0.00 -44.05 0.00

Middle
0.000 4.34 0.00 -77.08 0.00
0.131 4.34 0.00 -77.08 0.00
0.348 4.34 0.00 -77.08 0.00
0.375 4.34 0.00 -77.08 0.00
0.533 4.34 0.00 -77.08 0.00
0.750 4.34 0.00 -77.08 0.00

Beam
0.000 0.93 0.00 -73.66 0.00
0.131 0.93 0.00 -73.66 0.00
0.348 0.93 0.00 -73.66 0.00
0.375 0.93 0.00 -73.66 0.00
0.533 0.93 0.00 -73.66 0.00
0.750 0.93 0.00 -73.66 0.00

--- Longitudinal Beam Shear Reinforcement Required ---

| Units: d (in), Start, End, Xv (ft), PhIVc, Vu (kip), Av/\(\text{in}^2/\text{ln}) |
|-----------------|-----------------|-----------------|-----------------|-----------------|
| Span | d | PhIVc | Start | End | Vu | Xv | Av/\(\text{in}^2/\text{ln}) |
| 1 | 18.19 | 24.16 | 0.000 | 0.000 | 0.000 | 0.000 | 0.0000 |
| 2 | 18.19 | 24.16 | 2.266 | 4.118 | 32.35 | 2.266 | 0.0117 |
| | | | | 4.118 | 5.971 | 21.70 | 4.118 | 0.0117 |
| | | | | 5.971 | 7.624 | 11.38 | 5.971 | 0.0000 |
| | | | | 7.624 | 9.676 | 10.23 | 9.676 | 0.0000 |
| | | | | 9.676 | 11.529 | 20.88 | 11.529 | 0.0117 |
| | | | | 11.529 | 13.382 | 31.52 | 13.382 | 0.0117 |
| | | | | 13.382 | 15.234 | 42.17 | 15.234 | 0.0220 |
| 3 | 18.19 | 24.16 | 2.266 | 4.118 | 37.26 | 2.266 | 0.0160 |
| | | | | 4.118 | 5.971 | 26.61 | 4.118 | 0.0117 |
| | | | | 5.971 | 7.624 | 15.97 | 5.971 | 0.0117 |
| | | | | 7.624 | 9.676 | 6.78 | 9.676 | 0.0000 |
| | | | | 9.676 | 11.529 | 15.97 | 11.529 | 0.0117 |
| | | | | 11.529 | 13.382 | 26.61 | 13.382 | 0.0117 |
| | | | | 13.382 | 15.234 | 37.26 | 15.234 | 0.0160 |
| 4 | 18.19 | 24.16 | 2.266 | 4.118 | 42.17 | 2.266 | 0.0220 |
| | | | | 4.118 | 5.971 | 31.52 | 4.118 | 0.0117 |
| | | | | 5.971 | 7.624 | 20.88 | 5.971 | 0.0117 |
| | | | | 7.624 | 9.676 | 10.23 | 7.624 | 0.0000 |
| | | | | 9.676 | 11.529 | 11.38 | 11.529 | 0.0000 |
| | | | | 11.529 | 13.382 | 21.70 | 13.382 | 0.0117 |
| | | | | 13.382 | 15.234 | 32.35 | 15.234 | 0.0117 |
| 5 | 18.19 | 24.16 | 0.750 | 0.750 | 0.00 | 0.00 | 0.0000 |

--- Longitudinal Beam Shear Reinforcement Details ---

<table>
<thead>
<tr>
<th>Units: spacing &amp; distance (in), Span Size Stirrups (2 legs each unless otherwise noted)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
</tbody>
</table>

Beam Shear Capacity
### Slab Shear Capacity

<table>
<thead>
<tr>
<th>Span</th>
<th>d (in)</th>
<th>Start</th>
<th>End</th>
<th>X (ft)</th>
<th>PhIVc</th>
<th>PhIVm</th>
<th>Vu (kip)</th>
<th>Av/s (in²/in)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>18.19</td>
<td>24.16</td>
<td>0.000</td>
<td>0.750</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>12.08</td>
</tr>
<tr>
<td>2</td>
<td>18.19</td>
<td>24.16</td>
<td>0.000</td>
<td>1.000</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>46.79</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.000</td>
<td>5.971</td>
<td>0.0277</td>
<td>46.79</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.000</td>
<td>5.971</td>
<td>0.0277</td>
<td>46.79</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.000</td>
<td>5.971</td>
<td>0.0277</td>
<td>46.79</td>
</tr>
<tr>
<td>3</td>
<td>18.19</td>
<td>24.16</td>
<td>0.000</td>
<td>1.000</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>45.05</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.000</td>
<td>5.971</td>
<td>0.0277</td>
<td>45.05</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.000</td>
<td>5.971</td>
<td>0.0277</td>
<td>45.05</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.000</td>
<td>5.971</td>
<td>0.0277</td>
<td>45.05</td>
</tr>
<tr>
<td>4</td>
<td>18.19</td>
<td>24.16</td>
<td>0.000</td>
<td>1.000</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>45.05</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.000</td>
<td>5.971</td>
<td>0.0277</td>
<td>45.05</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.000</td>
<td>5.971</td>
<td>0.0277</td>
<td>45.05</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.000</td>
<td>5.971</td>
<td>0.0277</td>
<td>45.05</td>
</tr>
<tr>
<td>5</td>
<td>18.19</td>
<td>24.16</td>
<td>0.000</td>
<td>0.750</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>12.08</td>
</tr>
</tbody>
</table>

### Flexural Transfer of Negative Unbalanced Moment at Supports

<table>
<thead>
<tr>
<th>Span</th>
<th>b (in)</th>
<th>d (in)</th>
<th>X (ft)</th>
<th>PhIVc</th>
<th>PhIVm</th>
<th>Vu (kip)</th>
<th>Av/s (in²/in)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>250.00</td>
<td>4.19</td>
<td>0.000</td>
<td>99.32</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>2</td>
<td>250.00</td>
<td>4.19</td>
<td>0.000</td>
<td>99.32</td>
<td>0.00</td>
<td>0.00</td>
<td>16.40</td>
</tr>
<tr>
<td>3</td>
<td>250.00</td>
<td>4.19</td>
<td>0.000</td>
<td>99.32</td>
<td>0.00</td>
<td>0.00</td>
<td>16.40</td>
</tr>
<tr>
<td>4</td>
<td>250.00</td>
<td>4.19</td>
<td>0.000</td>
<td>99.32</td>
<td>0.00</td>
<td>0.00</td>
<td>16.40</td>
</tr>
<tr>
<td>5</td>
<td>250.00</td>
<td>4.19</td>
<td>0.000</td>
<td>99.32</td>
<td>0.00</td>
<td>0.00</td>
<td>16.40</td>
</tr>
</tbody>
</table>

### Punching Shear Results

<table>
<thead>
<tr>
<th>Supp</th>
<th>Vu (kip)</th>
<th>Mumb (k-ft)</th>
<th>vu (psl)</th>
<th>PhiIVc (psi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>48.86</td>
<td>46.8</td>
<td>80.04</td>
<td>111.0</td>
</tr>
<tr>
<td>2</td>
<td>104.56</td>
<td>90.5</td>
<td>-16.77</td>
<td>111.0</td>
</tr>
<tr>
<td>3</td>
<td>104.56</td>
<td>90.5</td>
<td>16.77</td>
<td>111.1</td>
</tr>
<tr>
<td>4</td>
<td>48.86</td>
<td>46.8</td>
<td>-80.04</td>
<td>111.0</td>
</tr>
</tbody>
</table>

### Deflections

<table>
<thead>
<tr>
<th>Span</th>
<th>Ig, Hor, Mmax (k-ft)</th>
<th>Load Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>9333</td>
<td>9333</td>
</tr>
<tr>
<td>2</td>
<td>20489</td>
<td>20338</td>
</tr>
<tr>
<td>3</td>
<td>20421</td>
<td>20348</td>
</tr>
<tr>
<td>4</td>
<td>20489</td>
<td>20338</td>
</tr>
</tbody>
</table>
Maximum Instantaneous Deflections - Direction of Analysis

<table>
<thead>
<tr>
<th>Span</th>
<th>Ddead</th>
<th>Dlive</th>
<th>Dtotal</th>
<th>Strip</th>
<th>Iy</th>
<th>LDF Ratio</th>
<th>Ddead</th>
<th>Dlive</th>
<th>Dtotal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-0.001</td>
<td>-0.001</td>
<td>-0.003</td>
<td>Column</td>
<td>20040.5</td>
<td>0.781</td>
<td>0.990</td>
<td>-0.001</td>
<td>-0.001</td>
</tr>
<tr>
<td>2</td>
<td>0.012</td>
<td>0.014</td>
<td>0.026</td>
<td>Middle</td>
<td>2862</td>
<td>0.219</td>
<td>1.916</td>
<td>-0.002</td>
<td>-0.002</td>
</tr>
<tr>
<td>3</td>
<td>0.006</td>
<td>0.007</td>
<td>0.013</td>
<td>Middle</td>
<td>2862</td>
<td>0.307</td>
<td>2.723</td>
<td>0.032</td>
<td>0.039</td>
</tr>
<tr>
<td>4</td>
<td>0.012</td>
<td>0.014</td>
<td>0.026</td>
<td>Middle</td>
<td>2862</td>
<td>0.327</td>
<td>2.903</td>
<td>0.017</td>
<td>0.020</td>
</tr>
<tr>
<td>5</td>
<td>-0.001</td>
<td>-0.001</td>
<td>-0.003</td>
<td>Column</td>
<td>20040.5</td>
<td>0.781</td>
<td>0.990</td>
<td>-0.001</td>
<td>-0.001</td>
</tr>
</tbody>
</table>

Maximum Long-term Deflections - Direction of Analysis

<table>
<thead>
<tr>
<th>Span</th>
<th>Dext Lambda</th>
<th>Dcs</th>
<th>Dcr+Lu</th>
<th>Dcr+L1</th>
<th>Dtotal</th>
<th>Dext Lambda</th>
<th>Dcs</th>
<th>Dcr+Lu</th>
<th>Dcr+L1</th>
<th>Dtotal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-0.001</td>
<td>2.000</td>
<td>-0.002</td>
<td>-0.004</td>
<td>-0.004</td>
<td>-0.005</td>
<td>-0.002</td>
<td>2.000</td>
<td>-0.005</td>
<td>-0.007</td>
</tr>
<tr>
<td>2</td>
<td>0.010</td>
<td>2.000</td>
<td>0.021</td>
<td>0.033</td>
<td>0.033</td>
<td>0.044</td>
<td>0.032</td>
<td>2.000</td>
<td>0.045</td>
<td>0.103</td>
</tr>
<tr>
<td>3</td>
<td>0.005</td>
<td>2.000</td>
<td>0.010</td>
<td>0.016</td>
<td>0.016</td>
<td>0.021</td>
<td>0.017</td>
<td>2.000</td>
<td>0.034</td>
<td>0.054</td>
</tr>
<tr>
<td>4</td>
<td>0.010</td>
<td>2.000</td>
<td>0.021</td>
<td>0.033</td>
<td>0.033</td>
<td>0.044</td>
<td>0.032</td>
<td>2.000</td>
<td>0.045</td>
<td>0.103</td>
</tr>
<tr>
<td>5</td>
<td>-0.001</td>
<td>2.000</td>
<td>-0.002</td>
<td>-0.004</td>
<td>-0.004</td>
<td>-0.005</td>
<td>-0.002</td>
<td>2.000</td>
<td>-0.005</td>
<td>-0.007</td>
</tr>
</tbody>
</table>

Material Takeoff

Reinforcement in the Direction of Analysis

- Top Bars: 989.4 lb => 18.32 lb/ft => 0.833 lb/ft^2
- Bottom Bars: 1274.0 lb => 23.59 lb/ft => 1.072 lb/ft^2
- Staircase: 98.3 lb => 1.82 lb/ft => 0.083 lb/ft^2
- Total Steel: 2361.7 lb => 43.74 lb/ft => 1.988 lb/ft^2
- Concrete: 817.2 ft^3 => 15.13 ft^3/ft => 0.688 ft^3/ft^2
Graphical Output

Loads
Internal Forces
Moment Capacity

LEGEND:
- Envelope Curve
- Capacity Curve
- Support Centerline
- Face of Support
Shear Capacity
Deflection
Beam Strip Flexural and Transverse Reinforcement
Middle Strip Flexural Reinforcement
Column Strip Flexural Reinforcement
## Appendix

### Conversion Factors – English to SI

<table>
<thead>
<tr>
<th>To convert from</th>
<th>To</th>
<th>Multiply by</th>
</tr>
</thead>
<tbody>
<tr>
<td>in.</td>
<td>m (1000 mm)</td>
<td>0.025400</td>
</tr>
<tr>
<td>ft</td>
<td>m</td>
<td>0.304800</td>
</tr>
<tr>
<td>lb</td>
<td>N (0.001 kN)</td>
<td>4.448222</td>
</tr>
<tr>
<td>kip (1000 lbs)</td>
<td>kN</td>
<td>4.448222</td>
</tr>
<tr>
<td>plf (lb/ft)</td>
<td>N/m</td>
<td>14.593904</td>
</tr>
<tr>
<td>psi (lb/in.²)</td>
<td>kPa</td>
<td>6.894757</td>
</tr>
<tr>
<td>ksi (kips/in.²)</td>
<td>MPa</td>
<td>6.894757</td>
</tr>
<tr>
<td>psf (lb/ft²)</td>
<td>N/m² (Pa)</td>
<td>47.88026</td>
</tr>
<tr>
<td>pcf (lb/ft³)</td>
<td>kg/m³</td>
<td>16.018460</td>
</tr>
<tr>
<td>ft-kips</td>
<td>kN • m</td>
<td>1.355818</td>
</tr>
</tbody>
</table>

### Conversion Factors – SI to English

<table>
<thead>
<tr>
<th>To convert from</th>
<th>To</th>
<th>Multiply by</th>
</tr>
</thead>
<tbody>
<tr>
<td>m (1000 mm)</td>
<td>in</td>
<td>39.37008</td>
</tr>
<tr>
<td>m</td>
<td>ft</td>
<td>3.28084</td>
</tr>
<tr>
<td>N (0.001 kN)</td>
<td>lb</td>
<td>0.224809</td>
</tr>
<tr>
<td>kN</td>
<td>kip (1000 lbs)</td>
<td>0.224809</td>
</tr>
<tr>
<td>kN/m</td>
<td>plf (lb/ft)</td>
<td>68.52601</td>
</tr>
<tr>
<td>MPa</td>
<td>psi (lb/in.²)</td>
<td>145.0377</td>
</tr>
<tr>
<td>MPa</td>
<td>ksi (kips/in.²)</td>
<td>0.145038</td>
</tr>
<tr>
<td>kN/m² (kPa)</td>
<td>psf (lb/ft²)</td>
<td>20.88555</td>
</tr>
<tr>
<td>kg/m³</td>
<td>pcf (lb/ft³)</td>
<td>0.062428</td>
</tr>
<tr>
<td>kN • m</td>
<td>ft-kips</td>
<td>0.737562</td>
</tr>
</tbody>
</table>

### Contact Information


E-mail:  
- info@StructurePoint.org
- support@StructurePoint.org

StructurePoint, LLC.
5420 Old Orchard Road
Skokie, IL 60077
USA

Phone:  (847) 966-4357

Fax:  (847) 966-1542